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COMMUNICATIONS 

APPLES HARE 
Accessing A Ftle On An AppleShare Server 
Accessing a shared file, folder or volume through the 
Chooser requires seven mouse steps. Creating a folder 
of aliases for shared items and leaving it on the desk­
top or on your Apple menu allows access in two 
mouse steps. 

1b access a particular shared item, simply open the 
File Server folder and double-click on the alias of the 
desired item. In the Password dialog box, just enter 
your password (if applicable) and click on OK. 

Better yet, you can access the File Server folder direct­
ly from the Open dialog box within an application. 
just click on the Desktop button, double-click on the 
File Server folder, pick a shared item, and double­
click on it. 

When the time comes that everyone on the network 
keeps a File Server folder of aliases instead of the 
actual shared files on their desktop, at day's end, as 
people start to shut down their Macs, you'll be less 
likely to see a flurry of Shut Down Alerts across the 
network. 

Prevent Server Virus Infection 
1b protect your server's Desktop file against \VDEF 
infections, simply lock the top level against changes. 
This has the side effect of keeping users tidy. 

Keeping Users From 'Ihlshing Database 
Ftles 
How can you keep users from trashing a database file 
on an AppleShare server, even though they need access 
to it? 

AppleShare controls user access by folder, so the first 
thing you have to do is to put the file in its own folder, 
which you can assign specific privileges to. 

If users need only Read Access to the file, you can 
simply select the folder, choose Privileges from the 
Finder's File menu, and select the See Folders and See 
Files check boxes for your group (or everyone). Don't 
check the Make Changes box, though. 

There's no easy way to keep people from trashing the 
file if they need write access. One kludgy solution is 
to use ResEdit or a similar file utility to make the 
database file invisible. This will keep the file's icon 
from being displayed in the Finder, which means the 
file can't simply be dragged to the trash. Note, how­
ever, that utility software still will be able to see and 
delete the file. 

Passwords Are Case Sensitive 
If your AppleShare server doesn't accept your password 
but you know you are typing it correctly, check the 
Caps Lock key. AppleShare passwords are case-sensitive. 

Security Rating 
AppleShare is rated as Cl in the National Computer 
Security Center's security criteria, according to Apple. 
This is just one grade above D, which indicates some­
thing that's not at all secure. 

Access Server Files With Timbuktu 
Wanna grab some files fast from an AppleShare 
server? If you're running Farallon Computing Inc.'s 
Timbuktu on it, you can transfer files quickly from 
virtually anywhere- including unmounted volumes 
and the Server folder 

APPLESHARE 3.0 
Open Ftle Limit 
AppleShare 3.0, despite the hopes of many people, does 
not allow more open files per server than 'krsion 201 or 
System Ts file sharing. The limit is still346 files open 
simultaneously on one Mac. 

Server Log-In limits 
According to a note in AppleLink's Thch Info Library 
database, there are strict limits on the number of 
AppleShare servers a Mac can be logged into at once. 
The Mac Plus can handle only three servers simulta­
neously; the Mac SE, Classic and Portable can be 
logged into eight; and the Mac II, LC, SE/30 and 
above (including all PowerBooks) can handle 18 
servers. These limits apply to the number of servers, 
not the number of server volumes, and are indepen­
dent of the amount of RAM in the client Mac. The 
number of volumes that can be mounted on the 
desktop is affected by available memory. 

~: 
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APPLETALK 
Updating Apple'Dllk 
If you are updating AppleThlk on an older Mac, make 
sure to use Apple's Installer. Starting with \ersion 53 of 
AppleTalk, you cannot simply drag the AppleThlk exten­
sion into the System folder. 

Finding A "Lost" Printer 
Sometimes the reason for printing problems is soft­
ware-based. For example, if you use a printer over 
AppleTalk, you might one day find that the printer 
doesn't show up in the Chooser Printer dialog box. 
If this happens to you, first Quit the application and 
make sure your disk contains all the files you need. 
If it does, try this: 

In the Choose Printer dialog box, if the printer you 
need doesn't show up as a print option, disconnect 
AppleTalk and close the dialog box. Then, reopen the 
dialog box and select Apple Talk Connected. Hopefully, 
the missing printer icon will mysteriously reappear so 
you can select it and try to print again. 

Another resort is to reinstall the printer drivers in your 
System Folder. 

Close The Chooser 
1b improve AppleTalk network performance, don't 
leave the Chooser open. Active Choosers create packet 
traffic on Apple Talk networks. On large networks, this 
chews up 5 to 10 percent of the available bandwidth. 

APPLETALK PHASE 2 
Mixing Phase 1 And Phase 2 
When you install System 7.x on a network, Apple rec­
ommends that you upgrade all routers and worksta­
tions to AppleTalk Phase 2, if you haven't already 
done so. A network that mixes AppleTalk Phase 1 and 
Phase 2 can have communications problems under 
System 7.x. 

For example, if you install System 7.x on an Ethernet 
network, workstations that use Phase 2 won't be able 
to talk to those running Phase 1. If you decide to keep 
the entire network on AppleTalk Phase 1, you must 
reinstall Phase I EtherTalk drivers on the System 7.x 
2 

workstations. Upgrading to System 7.x doesn't have 
any adverse effects on Local Talk or TokenTalk net­
works that use AppleTalk Phase 2. 

APPLETALK REMOTE 
ACCESS 
Security Stack Locks Out ARA Network 
Access 
Out of the box, AppleTalk Remote Access can let users 
dial into a network through a Mac. There are numer­
ous security features in the Apple Talk Remote Access 
software that can be implemented by the user doing 
the setup, but network administrators often want 
some control over what these users can do. 

The Security Stack is an Apple utility for those network 
administrators. This HyperCard stack lets the adminis­
trator require a password from any user who tries to set 
up a Mac for dial-in access to the network. The software 
requires a router on the network. 

Security Stack was originally available through APDA 
but also has been posted on AppleLink. The path is 
Software Sampler:Apple SW Update:Macintosh: 
Networking & Communications Product Software: 
AppleTalk Remote Access:Security Stack, and it takes 
about a minute to download. 

Remote Access Dps For Scripting High 
Speeds 
AppleTalk Remote Access depends heavily on the raw 
speed of the modem connection used, but the specific 
settings of your high-speed modem can improve per­
formance. Apple has compiled a set of tips for tuning 
ARA modem scripts: 

-Setyourcomputer'sserial-portspeed to a constant 19.2 
Kbps, since the modem can slow down if necessary. 

-Set the modem to buffer speeds so your Mac's con­
nection to the modem will remain constant. 

- Enable CTS hardware handshaking and always use a 
hardware-handshaking cable with V.32 or V.32bis 
modems. 



Modifying Script Slows Remote Access 
Answer 
You can tell AppleTalk Remote Access (ARA) to answer 
the phone after a certain number of rings, rather than 
instantly. Often this is a concern for folks who have a 
single phone line but prefer to leave ARA running all 
the time. 

Setting the modem to answer after a given number of 
rings requires editing the ARA script you're using-it's 
the one you select in the Modem Setup section of ARA's 
Remote Access Setup window; the actual file is stored 
in the Extensions folder. 

ARA scripts are text files, but most wont processors 
won't open them since their file type is not "TEXT." 1b 
edit one you should duplicate it and then use ResEdit 
or any file-editing utility to change the type from 
"mlts" to "TEXT." 

Now, open the script in your wont processor. At some 
point you should see a section like this: 

!@ANSWER 

! Set up the modem to answer 

@LABEL30 

write '1\TSO= 113" 

Change 'm'SO= 1" to 'm'SO=x/' where "x" is the 
number of rings you want to occur before the modem 
answers the'}Jhone. 

Now save your version of the script (make sure to save 
as text only) and change the file type back to "mlts." 
Change the script's name to indicate it's modified, 
drag it back to the Extensions folder, run ARA and 
select the modified script in the Modem Setup section. 

COMMUNICATION 
TOOLBOX 
Removing It From Your System 
The Communications Toolbox code looks like a sys­
tem extension and quacks like a system extension but 
it isn't a file in the System Folder. The Installer pro­
gram plants that sucker right inside the System file 
itself. The only really safe way to get rid of the Comm 
Toolbox is to have the Installer rip it out for you. 

Launch the Installer, choose the Customize option, 
select Communication Tholbox and hold down the 
Option key. The Install button in the upper right cor­
ner should change to Remove. Click on that button, 
and within seconds you should be rid of it. (By the 
way, this technique works for most Installer scripts.) 

Your only other option is to replace the whole System 
file with a virgin copy, but keep in mind that you'll 
also lose whatever else has been installed in there. 

COMPUSERVE 
Cutting Noise On CompuServe 
On CompuServe, as on any other network, line noise 
can ruin an upload or download. To cut out the noise, 
make the first character in each "typing" command 
in your macro the control character that says to the 
network, "Ignore what I've typed so far." This cuts 
down on problems associated with your program's 
reading noise input as you're typing. \Vhen you're on 
CompuServe, type Control-U. This tells the service to 
ignore noise. 

E·MAIL 
It's All In The 1ide 
Too busy to be bothered with opening your mail? 
Often, the substance of a message can be expressed in 
the title, leaving intricate details for the body of the 
message. For example, instead of entitling a message 
"Meeting Reminder" and furnishing the date and 
time in the body of the message, you can entitle it 
"Meeting 10/22 1 P.M." The title then acts as an effec­
tive reminder. You get all the infonnation you need 
just by looking at the mail window. 

Discourage E-Mail Printing 
One of the benefits of E-mail is that it can reduce the 
amount of paper in an office, but printing messages 
negates this advantage. Each time a message is print­
ed, it has to be transmitted over the network twice if 
you use a network spooler. An E-mail message sent 
to 20 people and printed by 10 should probably have 
been photocopied. 

J.: 
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There are usually two main reasons for printing their 
E-mail. The first is that they want to keep a record of 
their correspondence. Some E-mail packages, such as 
Quick Mail, let you create electronic folders in which 
you can store old messages. Another feature your 
E-mail program may have is the ability to store mail 
messages on a local hard disk, rather than on the 
mail server. Rereading a message stored on the server 
adds network traffic. 

Another reason for printing E-mail messages is that 
users are only in the office for a short time each day 
and want to be able to read them later. Remote access 
to the mail server might be a worthwhile alternative 
for such users. Perhaps they already have a computer 
and modem at home or can borrow the necessary 
equipment from their company. Using a remote 
computer lets them respond electronically to messages 
as they read them. 

ETHERNET 
Ethernet Connections In Macs 
The Mac Quadras and LaserWriter Ilg have built-in 
Ethernet along with LocalThlk. The Ethernet connec­
tions use AppleTalk Phase 2 protocols only. If you have 
an AppleTalk Phase 1 Ethernet network and you plug 
in one of these devices, it won't be able to communi­
cate with anything else. 

You'll need a transition bridge: a router that can 
handle both Phase 1 and Phase 2 traffic. 

GENERAL INFORMATION 
Getting Cheap Practice 
If you're new to telecommunications, or are just get­
ting to know a new telecommunications program, 
you don't have to pay a lot of expensive connect 
charges while you learn how to upload and download 
on networks. Contact your local Macintosh users' 
group or an experienced friend and get the phone 
number of a free local bulletin board. Practice uploading 
and downloading on the free network. 

Once you know your way around the local network, 
look for shareware and public domain libraries, 
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where you might be able to download programs for 
far less than youtl be charged by a national network. 

When Call Waiting Disconnects 
'Jioansmissions 
If you have Call Waiting and a modem, you can run 
into a lot of interrupted telecommunications sessions. 
A little-known trick is to add "*70" on touch-tone 
phones, or to dial1170 on pulse phones, just before the 
number to be dialed in your modem dial command. 
This disables Call Waiting. This tip may not work in 
all areas of the country. Ask your phone company for 
more details. 

'Ielephone Noise Can Interrupt 
'lhlnsmissions 
If you experience continued failures midway through 
transmission while using a protocol transmission, 
your problem could be telephone noise. Try getting 
a cleaner connection by hanging up and redialing. 

Disabling Internal Modem Speaker 
The internal modem speaker of a Hayes-compatible 
modem can be temporarily disabled. just type ATMO 
from your terminal program and press Return. The 
command will be acknowledged by an "OK." Tum the 
volume back on by typingATM1 and pressing Return. 

Getting Your Program To Wait Longer To 
Redial 
Many terminal programs allow users to change the 
amount of time that the modem waits for a carrier 
before redialing when in auto-redial mode. The 
command ATS7 =X sets the number of seconds the 
program waits, with X= the default number of sec­
onds. Default value is usually 20 seconds, but you can 
change it to almost any number less than 255 by 
changing the default value. 

INSTANT UPDATE 
Updating Several Documents At Once 
If you're using ON Thchnology Inc.'s Instant Update and 
you want to update several documents at once, do this: 
Select all documents with data that have changed, hold 
down the Option key and click the Update button. 



INTERNET 
What Is It? 
The Internet is sort of an existential roncept. It's a world­
wide network of almost half a million romputers belong­
ing to the military, institutes of higher and lower learn­
ing, research organizations, and rorporations big and 
small. The Internet is not a destination; it's a means by 
which you get to your destination. 

1b access it, you log on to a nearby romputer (an Internet 
site or host) that's been linked into the net and then run 
a set of programs for processing mail and files. 

Mail and files move from romputer to romputer until they 
reach their final destination. The Internet functions like 
one massive living, breathing organism If it were any 
more monstrous, it would battle Godzilla in 1bkyo Bay. 

But despite its size, many of the services you would expect 
from a rommercial on-line entity are available via the 
Internet. Users send personal mail by sending a message 
to someone's individual Internet address. It also has more 
than 2,000 "newsgroups," places where users can post 
messages fbr all to see. You can also download free or 
almost free software; in fact, you could spend the rest of 
your life downloading stuff and still get just a fraction of 
the files that interest you. 

To find Macintosh files on the Internet, you must first 
search a list of computer systems for one that (a) has a 
whole lot of Mac software and (b) allows open access 
for total strangers such as you, and then you have to 
tell your local Internet host to open a connection. 

Apple has Internet connections, and although it does 
not offer help, it does have a useful Internet-accessi­
ble file area open to the public. System software, 
source code, demo files, stacks, hacks, and official 
technical notes (real soon now) are available from 
Apple's FfP (file-transfer protocol) site. To connect to 
it, log on to your local Internet host and type 
ftp.apple.com (note that this command may vary 
from system to system). Enter Anonymous when 
Apple's computer asks for your user name and use 
your Internet address for the password, and you' 11 be 
in. You can also send mail to any AppleLink user via 
the Internet by addressing your message to 
user@applelink.apple.com, where "user" is the 
user's AppleLink ID. 

The best part about Internet: Using the Internet is 
free. There's no sign-up fee, no monthly charge, no 
per-message charge, no hourly rate. Sometimes you 
have to pay a modest fee to your local Internet host 
computer, but using the net itself is free. If you're in 
school or work for a big corporation or the govern­
ment, the big computer you have to deal with every 
day is probably on the Internet. (Acik your system man­
ager for details on how to access Internet services.) If 
you aren't fret not-many companies rent time on 
their computers to folks who want Internet access. 
Most popular are sites set up as PAU (public-access 
UNIX) systems. Call up a local bulletin-board system, 
and ask around for the number of a PAU in your area. 

Clear Out The Old Before Hanging Zones 
Names 
When you're using Apple's AppleTalk Internet Router 
software, it's easy to change the name of a network 
zone as long as you remember one simple step: Delete 
the old zone name first. If you just type over the exist­
ing zone name, click Done and save your changes, the 
router doesn't change anything. 

LASERWRITER IIG 
Changing The Ethernet Zone 
Apple's LaserWriter Ilg doesn't let you select its 
Ethernet zone, and Apple doesn't provide any software 
to change it. Here is a solution which requires down­
loading PostScript code to the printer. 

Using a program that lets you download PostScript 
code to a printer, send the following: 

serverdict begin 0 exitserver 

(
0/oEtherTalk0/o) <<IEtherTalkZone 

(TARGET _ZONE)>> setdevparams 

Remember to replace TARGET _ZONE with the name 
of the zone you wish the Ilg to appear in. 
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MACINTOSH 
COMUNICATIONS 
TOOLBOX 
Storing Frequendy Dialed Numbers 
There's a way to store frequently dialed phone num­
bers in the Macintosh Communications 'lbolbox. In a 
text file, enter the name of a service, followed by a tab, fol­
lowed by the phone number and a return. Enter all the 
numbers you dial and save the file as Apple Modem 1bol 
Phone Numbers inside your Preferences foldet 

MACTCP (SYSTEM 7) 
Mac Plus And 'ItP 'Irouble 
Users have reported problems with the combination 
of System 7 and Apple's MacTCP extension on Mac 
Pluses. The symptom is that TCP/IP network perfor­
mance slows down a great deal, or the connection 
won't work at all. 

The solution is an unsupported Apple utility called 
MacTCP+ 1bol. It patches MacTCP to prevent the 
under-run errors caused by MacTCP 1.1 and System 7's 
version of Apple Talk when running on a Plus. 

The utility is available from Apple over the Internet at 
ftp.apple.rom (130.43.23) in the ftp/dts/mac/netcomm 
directory as mactcp-macplus-tool.hqx. 

MCI 
QuickMail Cleanup For An MCI MNP Mess 
Dow Jones & Co. Inc. changed the modem setup used for 
its MCI Mail on-line service. The new 2,400-bps dial-in 
modems use Microrom Netwmking Protorol for error 
rorrection and rompression. 

Negotiating MNP causes a delay after the MCI modem 
picks up, and this delay causes problems with CE Software 
Inc.'s QuickMail scripted gateway to MCI. When using 
Version 2.02 or 3.0B of CE's MCIMail.Scrip~ the QuickMail 
server will not oonnect to the new MCI Mail modems. 

To solve the problem, you need to edit the script. 
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Change the first instance of the Pause command to 
read "PAUSE 8" instead of "PAUSE 2." This will make 
the gateway wait eight seconds instead of two before try­
ing to sign on. A five-seoond delay also seems to work. 

MODEM 
Quiet Dialing 
If you're using a Hayes-compatible modem and don't 
want to hear all those beeps and clicks during dialing, 
tum off the speaker using the ATMO command. 1b tum 
it back on, type in ATM 1. 

Dedicated Phone Une? 
If you plan on having a fax machine and a modem 
you may want an extra phone line for each, but it is 
not necessary. 

A phone line is a phone line, as long as you have a 
dial tone. A second phone line is a necessity if you 
intend to keep things running 24 hours a day (if 
you're running a BBS or want to keep the fax machine 
on 24-hour standby), unless you're absolutely sure no 
one will want to engage you in analog teleoom (nerd­
speak for "talk to you on the phone"). 

You may consider adding a second line for purely 
anthropological reasons, however, particularly if you 
have roommates. The usual way that human beings 
check to see if another human is using the phone is to 
pick up an extension and shriek, "Hey, anyone on the 
phone?!?" This has the effect of cutting off whatever 
data is coming across the phone line at the time and 
making your modem very angry with you. 

Another problem with voice/data cohabitation is Call 
Waiting. When you hear a beep on the phone, you 
know another call is coming in. Unfortunately, this 
beep is to modems what garlic is to vampires. One 
beep, and your modem runs screaming into the night, 
terminating its connection. 

You can temporarily switch off Call Waiting in most 
parts of the country by dialing *70 before dialing the 
number you want to connect to. Call Waiting will be 
reactivated as soon as your modem hangs up. 

Another solution is to buy a bunch of "privacy switches," 
little boxes you plug into every phone jack in the 
house. Then, whenever your modem goes off-hook, 



all the other receivers go dead. Radio Shack sells its 
Thleprotector (stock #43-107 ) for just $7.95 - if you 
put them onto two or three phones, it's a lot cheaper 
than a second phone line. 

If You Can't Connect, 'fell Your Modem to 
Wait Longer 
If you have trouble connecting to an on-line service, 
adjust the length of time the modem waits for a carri­
er signal before it hangs up and redials. The command 
ATS7 =X sets the number of seconds the modem waits 
for a carrier. The default value for x is 20 seconds, but 
you can substitute a new number of seconds for x. 

NAVIGATOR 3.0.4 
Typing A Few Characters For The 
Recipients Name 
When creating a message in Navigator 3.0.4, type the 
first few letters of the recipient's name into the Msg 1b 
field and select lookup. If Navigator finds only one 
matching entry, it will paste the name into the field. 
If it finds multiple matching entries, it will open the 
address book and highlight the first one. 

NETWORK 
MANAGEMENT 
Querying Routers With PacketSend 
A HyperCard stack called PacketSend, developed by 
Kurt VanderSluis, lets you directly query routers about 
their network and zone information. It can be utilized 
on any AppleTalk network, including LocaiTalk, 
Ethernet, andToken Ring configurations. 

PacketSend is designed as an adjunct to network­
management tools such as NetMinder and EtherPeek, 
and you'll need one of these protocol analyzers to cap­
ture and decode the response packets. PacketSend can 
query several routers on a network simultaneously, 
letting you gather data from all your routers at one 
fell swoop and quickly pinpoint discrepancies in their 
network and zone information. 

Say, for example, that your Ethernet network should 
have ten zones available but a technician mistakenly 

typed just a single zone name into one of the routers. 
You can easily find that router, as well as other routers 
it has led astray, by using PacketSend to send a ZIP 
Query to all the routers, asking for their zone names. 
The misconfigured routers-those that know about 
only one zone name-will return shorter packets. 

You can download PacketSend from ZiffNeVMac, (look 
for PKTSND.SEA in Librarv 6 of the Download & 
Support Forum) as well ~from other on-line services. 

Alternatively, you can order it directly from me at The 
Network Group ([206] 789-3111). The shareware fee is 
$40. As previously noted, you need HyperCard 20 (or 
later) to run PacketSend and a protocol analyzer such 
as localPeek, EtherPeek, or NetMinder to decode the 
respo~se packets. 

The Hit-or-Miss Method 
Troubleshooting a network can be a methodical pro­
cess, or just random attempts to get rid of the problem. 
Here are some random things to try for network prob­
lem solving: 

>If the problem appears to be somewhere on the net­
work, try cycling the power on network devices such as 
routers, star hubs, and network modems. Be sure no 
one is using the device before you cycle the power. 
Tum the device off, leave it off for 30 seconds, and 
then turn it back on. If the problem goes away, it's 
possible that the device or its software got "hung"­
the device received an instruction it couldn't process 
or ignore. Restarting the device clears that instruction 
and starts the device from scratch. 

>If it is an individual Mac having the networking 
problem, use the Chooser to turn Apple Talk off and 
then back on again or, more drastically, restart the 
computer. If you have more than one network driver, 
try switching to a different one. For example, if you're 
connected simultaneously to Ethernet and Local Talk, 
you can momentarily choose the alternative network 
with the Network cdev and then switch back to your 
regular network choice. This forces your Mac to join 
the first network all over again and re-alert other 
devices of its presence. 

>Turn off all your INI1S. INIT conflicts are tricky and 
unpredictable, and few people understand why they 
cause problems. If the problem goes away after you've 
turned off the I NITs and rebooted, then it probably is 
an IN IT conflict of some kind. Turning the INITs back 
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on one by one will help you discover which one is the 
culprit. 

>Check for viruses on the file servers and on your 
Mac. Viruses don't usually cause network problems 
(although they can be transmitted over a network), 
but it's worth a try. 

>Reload the software in network devices such as hubs, 
routers, gateways, and servers. Reenter the configura­
tion information, making sure it is exactly what you 
want and is compatible with the other devices in your 
internet. It's possible that a colleague changed the 
software or configuration tables without your knowl­
edge and misconfigured them, or perhaps you've mis­
configured them yourself. 

>Swap out the various devices, cables, connectors, 
and network cards on your machine and across the 
network. Do this one component at a time, and see if 
anything changes. Usually if cables or connectors are 
bad, they will be bad right out of the box, but some­
times they go bad while in service. Maybe a forklift 
ran over your network wires, lightning struck the 
building, or something wiggled loose. 

>If you use Ethernet or Token Ring configuration, 
reinstall your network software. If you have an older 
Mac, you may need to patch its ROM by running a 
newer version of AppleThlk or you may need to put the 
ADSP (AppleTalk Data Stream Protocol) patch file into 
your System Folder (ADSP is built-in to System 7). 

>Remove your password from the server, or reconfig­
ure your user information with the administrator soft­
ware that comes with your server. Maybe you typed the 
password incorrectly. Also, passwords are usually case­
sensitive, so be sure you're not typing in your password 
with the Caps Lock key down. 

>Try adding more RAM to your machine (or the 
server) or using the Finder instead of MultiFinder 
(if you are running System 6). Use CE Software's 
Heap Fixer to increase the size of your system's heap 
space. Do the same for the server if necessary. If 
your central workstation is running more than one 
network service (such as file-server, mail-server, 
and print-spooler software), try placing the services 
on different machines or disabling one of them 
temporarily. 
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>Try reading the manual, even if you've read it before. 
It's weird, but sometimes while you're having a prob­
lem, you open the manual and see an obscure passage 
you've never noticed before or didn't understand. 

NETWORK PRINTING 
Mac And PC Printer Sharing 
Cut the costs of printer sharing by attaching both PC 
printers and Apple LaserWriter printers directly to the 
file server. This allows the file server and its print-ser­
vice function to manage the print jobs, rather than a 
separate remote print servet With graphics-intensive 
print jobs, there may be some degradation in server 
performance. 

Using The AppleShare Print Spooler With A 
Router 
Those who use the ASPS (AppleShare Print Server), a 
network spooler, have probably figured out that 
although ASPS has a lot of benefits, one of the draw­
backs is that all print traffic goes through the network 
twice - once to get from your Mac to the spooler and 
again to get from the spooler to the LaserWriter. 

You might try putting your printers onto a different 
network, which involves running ASPS concurrently 
with a software router such as Apple's Internet Router 
or Farallon's liaison. 

Printing Large Documents Off-hours 
A practice that strains network resources is printing 
huge documents during the day on shared printers. 
Sometimes this can't be helped, but when possible, try 
to do large printing jobs during off-hours. 

Sometimes investing in a large paper bin makes this 
more attractive, in that you don't have to contend 
with adding paper to the 200-page tray that comes 
with, for example, an Apple LaserWriter liNT. With a 
print spooler, you can specify when a job will get 
printed. The cheapest print spooler, Print Monitor, 
comes free as part of Mac system software, but it 
requires that you have enough memory to run System 
7 (or Multi Finder in System 6) 



ON· LINE 
How To join ZiffNet/Mac 
Follow these steps to join ZiffNeVMac: 

CallS00-635-6225 (voice) to find your local access 
number Set up your telecom software with these set­
tings: 8 bits, 1 stop, and no parity. Dial the local access 
number. When connected, press Return. At the follow­
ing prompts, type in the responses: 

Host Name: CIS 

UseriD: 177000, 5200. 

Password: Z*MAC 

Agreement Number: Z12D9014. 

CompuServe users can just type GO ZMAC at any 
! prompt. 

PHONENET TALK 
Farallon's Apple'Ildk Runs Around 
Token Rings 
Surprise, surprise. Most people think Farallon 
Computing Inc.'s PhoneNET Talk software (previously 
Apple's AppleShare PC) works with only IBM PCs and 
compatibles equipped with LocalTalk cards. But, 
according to the company, PhoneNET Talk's Apple Talk 
protocol stack operates just fine over 3Com Corp.'s 
10-Mbps EtherLink cards for ISA and MicroChannel 
buses, and even with IBM Corp.'s 1bken-Ring Netwotk 
PC Adaptors for ISA and MicroChannel. 

QUICKMAIL 
An Easy Way 1b Force Names To The 
1bp Of The List 
Tired of scrolling through a long directory every time 
you want to send a message to the person at the bot­
tom of the list? An easy way to force names to the top 
of the list is to use QuickMail's Group command to 
create a group for the person (yes, a group can have 
just one member). Groups always appear at the top of 
the directory list. 

Checking To See If Your Message 
Has Been Read 
Want to know if someone read your message but don't 
want to be interrupted by a return receipt? Select 
Preferences from the QuickMail menu and click on 
Log Handling. You can then enable your Mail Log. A 
Log entry shows who has read each message and 
when. 

Un-Sending A Message 
Tired of sending the standard retraction "Ignore that 
last message-I forgot to ... "? You can un-send a 
message that hasn't yet been read by using the Mail 
Log (but only if you have it enabled). 

Sending A Ttmed Message 1b Yourself 
Wish you could attach messages to Apple's Alarm 
Clock DA? Use QuickMail to address a message to 
yourself and press the Delay button to postpone 
sending it until a specified date and time. 

Reading A Message Without Logging In 
Want to read a message you've filed on your hard disk 
but don't want to log in to a Mail Center? Use QM 
Remote. It can open text files as well as QuickMail 
letters you've filed. 

RESPONDER 
Built Into System 7 
The Responder functionality is built into System 7, and 
installing System 7 removes the Responder extension 
from a System 6 system. 

SERVER VOLUME 
Maximum Single-Volume Size Is 2 Gbytes 
If you are setting up a server, you may be wondering 
what the largest single volume you can have on a 
Macintosh is. 

The Mac's file system defines a 32-bit space to represent 
the number of bytes in any volume. Only 31 bits are used, 
however. With that many bits you can specify 
2,147,483,648 bytes- 2 Gbytes -which is therefore the 
maximum size of a volume. 
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SMARTCOM II 
Capture Routine Saves Only Selected '!ext 
If you capture data to disk after receiving a transmis­
sion, highlight the text you want to save. The Capture 
routine saves only selected text, so if you save a file 
with nothing selected, nothing is what you'll 
end up with. 

Saving 'Iext From The Capture Buffer 
If you accidentally Close your document without 
having saved the contents of the capture buffer, don't 
panic- yet. Try reopening a communications docu­
ment. If you didn't use the Clear command from the 
Edit menu to purge the buffer before you closed the 
transmitted document, the text is still in the capture 
buffer, and it will appear in the document window. 
This won't work if you accidentally Quit Smartcom, 
though. 

Save And Save As ... Don't Save What's In The 
Capture Buffer 
The Save and Save As ... commands only save the set­
tings, not the data in the capture buffer. 

TELECOMUNICATIONS 
Saving Money While 'lllking A Break Online 
While online, you may need to leave your computer 
for a period of time. But it's time-consuming to log off 
and a hassle to log on again later. On the other hand, 
if you don't log off, you'll be billed for the time-no 
small matter on commercial services such as 
CompuServe. 

But here's a solution: Almost every online service has 
a free help center you can go to and browse in as long 
as you like without paying. So if you must leave your 
computer for a few minutes during an online session, 
just pop over to the help center. You won't be billed for 
the time that you spend there, and you won't need to 
log on again later. 

Sharing Mac/PC Ftles Across A Remote Line 
You can move files between a PC and a Mac across a 
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remote line with a number of communications prod­
ucts, including Lap Link Mac, MacLinkPlus/PC, 
.Microphone II, RunPC, White Knight 
Telecommunications Software, and Zterm. 

DATABASES 

4TH DIMENSION 
Getting from Runtime to User Mode 
To immediately go from the Runtime opening screen 
to User mode, hold down the Option key and press F. 
This works even when no Quit menu item is installed. 

Shortcut To Call Up A Layout 
When you're programming procedures in 4th 
Dimension, it's sometimes useful to call up a layout 
you've referenced in a procedure. Here's a shortcut that 
bypasses going through menus. 

While you're in the procedure editor, drag to highlight 
the filename and the layout name mentioned in a 
procedure. Then press Command-L. 4D will automati­
cally open the highlighted layout. 

Getting to the Debugger Window 
Normally, to get into 4th Dimension's Debugger win­
dow, you have to put the Trace command into a script or 
procedure, where it can be evaluated. Here's a shortcut: 

Hold down the Option key, and hold down the mouse 
button while a procedure or script is running. Using 
this method, you don't have to put the Trace com­
mand into any code. 

Outlining an Object or Group 
When you're using the Layout Editor, it's possible to 
create an outline around any object or group of 
objects. Select the object, and then hold down the 
Command key and press any number from 1 through 
9. Command-! places the border one pixel out from 
the object; Command-9 places the border nine pixels 
out from the object. 



Using The Arrow Keys To Move Objects 
It's possible to move objects in a layout (when you're 
using the Layout Editor) by pressing the arrow keys. If 
you hold down the Command key while pressing the 
arrow keys, the upper left comer of the object will be 
anchored to the layout and the object will be resized 
according to the direction of the arrow key you're using. 
Holding down the Option key, instead of the Command 
key, and then using the arrow causes the objects to 
move along the x or y axis defined on the grid (the 
default is ten pixels). 

Bringing Up The Coordinates Box 
Holding down the Control key and then double-click­
ing on an object while using the Layout Editor dis­
plays that object's Coordinates dialog box. 

Seeing Scripts 
A quick way to view scripts is to Option-click on an 
object that has a script. This immediately opens the 
script. 

Getting Back To User Mode After Run-Tune 
Mode 
When you add a procedure to a 4D run-time-menu 
item that invokes the Quit 4D command, you return to 
the Finder after choosing that menu item. If your 4D 
application starts in run-time mode, however, it may 
not be apparent how to get back to user mode quickly. If 
you dig through the manuals, you can discover that 
pressing Option-F takes you out of run-time mode 
without your having to quit 4D, but if you can't remem­
ber that, try this: 

Add a new menu command such as Quit to user 
mode or expanded menus that calls no procedure. 
When you choose this menu command, the program 
simply reverts to user mode, which lets you have 
access to all of 4D's commands and design tools. 

DOUBLE HELIX 
Running Two Collections Simultaneously 
When using Double Helix, you may want to look at two 
collections (the Double Helix word for databases) 
simultaneously. Double Helix can open only one col­
lection at a time. 

Although Odesta has copy-protected the program so 

that copies with the same serial number cannot run 
on a network at the same time, you can run duplicate 
copies of Double Helix on one computer under 
MultiFinder with no problems. 

just copy the program by using the Duplicate com­
mand on the Finder's File Menu to make as many 
copies of Double Helix as you need. You can then open 
the copies under MultiFinder. Of course, you need gen­
erous amounts of RAM to make this work. 

Advance Planning Helps 
Th use one of Helix's abacus icons to perfurm complicated 
calculations, it's best to plan your function before build­
ing it in on the Mac. If possible, break the calculation into 
modules, then combine them in the final calculation. 
This also means you can use the modules in other calcu­
lations without having to start over from scratch. 

If you can't break a complex calculation into modules, 
plan it on paper first, then construct it on the Mac. A quick 
flowchart now can save hours of confusion later. 

Avoiding Icon Confusion 
Complicated relations clutter your work with a lot of 
icons. To keep from getting confused, name your most 
important and frequently used icons in all uppercase 
letters to make them stand out. Then, move lesser­
used icons off to the side of the window and arrange 
your icons in logical groups for easier tracking. 

Moving A Single Dle 
To move only one tile, click and drag anywhere on the 
tile except in an arrow or a blank space. 

Save Tune While Setting Up A New Relation 
When setting up a Relation for the first time, several 
fields will probably have formats different from the 
default settings. Save time by creating one field with 
each of the fonnats you plan to use, then replicate them 
as often as you' 11 need (one for each fonnat) and name 
them appropriately. 

Viewing Entire Complex Calculations 
Seeing the entirety of complex calculations can be 
difficult, since you have to view portions of it by 
scrolling the window. View the whole calculation by 
printing it out on the Image Writer by selecting Print 
Scaled Image from the File menu. This doesn't work 
on the LaserWriter. 
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Save T101e: Copy Old Calculations, Then 
Modify Them 
To create a calculation with an abacus icon that dif­
fers slightly from another one that's already created, 
duplicate the original calculation's icon and then 
modify the copy to create the new calculation. 

Moving Groups Of Segments Or Tdes 
To move a group of arrow segments and/or tiles, use 
Shift-Click to select the individual elements to be 
moved, or surround the group with the selection 
rectangle. 

FILE CONVERSION 
'lab-Delimited Fonnat 
The tab-delimited format, which most spreadsheet and 
database software can read, is a common format for 
importing and exporting data to and from databases. A 
database has each line as a separate record, with tabs 
separating the fields within each record. 

You can use a text editor to create and import tab­
delimited data into your database. 

FILEMAKER 
Selecting Records Without A Common Field 
Have you ever wanted to select a group of records in 
FileMaker II that have no field in common (for exam­
pie, the 23 people who lost last month's report)? Create a 
special ''select" box on your layout -a field in a box to 
make it easy to fmd 

To use the select box, issue the Find command to 
locate each individual record, and then enter X in the 
select box. Use the Find All command and then the 
Find command to locate the checked boxes. The whole 
group is selected, and you can mail-merge or sort the 
results. You can sort records into several groups by 
entering different characters into the select box and 
then using the Find command to select each subgroup. 

1b deselect the records, highlight the select field, press 
Delete, and then press Command-= to clear all the 
boxes. 
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Entering Multi-Word Phrases As Search 
Identifiers 
Use Option-Space instead of the space bar when you're 
entering multiple-word phrases to be used as search 
identifiers. That indexes both words as one, allowing 
searches by combinations or portions of all the words. 

Entering Copies Of A Record 
To enter a lot of copies of a record using the 
Command-M key combination, it helps to execute a 
Find on the first record entered. Thereafter, the num­
ber under Found will increase by 1 each time you 
press Command-M. This allows you to keep track of 
how many records have been entered. 

FILEMAKER PRO 
Using Option-Space In Fields With More 
Than One Word 
When you insert a text string of two or more words (for 
example, a company name) into a field, press Option­
space rather than just space between words when you 
first enter the text for that field. 

Then when you need to know the exact wording of 
that entry while in another record (for example, if 
you want to insert the company name into another 
record), you can press Command-I to access a dialog 
box that lists the values for that field in all the 
records in the database. Entries that use the Option­
space keystroke will be listed with all the text on one 
line rather than with the words listed alphabetically. You 
can then select the multi-word entry and click on the 
Paste button to insert the entry into a new record or a 
record you want to modify. 

Using Predefined Lists For Field Entry 
You can use the following technique to add any sort of 
predefined list to your FileMaker Pro database. This 
example assumes you are editing an address book 
with a State field to hold the two-letter abbreviation of 
each state: 

1. Choose Define Fields from the Select menu. Select 
the State field (or whatever field you want to add a 
predefined list to) in the dialog box, click on Options, 
and select "Use a pre-defined value list:" 

2. In the Display Values dialog box, type each state's 



name, followed by a Return, the two-letter abbrevia­
tion, and finally another Return. 

3. Switch to the Layout mode (on the Select menu), 
and select the State field. 

4. Choose Held R:>rmat from the R:>rmat menu. In the 
dialog box that follows, select the "Use field's value list to 
display fields as," check box and choose "pop-up list." 
Go to the Select menu, and switch to Browse mode. 

Note that whenever you select the State field to input 
information, a pop-up list with all the states' names 
and abbreviations will open. just start typing the first 
few letters of the state name, and the pop-up box will 
automatically scroll to that state. Then use the mouse 
or down-arrow key to select the two-letter abbrevia­
tion following the state name, and press Return to 
insert it into the field. 

Difficulty Printing PostScript Images 
If you have imported a PostScript image into a 
FtleMaker layout and it's printing the bitmap image, 
you may want to read further Even though you may be 
using the EPSIPFIT translator from the Claris XTND 
system files, the problem may be the amount of mem­
ory available to FtleMaker to do the complete import. 

Highlight FileMaker Pro, select Get Info, and increase 
the memory allocation. Keep increasing the alloca­
tion in 512K increments until it's large enough to 
import the entire file-both screen image and 
PostScript description. 

Missing Fields When Exporting 
Sometimes when using FtleMaker Pro's Export menu, not 
all of the fields are available to be exported. This problem 
is most likely to happen in data files that have been con-

e verted from FtleMaker II to Pro. 

The work-around for this is simple: Hold down the 
Option key while clicking on the New button in the 
Export dialog box. The Choose Fields dialog box, which 
appears next, displays all the fields. Simply select the 
fields you want to export. 

Exporting 1b Spreadsheets 
Export tab-delimited files instead of SYLK files if you 
need to use your data in a spreadsheet. 

FileMaker Pro exports numeric and calculation fields 
into SYLK files as text, not as numbers, making it 

impossible to perform mathematical calculations 
with this data after you've imported it into a spread­
sheet. These fields are treated as numbers in tab­
delimited files, though, and virtually all spreadsheet 
programs can import tab-delimited files accurately. 

Printing Commas Between Fields 
If you use FileMaker Pro and Page Maker or another 
layout program together for database publishing, you 
may benefit from this tip. 

To line up a comma in a label layout after the city field 
so that it prints correctly after the fields slide together 
(to eliminate spaces between the city name and 
comma), create a calculated field: CITI'comma = 
CITI' & ",·:Then use the CITI'comma field in the label 
layout instead of CITY. 

Concatenate Fields For Proper "slide left" 
and "slide up" Operation 
The easiest way to force horizontally arranged fields to 
slide in layouts is to use the Arrange menu's Slide Objects 
command, which is available in the Layout view only. 
This method sometimes proves unreliable, so you may 
want to force your fields to slide by using concatenation. 

Concatenation requires creating a new field for each 
record in your database and instructing FtleMaker Pro 
to add the information from several other fields to this 
newfield. 

1b create the name line on an address label, for exam­
ple, create a new field called NameLine and define it 
by using the following formula: Salutation & " " & 
FirstName & " " & LastName (substitute vour own 
field names for Salutation, FirstName, a~d LastName). 
Then place the NameLine field instead of the 
Salutation, FirstName, and LastName fields in your 
address-label layouts. 

You can use this same trick to ensure that objects slide 
up: Use a carriage return and the If statement to 
define multiple lines in a single field. 

Perform the Find Command In One 
Layout\ View Data In Another 
Often you will want to view a subset of your records in 
a layout that doesn't include the fields that define the 
subset. You may, for example, want to print mailing 
labels for all clients who have purchased more than 
$5,000 in goods during the past year. Because the field 
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containing your clients' year-to-date purchases is not 
on the mailing-label layout, you should execute the 
Find command in a generic layout and then switch to 
your mailing-labellayout before you print. 

This procedure can't be automated with a single 
script- FileMaker Pro will fail to execute the Find 
command, because it requires a field not present in 
the final layout. 

Therefore, you must create three scripts: one that selects 
the layout containing the necessary field and then per­
forms the find, one that specifies your mailing-label 
layout and the required printing options, and a third 
that runs the first script and then runs the second script 
by using the "Perform a chain of scripts" option. Do not 
include the first or second scripts in the menu or assign 
keyboard shortcuts to them. 

'Jhke Advantage Of The Replace Command 
Many people don't understand the Replace command 
and perform unnecessary data entry as a result. The 
Replace command lets you enter data into a single 
field in the current record and have that data copied 
into all other currently selected records. 

Suppose, for example, that you're renewing your state 
licenses for all the hazardous chemicals that have 
been stored in your warehouse under expired permits. 
After identifying all such materials by using the Find 
command, printing the required reports, and complet­
ing the necessary licensing forms, you can reset all 
license-expiration dates (assuming they're all the 
same) by entering the correct value into the license­
expiration-date field of one record and using the 
Replace rommand to apply that.date to the other cur­
rently selected records. Be certain that you've selected 
the correct subset of records before confirming the 
replacement- you can't undo the Replace command 

Use Page Setup 1b Adjust The Layout 
Marker 
In the Layout view, FileMaker Pro displays striped lines 
that represent page borders. These borders' calculations 
are based on the current settin~ in the Page Setup dia­
log box, so be sure to configure your pages horizontally 
or vertically and to specify any printing reductions or 
enlargements before finalizing your layout. 

Using reduction is a good way to gain some extra 
room to fit all required data onto a layout. If you use 
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this technique, create a script that switches to the lay­
out and uses the "Restore the Page Setup options" 
option so that your reduction is applied every time you 
use the layout. 

Hold Down The Option Key 1b Customize 
Boundaries 
When you're defining layouts, the gray lines that 
define part borders (such as headers and footers) can­
not normally be moved past any fields, text, or graph­
ics. If you hold down the Option key while you're repo­
sitioning the part border, however, you can move the 
border freely. 

Give FileMaker Pro Sufficient Memory 
When FileMaker Pro runs short of memory, the "Out of 
memory" error message· usually appears. In some 
cases, there's not even enough memory left to display 
this dialog box, so you may notice that keyboard 
equivalents or menu commands suddenly seem to 
have no effect. 

To correct this problem is to increase the amount of 
memory allocated to FileMaker Pro. The 1,024K of 
RAM that FileMaker Pro normally requests is insuffi­
cient in many cases, especially if you're working with 
large databases. 1b change the memory allocation, 
highlight the FileMaker application icon, open the Get 
Info dialog box (under File menu in the Finder) and 
change the ·~plication Memory Size" option. Provide 
l,SOOK as a minimum- more if you have enough 
memory available and work with very large databases. 

Avoid Printing Duplicates 
1b create a layout that includes only one occurrence of 
any duplicate record, define a layout using the "Sub­
Summary when sorted by" option in the Define Parts 
dialog box. 

When scrolling through the field list to select the field 
that will determine duplication, be sure to select a 
field that will be unique for all non-duplicate records. 
Remove the body part in your layout, and position all 
required fields within the subsummary part. Sort the 
database by the field you've selected to determine 
duplication, and choose the "Preview" option from 
the Select menu. The resulting duplicate-free 
database is then displayed. Choose the Print com­
mand to print this data. 



Use A Subsummary Part To Create 
Running Page Totals 
To create a running page total for any report, define a 
"Sub-Summary when sorted by" and place summary 
field types, that have the "Running total" option, into 
this part. To force this subsummary to appear at the 
bottom of every page, determine the number of 
records that will fit on one page by doing a preview of 
your report and then select the "Page break after every 
X occurrences" option and enter this value. 

This method works best if no "slide up'' options are 
used in the report body. If records in your report are of 
variable length, you must choose the minimum num­
ber of records that naturally fit on a single page and use 
that value in the "Page break after every X occur­
rences" option. 

Replace One Field With Another In Layouts 
Without Deleting 
If you accidentally place an incorrect field in your lay­
out or just decide that your needs have changed, hold 
down the Option and Command keys and double­
click on the field you want to replace. This allows you 
to select another field to replace the one you selected 
previously. 

Fitting 'Iemplates For Any Monitor 
If you create FileMaker Pro templates on a Mac with a 
large monitor, it can be hard to know whether your 
layout will fit on a smaller monitor, such as the 
Classic's 9-inch screen. You can create a page guide for 
small screens by choosing Help from the Apple menu. 
This brings up a window exactly the size of a small 
Mac screen. Simply size your layout window so that it's 
the same as the Help window, and your layout will fit 
fine on a small-screen Mac. 

Producing Columnar Reports With 
Repeating Fields 
Repeating fields do not slide up properly in columnar­
report layouts. If you have an existing columnar-report 
layout containing repeating fields, copy all its elements 
and paste them into a new blank-format layout. 

Another way to improve the sliding of repeating fields 
is to choose Field Borders from the Format menu, 
check the Between Repeating Values box, and make 
sure all border options are set to None. 

Putting A Better Font Forward 
In FileMaker Pro 
The default font in Claris Corp.'s FileMaker Pro is 
Helvetica. Here are some steps to follow if you would 
like to start a database out in a different face: 

Create a new database. When the field-definition 
dialog box appears, hit the Done button. An empty 
database layout appears; switch to Layout mode and 
choose a new font, size and style (and your preferred col­
ors, if you like). Choose Define Fields from the Select 
menu and go on creating your database fields. When 
you're done, the fields shown will be displayed in your 
choice of type. 

Tune Flies With FileMaker On Big Networks 
Timeouts-when one AppleTalk node gives up trying 
to communicate with another -normally indicate 
bad connections. But sometimes big networks work 
slower than applications expect, and premature time­
outs result. If you've got a large network, you may run 
into this problem when trying to use the internal 
database-sharing capabilities of Claris Corp.'s 
FileMaker Pro. 

To lengthen the amount of time before the network 
times out when communicating with a FileMaker 
database, hold down the Option key when clicking 
the Network button in the Open dialog box or when 
switching between zones in the resulting dialog box. 
This trick is useful only on slow networks, so you 
should expect correspondingly sluggish response from 
the database. 

PANOUMA 
Creating More Titan 256 Fields 
There are two ways to create a database with more 
than 256 fields in Panorama. 

You can put cells onto a form by using Auto Cell 
Layout from the Arrange menu. That dialog box uses 
the Apple List Manager and is good for about 500 
items. The scrolling window updates much faster 
than the pop-up menu, and you can select one or 
more of the cells you want. 

Or, you can create an auxiliary database that dupli­
cates cells beyond the 256-field "limit." The first item 
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in the auxiliary database is the first item beyond the 
main database's pop-up menu (in other words, item 
number 257). You can then simply copy and paste these 
cells from the auxiliary database to the main database. 

Both of these methods will give you cells beyond the 
the 256-field limit before the pop-up menu with 256 
items can even draw itself. 

DESKTOP PUBLISHING 

ADOBE TYPEALIGN 
Highlighting 'lext Strings 
When you're using Adobe's TypeAlign, the text-distor­
tion DA from Adobe, you can highlight an entire text 
string without dragging from left to right. just insert 
your I -beam tool anywhere in the text, and press the 
Tab key. It's easier than drag-selecting, which can be 
difficult with curved text, and it's not mentioned in 
the manual. 

ADOBE TYPE MANAGER 
Undocumented Type Manager np 
Here's a tip about Adobe Type Manager (ATM} that's 
not mentioned in the product manual: 

If you have little need for math and Greek characters, 
you might be tempted to save disk space by not 
installing the Symbol font. But when you try to print 
one of the 18 characters that are also included in the 
other three fonts, you'll find that they print with a bad 
case of the jaggies. 

It turns out these characters are represented in the 
Helvetica, Times, and Courier PostScript files only by 
references to their locations in the Symbol font. 
Without Symbol available, your Macintosh has no 
choice but to print the bit maps instead If you want 
decent output for any of these characters, you must 
install the Symbol font-both the outline fonts and 
the bit-mapped font. 

The Font Cache 
If ATM seems to be slowing down operations such as 
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popping into Word's page preview or zooming in a 
graphics program, you probably need to give it more 
working space. When ATM creates screen fonts, it tem­
porarily stores the characters in a reserved area of 
RAM called the Font Cache. When the cache overflows, 
the currently undisplayed characters are deleted and 
replaced by newly built ones. When you scroll to a part 
of your document that contains deleted cached fonts, 
ATM patiently rebuilds them. This purge/rebuild cycle 
always takes noticeable time, and you will blame ATM 
for slowing you down. 

1b give your system back its old zip, use the Control 
Panel DA to access the ATM cdev and then set the Font 
Cache to 256K or more-sometimes far more. A large 
enough cache will pay off in zero waiting time when­
ever you scroll or zoom. You should pump up the 
cache appropriately whenever you use large sizes or 
many different sizes or if you routinely zoom to several 
levels. Keep in mind that the first time you zoom or 
use a new fonVsize/style, ATM will need extra time to 
build the properly sized screen font. 

ADOBE TYPE MANAGER 
2.0 
Eliminate '&ueType Fonts 
If you are using ATM, you may want to eliminate any 
TrueType versions of your PostScript outline fonts­
typically, Helvetica, Times, Courier and Symbol. 

1b remove TrueType fonts, double-click on the System 
file while running Finder 7 and locate the icons that 
show three 1\s- these are TrueType fonts. (Bit-mapped 
fonts show only a single A in the icon and include a point 
size in their names.) If you have a PostScript outline font 
and at least one bit-mapped font, you can drag the 
equivalent TrueType icon out of the System file and 
throw it into the Trash. 

It is not a good idea to keep both TrueType and 
PostScript fonts for the same typeface, since the rela­
tionships among bit-mapped, PostScript and 
TrueType fonts are complicated (and confusing) in 
this configuration. 

ATM gives non-PostScript printers such as the 
ImageWriter and LaserWriter IISC the ability to print 
Adobe's PostScript fonts. The package includes the 



PostScript outline fonts for the four "basic" fonts as 
well as the corresponding bit-mapped fonts: Helvetica, 
Times, Courier, and Symbol. 

ADOBE TYPE REUNION 
Use Res Edit To Disable Adobe Type 
Reunion In Applications 
Adobe Type Reunion is a great utility for uncluttering 
Font menus, but it can slow down menus in many pro­
grams and some programs are even incompatible with 
it. You can hold down the Shift key upon launching a 
program to disable ATR temporarily for one session, 
but there is a way to permanently disable ATR for spe­
cific programs. 

ATR checks a program's resource fork to see if it has an 
ATR resource with ID-1 containing a single zero byte 
(00). If it finds such a resource, it disables itself for 
that program, as it would if you had held down the 
Shift key. 

Just use ResEdit to install that resource in all pro­
grams and DAs that don't need ATR, and you'll find 
that their menus are much faster! 

Adobe itself uses this trick in Adobe Illustrator, so you 
can copy and paste the resource between Illustrator 
and other applications. As always when working with 
ResEdit, only modify copies of your programs, never 
your master disks. 

DATABASE PUBLISHING 
Fonnatting Utilities 
1\veaking a database program to arrange and format 
your information can be quite a challenge, especially 
if you don't have programming experience. Suppose 
you use data from many different sources. It might be 
hard to ensure that all your information arrives at 
your page-layout program tagged and ready for use. 

In such cases, it's probably easier to work with plain 
delimited ASCII files and to do all the formatting in 
your layout program. It would be easier if you could 
set up your document once and have your layout pro­
gram automatically apply the design and formatting 
you want to your data when you import it. 

Fortunately, programs are available for the two most 
popular layout applications. PageMaker users can turn 
to ElseWare's DataShaper (ElseWare Corp. 3201 
Fremont Avenue N., Seattle, WA 98103; [206] 547-9623 
DataShaper, $179.95), and QuarkXPress users can get 
Em Software's Xdata (Em Software, P.O. Box 402, 
Westbrook, CT 06498 [ 407] 321-8173 Xdata, $199.95). 
Both programs bring mail-merge functions to these 
layout programs. 

Programming Text Formatting With 
Database Languages 
You can tell a programmable database manager to 
add text-formatting information to exported files. To 
do this, you must know, in addition to the database's 
programming language, the tagging system your lay­
out program uses. Tagging is a method in which you 
include codes within a plain ASCII text file that 
instruct a layout program what formatting should be 
applied to the text. 

Such a code can be a simple instruction for the layout 
program to apply a predefined style to a paragraph, or it 
can contain a specific formatting instruction for a single 
character or a range of text. When the layout program 
interprets the tags, it automatically applies the format­
ting and also removes the tags. 

QuarkXPress supports two tagging formats: Style Tags 
andXPress Tags. You'll probably want to stick with the 
newer XPress Tags, which lets you use tags to assign 
every one of QuarkXPress' formatting commands as 
well as define styles through tags. 

PageMaker 4.0's more rudimentary tagging, available 
through its smart ASCII filter, is limited to assigning 
predefined styles to paragraphs. Version 4.2 of 
Page Maker supports far more powerful tagging capa­
bilities, however. In fact, Aldus' language sounds 
much like the DesignScript command language that 
is used by LetraSet's DesignStudio. This powerful tag­
ging language lets you not only specify text format­
ting but also create and position page elements, such 
as text and picture boxes, anywhere on a page. 

Frame Thchnology's FrameMaker, a powerful long­
document processor, also uses two tagging languages, 
MML and MIE MML lets you create tags for most basic 
text and paragraph formatting, and MIF codifies virtu­
ally any object you can create in FrameMaker. Xerox's 
Ventura Publisher, the pioneer of tagging, inserts for-
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matting tags into any word-processing file it incorpo­
rates into a document. 

If you're good at programming and are resourceful, 
you can write a program that has your database pro­
gram add the appropriate tags to fields or groups of 
fields when you export data. Even simple FileMaker 
Pro, which isn't really programmable, can add tags to 
data in a report if you're clever with its arithmetic 
functions. 

CHAUCTERS 
Displaying PC Une-Drawing Characters 
If you have documents created on a PC that use "line­
drawing" characters, you will want to display them on 
the Mac. 

IBM PCs and compatibles define an extended set of 
characters using ASCII codes 128 through 255; these 
characters include the line-drawing ones. On the Mac, 
there's no standard for characters with ASCII codes 
above 127. Commercial utilities that provide PC-style 
fonts for the Mac include Insignia Solutions Inc.'s 
SoftPC line and Vano Associates Inc.'s MacChuck PC 
remote-control program. Also, check the Fonts library 
of CompuServe's Mac Systems Forum (GO CIS:MAC­
SYS); you can find two Mac fonts, PIXYMB.SIT and 
IIBMKL.SIT, both of which contain the kinds of PC 
characters you need. 

FAXES 
Sending PostScript Illustrations 
If you have to send PostScript illustrations from a fax 
modem, create them at roughly three times the desired 
finished size and then export and reduce them in a 
layout program before faxing. This process enhances 
the apparent resolution of the embedded PICT image, 
minimizing the jaggies you normally get when faxing 
the PICT portion of a PostScript object. 

Graphic Mistakes 
If you're using a conventional fax machine, avoid lay­
outs with long straight lines, small type sizes, and 
intricate artwork. Misfeeds and phone-line noise 
cause unsightly broken lines, and the scanning pro-
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cess can thicken lines and darken type, causing text to 
become unreadable and turning artwork into a 
blotchy mess. 

Reverse Type To Emphasize 
For special emphasis, try reversing white type out of a 
black background. A sans serif typeface set in 18-point 
bold works well. 

No Letterhead 
Don't use your printed letterhead for fax documents. 
Many things that are effective in print -embossing, 
foil or other metallic type, screened or pale type, very 
small type-can't be communicated effectively by 
fax. Instead, use a special fax letterhead with a 
related design. 

'&uncated Type 
Keep type and images away from the margins so that 
they aren't truncated by the faxing process. Margins of 
three-quarters of an inch all around seem safe. 

FAXMODEMS 
Don't Do Photos Without Gray-Scale Ability 
Unless your faxmodem has gray-scale capabilities, 
photographs and screened artwork are lost causes. 
Gray tones in the original image are converted to 
stark black-and-white blocks for transmission, often 
obscuring the contents. A conventional fax machine 
with gray-scale and contrast controls does a much 
better job of handling such images. 

PostScript graphics usually look better if they are 
printed on a laser printer and then scanned into a 
fax machine. None of the Mac faxmodems current­
ly include a PostScript interpreter, which would 
bring the language's device- and resolution-inde­
pendence to faxing. Because faxmodem software 
isn't able to interpret PostScript code, it sends a low­
resolution (PICT) screen image instead. (If an EPS 
file doesn't include an embedded PICT, the image will 
be replaced by a rectangular placeholder.) 

ATM Type For FaxModems 
The best way to image type for a faxmodem is 
through Adobe Type Manager. ATM uses the power of 
PostScript to create crisp text on-screen at any size, 



and the faxmodem transmits that scaled type 
directly. If you don't use ATM, the only way to avoid 
jagged-looking type is to install bit-mapped screen 
fonts that are three times the size of those in your 
document. The faxmodem software uses the over­
sized fonts to scale the type correctly for transmis­
sion, but this option can be limiting. 

FILE CONVERSION 
Converting PC Files 1b PICT Fonnat 
There is one anomaly of note that you may experience 
when converting PC files into PICT graphics for the 
Mac: The images often open as negatives. The fix is 
simple: Open the PICTwith any Mac graphics pro­
gram that supports the format and has an invert com­
mand. Select the entire PICT and invert it. 

FILE FORMATS 
What Is TIFF1 
The Thg Image Flle Format, or TIFE is a raster or bitmap 
format developed by Aldus and Microsoft to store images. 
It originated from a desire to provide a rommon, stan­
dardized format, particularly for scanned images since, 
up to that point, scanning software saved images in a 
bewildering variety of proprietary fonnats. 

TIFF is generally categorized into five classes: 

Class B: black-and-white images. 

Class G: gray-scale images. 

Class P: palette-color images, using an indexed color 
map or palette to define 256 colors. 

Class R: RGB full-color images, where Red, Green, and 
Blue values are set for each pixel in the image and 
over 16 million colors are possible. 

Class F: FAX images. 

TIFFs produced on the PC and Mac differ somewhat 
because of the way the byte order is stored on the PC 
(the Intel format) and Macintosh (Motorola format), 
causing occasional problems, especially when trans­
ferring PC TIFF files to the Macintosh. Translation 
software must generally be used to ensure that trans-

ferred TIFF files can operate correctly. 

f'Or the full specifications of this format, contact: Tag 
Image File Format, Revision 5.0, Developer's Desk, 
Aldus Corp., 411 First Ave. South, Suite 200, Seattle, WA 
98104; (206) 622-5500. 

WhatlsCGM? 
The Computer Graphics Metafile ( CGM) format has 
its roots in workshop discussions during 1976 and was 
accepted as an ANSI and ISO standard for the 
exchange of graphics files printed on a laser printer 
and then scanned into a fax machine. 

WhatlsEPS? 

Encapsulated PostScript (EPS, or occasionally EPSF) 
is a file format developed by Adobe Systems and Altsys 
that provides a way to bring PostScript code or graph­
ics into software applications. What sets EPS files 
apart from straight PostScript programming code are 
two lines in the header: 
0/o!PS-Adobe-2.9 EPSF-1.2 

o/o0/o8ounding8ox: llx 11 y urx ury. 

The bounding-box comment tells the importing 
application the size of the EPS file. 

The fonnat usually, but not always, incorporates a 
screen representation of the PostScript code. On the 
Macintosh, this screen image is stored as a PICT 
resource. On the PC platform, it's included as either a 
Windows Metafile (WMF) or TIFF image. When the 
screen representation is absent, the user will generally 
see a gray box or a rectangle with an X through it. 

EPS as a format is widespread in the Macintosh 
environment, where it has found great favor 
among graphic artists and technical illustrators. 
Its popularity is growing in the PC community, 
and a form of PostScript called Display PostScript is 
currently used by the NeXT workstation for actual 
screen display. 

For the full specifications of this format, contact: 
Encapsulated PostScript Flies Specification, Adobe 
Systems Inc., 1585 Charleston Rd., P.O. Box 7900, 
Mountain View, CA 94039-7900; ( 415) 961--4400. 

What Is PICT? 
PICT is an object-oriented format common on the 
Mac . PICT comes in two flavors, PICT 1 and PICT 2; 
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the latter is an enhanced version that includes color 
support. PICT is widely supported. 

What Is RTF? 
RTF is a word-processing format in which text-fonnat­
ting commands are embedded within the text itself. 
For example, "Fleshy-headed mutant" looks like this: 
"Fleshy-headed {V mutant}"- and there's lots of 
header infonnation (about fonts, margins, and the 
like) in front of it. 

Nonnally this RTF "code" is generated by a word pro­
cessor, but it's possible to write it all in by hand as you 
compose the document. You can download complete 
documentation on the RTF format from ZiffNeVMac, 
MacUser's online service. Look for the filename RTF­
DOC.TXT in the Reference library of the Download & 
Support Forum. 

FONTS 
Screen Font Alignment 
Most Macintosh screen fonts supplied by Apple and all 
LaserWriter fonts have constant-width digits. It's been 
a standard in typography since the birth of financial 
printing. So if you're having trouble lining up 
columns of numbers, try the following suggestions. 

In spreadsheet programs such as Excel, use a cell for­
mat that has a constant number of places after the 
decimal and left-align them. Using the General for­
mat in Excel with numbers that vary in precision is a 
sure way to have your columns wander. Similarly, in 
word processors, use a right-aligned tab and keep a 
constant number of places after the decimal or use 
the decimal tab that many word processors include 
specifically for this purpose- it aligns a tabbed col­
umn on the decimal point (or on the right if no deci­
mal point is present). Both MacWrite and Word 
include decimal tabbing. Remember- use the Tab 
key, not spaces, before each number in the column. 

The presence of non-digit characters, such as com­
mas, parentheses, and dollar signs, may alter the 
alignment of digits in columns, but they shouldn't be 
a problem if you use them consistently. 
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FOOTNOTES 
Placing Footnotes At The End Of A Page 
In PageMaker 4.0, to put a footnote (or more than one) 
on the bottom of the page on which the footnote refer­
ence appears rather than in a separate chapter at the 
end of a book, you can automate much of the process 
with PageMaker 4.2's built-in scripting. For even more 
power, try UserLand Frontier (UserLand Software, 490 
California Avenue, Palo Alto, CA 94306; [ 415] 325-5700), 
a scripting program that lets you write scripts to con­
trol almost every aspect of PageMaker 4.2. 

If that sounds like too much trouble for you, check 
out FrameMaker (Frame Thchnology, 1010 Rincon 
Circle, San jose, CA 95131; [408] 433-3311) and Ventura 
Publisher (Ventura Software, 15175 Innovation Drive, 
San Diego, CA 92128; [ 619] 673-0172), a pair of page­
layout programs that are particularly good at produc­
ing long, structured documents. Each can automati­
cally place footnotes at the bottom of the page on 
which the reference number appears, and each allows 
extensive control over the footnotes' appearance. 

FRAMEMAKER 
Printing A 'lemplate Style Sheet 
Like most page-layout programs for the Mac, Frame­
Maker provides no easy way to print out a style sheet 
for a particular template. But here's a way to do it: 

Open a new document based on the template whose 
style sheet you want to print. Save the new document in 
MIF fonnat, and then open it in FrameMaker or in a 
word processor. You'll find the template's paragraph tagc; 
listing in the MIF file, beginning at the following line: 

<PgfCatalog 

The specific formatting for each paragraph tag after 
that line is bracketed by these lines: 

<Pgf 

<pgfTag'TagName Here'> and 

>#end of Pgf 

Any other tags are listed in order and are always 
bracketed in the same way. 



It may not be the ideal way to access this information, 
but with some editing, you can tum this code-like 
material into a printed style sheet that can be shared 
by several users. 

GENERAL 
Avoid Spaces During 'Iext '&ansfer 
When transferring text from one document to anoth­
er-for example, from a word processor to a page­
layout program-be aware that space-bar spaces are 
related to the size and style of each individual font. If 
you line things up beautifully and then change the 
font or export your text to another program, the 
spaces can change unexpectedly. 'lb ensure exporta­
bility of text, use tabs rather than multiple spaces. 

Generating Special Characters 
Use the Option key to generate special characters such 
as the tilde (-, Option-N), registered trademark ( ®, 
Option-R), and delta((), Option-D). Use Key Caps 
under the Apple menu to view other special characters. 

Resolution, Dpi And Lpi 
Resolution is the maximum number of dots that a 
device, such as an imagesetter or laser printer, can 
cram into a linear inch, and it is the key determina­
tion of image sharpness. Resolution is measured in 
dpi (dots per inch), which could more descriptively be 
called dpli (dots per linear inch). A 300-dpi laser 
printer is capable of printing 90,000 (300x300) dots 
per square inch. 

Lpi refers to the resolution you specify for printing a 
particular job on an offset press. The lpi (lines per 
inch) is also called the line frequency or line screen. If 
your job contains screens or halftones, ask the per­
sonnel at you printer ahead of time what line fre­
quency to use and then specify that figure when out­
putting the document to an imagesetter or laser print­
er. (There's no need to specify a frequency for work 
that has only solid type and line art.) The printer's 
recommendation for frequency will reflect pragmatic 
factors- the quality of paper and ink, the size and 
sophistication of the printing press, and your budget 
for the job. 

Getting The Command-Key Symbol 
Many users are suprised that the Command-key sym­
bol (also called the Apple key) isn't included in the 
Dingbats font -especially since Apple thoughtfully 
provides its logo in the other LaserWriter fonts. In fact, 
the Command-key symbol is hiding in the Chicago 
font in another nearly untypeable location: ASCII 17. 
Only owners of keyboards with Control keys -which 
excludes you if you own a Mac Plus-can type this 
symbol easily; you can access the command key sym­
bol by pressing Control-Q. 

Chicago isn't a PostScript font, so if you need high­
quality output, try ChicagoSymbols, a shareware 
PostScript font. (Send $10 to Bradley-Poulson, 
Northwind Enterprises, 4003 Martin Lane, Two Rivers, 
WI 54241.) If you own Altsys's Fontographer, you can 
use the accompanying DemoFont, which also con­
tains the Command-key symbol. 

GRIDS 
What Is A Page Grid? 
A page grid is an underlying structure of nonprinting 
guidelines that helps anchor elements such as text, 
pictures, sidebars, and folios. The grid provides a 
framework for the page design, and like the smooth 
layout of a highway system, it defines the best trans­
portation routes for reading a page. 

Using White Space Effectively 
White space gives the reader's eye a rest but can be a 
distraction if misused. A grid must place text, graph­
ics, and utility functions consistently. 

A Ftxed Zero Point Is An Absolute 
Reference Point 
Construct the grid from a fixed zero point so that you 
always have an absolute reference point for position­
ing elements on the page. This is important if you're 
sending documents to a high-end prepress system 
such as a Crosfield or a Scitex, which positions all 
page elements based on a fixed zero point. 

QuarkXPress 3.0 offers this sort of precision grid build­
ing. You can select a text or picture box and use the 
Modify dialog box to enter its x (origin across) andy 
(origin down) coordinates from the zero point. This 
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establishes where the left and top sides of the object 
begin. Entering the width (second x coordinate) and 
height (second y coordinate) establishes the object's 
right and bottom sides. This method is more accurate 
than positioning elements by eye. 

Re-Creating A 'Iraditionally Existing Grid 
When you're electronically re-creating a grid for an 
existing publication, it's best to first create a test grid, 
using hairline rules, and output it to positive film. 
Lay it over your existing grid sheet to check for mis­
alignment. 

Matching Page-Layout And Prepress 
System Measurements 
Prepress systems use the metric system for detennin­
ing the trimmed page size, so you too should use met­
rics to measure page size and to create trim and bleed 
coordinates. Inside the page margins, however, you 
can safely use points and picas to measure text and 
image areas. 

A note of caution: Many prepress systems use a mea­
suring system of 72.27 points per inch, whereas most 
page-layout programs count 72 points per inch. If this 
level of accuracy is important to you, talk to the staff at 
your prepress bureau about dealing with this discrep­
ancy. It may be possible to make adjustments at the 
prepress end- by adjusting the leading in an Atex sys­
tem to match the Macintosh grid, for example. 

Optimum Viewing Precision 
View the page at 400 percent to achieve the best preci­
sion when you're placing elements. 

Securing Page Elements 
Group and lock all page elements to ensure that they 
aren't accidentally moved out of position. 

Varying Columns For Easy Reading 
Varying the number of columns makes it easier for 
a reader to select important infonnation on a page; 
uneven column widths are ideal for small art, sub­
heads, and quotes. 

LASERWRITER 
Printing With Ligatures 
If you're using a LaserWriter to print, don't forget the 
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two "ligatures" that all the LaserWriter fonts provide: 
"fi" and "fl." These will make your text "extra tight" 
for best appearance. The "fi" is Option-Shift-S and 
"fl" is Option-Shift -6. Don't forget the printer's quotes 
either:" Option-[," Option-Shift-[,' Option-],' 
Option-Shift-]. 

There are several desk accessories and INI'I's available 
through on-line services and user groups that make 
using printer's quotes (also called smart quotes) easi­
er. TI1e ligatures are probably easiest if you type in "fi" 
and "fl" normally and use a Search-and-Replace in 
your word processor before printing. 

OCR (OPTICAL 
CHARACTER 
RECOGNITION) 
Put A Lid On It 
It may be tempting to leave a flatbed scanner's cover 
up if you are flipping pages on and off the scanner 
bed, but you will regret it. Leaving the lid open can 
adversely affect the accuracy of a scan, because the 
page is not completely flat against the scanner's glass 
bed. If you are scanning text from bulky books, you 
want to photocopy the desired pages first. Also, 
remember to keep the glass bed of the scanner clean. 

Dropping Out 
If you are editing the hard copy before it is scanned, be 
sure that you mark up the pages with your scanner's 
dropout color, which is usually nonrepro-blue. 
Nonrepro-blue pencils are available in most office or 
art supply stores. If you use the nearest ballpoint pen, 
you will dramatically increase processing time as well 
as the amount of garbage you have to trash in the 
word processing file. 

When Less Is More 
Your OCR software lets you scan at 300, 400, or 600 dpi. 
Bigger is better, right? Wrong. You generally get more 
accurate results if you scan nonnal or large text at 200 
dpi. A higher-resolution scan only takes longer and can 
introduce recognition errors by drawing attention to 
smudges and imperfections in the character shapes. 
TI1e only exception is text that is smaller than 10 
point- expecially laser output. 



Connect The Dots 
Many OCR packages feature a setting that improves the 
accuracy of dot -matrix scans. If your package lacks such 
a setting, try photocopying the material and scanning 
the copied pages. Photocopying blurs the text somewhat, 
effectively connecting the dots of the characters so they 
can be recognized more accurately. You can sometimes 
achieve the same effect by setting the brightness control 
to darken. 

Choose Your Scanner Wisely 
If OCR is a major regular chore for you, use a flatbed 
scanner-hand-held scanners just don't cut the mus­
tard. But if you need OCR only occasionally, here are a 
couple of tips for using hand-held scanners such as 
Caere's Typist. 

Make sure you put the document you are scanning 
onto a smooth, wrinkle-free surface. Also be aware 
that if you are scanning pages in a book, a hand-held 
scanner will tend to fall off the edge of the book, 
which can create garbage in the word processing file. 
You can avoid this problem by "extending" the 
dimensions of the book by placing another book of 
the same size next to the open page. This extra space 
helps to keep the scanner from falling off the edge 
during the scan. 

Be Prepared 
Prepare your materials before you start scanning. 
Stack all dot-matrix hard copy together, take out sta­
ples, and so on. If your software supports it , create set­
ting files for the various types of documents you usu­
ally scan, such as dot-matrix output, pages from a 
specific printer that scan better when you darken the 
contrast, and the like. If you expect to do a lot of OCR 
work, consider buying an ADF (automatic document 
feeder). If you are not certain, you should buy soft­
ware and hardware that support an ADF so you can 
add it later. 

I Shot The Serif 
If your OCR work includes regularly processing type­
written material or computer output, try to ensure 
that the material is in a sans serif font such as 
Helvetica. Sans serif fonts generally scan far more suc­
cessfully than serif fonts such as Times or Palatino do. 
Serifs can confuse the recognition engine of many 
OCR packages. 

Bright Lights 
One of the most overlooked and underused controls 
in most OCR software is the brightness control. · 
Unfortunately, it's also the most important part of 
accurate OCR processing. If you have to deal with 
overly dark or smudged copy, such as faxed text, 
lighten the scan by 25 percent. Scanning screened 
text is usually very difficult, but you can sometimes 
get better results by fiddling with your software's 
brightness setting. 

Frequently, however, you can move the brightness con­
trol toward the lightest setting (70 to 80 percent) and 
essentially remove the screen shading. This leaves the 
text to the mercy of the OCR software. You can also try 
photocopying a page with screened text at a light set­
ting and then scan the copy. 

just Type It! 
There comes a point where OCR just isn't efficient, 
despite all the hype. If you have scanned the same 
page repeatedly and had only marginal success, it's 
probably best to give up and type the text. It's faster to 
retype a difficult page than to correct a scrambled 
scan. 

OMNIPAGE 
Edit With AppleScan To Differentiate 
Pictures And Words 
OmniPage has some trouble recognizing text and 
pasting text blocks. The less "traditional" the page 
layout, the more difficult it is for OmniPage to differ­
entiate pictures and words. AppleScan's editing tools 
offer a good remedy: 

First, use AppleScan to get a picture of the page. The 
scanner settin~ should be 300 dpi, Line Art. After 
scanning, move to the document window and use the 
erase.; lasso, and selection-rectangle tools to elimi­
nate graphics that crowd into text, and to move text 
into groupin~ that are more easily handled by 
OmniPage. Then, Save the document as a TIFF file. 

Now, open OmniPage, choose Open from the File 
menu, and open the document you just saved. Choose 
Recognize from the Thxt menu. OmniPage runs 
through your newly-designed page flawlessly-and 
in record time! 

23 



Scanning Screened Or Colored text 
Scanning text from magazines into files can be a real 
time-saver, but you'll frequently come across text in 
sidebars or on the contents page that is boxed and 
screened with a color ramp or shading, which can 
play havoc with OCR. 

When faced with this problem, you can lessen your 
scan time while increasing the accuracy of the scan by 
selecting Lighten in the Thxt Settings dialog box. More 
often than not, this strips out background screens and 
lets OmniPage do its stuff. 

PAGE LAYOUT 
Mixing Type Sizes In Headlines 
You can usually get a more professional effect when 
you're using two type sizes in heads or when you're 
using a drop cap set within body text if you see a font 
that's one weight lighter for the larger type than the 
weight that's used for the main body text. 

For example, if the main body text is set in Helvetica 8 
point, use Helvetica Light for the 20-point drop cap. 
Otherwise, the large character overwhelms the sur­
rounding text. 

PAGEMAKER 
Keep Your Master Disks 
Don't erase your old PageMaker master disks when 
you get a new version, because the program recog­
nizes only documents created with the current or pre­
vious version of PageMaker. In other words, 
PageMaker 4.0 can open and use documents created 
with version 3.0 or version 4.0, but it can't open docu­
ments created with PageMaker 2.0 or earlier. 

You can upgrade all of your PageMaker documents 
each time a new version is released (and hope that 
you don't overlook a critical document!), but the safest 
solution is to keep all the master disks so that you can 
reinstall older PageMaker versions when necessary. 

Repeating Items 
In FreeHand, if you want to repeat an item (such as 
grid lines that you want to be a specific distance 
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apart), you can clone the item, move it, and then 
duplicate the action. PageMaker offers the same capa­
bility but requires a different set of steps: 

1. Draw the item (a line, for example) you want to 
repeat. 

2. Copy it, and paste it on top of itself by using the 
Option-Paste command (Command-Option-V). Move 
the duplicated item to where you want it to be on the 
page. 

3. Use the Option-Paste command again. PageMaker 
will paste another line at the same distance as specified 
in the last move. You can keep using Option-Paste until 
you have all the lines you need. 

Toggling To A MacPaint-Style Hand Tool 
Hold down Option while clicking on your document 
in any other place but in a column guide. Use the 
hand to drag an image around the window and repo­
sition your page. 

Duplicating, Cloning And Moving Objects 
In FreeHand, if you want to repeat an item (such as 
grid lines that you want to be a specific distance 
apart), you can clone the item, move it, and then 
duplicate the action. PageMaker offers the same capa­
bility but requires a different set of steps: 

1. Draw the item (a line, for example) you want to 
repeat. 

2. Copy it, and paste it on top of itself by using the 
Option-Paste command (Command-Option-V). Move 
the duplicated item to where you want it to be on the 
page. 

3. Use the Option-Paste command again. PageMaker 
will paste another line at the same distance as speci­
fied in the last move. You can keep using Option-Paste 
until you have all the lines you need. 

Using Macro Utilities To Set Fractions 
If you use a lot of fractions in your PageMaker docu­
ments, it's a good idea to define a macro that trans­
forms a typed fraction such as 118 into a more profes­
sional-looking typeset fraction. To do this, you need a 
macro utility such as MacroMaker or CE Software's 
QuicKeys. (These instructions work for fractions that 
have one-digit denominators and numerators, such as 
114 and 118.) 



Type the fraction normally, place the cursor in front of 
the numerato~ and open the macro program. Record 
the following steps: 

1. To highlight the numerator, hold the Shift key and 
press the right-arrow key once. 

2. Press Command-Shift-+ to invoke the superscript 
text attribute. Press the right-arrow key so the numer­
ator is no longer highlighted. 

3. To highlight the slash between the numbers, hold 
the Shift key and press the left-arrow key once. 

4. Press Option-Shift -1 to replace the highlighted slash 
with the printer's slash character ( * ). This character 
works better with fractions than does the normal slash. 

5. Highlight the denominator by holding the Shift key 
and pressing the right-arrow key once. Press 
Command-Shift-hyphen to invoke the subscript text 
attribute. 

6. Press Command-T to access PageMaker's Type 
Specifications dialog box, and click on the Options 
button. 

7. Tab three times to the Subscript position box, and 
type 0. Press Return twice. 

8. Press the right-arrow key once to move the cursor 
off the denominator. 

9. Press Command-Shift-hyphen. This combination 
deactivates the subscript attribute so the subsequent 
characters after the fraction are not subscripted. 

10. Stop recording, and save the macro. 

If you use fractions with double-digit numerators 
and/or denominators, simply create another macro 
and press the right-arrow key twice in steps 1 and 5 to 
highlight the entire number. 

The macro is cumbersome to define, but it saves you 
time whenever you use it. Another advantage is that 
because the superscript/subscript text attributes are 
defined as a percentage of the current point size, the 
fractions will always be the correct size. 

Resetting The Page Numbering For Fonns 
When using PageMaker to set up a double-sided form, 
you don't have to set the starting page number to 1 
and then flip between pages 1 and 2. just set the start­
ing page number in the Page Setup dialog box to 2 

and create two facing pages. 

This lets you work with both sides of the form on the 
screen at the same time (and the master pages corre­
spond to the on-screen form). Late~ you can reset the 
Page Setup dialog box. Remember also that most DTP 
programs offer automatic page-numbering tricks, 
which become useful when your documents start to 
grow. 

Setting Consistent Spacing Between 
mements 
Getting the spacing consistent between several repeti­
tive elements, such as photos and their captions, 
throughout a multipage publication can be a real 
chore-but not if you use this PageMaker trick: 

1. When setting the style for a caption or other repeat­
ing text element, go to the Rules dialog box, which 
you access by selecting Paragraph on the Type menu. 
Check Rule Above Paragraph, and set Line Style to 
None on the pull-down menu (this gives you an invis­
ible rule above the text). 

2. Next go to Options, and type the desired number in 
the Top box for the amount of spacing you want 
between the text and the invisible rule. For example, 
if you're working in 12-point type, an 18-point space 
gives you 6 points between the text block and the 
rule which translates to the bottom of the graphic 
element. 

3. When you drag the text block to position it, the 
invisible rule above the text will enlarge the text box 
(shown as a dotted line), according to the amount of 
space you entered. Line up the top edge of the text box 
with the bottom edge of the graphic (see Figure 1). 
This will give you consistent spacing between all cap­
tions and related graphics. 

This trick also works if the invisible rule is set below 
the text block (which lets you place the text above the 
graphic) or if the text block is rotated (for example, 
for a photo credit on the side of a photo). 

Correcting Underscoring Problems 
When making a "fill-in" sheet, the underscore charac­
ters you type at the end of each line will occasionally 
line up with the end of other lines. 1b correct this, after 
you've rompleted a page, draw a box over the edges of 
the ends of the lines which encompasses all of the asso­
ciated lines. Give this box a white shade and "None" 
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lines, so it can't be viewed The objects behind it will be 
invisibly covered. 

Getting The Most Accurate Size Display 
Although the 200% size has the most fractional mark­
ings on the rulers, it is not the most accurate size dis­
play. Since the printed version exactly matches the 
Actual Size display, always check it before doing your 
final printing. 

Disabling ''Snap To Guides" 
You have the option of turning off Snap 1b Guides in the 
Options menu if you don't use them often. When making 
a move that isn't affected by these guides, be careful 
where you plare the pointer. Position the pointer away 
from the guides when you start the move so that the item 
you're moving won't be affected by the guides. 

Save Time When Switching Printer Drivers 
Switching from the Aldus printer driver to the Apple 
driver for background printing under System 7 or 
MultiFinder is a hassle if you rely on the usual, slow 
method of invoking the Aldus Print dialog box and 
selecting Change. 

You can make the change much more quickly by 
holding down the Option key while selecting Print 
from the File menu; then click on OK in the two 
resulting dialog boxes. You' 11 find yourself at the 
familiar LaserWriter dialog box, where you can specify 
the number of copies and pages to print. You've auto­
matically switched printer drivers! 

Printing a Publication From Page One, 
With A Tide Page 
You may want your publication to have a title page 
and then start the document with Page 1, but 
PageMaker doesn't let you treat the title page differ­
ently from your document (it also won't automatical­
ly number the pages starting with the second docu­
ment as Page 1). 

If you put the title page at the end of the document 
and tum off the Display Master option on the Page 
Menu for that page, you can use automatic page num­
bering for the document and still have a title page 
without a folio. 

Remembering Page Setup Alterations 
Page Maker will permanently remember page setup 
alterations if you choose Page Setup from the File 
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menu with no document open and only the gray desk­
top showing. Every new publication you create will 
default to the altered settings. 

Creating Evenly-Spaced Lines In Difficult 
Places 
There will be times when you want evenly-spaced 
lines in a place not easily divided by the ruler. You can 
create these lines easily: 

First, draw and save your own simple ruler (with some 
division lines) in a PICT file (you can make these 
with MacPaint or MacDraw, for example). 

Enter PageMaker and use the Place command to put 
your ruler on the page. Select the ruler and resize it to 
fit the space you need to divide. You can now draw 
Hhes using the ruler as a guide. When you're finished, 
remove the ruler. 

'lbggling Between "Full Page" And "Fit To 
Window" Views 
You can toggle between the full Page and Fit in 
Window views by holding down the Command key 
while clicking in the page window. 

Keyboard Command Shortcuts For 
Extended Keyboard Users 
If you have Apple's Extended Keyboard, you can choose 
tools from the PageMaker Tholbox window by using the 
following undocumented key oombinations: 

Control-Shift-Fl selects the Pointer. 

Control-Shift-F2 selects the Line tool. 

Control-Shift-F3 selects the Horizontal/Vertical tool. 

Control-Shift-F4 selects the Thxt tool. 

Control-Shift-F5 selects the square rectangle tool. 

Control-Shift-F6 selects the rounded rectangle tool. 

Control-Shift-F7 selects the Ellipse tool. 

Control-Shift-FS selects the Cropping tool. 

Flowing 'Iext Around Irregularly Shaped 
Objects 
PageMaker lets you flow text around irregular graph­
ics using an invisible outline that text won't cross. 
This feature also lets text flow into an irregular shape. 

Start by drawing or placing a graphic in a shape that 



you wish to replace with your text. 

Using the rectangle tool, create two side-by-side rect­
angles to cover the graphic, with the two rectangles 
touching in the center of the graphic and extending 
across the width of the column and above and below 
the graphic. 

Select the center text -wrap feature, (found in Thxt 
Wrap under the Options menu) for each of these rect­
angles. The invisible wrap control lines will appear, 
overlapping in the center. 

Working first with the left rectangle, click along the 
right control line enough times to create the number 
of points necessary to outline the left side of your 
graphic. Use these points to stretch the control lines 
around the left side of your graphic. 

Repeat the process for the right rectangle, using the 
left side of the rectangle. Make sure the top and bot­
tom control lines still overlap at the center. 

When you have the graphic outlined completely, 
delete it. 

Now, choose the two rectangles and specify None 
under the Lines menu. 

Flow your text into the column, and it will fill the area 
you created. 

Set the text to be justified to flow it properly across the 
area. This tip works best when you're working with 
small font sizes, tight leading, no paragraph breaks, 
no tabs, and a column width no larger than the size of 
your graphic. 

Saving Money When Going To Print Or Ftlm 
Most service bureaus charge less for printing one 11 x 
17-inch sheet of paper or film than they do for print­
ing two 8.5 x 11-inch printouts. You can take advan­
tage of the price break by using PageMaker's wide 
tabloid page setup to lay out two pages on a single 
page. This also lets you produce bleeds (graphics that 
extend across two pages). 

Here's an example of how to set up two three-column 
pages on one tabloid-sized page: 

Set the left and right margins to be the outside margin 
measurements (since neither one is an inside, or 
bound margin, they should be equal). Next, choose the 
distance between columns and the number of 

columns, but choose seven columns instead of the 
more common six. The columns will be evenly spread 
across the two-page spread. 1b rearrange them, you 
need to know the width of the column you want. For a 
three-column page, the formula is (8.5 - (2 X the dis­
tance between columns) -(outside margin + inside 
margin)) divided by 3. 

Starting from the left margin, measure the width of 
your column and then drag the left side of the first 
column guide to that point. Zero the ruler to the right 
edge of the column guide, and repeat the procedure 
for the second and third columns. Then move to the 
right margin and repeat the measurements for 
columns six, five and four. The remaining "seventh" 
column (the one left in the middle) and adjacent col­
umn divisions will be equal to the two inner margins. 

When printing proofs on a LaserWriter, make sure that 
you change the options at the bottom of the print dia­
log box so that the paper is set at Tall. At this setting, 
with the tile feature set at automatic and the overlap 
set at 0, the LaserWriter will print your proofs as neatly 
as if your layout were in an 8.5 x 11 fonnat. 

Working With Word's Style Sheets 
When you first place a Word document into 
PageMaker, you place Word's style sheet into the 
PageMaker document's style sheet, even if you previ­
ously hadn't been using a style. In other words, the 
style is not actually created by PageMaker; rather, it's 
borrowed from Word. 

Once you've placed Word text into the program (and 
so, placed it in its style sheet), PageMaker will read 
whatever Nonnal text you place from Word, whether 
it's been formatted differently or not, as the same 
Nonnal style. 

If you have several stories with different formats to 
place in your document, make sure to delete the 
Nonnal entry from the PageMaker style sheet before 
adding text. You can either add the styles you want in 
Define Styles under the Format menu while still in 
Word, or else save your formatting until you've 
imported all your text into PageMaker. 

How To Save Revised Print Parameters 
Page Maker saves updates to your print parameters 
(like Paper Source, Driver, Scaling, etc.) only if it per­
ceives that you have changed the file. Even though 
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you may only be opening the file to print it, your 
changed parameters will be lost when you close the file. 

One solution is to do something and then promptly 
Undo it. For example draw a box and then delete it. Now 
PageMaker will perceive a saveable change, and your 
new print parameters will be saved within your file. 

Use Easy Access To Nudge Graphics Or 'text 
A Short Distance 
If you need to nudge an object just a tiny distance, you 
probably know that using the mouse to drag it is 
extremely inexact. Easy Access, an I NIT that comes 
with the new System, can help. 

just press Command-Shift-Clear to turn on the Mouse 
Keys. Press the 0 key to lock the mouse button down, 
then use the numeric keypad to move the pointer (press 
8 to move up, 6 to move right, etc.). 

To move the pointer one pixel on the screen, tap the 
key once. For a longer movement, hold down the key a 
little longer. Press the decimal point to unlock the 
mouse button, and press the Clear key to turn off 
Mouse Keys. 

Hide Guides And Rulers To Gain Screen 
Space On Plus\SE Screens 
You can gain some space on the small Mac Plus and 
SE screens by hiding the guides and rulers. To navi­
gate through your documents, use: 

Command-Tab to move forward. 

Command-Shift-Tab to move backward. 

Command-G to go to a specific page. 

Select the hand tool and Option-Click with it to move 
around the page. 

An Easy Way To 'lhlck Hours Spent Working 
If you need to track how many hours you spend on a 
particular PageMaker job, you can create a small 
chart on the Pasteboard, just off to the side of a page. 
Create columns for Date, Time Started, Time Ended, 
and Hours Worked in the chart, using tabs. Each time 
you open the document, add a new row for the day 
and enter the pertinent information. When you close 
the document, fill in the Time Ended column. Now 
you'll always have accurate data handy for invoicing 
that project, and it's a lot cheaper than buying a time­
tracking program. 
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Typing Numbers Using The Keypad 
Many people prefer to enter numbers from the numeric 
keypad, but with PageMaker the keypad numbers are used 
for moving around within a document (and the Nwn 
Lock key has been disabled). You can use the numeric key­
pad by making sure the Caps I.ock key is down. 

'Ihbbing With Dot Leaders 
When using tabs with dot leaders in PageMaker, the 
dot leaders take on the text format of the character to 
the left of the tab. Therefore, if you use a Zapf Dingbats 
character just before the leader, the dots become little 
pencil icons. 

It isn't possible to select the dots and change their type­
face fonnat separately. 1b avoid this problem, press 
Option-spacebar just before the tab. Then select this spe­
cial nonbreaking space character and fonnat it so that 
the dots appear as desired. 

PAGEMAKER 4.0 
Refonnatting 'text In Imported 'Ihbles 
The Table Editor that comes with PageMaker 4.0 works 
well, but once a table has been imported into 
PageMaker, text within a cell can't be refonnatted. 
Here's how to solve this problem: 

1. Create a table in the Table Editor as usual, and copy 
it to the Clipboard. 

2. Paste it into a graphics program that accepts PICT 
graphics. 

3. Select the text, and format it as needed. 

4. Select the table, copy it, and then paste it back into 
Page Maker. 

The table's lines and shading can be modified in the 
graphics program in the same way. 

PageMaker 4.0 'Iii.es 1b Forget Its Past 
If you've been using PageMaker for years and have 
upgraded to Version 4.0, you might not want to 
throw away your previous versions just yet. 
Page Maker 4.0 can open and use documents created 
with version 3.0 or 4.0, but it can't open documents 
created with PageMaker 20 or earlier .. To get your 
older PageMaker documents into Version 4.0, you 



need to open them in PageMaker 3.0 first and save 
them in that version's format. Then you can open 
the files in Version 4.0. Aldus recommends having 
free space on disk equal to three times the size of the 
file being converted. 

You can upgrade all of your PageMaker documents 
each time a new version is released, but the safest solu­
tion is to keep all the old master disks so that you can 
reinstall older PageMaker versions when necessary. 

Saving Documents Created With Older 
Versions Of PageMaker 
PageMaker 4.0 has enhanced exporting features for 
text, which can be a boon if you need to compress and 
save documents created in older versions of 
PageMaker. These documents are most likely large, 
and the formatted text sections are probably the most 
important part. If this is true, then translate the docu­
ment created with PageMaker 3.0 or 3.02 up to 
PageMaker 4.0. 

Now you can export the documents (you can combine 
them by cutting and pasting) into a document that's 
formatted in your favorite word processor-style (or text 
only). This technique might save you lOOK on small 
documents and as much as megabytes on large ones. 

H you ever need your older document again, you'll 
find that reassembly is easy. Other exporting programs 
can perform this trick as well, but PageMaker docu­
ments save you the largest amount of space when you 
remove the formatting. 

PageMaker Graphic Dropouts 
Are you experiencing problems when importing 
graphics? There may be some explanations depending 
on what's happening. Here are some common causes 
of the "Hey, the graphics didn't print!" problem. 

You may have placed a scanned image and then 
moved the image file to another disk or folder, where 
PageMaker couldn't find it. Fortunately, if the program 
can't find a file it needs, a dialog box will appear 
telling you, so you'll know what happened. 
PageMaker 4.0 automatically incorporates all EPS 
graphics into the data file itself, so the location of the 
original EPS file doesn't matter. 

Another possibility is that you may have checked the 
Proof Print option in the Print Setup dialog box. This is 
a time-saving measure in which PageMaker prints 

dummy-style boxes in the place of any placed graphics. 
If you don't see a box containing a jumbo X where you 
placed your graphics, you can rule this one out. 

If the dropouts are irregular (page elements of all 
types either print or won't print, without reason or 
mercy), you're probably looking at a bona fide com­
puter problem. If you've installed a screen saver, try 
turning it off. Some screen savers can cause trouble if 
they kick in while a document's being printed; the 
computer becomes engrossed in the challenge of 
drawing those fireworks, or fish, or exploding pen­
guins, or whatever and quite literally "forgets" to send 
some data to the printer. 

It's also possible that the page was complex and your 
printer ran out of memory. Usually when that hap­
pens, your Mac is polite enough to report a "Not 
enough memory, bonehead!" -type error message. If 
you suspect this kind of trouble, you can clear any 
and all errors from your printer by switching it off and 
back on again. 

If you've already turned your printer off and then back 
on again and you still can't get the page to print, turn 
the printer off and then on one more time. Then man­
ually download all the fonts used on the troublesome 
page- all the fonts you used in PageMaker and all 
the fonts in your EPS graphic. Now print the trouble­
some page (but not the entire document). To down­
load stuff to your printer, you need a program such as 
Font Downloader, which is included with Adobe fonts, 
or CE Software's Widgets or LaserStatus. 

Using Auto-Linking Th Create Documents 
Automatically 
With PageMaker 4.0's auto-linking and updating fea­
ture, you can create documents automatically. The 
technique works best for highly structured documents 
such as brochures or manuals, in which text has a 
consistent length and placement. Here's how to do it: 

1. Create some dummy text files in your word-process­
ing program, and name them Story 1, Story 2, and so 
on. You can also do this with graphics, naming them 
Picture 1, Picture 2, and so on. 

2. Create a new PageMaker document, and turn on the 
Update Automatically and Alert Before Updating fea­
tures, by clicking on the Links Options button in the 
Links dialog box (Command -= ), which you access 
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from the File menu. Now place (Command-D) each of 
the dummy stories and graphics you've created. 
Choose Save, and click on the Thmplate button in the 
Save dialog box before you save the file. Then quit 
Page Maker. 

3. When you're ready to create a new self-creating docu­
ment based on the template, open the dummy text and 
graphics files in your word-processing or graphics pro­
gram and delete everything there. Type in the new 
material, and save the files with the same names (Story 
1, Picture 1, and so on) and in the same location. 

4. Double-click on the Page Maker template file. A new 
untitled document based on the template will open, 
and you'll be asked if you want to update the linked 
dummy files. Click on OK, and the new text and 
graphics will appear in the template. 

Professional-Looking Fractions 
In order to set professional-looking fractions in 
PageMaker 4.0, change the option for subscript posi­
tion (on the Type menu) from 33.33 percent to 0 per­
cent. To set a fraction, all you need do is type in the 
numbers and change the numerator to superscript 
and the denominator to subscript. No more calculat­
ing and changing the size of your denominator- it 
will be perfect every time. 

Conversion Of Mac Write II 1b 
PageMaker 4.0 
In converting documents from Mac Write II to 
PageMaker 4.0, the import and creation of en dashes is 
inconsistent. In the story editor of PageMaker, you 
can't import en dashes, nor can you create them. The 
mode's global-change options don't recognize them. 
They import as hyphens. 

When you use the Place command on imported text 
in the page-layout view, the en dashes change to 
hyphens. You can create en dashes in the page-layout 
view with the standard Option-hyphen keystroke com­
bination, however. 

There is a way around this shortcoming: Cut and 
paste between applications. Copy the text you want to 
import from your word processing file, and then close 
the document. Open the Page Maker 4.0 file, and paste 
the text. 

Although more steps are involved in this technique, if 
you have many en dashes in an existing document 
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and want to copy directly to the PageMaker document, 
this is the only way the en dashes will survive the 
transition. 

Using The Scrapbook To Reuse Layout 
Elements 
If you use various elements such as company logos, 
slogans, or advertising copy interchangeably in your 
documents and you need those elements placed at 
specific locations on the page, you probably have to 
create one or more PageMaker templates for this pur­
pose. 

An easier way is to use the Scrapbook and PageMaker's 
"power-pasting" feature. First, accurately position the 
text or graphic elements you plan to reuse in 
PageMaker documents, and then copy or cut them 
and paste them into the Scrapbook. Repeat this proce­
dure until all these elements are placed in the 
Scrapbook. Whenever you need to reuse any of them, 
simply open the Scrapbook, select the item, copy it, 
return to your PageMaker document, and poweF-paste 
it by pressing Command-Option-V. Your text or graphic 
element will be pasted into its original position. 

Importing PC TIFF Files 
If you want to import a PC TIFF file into your layout, 
you'll discover that Aldus PageMaker 4.1 imports PC 
TIFFs without prior processing or conversion. This fea­
ture can speed up the layout cycle, although the PC 
TIFFs often import at about25 percent of their original 
size, making resizing necessary. 

PERSUASION 
Changing The Size Of The Arrowheads 
If you find the arrowheads in Aldus Persuasion too 
large for your taste, you can change their size by 
changing the length of the line to which they're 
attached. On longer lines, Persuasion consistently 
makes the arrows the same size, but by adjusting 
shorter lines, you can obtain a variety of sizes. 

Draw the line in the position you want. Instead of 
choosing the arrow style from the Effect menu and 
applying it to your line, draw a shorter line off to one 
side, make it the arrow line, and then adjust the 
length until you get the arrowhead size you want. 
Copy and paste this arrowhead on top of the first line. 



You can also create a selection of arrowheads and 
copy them to the Scrapbook so you can use them later. 
Be sure to create them pointing in different directions. 

Change The Master For Some But Not All Of 
Its Associated Slides 
You can't do this, but Persuasion's multiple masters 
can produce the same result. Simply create a new slide 
master based on the old one by choosing Go to Master 
on the View menu and New from the submenu. Then 
select any subset of slides by Shift-clicking in the 
Outline or Slide Sorter view; and apply the new master. 
Reformat the new master to suit your needs. 

Switch Auto'lemplates To Give Your Slides A 
New Look 
Use the AutoTemplates command to quickly change 
the formatting for an entire presentation. This is a 
convenient way to alternate between black-and-white 
overheads and 35mm color slides. Persuasion auto­
matically replaces masters with the same names, 
reformats all slides, and replots charts to match the 
new design. The new Auto'Iemplate format also over­
rides any previously applied color schemes and 
defined text and chart formats. 

Restore Master Fonnatting To An 
Individual Slide Element 
You've made several changes to the body text of a slide 
- italicized some words and moved and resized the 
text block- but you don't like the results and want to 
restore the master's formatting. 

The solution is , in Slide view; use the pointer tool to 
select and delete the entire text block. Leave Slide view; 
and then return to it. Voila- your body text has been 
reformatted and repositioned based on the master. 

This shortcut works for any text that's linked to the 
outline, including titles, subtitles, and body text. For 
an organization chart, just select and delete the whole 
chart. (Note: A quick way to leave and return to Slide 
view is to click on the slide icon at the upper right cor­
ner of the window.) 

Use Chart Placeholders 
You don't have to use chart placeholders, because you 
can plot a chart directly to any slide regardless of 
which master you're using, but you can easily use a 
chart placeholder by assigning a master containing 

one to the slide before you plot. A chart placeholder 
offers two benefits: One, you can adjust the size, posi­
tioning, and formatting of charts on several slides at 
once simply by changing the master. 1\vo, if you 
switch Auto'Iemplates, all the charts will automatical­
ly be replotted, resized, and repositioned to reflect the 
new template design. 

Use ''Selective" Select All To Choose All 
Objects Of A Given Type 
In Slide view; you can select all the objects created 
with a specific tool by choosing that tool and then 
using the Select All command (Command-A). If you 
choose the rectangle tool and choose Select All, for 
example, all rectangles are selected. Choose Select All 
again, and all objects on the slide are selected. 

In Outline view; the Select All command has three lev­
els of operation: Issuing the command once selects all 
the text in a single heading, twice selects all the head­
ings of the same level that share the same superior 
heading, and three times selects all the visible head­
ings in the outline. 

'Jake Advantage Of'Iemporary And 
Pennanent Defaults For Drawing Tools 
Permanent defaults are saved with your document. 
You can change them by selecting the pointer tool 
and choosing line styles, colors, or patterns from the 
Effect menu. (Make sure no objects are selected, or 
they will be affected by the changes.) 

You can set temporary defaults by clicking on a draw­
ing tool and then making selections from the Effect 
menu. The temporary defaults affect all the objects 
you draw until you choose another tool. 

Create One Or More Preview Slides 
Automatically 
A preview slide gives an overview of a set of slides by 
listing their titles. You create preview slides in the 
Outline view by using the Set Heading As command 
from the Outline menu to tum subordinate headings 
into slide titles. The subordinate slide title then 
appears twice, once as body text in the preview slide 
and again as the title of its own slide. 

Restore Master Fonnatting To An Entire 
Slide 
The fastest way to remove all local overrides -such 
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as fonnat and position changes to the title, subtitle, or 
body text-is to select None for the master and then 
reassign the original master. 

Let Persuasion Keep Thxt Blocks And 
Charts Centered On The Slide 
You might want to keep a text block centered on the 
slide even if the text within the block is aligned on the 
left. Use the Anchor Placeholder command to do this. 
Few of Persuasion's Auto-Thmplates use center anchor­
ing, so this feature is largely unknown. 

Go to the slide master, select the placeholder for body 
text or organization chart, and choose Anchor Place­
holder from the Master menu. Select both Center 
options, and you've finished. Now all the text that's 
contained in the placeholder, regardless of its size and 
alignment, is vertically and horizontally centered rel­
ative to the placeholder. 

Use Auto'lemplates As More Than 
Coordinated Masters 
You can save any presentation as an AutoThmplate, 
and all the data, document attributes and defaults are 
saved along with it. Similarly, you can open the origi­
nal of any AutoThmplate (instead of a copy), modify it 
to fit your needs, and resave it. 

Here are some possibilities for enhancing 
AutoThmplates. Set up level-specific text styles for the 
Outline view (you can always override the styles for 
individual characters and topics). Define drawing-tool 
defaults for patterns, colors and line styles. Create 
your own color schemes. Save a collection of drawing 
objects or clip art on an unused slide, a notes page, a 
handout master, or the gray area of any slide (in other 
words, any place they won't print). 

Create Slide Builds (or Layers) 
Automatically 
A build reveals a slide's text and graphics one layer at 
a time, in a manner similar to using a flip chart with 
acetate overlays. You can create builds manually by 
selecting objects in Slide view and sending them to 
different layers (using the Layer pop-up menu in the 
lower menu bar). But many users don't realize they 
can create builds for text and charts automatically for 
an entire presentation. 

The process is simple: Go to a slide master, select the 
appropriate place-holder, pick Build Layers from the 
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Master menu, and choose a build option in the dialog 
box. All the slides based on that master are now layered. 
1b see the builds, you can run the slide Show or output 
them by checking Builds in the Print or Export dialog 
box. (Note: Builds print cumulatively-layer 1 on the 
first page, layers 1 and 2 on the second page, and so 
forth.) 

Creating A Presentation Without 
TheOudiner 
The key here is to choose New from the Slide pop-up 
menu. This gives you a brand-new slide with a 
dummy title and body text based on the slide master. 
Use the text tool to select the dummy text, and type in 
new text. You can use the Move Right and Move Left 
commands (on the Thxt menu) to alter the heading 
level of a paragraph, and the font and style automati­
cally change to reflect the new level if it is different on 
the master. 

Assigning Different Type, Style And Color 
1b Body 'lext On A Master 
Use the text tool to select one or more paragraphs of 
body text, and then choose the desired styles and color 
from the Thxt menu. 

Changing Body 'Iext On The Slide Master 
Make changes to body text, organization charts, and 
so forth on the slide master rather than on individual 
slides. All slides that use the master will be updated 
instantly. 

Mixing 'Ihll And Wide Overheads In The 
Same Presentation 
Slide or overhead orientation is always based on the 
orientation of the master and is usually horizontal 
(wide). If you prefer an overhead with a vertical orien­
tation, make a new master, don't give it a background 
(select None from the Background pop-up menu), 
and choose Tall Orientation from the Master menu. 
Any slide using this master is now tall instead of wide. 
This technique always works for overheads, but it's less 
reliable for slides, because some film recorders can't 
handle a tall orientation. 

Replacing The Default Auto'lemplate 
Without Reinstalling 
\Vhen you install Persuasion, you have the option of 
installing one AutoThmplate as the default presenta­
tion; this file is called Persuasion Prefs and resides in 



the Aldus Folder, inside the System Folder), If you later 
want to make another AutoThmplate the default, you 
don't have to reinstall the program. Instead, just create 
a presentation and adjust the various settings to meet 
your needs. Save the file as a presentation called 
Persuasion Prefs and store it in the Aldus Folder, where 
it replaces the original file. 

Reformat All Slides Simultaneously By 
Changing The Slide Master 
Most people change the formatting for existing slides 
one at a time right on the slide, but one of 
Persuasion's unique features is that you can reformat 
all your slides simultaneously by making changes to 
the slide master. All slides based on the master imme­
diately reflect the changes. This works for any place­
holder change, including font, style, size, position, 
and fills. (Placeholders are markers that define the 
size, format, and location of objects on a master.) 

Persuasion Does Animation 
You can use Persuasion's layers to achieve animation 
effects. Say, for example, that you want to have a ball 
bouncing across the screen. First, copy and paste the 
ball at different positions on successive layers of the 
slide. On each layer, hide the ball from the previous 
layer by using a solid rectangle whose fill is the same 
color as the background. Similarly, you can build text 
word by word (or letter by letter) by sending the appro­
priate characters of the text block to different layers. 

Note: When you paste or draw new objects they always 
go to the current drawing layer. You can change the 
drawing layer by choosing it from the Layer pop-up 
menu when no objects are selected. 

Use "Warm" Links To Quickly Replot 
Charts Linked 
You can open a spreadsheet from another program (if 
it's saved in text or WKS format) and use it to plot 
selected information. Persuasion maintains a link to 
this external tie enabling you to update a presenta­
tion quickly if data in the original spreadsheet 
changes. Simply use the Data Sheet command to 
open the external spreadsheet, select the data to be 
replotted, and click on the Replot button on the 
menu bar. 

Spice Up Your Charts With Some Variety 

tion legends and pie slices by double-clicking and drag­
ging. You can add round comers to bars via the Round 
Corners command on the Draw menu as well as 
ungroup any chart and alter the individual elements. 

Improve A Resized Chart Using The Redraw 
Chart Command 
When you stretch or resize a chart in a drawing pro­
gram such as Persuasion, the screen image may 
become distorted. If you select Redraw Chart from the 
Chart menu, the chart will be recalculated based on 
its new size and replotted, giving you a clean image. 

Highlight Key Data Points By Enhancing 
Individual Chart Elements 
You can change patterns, colors and line styles for a 
single data element as well as for an entire series. 

When you double-click on a bar, all the bars in the 
series are selected. If you double-click again, the 
individual bar is selected and you can alter its 
appearance without affecting other chart elements. 
Similarly, you can alter the tops and sides of bars, 
pie slices and so on; make independent changes to 
major grids, minor grids and tick marks; and 
enhance text for individual category and legend 
labels. (Note: You can use one triple-click instead 
of two double-clicks to select an individual chart 
element.) 

7 Keyboard Shortcuts 
I. Move between slides by holding down the command 
key and pressing either the up-arrow key (to go back­
ward) or the down-arrow key to go forward. 

2. Move between the Outline, Slide, and Notes views by 
holding down the Command key and choosing the 
right- or left-arrow key 

3. Use the Command key to make resizing easier. 

You don't have to use the selection handles to resize 
selected objects. Just hold down the Command key 
and drag the mouse anywhere on the slide. You can 
reduce the effect of mouse movement by beginning 
the drag outside the select on and magnify it by start­
ing the drag inside it. 

4. Resize text blocks without leaving text editing 
mode. 

You can flip charts vertically or horizontally and reposi- Just hold down the Command key and drag the left or 
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right edge of the text block. This applies to all text 
blocks, including those in groups and charts. 

5. Select objects behind other objects by using the 
Option key. 

Sometimes you can see an object but can't select it 
because another object is in front of it. If you hold 
down the Option key and click, you can select an 
object behind the front-most object. You can use this 
keyboard shortcut to select several unreachable 
objects in succession. 

6. Change the default text style for one or more lev­
els of the outline without using the Outline Styles 
dialog box. 

~old down the Option key while you choose any font, 
stze, style or color from the Thxt menu, and all the 
headings on the same level as the selected one change 
simuitaneously. All the new headings have the new 
formatting, but local style overrides are preserved. 

7. In the Outline view, you can show only first-level 
subordinates of a heading and hide all deeper levels 
by holding down the Command key and double­
clicking on the heading icon. 

To re-expand the subordinates of the heading, hold 
down the Option key and double-click on the heading 
icon. 

Let Your Chart Data Go Through The Roof 
You can emphasize, expanding sales figures by chang­
ing a chart's plot range so that the largest numbers lit­
erally go off the chart. Select the chart, and then 
choose Axes from the Chart menu and Value Axis 
Format from the submenu. When the dialog box 
appears, reduce the value for Plot Range Maximum. 
Now the longest bars (or highest points) will extend 
beyond the chart axes. 

Edit 'Iext In Grouped Objects Without 
Ungrouping 
Choose the text tool, click on the text in any group or 
chart-no matter how deeply nested it is-and pro­
ceed with your editing. You can also change the type 
style and apply superscripts or subscripts. (Note: Thxt 
changes you make to chart labels are automatically 
reflected in the data sheet.) 
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POSTSCRIPT 
Sending A PostScript File To The Printer 
Once you have created a PostScript file on the Mac, 
you need an application or DA capable of sending the 
file to the printer. Adobe's Font Down loader can, in 
addition to manually downloading fonts, download 
PostScript files one at a time. CE Software's Widgets 
application or LaserStatus DA can download files one 
at a time or in batches. 

Font Downloader is included with Adobe fonts, and 
you can download it from the Adobe Forum on 
CompuServe. Widgets and LaserStatus DA are bonus 
programs included with CE Software's Finder-replace­
ment DA, Disk1bp. 

POSTSCRIPT FILES 
PostScript File From LaserWriter 7 
With the LaserWriter driver from System 7, the old trick 
of pressing Command-K or Command-Fat just the 
right instant to get a PostScript file no longer works. 
Instead, a new button in the print dialog offers 
"PostScript file" as an alternative destination to 
"Printer." 

Printing PostScript to Disk Under 
MultiFinder 
Prior to System 7, one way of sending a PostScript file 
to disk is to hold down the Command and K keys 
immediately after clicking on the OK button in the 
Print dialog box. This approach works, unless you're 
using MultiFtnder and have Background Printing 
enabled. If this is the case, your PostScript file will 
never be printed to disk. 

If you normally use both MultiFinder and Background 
Printing, don't despair- you can still print a 
PostScript file to disk. Here's what you need to do: 

1. Open the Chooser DA. 

2. Select your laser printer. 

3. Turn Background Printing off. 

4. Close the Chooser. 



Now, if you hold down the Command and K keys 
immediately after you click on OK in the Print dialog 
box, you'll see a box that says, "Now printing 
PostScript file." Don't forget to turn Background 
Printing back on when you've finished. 

'ftoubleshooting Output Problems 
One way to troubleshoot potential output problems is 
with LaserCheck, a $149 utility from Systems of 
Merritt ([205] 660-1240) that turns your PostScript 
laser printer into a proofing device for an imagesetter. 

It uses the imagesetter's printer files and output set­
tings and scales the pages to fit 8.5 x 11-inch paper. 
LaserCheck's output shows crop and registration 
marks; displays job information such as screen 
angles, fonts used, and processing time; and flags any 
PostScript errors and coloF-separation problems. 

PRINTER DESCRIPTION 
FILES/DIALOG BOXES 
Selecting The Printer Description File 
In some applications, such as QuarkXPress, 
PageMaker, FreeHand, and Illustrator, the Print or Page 
Setup dialog boxes let you select a specific printer, such 
as a LaserWriter II, QMS PS-810, or Linotronic 300. 
Your printer choice affects the PostScript code that is 
sent to the printer and can occasionally limit the out­
put quality. This is because when you choose a printer, 
the application uses a printeF-description file to deter­
mine what information to send to the printer. Some 
descriptions are built in to the application; others use 
separate printeF-description files. These files are usual­
ly identified by a special filename extension, such as 
APD for Aldus applications, PDF for Quark programs, 
and PPD for Adobe applications. The printer descrip­
tions affect gray levels, page margins, and other 
factors-some permit more versatility than others. 

It would be great if these descriptions were perfect, but 
that's not always the case. If you suspect that the 
printer description is limiting the quality of your out­
put, try telling your application that you're printing to 
a Linotronic 300, which is a high-end imagesetter. In 
many cases, this printer description gives the printer 
the ability to print the best-looking page instead of 
sending a restricted copy of the page's code. 

PRINTING 
The Wrong Font 
If Courier unexpectedly pinch-hits for a PostScript font, 
the laseF-printer driver probably couldn't locate the 
right outline- or printer-font file. These files should be 
stored in the System Folder, unless you're using a font­
management utility, such as Suitcase II or 
Masterjuggler, in which case the outline-font and bit­
mapped-font files should be stored in the same folder, 
not necessarily the System Folder. 

Missing Elements 
If you're using a page-layout or graphics program and 
an individual element fails to appear on the page, you 
may have turned on a "proof printing" option in your 
application. Proof printing saves printing time by sub­
stituting empty placeholders for graphic images. 

If you see an empty box or one displaying only a file­
name, the program may not have been able to locate a 
placed image on-disk; delete that element from the 
document, and try placing it again. 

Image Chopped Off 
If you find an image is chopped off or cropped and 
you didn't intend it to be, you may have placed a page 
element too close to the edge of the paper. Keep every­
thing at least an eighth of an inch away from the 
edge. 

jaggy PostScript Graphics 
When that spiffy EPS graphic you worked so hard to 
produce looks like a low-quality 72-dpi bit-mapped 
image, it's because the program couldn't find the EPS 
image and printed the bit-mapped PICT preview 
instead. Delete the bit-mapped image from the docu­
ment, and place the original graphic again. 

JaggyType 
When you get the right font printed but it's horribly 
jaggy, it's probably because the driver couldn't find the 
PostScript outline-font file for that face and you had 
the Font Substitution option in the Page Setup dialog 
box turned off. The driver substituted the highest­
quality bit-mapped version of the chosen font. 
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QUARKXPRESS 
lining Up Numerals Using Kerning 
Because numerals are generally designed as 
monospaced characters, even in proportionally 
spaced fonts, they don't look as if they line up flush 
left with smaller type above and below-there's usu­
ally too much white space to the left of the numeral. 

Unfortunately, in QuarkXPress you can't kern to the 
left of the first letter in a line unless the first character 
is a space. If you have a numeral as the first character 
in a line, insert a space before it -you can then kern 
the space between it and the second character, lining 
up the numeral with the text above and below it. 

Applying Two Style Sheets To A Paragraph 
QuarkXPress, like most other word processing and 
page layout programs, doesn't let you mix two style 
sheets in the same paragraph. But let's take an exam­
ple where your layout needs a hanging indent with 
New Century Schoolbook and numbers in Helvetica 
Bold. 

In this case, you might set up a format for the hanging 
indent in New Century Schoolbook and then painstak­
ingly select and change the numbers to Helvetica Bold. 

A quicker way is to set up a style sheet for the hanging 
indent and a separate style sheet for the part number. 
Then instead of running the part number and the 
description together, as they will eventually appear, 
insert some unique combination of paragraph returns 
(and other characters if necessary) between the part 
number and the description so you can search for and 
replace it later. 

Select the entire text, and format it as a description 
(with hanging indents) by using your first style sheet. 
Now click on each of the part numbers and- with the 
function-key equivalents that QuarkXPress lets you 
assign to style sheets- format all the part numbers 
with their own style sheet. 

Now use QuarkXPress' Edit Find/Change menu option 
to replace your separator (in this case, two carriage 
returns) with spaces or whatever else you want to have 
between the part number and the description. 

When you've finished, you'll see that the description 
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and the part number each have their own style. 
QuarkXPress, unlike PageMaker and Word, doesn't 
store styles in the paragraph marker, so when you 
eliminate the paragraph marker between dissimilar 
styles, QuarkXPress simply juxtaposes the styles rather 
than replacing one with the other. 

Because all formatting options in the style sheet 
remain with the text itself, you can have different 
fonts, styles, formats, and you-name-it, and 
QuarkXPress will preserve them. 

QUARKXPRESS 3 
Setting Up A Left Ftrst Page 
Normally, the first page of a QuarkXPress document 
has to be a right-hand page, but you may want to set 
up your document so that the first page is on the left­
you may, for example, want to print a publication's 
back cover to the left of the front cover. 

1b do this, create all the pages in the document except 
the final one. Select page 1, and start a new section 
with the Section command on the Page menu. In the 
resulting dialog box, specify that page numbering 
start on any even numbet Page 1 will automatically 
move to the left side of the gutter. Now insert a page to 
round out the job, and start importing your text and 
graphics. Be careful if you're using automatic page 
numbers, because this technique will throw them off. 

Quick Access 1b Typefaces 
Are you tired of pulling down a long menu to choose a 
font in QuarkXPress? Just go to the Measurement 
palette at the bottom of your screen (use the View 
menu to make it visible, if necessary), double-click on 
the current font name to highlight it, and type in the 
first few letters of the desired typeface. For example, 
type He, and the name changes to the closest match, 
probably Helvetica. If that's what you want, press 
Return to select it. 

Recovering The text From A Corrupted 
Document 
If you get a Bad File Format error when you're attempt­
ing to open a QuarkXPress 3.0 document, the document 
is history. You can, however, recover most of the text in 
the file by using the Open Any File command in 
Microsoft Word ACAR.SS this oommand by holding down 



the Shift key as you pull down the File menu (you can 
also add this command to the menu by using the 
Commands item on the Edit menu). The text may be 
somewhat scrambled and there will be some garbage in 
the file; however, if you need the text, you are in luck. 

Creating Crop Marks For Consolidated jobs 
If you're outputting files at a service bureau that 
charges per page, you can consolidate space and 
reduce costs by combining several small jobs such as 
business cards onto a larger page. However, because 
you are putting several separate documents onto one 
page, you can't use QuarkXPress' automatic-crop­
marks feature. Here is a way to quickly create accurate 
crop marks for each document on a page: 

1. Draw a text box within a letter- or tabloid-sized 
page, and give it a white fill with no runaround. 

2. Select the box, and make it the size of the document 
you want (for example, a 2 x 3 business card), using 
the Modify command from the Item menu or the 
Measurements palette. 

3. Draw two lines with a 0.25-point line weight. One 
should be horizontal, butting the top of the box, and 
the other should be vertical, butting the left side of the 
box. Both lines should extend about 114 to 112 inch 
beyond the box at both ends. 

4. Duplicate each line, and drag it to the opposite side. 

5. Now drag the zero ruler guide to the top left corner 
of the text box, and drag the corner to resize the box 
so that it is 118 inch larger than it was at the top and 
left. Drag the ruler guide to the bottom right corner, 
and extend the box likewise to the right and bottom. 
With the box still selected, bring it to the front, using 
the Item menu. 

6. Create a descriptive title if necessary (for example, 
"My business card- shoot@ 100%"), and place it 
appropriately. Select all items, and group them. If you 
want to save this as a template for future use, drag a 
copy of it to a library. 

7. Now drag the grouped item to an appropriate place 
on the page, and add any ruler guides as necessary. 
Continue adding other items to the page as desired. 

Accessing The Environment Box 
QuarkXPress 3.0 can provide you with useful informa­
tion about your system configuration in its 

Environment dialog box. You access it by holding 
down the Option key when you choose About 
QuarkXPress from the Apple menu. But if you use 
QuicKeys 2 or Suitcase II, you can run into problems, 
because those programs use the Option key to modify 
menus. Quark suggests that you change this menu­
modifier key; but if you have an Apple Extended 
Keyboard, you don't have to. Hold down the Option 
and Help keys, and the QuarkXPress Environment dia­
log box is all yours. 

Importing Word's Fast Saved Documents 
Here's a quick tip on importing Word documents with 
style sheets into QuarkXPress. When you import text 
by using the Include Style Sheets option and the Word 
document's styles have the same names as those in 
the QuarkXPress document (for example, Body Thxt), 
the QuarkXPress styles should override the Word styles. 
However, this won't work consistently if you've saved 
your Word text with the default Fast Save option -only 
some formatting will take effect. Th make sure the 
QuarkXPress styles do override all the Word styles, use 
the Save As command when saving your documents in 
Word. You can also use the Commands option from 
the Edit menu to add the Fast Save Enabled command 
to a menu. This lets you toggle Fast Save on or off as 
you need it. 

Creating Real Fractions 
QuarkXPress 3's in-line-graphics and paragraph-rule 
capabilities give you an easy way to create real frac­
tions (placed top over bottom, not diagonally as in the 
QuarkFreebies extensions). In-line-text boxes are sim­
ple to manipulate. 

First create your standard text, leaving markers where 
you want the fractions to be. Then create a new text 
box on the pasteboard, making sure that the text inset 
for this box is set to 0. Create a fraction by typing the 
numerator, pressing Return, and then typing the 
denominator. The point size of the fraction should be 
1 to 3 points smaller than the body text. Set the align­
ment to center. 

Highlight the first line, and create a paragraph rule 
(using the Style menu). A hairline rule based on the 
indents works well with numbers greater than 9, but 
you can use the text setting for fractions that contain 
only a single digit top and bottom. 

Make sure the text box is as small as possible without 
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losing any type, and then click on the text box with 
the item-selector tool and copy it. Using the editing 
tool, paste this box into the body text where you want 
the fraction to be. Use the Baseline Shift command in 
negative increments to bring the fraction down to the 
level you like. Use the kerning command on the 
Measurements palette to adjust the word spacing. 

For small body text, you may find that the in-line text 
box has too much white space to the right and that 
even kerning does not help. The only solution is to use 
the text box as a free-floating graphic. Just make sure 
that if you edit the body text, you also reposition the 
fractions, if necessary. 

Once you've created a fraction this way, you can create 
others by copying and pasting the original fraction into 
new positions and changing the numbers. 

Creating A Large Letter With Nested 'Iext 
If you've ever wanted to create a word with a large ini­
tialletter and the other letters nested inside it, you 
can do it in QuarkXPress 3. The following steps will 
help you create this effect: 

1. Type the first letter in a large font size. 

2. Type the rest of the word in a smaller point size. 

3. Select the smaller letters, and move the baseline up 
until it is in the middle of the opening of the letter 
(An example of this is the word Cats, where the C is 
the large letter and ats are the letters nested in the C). 

4. Select the large and small letters, and modify the 
tracking until the small letters are nested inside the 
large letter. 

5. Select the small letters, and reset the tracking to 0. 

Although you can achieve the same effect by using 
two text boxes and placing one inside the other, this 
method is easier, because you don't have to worry 
about grouping text boxes or making boxes transpar­
ent. It's also a lot easier to rearrange and copy. 

READYSETGO! 4.0 
Stretching 'Iext Easily 
There's a quick and easy way to stretch text as tall or 
as wide as you want. Start with a text block and type 
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in the desired text. Then draw out a picture block to 
the size of the end product. If, for example, you want 
the text to come out half as wide and four times the 
height, create the picture block in that size. 

Select the text block to be stretched by clicking on it, 
then Cut or Copy it. Now, ready the picture block as if 
it were to receive clip art, and then paste the text into 
the block. Select the Picture block, choose 
Specifications (Command-M), and use the Scale 
Across and Scale Down functions to stretch the text 
accordingly. The stretched text will now appear as you 
want it. 

Wrapping 'Iext Within Two Graphics 
It's possible to wrap text within two graphics to create 
interesting paragraph shapes like circles, triangles, or 
just about any shape you can imagine. Here's how: 

Draw the shape that you want the text to conform to 
with a graphics program like MacDraw. The trick is to 
draw it in two halves (such as two half-moons that 
together would form a circle). Copy and Paste each 
half of the drawing separately into the Scrapbook. 

Now, boot RSG! 4.0 and create two graphic blocks large 
enough to accommodate your drawings. Make sure 
they butt up against each other. Then, paste your two 
graphics into these graphic frames-the left half into 
the left block, and the right half into the right one. 
The two halves should now resemble the graphic 
shape you want. Invoke the Specifications box 
( Command-M) for each graphic block and click Don't 
Print and Runaround Graphic (instead of Runaround 
Frame). 

Then, create one text block as large as the two graphic 
blocks. Make sure the text block lies directly on top 
and covers these blocks. Put your insertion point in 
the text block and start typing or import a text file. 
The resulting text will take on the shape you created 
with the two graphics. 

Use justified text if you want the text to conform 
exactly to the shape you've created. And set text repel 
distance to zero. 

If you have problems getting the text to flow correctly 
into the shape, try drawing non printing lines above 
and below your graphic. 



READYSETGO! 4.5 
Using ReadySetGo! To Produce Gray-Scale 
Characters 
An undocumented feature of this program is its ability 
to produce gray-scale characters. just make text differ­
ent colors and print without the Color Separation 
option checked to get gray-scale characters when 
you print on a PostScript-compatible printer. 

Getting Rid Of Unwanted Characters In 
Imported '!ext Ydes 
You may need to import a text file into RSG 4.5 that 
displays unwanted or unknown characters on-screen. 
Files transferred from other computers or downloaded 
from bulletin boards often contain such characters, as 
do files from non-Macintosh operating systems. These 
unwanted characters often appear as little boxes. 

You can get rid of these characters by using the 
Replace command. Select the offending box or symbol 
by highlighting it. When you select Replace, the char­
acter is automatically pasted into the Find box in the 
dialog box. Move the cursor to the Change To box and 
press Option-D and then R (this specifies that you 
want the replacement character to be a carriage 
return; or you can replace the nonprinting characters 
with a space or with nothing at all). When you click 
OK, all your unwanted characters will be deleted. 

Increasing And Decreasing '!ext Point Size 
From The Keyboard 
You can increase and decrease the point size of your text 
right from the keyboard. Select the text whose point size 
you want to alter Press Command-> (greater than) to 
increase the text size one point at a time; press 
Command-< to decrease the size by one point. 

Shortcut When jumping Around View Levels 
This shortcut makes it much easier to jump to a spe­
cific spot on the page when you change view levels in 
Ready,Set,Go! 4.Sa. 

If you find yourself at the Size To Fit view and you need 
to zero in on a text or graphic element at the Actual 
Size view, just hold down the Command and Option 
keys while clicking on a text element with the 1-beam 
or on a graphic element with the pointer arrow. You 
will automatically switch to the Actual Size view. 

Underlining '!ext Selected As Italic 
Underlining text that has been selected as italic from 
the Style menu can be tricky in Ready, Set, Go. 

If you are like most users, you double-click on words 
to select them and then make style changes. However, 
as with most word processors, double-clicking on a 
word in Ready,Set,Go selects both the word and the 
space after it. If this word is then underlined, for 
example, the space following the word will also be 
underlined. 

You can eliminate this problem by simply pressing the 
Command key when double-clicking on the word. 
This ensures that the space after the selected word will 
not be selected too. 

SCANNING 
Control Your lighting Environment 
Color is passed to your eye through reflected light. The 
light under which you view the image you're about to 
scan is crucial when you're trying to match the 
image's colors to on-screen colors. Because colors vary 
with different lighting conditions, it's best to use 
incandescent or fluorescent lamps designed to simu­
late a daylight standard such as 050. 

Using Plug-In Modules 
Use a plug-in software module for your image­
enhancement application. Scanning from within your 
favorite image-manipulation application makes get­
ting a good scan convenient. Correcting any scanner­
induced deficiencies also becomes a simple matter of 
using the image-manipulation software's features. 
Image-enhancement applications such as Photoshop 
provide many valuable tools that can help you ana­
lyze what's wrong with a captured scan. 

Start With The Best Possible Image 
Remember GIGO-garbage in, garbage out. A bad 
image won't produce a good scan. Study the image 
before scanning, and find the lightest and darkest 
areas-the white and black points. Concentrate on 
getting those right, and you' II probably get a good 
scan. If you need to crop the image, do it while you're 
scanning, because you can save time and disk space. 
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SERVICE BUREAUS 
Make a List 
This is the most important piece of advice for any ser­
vice bureau customer: Make a list, and check it twice, 
before you make the trek to the output shop. Hand this 
list to the technicians along with your files, so they 
know what you are giving them and what you expect 
to see on paper or film. 

List the names of the files you want printed and the 
page numbers to print from each file. Better still, if 
possible, send files that include only the pages you 
want printed. 

PageMaker Utilities 
Display Pub Info, an Addition that comes with 
Page Maker 4.2, is helpful: It can save a text file that 
lists a document's fonts, styles, and linked elements. 
Much more useful is Else Ware's CheckList 1.0, which 
scans a PageMaker (any version) file and creates a 
report that details its constituent fonts, graphics, and 
style sheets. This $45 shareware utility is available 
from user groups and on-line services such as 
ZiftNeVMac. It also comes with PageMaker 4.2. 

To gather all the necessary files, PageMaker 4.2 
makes this job a little easier: If you select the Files 
for Remote Printing option in the Save As dialog 
box, the program will copy into a single folder all 
the files needed to print the publication, including 
linked graphics and special files such as the track­
kerning resource file. Aldus, 411 First Avenue S., 
Seattle, WA 98104; 800-367-1892 or 
(206) 622-5500. 

CheckList 2.02 is a utility that automates your list 
making and rounds up the supplementary files. This 
must-have utility greatly expands on the capabilities 
of its shareware cousin. The $180 CheckList 2.02 
works with PostScript and EPS files including those 
created by FreeHand, Illustrator, QuarkXPress, or 
Microsoft Word and includes printer settings in its 
reports. It alerts you to problems with fonts and 
linked graphics, lets you add notes to files, and 
enables you to change a PageMaker file's print 
options. CheckList 2.02 can also gather all the files 
needed for output, copy them to a common folder or 
disk(s), and compress them into a self-extracting 
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archive. Else Ware, 3201 Fremont Avenue N., Seattle, 
WA 98103; (206) 547-9623. 

QuarkXpress Utilities 
If you want an easy and economical utility, there's 
Save for Service Bureau. This free XThnsion combines 
the capabilities of PageMaker's Display Pub Info and 
Save As Files for Remote Printing features. SSB copies 
the QuarkXPress document and associated graphics 
into a single folder and produces an ASCII text file 
that lists all the fonts and graphics in the document. 
It's available from user groups and online services or 
for $25 from Quark. 

QuarkPrint, an XTension aimed at service bureaus, is 
considerably more robust. It can print and save a list 
of all the fonts, graphics, style sheets, H&J (hyphen­
ation and justification) specifications, and colors 
used in a document, even if that document isn't cur­
rently open. It also lets you save and apply printer set­
tings, specify custom screen angles, and compensate 
for dot gain. But QuarkPrint's best feature may be its 
ability to print nonsequential pages and to print just a 
specified area of a page. QuarkPrint costs $195, but 
Quark authorized service bureaus and registered 
QuarkXTras owners can get it for $95. Quark, 300 S. 
Jackson, Denver, CO 80209; (800) 356-9363 or 
(303) 934-2211. 

'Iraditional Versus Desktop Color Printing 
The first step in traditional color publishing involves a 
trip to a separation house-a specialized graphic-arts 
shop that converts your color slide or print into the 
three separate colors (cyan, magenta, and yellow) of 
the subtractive primaries plus black, for the fou~:-color 
printing process. 

This used to be a photographic process, but today sep­
arations are typically generated by high-end digital 
scanning equipment from such companies as Hell, 
Crosfield, and Scitex. Rather than being shot through 
a series of filters, the image is scanned and the color 
information is electronically separated into its com­
ponent four colors. The film separations are cut and 
pasted and stripped together in a flat, with line art for 
each printing color. Each flat is then laid over the 
plate material and exposed in a vacuum frame; the 
result is that color's printing plate. 

The Mac can save you a couple of steps and give you 
more flexibility. You can perlorm the scanning, plac-



ing, and separating in-house. Depending on your 
quality requirements, you'll need some expensive 
hardware. And you' II need to work closely with your 
print shop's staff to figure out the best settings for the 
separations. 

Software Usage 
When dealing with Service Bureaus, point out the soft­
ware you used to create the files, its version number, 
and the fonnat(s) in which the files are saved. Every 
service bureau should have applications such as 
Microsoft Word, PageMaker, QuarkXPress, Photoshop, 
Illustrator, and FreeHand. If you are using a different 
program, call ahead to be sure the shop can process the 

' files or save your documents in a standard fonnat such 
as PostScript, EPS, or TIFF, which can be opened by 
other applications. 

Also make a note of version numbers. If you're still 
using QuarkXPress 3.0 but your service bureau has 
version 3.1, you should both be alert for document­
conversion snafus. Conversely, if you are using a 
newer software version than the service bureau is, it 
may not be able to output the files. 

Font Problems 
Make a complete list of the fonts used in your files. 
Fonts are the No. 1 source of output problems at service 
bureaus. Whether you experience a mysterious 
replacement of Garamond by Courier or changed line 
endings in carefully designed columns of type, fonts 
can be a major headache when you send files to a ser­
vice bureau. But the technician won't know there's a 
problem unless you provide a list of the fonts you used, 
along with a printout that shows the intended appear­
ance of the pages. Be sure to list all style variations­
Minion Italic is a different font from Minion Regular. 

Font substitutions usually occur when the ID numbers 
of fonts in your system don't match those at the service 
bureau. This is a problem only if your application 
tracks fonts internally by ID number; in such a case, 
ID number 1578 may be Palatino on your Mac and 
Brush Script at the service bureau. Current versions of 
most applications-PageMaker, QuarkXPress, and 
FreeHand, for example-identify fonts by name, 
which eliminates the problem. 

One longtime holdout was Microsoft Word. With ver­
sion 5.0, however, Word finally calls fonts by name. But 
if you use older versions of Word or other programs, 

you may run into problems. One workaround for Word 
is to save files in its Interchange Fonnat (RTF), which 
does store font infonnation by name. 

Also note whose version of a font you're using, espe­
cially if it's a non-Adobe font. Some fonts are manu­
factured by more than one vendor; both Adobe and 
Bitstream market versions of Futura, for example. The 
two fonts have slight variations in character width and 
letterspacing, which can affect line breaks and page 
composition. 

Finally, if your fonts are in True Type fonnat, be sure to 
indicate this. Otherwise, your service bureau will 
assume that they are PostScript Type 1 fonts. 

Do A 'lest Print Before Sending Out 
Make test prints of your files on your laser printer 
before sending them to the service bureau. If your 
document takes 45 minutes to print on a laser printer, 
it will take much longer on an imagesetter. And if it 
won't print at all, it won't work on the imagesetter 
either. 

Taking an unprintable file to the service bureau won't 
magically fix output problems. More than likely, it will 
exacerbate them. Instead, simplify the document's 
design and/or contents. 

Helvetica Narrow 
Don't use Helvetica Narrow. This font exists only on 
laser printers. 

Don't Use Unreleased Software 
Don't submit jobs created with unreleased software. 
The software isn't shipping because it isn't finished. 
Don't become an unwilling beta tester. 

Don't Use PICT Files 
The PICT file fonnat is not well supported by such 
page-layout programs as PageMaker and QuarkXPress 
or bycoloF-separation utilities. As a result, printing 
problems are common. Save bit-mapped images as 
TIFF files and object-oriented graphics as EPS files. 

Keep It Simple 
A large and/or complex file can cause agonizingly 
long printing times and even "choke" an imagesetter, 
aborting the print job. 

The most common culprits are graphics-related: 
blends and fills, masks, TIFF images, complex paths, 
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and high-resolution line screens. When it comes to 
outputting files, smaller and simpler are always better. 

Keep files small enough to maneuver. Not only are 
huge files difficult to transport but they can also 
exceed the available memory of the imagesetter, pre­
maturely terminating the print job. Divide large jobs 
into several smaller files; for example, each chapter of 
a book can be a separate file. 

Eliminate Unnecessary Elements 
Delete any items that are on the pasteboard or are 
completely hidden by other objects. Instead of cover­
ing an unneeded element with a white box, delete it. 
The imagesetter processes everything in an image, 
even the parts that are hidden. 

Don't Overuse Blends, Fills And Patterns 
Be judicious in your use of these memory-intensive 
elements, and use only the minimum number of steps 
required to make the blend or fill look smooth. 
Otherwise, you face long output times and the risk 
that the imagesetter will run out of memory before it 
can output the page. 

A PostScript blend can have as many as 254 interme­
diate steps between the beginning and end colors. 
Fortunately, you don't always need 256 steps to create 
a smooth blend. You can use a handy (and free) utili­
ty called Blender to calculate the minimum number 
of steps that are necessary for a smooth transition 
between two colors. Blender is available from user 
groups and on-line services such as ZiffNeVMac. 

Be Sparing With Fills 
Be sparing with fills made from patterned tiles such 
as those available in FreeHand and Illustrator. A back­
ground made from a repeating pattern may look 
great, but using one is among the easiest ways to 
choke an imagesetter. 

Using Masks 
Don't use masks as substitutes for careful design. 
Masks (sometimes called clipping paths) are impor­
tant design tools, but don't casually use them to cover 
up design flaws. 

Masks increase output times, for two reasons: They are 
complex, and the imagesetter processes the hidden 
image areas. (FreeHand 3.1 is an exception; it doesn't 
cause the imagesetter to process masked areas.) And 
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don't mask already masked areas of an image unless 
your design absolutely demands it. 

Auto-'fracing And Pen Tools 
Be careful with auto-tracing and pen tools. The 
imagesetter interprets every single point on a path. If 
the path has too many points, it will generate a 
PostScript limitcheck error and not print at all. Auto­
tracing, in particular, can easily create paths with 
excessive numbers of points. 

One way to reduce the number of points on a path is 
to reduce the image's curviness. FreeHand, Illustrator, 
and Photoshop all let you adjust the sensitivity of 
their drawing tools. 

Camera-Ready Print Settings 
If you're producing camera-ready output for a press 
run, use the appropriate print settings. For film out­
put, ask your printer whether you should provide a 
positive or a negative image and which emulsion 
direction to use. If your program offers these features, 
find out what to select for knockouts, paper stock, dot 
gain, and halftone screen angles. 

Saving In PostScript Format 
Save the file in PostScript format. If your document is 
set up exactly right, with all the correct settings, con­
vert it to a PostScript file. If the file is in the format of 
the original application, the technician must open the 
file, adjust the printing options for the imagesetter, 
relink the graphics, and print it from within the pro­
gram. A file in PostScript format, however, can be sent 
directly to the imagesetter. When saving a PostScript 
file to disk, remember to change the printer selection 
to the imagesetter used by your service bureau. 

Also note that if anything goes wrong, you'll have to 
make changes in the original file, as the PostScript file 
is not easily editable. 

Using 'Ihlpping 
Don't use trapping unless you know what you're 
doing. Trapping the overlapping of adjacent colors to 
compensate for misregistration on the printing press 
is a complex skill, and desktop trapping is done differ­
ently (or not at all) from program to program. 

Improperly specified traps can create more havoc than 
untrapped images can, so always talk to the people at 
your printshop beforehand. Most printshops prefer to 



handle trapping themselves and don't charge extra for 
it. If your printer does want you to apply trapping, find 
out how much is needed and how it should be done 
for the particular press. 

Color Or Black And White 
If you are using color, say so. Laser-printer samples 
are usually black-and-white, so tell the service 
bureau if you use spot colors or expect separations of 
process colors. 

If you want color separations, adjust the program's 
settings accordingly. Make certain that you check the 
appropriate boxes for separations, crop marks, and 
registration marks. Color separations can frequently 
create special output problems, so you should talk to 
the service-bureau and printing-press personnel 
ahead of time, and follow their advice. 

Line Screen Settings 
Use the correct settings for line screens. A 65-line 
halftone screen might work well for laserprinter out­
put, but it looks cheesy coming out of a high-resolu­
tion imagesetter. Talk to the people at your service 
bureau and printshop about the appropriate screen 
frequencies and angles, and adjust the settings before 
you output the job. A magazine, for example, typically 
uses a 133-line screen. 

Keep TIFF Images As Small As Possible 
Don't save gray-scale or monochrome images as 
color TIFF files. When you're scanning, keep in mind 
that the resolution for gray-scale and color images 
usually shouldn't be more than twice that of the 
output line screen. For example, if you're printing 
photographs at 85lines-per-inch in a newspaper, 
scanning them at 300 dpi won't improve their looks 
but it will dramatically increase the file sizes and 
output times. 

Proofread Your Copy 
Proofread your copy before you send it to the service 
bureau. Paying another $7 per page because you for­
got an 's' in embarrassment is costly, aggravating to 
everyone involved, and embarrassing. 

'Jaking Note Of Special Settings 
When dealing with a service bureau, make a note of 
the page size(s) you want. This is particularly impor­
tant if you need a page size other than 8.5 x 11 inches. 

If your publication is tabloid-sized, for example, you 
want to be sure the entire llx17-inch page is printed. 

Note any special print settings, such as scaling, paper 
orientation, and crop marks. Don't assume that ser­
vice-bureau technicians can read your mind. If you've 
changed the scaling percentage in the Page Setup dia­
log box to something other than 100 percent, be sure 
to say so. 

Send In The Fonts 
Check with the service bureau to see if it has all the 
fonts you're using. If not, you'll need to supply the 
missing fonts both bit-mapped (screen) and outline 
(printer) versions to ensure that you get accurate 
output. If you've customized your fonts in any way, 
such as tweaking the kerned pairs, the modifica­
tions are stored in the screen fonts, so be sure to take 
them with you. Sending the required fonts also 
eliminates the potential for font-ID conflicts. 

Note that although you can freely distribute screen 
fonts, disseminating printer fonts violates the ven­
dor's license agreement. Therefore, don't take printer 
fonts to the service bureau without first obtaining 
their comm~tment to erase your fonts from their sys­
tem when they've finished your job. Reputable ser­
vice bureaus will do so. 

Include Linked Graphics 
Linking graphics to a page layout, rather than storing 
images in the document, reduces file sizes that go to the 
service bureau, and makes it easier to update images. 
just don't forget to take the original graphics files with 
you to the service bureau. Also double-check that the 
names of linked files haven't changed and that you've 
linked the correct versions. 

Include Color-Separation Flies 
Include all color-separation files. If you've already 
separated some or all of your color images, be sure to 
send the related files. Images separated with the DCS 
technique, for example, have four EPS files (one for 
each of the color plates) in addition to the PICT file 
that you place in the page layout. 

The Proof Is In The Copy 
Provide an accurate and complete paper copy of your 
files. This shows the technician what you expect the 
output to look like. It also reflects the file's complexity 
and potential output problems. 
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Include Kerning, Hyphenation And 
'Ihlcking Data 
Don't forget to include customized hyphenation or 
kerning data in your delivered files. If you've modi­
fied the hyphenation, tracking, or kerning informa­
tion for text within a page-layout document, that 
data may be stored in a special resource or prefer­
ences file. For example, depending on the options 
you choose, QuarkXPress may store some of this 
information in the XPress Preferences file. If so, be 
sure to send that file along to the service bureau. 

SLIDES 
What Printer Driver Is 1b Be Used? 
If you're creating files to be imaged by Autographix or 
Genigraphics centers, it's wise to use their proprietary 
printer drivers (Mac Chooser documents) when you 
create slides. These printer drivers are included in 
some presentation packages. Power Point includes a 
copy of the Genigraphics driver, for example, and 
Persuasion includes the Autographix driver. 

If your software doesn't include one of these drivers 
and you want to use an Autographix or Genigraphics 
center, you can probably get the correct driver from 
the imaging center for a fee that is usually deducted 
from the cost of your first slide order. These drivers 
work with all presentation programs, so you're not 
locked into using one of the name-brand services if it 
would be more convenient to use another. Also note 
that the driver you use has no effect on the quality of 
your slides. 

Select The Printer Driver Before Creating 
Slides 
If your software includes a special driver for writing 
slide files to disk, always go to the Chooser and select 
it before launching the program. Converting from 
another format is always more difficult than working 
in slide format from the outset. 

Avoid Side-to-Side Or Diagonal Blends 
Film recorders are raster devices, which write images 
in horizontal lines. Although your presentation soft­
ware may make it easy for you to create ramps of grad­
uated color that change in intensity from left to right 
or even diagonally, the film recorder can take a long 
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time to image such a slide. A ramp that changes from 
top to bottom, on the other hand, can run efficiently. 
(This doesn't mean you can't have a diagonal blend if 
you need it, just that it carries a price-literally, if 
your service bureau charges extra for slides that take 
more than a minute or two to image.) 

'lest Your Files Before Running An 
Important job 
Create a small file containing the types of slides you 
normally use-word slides, pie charts, diagrams, and 
so on-and send them to any imaging center you're 
thinking of using. This is also a good way to deter­
mine which format you prefer to work with. 

Keep It Simple When In A Rush 
When doing a rush job, use only Times or Helvetica. 
Film recorders are less likely to have problems with 
these basic fonts. 

TRUETYPE 
'IrueType Or Type 1 Fonts? 
Should you install System 7 and use Apple's True Type 
fonts, or should you install Adobe Type Manager and 
start a PostScript Type 1 collection? There does seem 
to be a lot of confusing font options, but fortunately, 
things are looking up. Apple and Adobe Systems are 
developing software that supports the Type 1 rasteriz­
er and Type 1 fonts within the Mac's system software. 
While that is happening, Mac users can get a hold of 
ATM and four faces of Adobe Garamond for the 
special price of $7.50 by calling Adobe at (800) 
521-1976, ext. 4400 (or ask your local Apple dealer). If 
you want the full ATM package, which includes the 
Times, Courier, and Helvetica fonts, you'll have to buy 
the standard ATM package, which costs $99. Most type­
face vendors are now offering both Type 1 and 
TrueType formats. 

Apple will continue to support the TrueType font for­
mat, so there will be little or no difference between 
TrueType and PostScript fonts, at least from a user's 
perspective. You'll install a font-TrueType or 
PostScript Type 1-which will look beautiful 
onscreen and will print at the highest resolution your 
printer supports. 



What's The Difference Between Type 1 And 
Type 3 PostScript Fonts? 
Type 3 fonts used to be Adobe Systems Inc.'s public font 
fonnat; the specification was published and available 
to anyone. Type 1 fonts were proprietary; Adobe kept 
the format secret. These font files were encrypted also. 
The main difference between the two fonnats is that 
the algorithm used to fill in the letter outlines in Type 
3 fonts is inferior to the algorithm in Type 1 fonts. So 
Type 3 fonts tend to look darker than Type 1 fonts, 
especially at small point sizes on low-resolution print­
ers. While seemingly trivial, this type of thing drives 
graphic artists bonkers. 

The situation changed when Apple and Microsoft 
Corp. announced TrueType outline fonts. This 
fonnidable alliance prompted Adobe to make the Type 
1 specification public; so now everyone can create 
Type 1 fonts. Furthennore, Adobe Type Manager uses 
only Type 1 fonts so that's the only format customers 
want these days. 

For those interested in such trivia, Type 4 fonts are those 
built into the ROMs on PostScript printers, and there is 
noType2. 

ZAPF DINGBATS 
Creating A Simple Square With Zapf 
Dingbats 
Zapf Dingbats, a PostScript font, has some startling 
omissions. One is the simple square. There are shaded 
boxes and an all-black one, but no simple square 
exists. The solution is to use the black box in the 
Outline style. 

Breaking Away From Bullets 
To get rid of those boring Option-8 bullets, use Zapf 
Dingbat characters such as a tiny triangle, V (press T), 
or a diamond, V (press U). To make these bullets sub­
tler, raise their placement above the baseline by 
superscripting them. 

Left Out 
In Dingbats, virtually everything points to the right. If 
you would like to point to the left, you are stuck with 
the pedestrian arrows from the Symbol font. Here is a 
solution: 

Convert the dingbat of your choice, say the pointing 
hand, to a graphic and then flip it. Using a graphics 
program such as Canvas or Cricket Draw, you can do 
this quite easily. Since PostScript doesn't care which 
way a font character points, the graphic still prints at 
the maximum resolution of the printer. 

Untypeables 
There are three font characters that cannot be typed 
from the Macintosh keyboard. They correspond to 
ASCII numbers 252,253,254. In the Dingbats font, the 
missing characters are three types of arrows. The font 
has more than enough arrows already, but if you're 
detennined to access the three missing arrows, use 
Word's Character Code command, Command-Option­
Q. You can then type in the ASCII number of the char­
acter you want. When you press Return, the desired 
character will appear. Using this technique, you can 
copy the untypeable arrows into the Scrapbook for 
later use in any application (and in any font). 

Missing In Action 
Eventually you will need a dingbat that is not in the 
Zapf collection. What to do then? You can buy Adobe 
Collector's Edition I, which contains 280 PostScript 
shapes: circles, squares, crosses, arrows, stars, and so 
on. They can be used as is or enhanced in FreeHand or 
Illustrator. You can get this collection from Adobe 
Systems, Box 7900, Mountain View, CA 94039; 
800-344-8335. 

Another possibility is a shareware PostScript font 
called Bill's Dingbats. It has 138 dingbats, including 
arrows that point in eight directions. This font is 
available from U-Design, 201 Ann St., Hartford, CT 
06103; (203) 278-3648. 

If that doesn't help, start looking through the numer­
ous available picture fonts, such as Cairo and Mobile. 
Many are freeware of shareware and are available 
through most on-line services. 

Drawing A Dingbat Yourself 
If you really cannot find the appropriate dingbat, draw 
the dingbat yourself. A utility called Art Importer ( a.k.a. 
KeyMaster) lets you create an installable PostScript font 
containing EPSF and PICT graphics. The resulting 
graphic characters can be typed like letters in any other 
font. This $99.95 program is available from Altsys, 7'lJJ 
Avenue F, Suite 109, Plano, T.X 75074; (214) 4~888. 
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Creating A Plain, Empty Box 
You can get a plain empty box-to indicate the 
Macintosh's no-character symbol or for such uses as a 
check box-with a word processor or desktop pub­
lishing program such as Word, QuarkXPress, or 
PageMaker. The Zapf Dingbat font has shadowed and 
filled boxes, but not empty ones. 

To create an empty box, type a lowercase n. Select the 
character and then choose Zapf Dingbats from the 
Font menu and Outline from the Format menu. Voila! 
An empty box. If you want a box with a heavier border, 
make the character bold, as well as outlined. 

You can make the box any point size, but if you want 
it to appear the same size as the text you're working 
with, make the box a point size or two smaller. For 
example, if your text is 11 points, the box should be 9 
points; if you have 9-point text, you should make the 
box 8 points. Otherwise, the box appears to be slightly 
larger than the surrounding text. 

ENTERTAINMENT 

DARK CASTLE 
'lhlcking How Many Tunes You've Won In A 
Session 
If you're expert enough, you can track how many 
times you've toppled the throne. While typing your 
name into the Hall of Fame, type Option with any 
other key. This creates a Dark Castle symbol. Use the 
number of castle symbols to represent how many 
times you've finished the mission. 

Keeping your shield activated 
The shield usually lasts only about 3 seconds. You can 
keep wearing it indefinitely, though. When you acti­
vate your shield, hold down the key for about 2 112 
seconds. Then, at the last moment, release the key 
and press it again quickly. Experiment with this to 
pick up the rhythm. 

How To Walk On Air 
It's possible to make your on-screen hero literally walk 
on air. Press the duck key with either the up- or down­
key as you go up or down a staircase or ladder. When 
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you reach the top or bottom, your character will seem 
to be walking on air. Once there, experiment with dif­
ferent commands to get some entertaining results. 

Express Route To The Trouble Room 
The easiest way to get to the Trouble Room is to push 
Door# 3. You'll go to the Black Knight's first chamber. 
If you wait, the platform will slip out from underneath 
you, dropping your character down to Trouble #3, sav­
ing you the trip through the first two rooms, and pos­
sibly saving a few game lives as well. 

MAC GOLF 
Putt Like A Pro 
When you're on the putting green, make sure the wind 
is at zero. Then face away from the hold, and place the 
swing indicator at zero. Click once on the Up-arrow 
and putt, recording how far the putt goes. Now, do the 
same thing again, except this time, click twice in the 
swing indicator's Up-arrow. Keep doing this, adding 
one click each time, until you reach a full-strength 
putt. This helps you figure out how many clicks you 
need to do to get the ball to move different distances. 

SHADOWGATE 
Use The Note Pad 1b Keep 'lhlck Of Clues 
The Note Pad DA is useful for keeping notes handy. just 
jot them on the Note Pad and you can refer to them 
whenever you need to. 

Don't Ignite Torches Without Examining 
Them 
There's a special torch you need to get through a cer­
tain section of the game. Examine all torches you find 
before lighting them, and save the one that looks dif­
ferent for a special situation. 

Surviving The Dragon Room 
You need several items located in the dragon's lair. To 
retrieve them with your hide intact, grab the shield 
first. You then have three more times to take more 
things (like weapons) before the shield melts under 
the dragon fire. 



Let Randomization Work In Your Favor 
The Sphinx asks you for a certain item, couched in 
the fonn of a riddle, when you enter the room it 
inhabits. However, the exact item it asks for is ran­
domly generated. To increase your chances of having 
the item the Sphinx wants in your possession (or at 
least, knowing where to find it), save the game just 
before entering the room. If the Sphinx asks for an 
item you haven't located, just Quit and start again for 
a chance at better luck. 

SHANGHAI 
Remove 1Ues When You Can See 
All Four Of Them 
While you can't really cheat at Shanghai, you can vastly 
improve your chances for winning by trying not to remove 
any sets of tiles unless all four matches are showing. This 
guarantees that you aren't inadvertently trapping a tile 
under its only match. 

SIMCITY 
Bringing A Village To Metropolis Status 
Here's a slick way to bring a SimCity village to metro­
polis status within five years - a maneuver that 
should delight even the most jaded politico. 

Set the tax rate down to 0 percent, starting with the 
January Budget Report that automatically flashes on 
the screen each year. Sims will flock to your apparent­
ly tax-free village. 

Leave the tax rate at this setting until December rolls 
around. When it does, select Budget from the Windows 
menu (or press Command-B) and set the tax rate to 
the highest allowable level, which is 20 percent. 

When the january Budget Report appears, you'll see a 
sudden influx of cash for your coffers. Now set the tax 
rate to 0 and wait until December -when you again 
set it back to 20 percent. 

If you keep your eyes on the calendar, you will gener­
ate enough tax revenues this way so that you'll never 
have to embezzle funds again! And the Sims, who 
never seem to catch on to the devious ways of the 

mayor, just keep on moving in. 

If you think taxes aren't enough, try SimCity's giant 
reptile! 

Collecting All The 'Ihxes You're Owed 
SimCity has an annoying habit of resetting the tax 
rate to zero when you load a saved city. If you save and 
quit from the loaded city mid-year, you'll find that 
when january rolls around, several months have gone 
by with no taxes being collected. This can devastate a 
city already on the brink of financial disaster! 

To avoid any loss of funds when you restart a game, 
immediately call up the Budget window and enter the 
tax rate. 

SPECTRE 
Fourth View Perspective 
In Spectre l.O there's a fourth, little-known view per­
spective. To access it, type GOD at any point after the 
game has started, and you'll see the game from a view 
far above the game field. To get back to the nonnal 
perspectives, simply press the Tab key. This trick is par­
ticularly helpful in the network-play mode. 

STUTEGIC CONQUEST 
Attack On Each Move 
Don't limit fighters to two attacks per round. Use the 
Move Later command after each attack to attack on 
each move. This works for all water pieces as well. 

Regaining Full Naval Strength 
Carriers and battleships can safely regain their full 
strength if you put them into port for repairs and then 
use Move Later until they're fixed. 

Keeping Fighters Out Of Combat 
You can protect fighters from attack by leaving them 
in an empty enemy city. 

When To Build Bombers 
Start building bombers on day 30 to get a blast radius 
of 1. For a blast radius of 2, start on day 65. 
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Stealth Bombers On The Cheap 
You can hide bombers by placing them on the same 
square as any other piece. 

GRAPHICS & DESIGN 

ADOBE ILLUSTUTOR 
Undoing A Move Even After Disabling 
"Undo Move" 
There's a helpful way to Undo an accidental move, 
even if you've already clicked the mouse button and 
so lost the opportunity to Undo Move from the Edit 
menu. First, make sure that the same anchor points 
are still selected - if they're not, select the object. 

Now, hold down the Option key as you click the 
Pointer tool. The Move dialog box will appear, show­
ing a positive value beside "Move distance." This value 
represents the distance in points of the LAST MOVE 
YOU MADE. All you have to do is make that value neg­
ative by inserting a minus sign in front of the positive 
number, and then click OK. Your anchor points will 
slink right back to where they were before you made 
the "wrong" move. 

Creating A Smooth Graduated Fill With 
The Blend Tool 
There are some tricks to getting nice, smooth graduat­
ed fills in Illustrator using the blend tool. If you are 
not careful, you can produce what looks like a band­
ing effect in going from step to step in the graduation. 
You can specify more blending steps so the difference 
between one step and the other becomes more diffi­
cult to notice, but there are a couple of drawbacks to 
this ploy. It makes for a huge file that takes insanely 
long to print and it may also cause your printer to 
freeze for lack of memory. Also, PostScript imposes a 
limit of 256 steps on a fill, so at some point in a cer­
tain job, it may become clear that simply increasing 
the number of steps may not be the best solution. 

A better solution is to tweak the screen frequency 
(lines per inch) that the printer uses in printing the 
image. Lines per inch has a direct effect on the 
appearance of graduated fills. The higher the screen 
frequency, the fewer shades of gray the printer can 
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generate. Therefore, a high lpi can lead to savage 
banding no matter how many steps you've used in the 
fill! Lowering the screen frequency generally yields 
smoother-looking blends, but it can give the image a 
coarse appearance. 

Layering Graphics Higher­
But Not At The Top 
You probably already know how to take an object low 
in the painting order and bring it to the front of every­
thing else. However, there will probably be times when 
you wish you could bring the graphic forwanl, but not 
all the way to the top, as if removing a playing canl 
from a deck and inserting it several cards away from 
the top. If you cut the object and paste it in front, then 
you'll have to select all the other objects that are sup­
posed to be in front of it, and then move them in front 
to achieve the proper layering. Sounds complicated, 
and it is. However, there is a simpler way: 

Select the object that you want to bring forwanl, 
together with the forwanl object directly behind which 
you want to move it. Group them while they're both 
selected by pressing Command-G. That's it! You don't 
have to cut and paste, and even if you Ungroup them, 
the layering change is preserved. The front-most 
objects can be left alone, with no editing at all. 

Moving Or Copying Objects In The 
Preview Mode 
Although the Adobe Illustrator manual states that the 
current art file can't be edited in the Preview mode, 
there are some ways around that. You can move and 
copy objects in the Preview mode by using the Move 
dialog box. 

Select the object you want to move or copy, and enter 
the Preview mode. While there, hold down Option 
while clicking the Pointer tool in the toolbox to call 
up the Move dialog box. Now; just enter the distance 
and/or angle data you want and click OK (or Copy). 
The object will move or duplicate immediately and 
you'll be able to see exactly how this adjustment will 
affect your printed copy. You'll find this very useful in 
making changes to aspects of the illustration that you 
can only see during Preview. 



ADOBE ILLUSTRATOR 3.0 
Creating Embossed Text 
Creating the look of embossed text is a little hard­
er than creating effects such as outlines, shadows, 
and drop shadows, but when you do it correctly, it 
can add a touch of class to your layouts. Here's a 
way to create embossed text in Adobe Illustrator; 
the basic technique should work in a variety of 
programs: 

1. Create a box containing a background shade. 

2. Type the text inside the box. It's best to use a heavy 
type style, such as Helvetica Black or Stone Sans Bold. 

3. Copy the text to the Clipboard. Paint the text 
lighter than the background (say, 25-percent black). 
Using the arrow keys, move the block of text left and 
then up the same amount of space (in the example, I 
pressed the left-arrow three times and the up-arrow 
three times). 

4. Use the Paste to Front command (Command-F) to 
place the Clipboard text in the box. Paint this text a 
shade that's darker than the background shade (say, 75-
percent black). Using the arrow keys, move this text 
block down and to the right the same number of spaces 
as before. 

5. Use the Paste to Front command to place another 
copy of the Clipboard text in the box, and paint in 
the same color as the background. Preview the 
image (Command-Y), and you' II see the embossed 
effect. You may need to go back to the image and 
tweak the number of spaces you've moved each 
copy of the text to get the best effect. 

Using the same technique, you can make simple EPS 
clip art look embossed. 

Accessing Some Elusive Symbol Characters 
Certain characters in the Adobe Symbol font, such as 
[pi] and [derivative], are accessible within other 
Adobe fonts such as Helvetica but are not displayed on 
the keys (you can see what keys to use via the Key 
Caps DA). 

Although you can see these characters on-screen in 
Illustrator 3.0, some of them don't print, even if you 
import text containing these symbols. If you need 

these characters and can't- or don't want to- switch 
to the Adobe Symbol font (within which they will 
print), here's a simple work-around. 

First make sure you have Adobe Type Manager 2.0 
installed. Then with the new Create Outlines com­
mand on Illustrator 3.0's Type menu, select the text 
and choose Create Outlines. By selecting Preview 
Selection from the View menu, you can see how the 
text will look when it is printed. The only drawback is 
that the characters may look slightly bolder when 
they're printed. 

BRODERBUND 
TYPESTYLE I 
Converting Fonts To SmoothFonts 
To use regular fonts that you've converted into 
TypeStyler SmoothFonts, you must have the original 
corresponding screens fonts installed in your system 
for TypeS tyler to recognize them. But if you've creat­
ed several SmoothFonts, it can be inconvenient to 
remember to install all the appropriate screen fonts. 
It's easier to install the necessary screen fonts right 
into the SmoothFont suitcase. 

Here's how to do it: 

After you've created your SmoothFont in the usual 
way, open the FonVDA Mover. Close both windows. 
While holding down the Option key, click on Open; 
then select your SmoothFont file. In the second win­
dow, open the original screen font's suitcase. Now copy 
the original's 18-point screen font(s) into the 
SmoothFont file, and then quit Font/DA Mover. As long 
as the SmoothFont is available, TypeStyler will make 
use of this embedded screen font without your having to 
install it in your system. 

CANVAS 
Easy Method For Creating Filled 'Iext 
The way to produce filled or patterned text in Canvas 
is not readily obvious, because the fill tool fills the 
background instead of the actual letters. Here's an 
easy method for creating filled text. 
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1 Type the text. Thick letters work best. 

2. Draw a rectangle (or other shape) so that it covers 
the text, and fill the rectangle with a shade or pattern. 

3. Select the ink-manager tool (indicated by the word 
Copy near the bottom of the toolbox) and drag over to 
Bic (black is clear). This eliminates the black in the 
text and fills it with the pattern or shade . 

LaserWriters can be finicky about printing documents 
that use the ink manager, but you should have no 
problems using non-PostScript printers such as the 
DeskWriter. 

Creating An Accurate Display Of 
Proportional Rectangle Resizing 
To accurately see the proportional resizing of rectan­
gular objects, draw a diagonal line from one corner of 
the object to the other, and extend it, keeping it lined 
up against the two handles. 

NO\V, grab a corner handle at the end of the diagonal 
line and resize the object while keeping the handle on 
that line. 

Finally, delete the line. As long as the handle is on the 
diagonal line, the object is in proportion. 

Accessing An Undocumented 
Search-And-Replace Feature 
You can perform an easy search-and-replace: Hold 
down Option while choosing Select All from the Edit 
menu. Then, make a selection from the Pen Pattern, 
Fill Pattern, Foreground Color, Background Color, Pen 
Shape, Line, or Transfer Modes pop-up menu. Canvas 
will select all the objects with that attribute. You can 
now choose any attribute (such as fill patterns) that 
you want, to globally replace the selected attribute. 

Using Separator To Keep Graphics Straight 
Macintosh users know about the problems with quali­
ty that can occur when MacDraw or similar graphics 
are pasted into other applications. Many things such 
as alignment and line weights go haywire when you 
print. If you own Canvas Separator, you may have a 
solution right under your nose. 

1. Open the original graphic in Canvas. 

2. Save the graphic in Canvas format. 

3. Use Canvas Separator's Convert command to con-
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vert the file into a suitable format, such as EPS, PICT 
or EPS Illustrator. 

4. Finally, import the file into your page-layout or 
word-processing package. More often than not, the 
problems will vanish. 

More Realistic 'Ihlcing 
You can make your traces more realistic and closer to 
the original image by selecting the bitmapped object 
and choosing the Object command from the Object 
menu. Change the resolution in the dialog box from 
72 to 300 dpi. Click OK and close the box. Now auto­
trace the object. This increased resolution creates 
more handles as well as drastically improving your 
traced image's appearance. 

Switching Windows Without Using The 
Windows Menu 
If you're working with Canvas on a large-screen moni­
tor and have several windo\\I"S open, using the 
Windows menu to switch between all your windows is 
a bother. An alternative is to Option-click anywhere in 
the title bar of a window (except the zoom or close 
boxes) to get a list of all open windows. 

CANVAS 2.0 
Displaying Small-Scale Fractions On­
Screen 
When using Canvas 2.0 for architectural or engineer­
ing drawings, choosing Show Dimensions in Fractions 
under Preferences will not give you fractions for small 
scales such as 1" = 1' or 112" = r: You can't get frac­
tions in your dimensions by typing in 1" = 1' in the 
Ruler Manager. 

If you want to display fractions on-screen for such 
scales, the right-hand side of the scale in the Ruler 
Manager box must always remain at 1': Then divide 
the left-hand side of the scale for whatever fraction of 
the inch you want. For example, if you need 1" = 1 ', 
use 1112" = 1'; which you enter as .0833= 1 ·:Fractions 
now appear in your auto-dimension lines. 



CANVAS 2.1 
Organizing And Storing Object-Oriented 
Clip Art 
You may have learned the hard way that object-type 
artwork that is stored in a HyperCard clip-art file loses 
its high resolution and becomes 72 dpi. So how can 
you store large amounts of object-oriented clip art in 
an organized manner? Canvas 2.1 provides a simple 
but elegant solution: 

1. Create a new document, and give it a descriptive 
name, such as Business Images. Then begin pasting 
in the graphic objects, arranging them on the page. 

2. Use the scroll bars or magnification tool to center 
one of the objects on your screen. 

3. Choose the New View command from the Layout 
menu, and give the view of the centered graphic a 
descriptive name such as Bottle Message. Click on OK. 
Repeat this step for every graphic on the page. 

Now whenever you drag your cursor down to the Views 
command on the Layout menu, the hierarchical pop­
up menu includes the names you have given to these 
views, allowing you to jump quickly to any graphic on 
the page, modify it if desired, and copy it to the 
Clipboard. 

CANVAS 3.0 
Using Publish And Subscribe To Replicate 
Images 
With System 7, you don't have to publish an entire doc­
ument; you can publish just a group of objects. This is 
useful in an unusual way: You can replicate a group of 
objects by publishing it and then subscribing to it in 
the same document. This is helpful, for instance, 
when you're laying out a bunch of business cards or 
tickets on a single page. 

In Canvas 3.0 simply draw one card, select all the 
items in the card, and choose Create Publisher from 
the Edit menu. Then choose Subscribe from the Edit 
menu. Subscribe the same number of times as you 
want duplicates of the card on the page. 

To change the card, modify the original, double-click 

on the Publisher box around it (if your preferences 
indicate that the box should be visible), and click on 
the Send Edition Now button. 

This is easier than editing one copy, deleting the oth­
ers, replacing them with new copies, and then realign­
ing them on the page, as you must do without pub­
lish-and-subscribe. 

CLIP ART 
Recycled Clip Art 
One of the best resources for locating clip art, Canned 
Art- Clip Art for the Macintosh, by Eifert Fenton and 
Christine Morrissett (Peachpit Press, 1085 Keith 
Avenue, Berkeley, CA 94708; [800] 283-9444). It's a 
meticulously indexed and organized book with repre­
sentations of artwork from dozens of clip-art manu­
facturers. It's huge and worth every penny of its $29.95 
cover price. 

You can create your own recycling clip art after seeing 
the art in Canned Art; alternatively, there are BBSs and 
public-domain libraries full of pictographs and the 
like, drawn by thoughtful, caring Mac users and avail­
able for pennies. Also, check for recycling logos avail­
able on-line from Zmac or from your local user 
group. 

If you can't find the symbol you need, though, just 
hop on down to your local art-supply store. It'll have 
books of public-domain symbols (artwork you can 
reproduce with impunity) for just a few dollars apiece. 
Take the book down to your local DTP service bureau, 
and the staff' II scan the pictograph into a TIFF file for 
about ten bucks or so. 

CRICKET DUW 
Creating A Pardy-Dotted, Pardy-Solid 
Element 
If you want to draw an oval or circle that's partly solid 
and partly dotted lines, you can do a quick cheat to 
get it done. First, draw a number of evenly-spaced 
lines over the portion you want to make dotted 
(Cricket Draw's Grate tool is excellent at this) and 
then just make those lines white. 
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Use Align Objects 1b Control Object 
Placement Pennanendy 
Cricket Draw contains a little-known trick that allows 
users to gain total control of object placement by using 
the Align Objects command. The ordering of objects 
drawn doesn't depend on their creation order or posi­
tioning, but rather in their layering. That means, 
selecting an object and choosing Bring To Front from 
the Arrange menu will later make that object the point 
of reference for future Align commands. 

For example, when you have an object youtllike to 
align with other objects, select the item and choose 
Bring To Front from the Arrange menu. Then, Shift­
Click on the other objects you want aligned (press 
Shift while clicking on each one), and choose Align 
Objects from the Arrange menu. Regardless of the 
alignment done, the object on the top layer will 
remain in i~ original position. 

Printing Is Faster When You Ungroup 
Objects 
When printing documents that contain a large num­
ber of grouped objects, you'll save printing time on 
LaserWriters by ungrouping your objects just before 
you print your document. 

.... 

FREEHAND 
Adding Variety 1b Lines With Zapf Dingbats 
Unless you can program in PostScript, you'll probably 
find the fill and line options dull after a while. You 
can expand your options by combining two FreeHand 
techniques with some ready-made PostScript images­
Zapf Dingbats. 

To convert any drawn line to a line made up of ding­
bats, use the "text on a path" feature. First, draw the 
line. Then choose the Thxt tool and create a single 
line of text in a small-point font (6 points works very 
well) that's longer than your drawn line. Select both 
your text block and the line you wish to convert, and 
use the join Elements command from the Element 
menu. That's all there is to it. 
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Cropping Imported Graphics 
Th crop imported graphics in FreeHand, paste them 
inside a path. Pan by selecting the path as points by 
dragging a selection rectangle over the path and then 
moving the path. If you select the whole path, the 
image will move as you move the path. But if you 
select points in the path, you can move the path with­
out moving the image. 

Using Zapf Dingbats As A Ftll Pattern 
You can also use dingbats as an unusual fill pattern 
in your objects by using the "clipping path" feature. 
First, create the area you want to fill. Then select the 
Text tool and create a block of text large enough to 
cover your fill area. Now, select the text block and 
use the Cut command to send it to the Clipboard. 
Finally, select the area to be "filled" and choose 
Paste Inside from the Edit menu. 

The same techniques work with other fonts, but if they 
aren't PostScript fonts you'll find them printed out as 
bit-mapped characters. 

Drag A Small Object Without Grabbing Its 
Resize Handle 
If you can't drag a small object without grabbing one 
of its resize handles, try drawing a large object next to 
it, selecting both, and then putting the pointer on the 
big object to move them as a unit. When the small 
object is in the correct spot, deselect both objects and 
delete the larger one. 

Express Route To The Edit Dialog 
You can get to the Edit dialog fast to alter a line, fill or 
color style. just press Option and select the style from 
its menu. 

Archiving Unes, Ftlls, and Color Styles 
To save a reusable library of lines, fills, and/or color 
styles for use in other FreeHand illustrations, define 
the styles in a blank illustration file. You can also 
select a target printer and print settings, and add 
objects (like logos) that you want in every new docu­
ment. Then choose Save As, name the file, click on the 
Thmplate option, and save. 

The next time you need these styles, use the template 
to create your illustration. You can even make these 
styles your FreeHand default setting by deleting the 
Aldus FreeHand Defaults file that came with the pro-



gram and assigning that name to your template file. 

Getting More Control Over FreeHand 
'&acing 
Double-click on the trace tool to display the Curve 
and Corner dialog box, which lets you get more con­
trol over the number and kind of points FreeHand 
applies while it traces. 

Getting The Most Out Of '&acing Gray-Scale 
TIFF Images 
When tracing a gray-scale TIFF image, you'll get the 
best results if you make it into a black-and-white 
image first. Select the image, choose Element Info, 
and click on the Black and White option. Adjust the 
contrast and lightness to obtain the highest contrast, 
and then trace the image. 

Pelster Printing Of PostScript Fills 
When printing PostScript fills to a LaserWriter, make 
the color parameter gray (either 0 or 1) instead of 
color to speed up printing. 

Pelster Printing Of TIFF Files 
Make TIFF files print faster by using black-and-white 
images whenever possible. If you've applied color to a 
TIFF image, the color processing slows down printing 
tremendously. 

Having '&ouble Printing Custom PostScript 
Line And Fill Effects? 
You can avoid problems when printing custom 
PostScript Line and Fill effects by making sure your 
UserPrep file is in the correct folder and is properly 
named. If UserPrep isn't in the FreeHand folder or 
the System Folder, you'll get an "undefined" 
PostScript error. 

Compatibility Problems With Older Systems 
And LaserWriter Drivers 
If your printer won't print a FreeHand file unless there 
is text on the page, it's because you have old or incom­
patible System and LaserWriter-driver files. When you 
update your System file, make sure to update your 
printer files as well. 

Centering 'text Along The Outside Of A 
Circle 
You can center text along the outside top and bottom 
of a circle by first making the two text blocks and set-

ting the text to be center-aligned. 

Draw a circle and ungroup it. With the knife tool, split 
the circle at the side points and delete the bottom half. 
Clone the top half and use the reflecting tool to make 
the clone the new bottom half of the circle. Then join 
each text block with its respective half of the circle. 

To make the text run along the outside of the arcs, use 
the Element Info dialog box to align the text to the 
path, with the baseline (top halO and the ascent (bot­
tom halO options. 

Creating A Three-Dimensional Box 
'lb create a 3-D box, first skew a rectangle upward to cre­
ate one side. Then, clone it and use the reflecting tool to 
click on a vertical edge and move the clone to the oppo­
site side of the original. Nmv, clone the second side of the 
box and ungroup the clone. Shift-select the lower left 
and lower right points of the cloned element. Release the 
Shift key, then click on one of these points and drag to 
create the top of the box. Finally, give each side an appro­
priately shaded fill or colo[ 

Ftxing Improperly Printed Strokes 
When you specify a point size for the stroke of text in 
the Fill & Stroke dialog box, the stroke will be too 
large to print properly if the text isn't joined to a path. 
For painless printing, place a period before the point 
setting in the dialog box. For example, a stroke set at 
.20 points prints out as 20 points high. 

Getting The Smoothest Graduated And 
Radial Fills 
You get the smoothest graduated and radial fills by 
making sure that the print quality is set to Better. 
Lower screen rulings generally create smoother fills 
because they produce more shades of gra}~ However, 
screen rulings are closely related to printer resolution: 
a high-resolution image-setter gives you smoother 
grays, and sharper images, at higher screen rulings. 
(For a table of recommended screen rulings based on 
printer resolution, see pages 9-12 of the manual.) 

For best results, print to the highest-resolution printer 
available. Also, smaller filled areas stand a better 
chance of being smooth than do larger filled areas. 

Starting With Your Own Defaults 
When you select New from the File menu in FreeHand, 
your new page appears with a sometimes-annoying 
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set of its own defaults. They include Snap to Grid, 
many different shades of gray, line weights, and other 
items that most people usually end up changing. 

If you want to avoid this problem, start by creating a 
template that has whatever line weights, fills, and col­
ors you use regularly. Turn on features you consistent­
ly use, and turn off those you do not. 

Once you have set everything to your liking, save the 
document as a template, name it Aldus FreeHand 
Defaults in your FreeHand Folder. (You might want to 
rename the old defaults first, in case you want to use 
then again.) 

You cannot change some things, such as the default 
font and font size, but you can add guides, select your 
printer type, and set the measuring system to the 
standard you prefer, just as with a regular template. 

Cheap, Editable Outline Fonts 
Here's a simple and economical tip for creating 
editable font outlines with Aldus FreeHand 2.0. 

Choose the text tool, and click anywhere. Set the text 
size to the largest size that you have bit maps for (if 
you have Adobe Type Manager, then the sky's the 
limit), and type the character(s) that you want. 

Once the text is on-screen, simply choose the tracing 
tool and auto-trace the text. FreeHand's auto-trace tool 
treats the text as an ordinary bit-mapped object. As 
with any tracing, you have to play with the auto-trace 
controls, but with large screen fonts, you can get very 
good outlines that require only minimal touch-up. 

A Quick Way To Create Repeating Elements 
The most common technique for repeating elements 
in a closed path is to duplicate them as many times as 
required to fill the space, cut these elements to the 
Clipboard, and finally use the Paste Inside function to 
create the effect. However, the Tiled Fill option is faster 
and makes it easier to adjust the spacing of the 
masked elements. 

In the dialog box you get when you select Tiled from 
the Fill menu, you can modify only scaling, angle and 
offset properties. The problem is that you cannot con­
trol spacing between the repeated elements of a tile. 
Here is a way to bypass this limitation: 

1. Create your tile (text, path and so on). Make sure 
your elements are ungrouped. 
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2. Draw a square or rectangle around your tile, and 
align all elements to the square horizontally and ver­
tically centered (you may have to group your ele­
ments to do this easily). 

3. Select your square, and set the line to None on the 
Line menu. 

4. Ungroup everything, and cut to the Clipboard. 

5. Select the path to fill, choose Tiled on the File 
menu, and click on the Paste In button in the Tiled 
dialog box. As with the Edit menu's Paste inside func­
tion, you will not be able to see your results unless you 
are in Preview mode. 

If the tiled graphic you have created does not tile cor­
rectly to form a pleasing pattern, you can easily 
change the spacing now. To edit the distance between 
objects, select the path, choose the Tiled command, 
and click on Copy Out. Paste the ungrouped elements 
back onto the document. You can now modify the 
height or width of your square to change the way the 
element or elements will be tiled into a pattern. 

Once you are satisfied, paste the elements back into 
your fill. 

FREEHAND 3.0 
Using Document Setup As A Conversion 
Calculator 
You can use FreeHand's Document Setup dialog box as 
a quick measurement-conversion calculator. This is 
handy when your measurement preference is set to 
picas or points, for example, but you want to know 
what a document's measurements are in inches. 

1. Choose the Document Setup command from the 
File menu. In the resulting dialog box, enter the 
poinVpica measurements in the custom-page-size 
entry fields. 

2. Change the unit of measure to inches (FreeHand 
makes the conversion for you automatically), and 
note the converted measurements. 

3. Return the preferences to points or picas, and select 
Cancel to return to the main drawing window. Use the 
converted measurements as needed. 

If you want to enter a measurement in inches, you 



can override the poinVpica preference by typing i 
immediately after the number (8.5i for 8.5 inches, 
for example). 

Speed Printing Tune With Convert 1b Paths 
Here's one way to print a FreeHand 3.0 document that 
has several fonts, a situation that can frequently 
choke a PostScript printer. All you have to do is use 
the Convert to Paths command from the Type menu 
to change the letters into outline graphics that you 
can fill just like any other graphic element. 

Now the printer doesn't have to download any unnec­
essary font information-instead, it takes just the 
individual letter descriptions that you have converted 
to a graphic element. 

This tip also helps if you're shipping documents to a 
service bureau that may not have the fonts you used 
in your document- with the text converted to graph­
ic outlines, it no longer matters whether the bureau 
has the fonts or not. 

'lhlcing FreeHand Objects 
Most people use FreeHand 3.0's auto-trace tool to trace 
line-art bit maps, but it can also be used to trace 
FreeHand objects. Using this technique lets you create 
complicated objects by overlaying several simple 
objects and auto-tracing them. (FreeHand can't trace 
items at their highest resolution.) The trace will 
include the outline of the entire group of objects rather 
than each component plus the insides of the various 
shapes as they overlap. It's easy to delete any shapes 
you don't want. 

ILLUSTRATOR 3.0 
Quick And Simple Fancy Borders 
Here's how to use Illustrator to make fancy borders 
simply and quickly: 

1. Draw a rounded rectangle around the design or art­
work you want to border. You can also use a custom 
path, but borders should generally be fairly regular and 
the rounded-rectangle tool is easy to use. Also, sharp 
corners do not work nearly as well as rounded ones. 

2. With the path-type tool, click on the top center of 
the rectangle. You can now type text, and it will wrap 
to the path of the rectangle. For a fancy border, use 

a character from Zapf Dingbats or any other iconic 
PostScript font. Repeat the character until it fills the 
path around your border. 

3. 1b make the characters fit the border exactly, press 
Command-A to select all the text. 

4. Press Command-T to bring up the Type Style dialog 
box. Arrange the screen so that you can see the bottom 
of your border and the dialog box. Adjust the size and 
tracking options, and click on Apply to see how these 
changes affect the border's fit. Use negative units to 
tighten the text. 

5. The border is lined up properly when the white gap 
between the highlighted letters disappears. Click on OK. 

When printing these kinds of borders on a printer 
other than your own that may or may not have the 
fonts you used (at a service bureau, for example), 
use the selection tool to select the entire border and 
choose Create Outlines from the Type menu (this 
command requires that you have ATM 2.0 or later 
installed). This eliminates the need for the printer to 
have the font you used. You can also use this trick to 
create several borders as EPS files for later use in 
PageMaker or other programs. 

MAC DRAFT 
The Same Name Can Spell '&ouble 
Thke care when naming your files. If you save with the 
same name as a MacPaint document in the same 
folder, the new MacDraft document will not be acces­
sible from the application. The only way to open it 
will be to use a file editing tool like Mac1bols or FEdit. 
Open the file and change the creator to MDFT and 
type to DRWG. This will allow MacDraft to access the 
file again. 

Producing Laser-Printable Diagonal 
DottedUnes 
1b produce high-quality diagonal dotted lines, start by 
editing a pattern so that most of the pattern is black, 
with a one- or two-pixel column or row being white. 
Now confirm that you're drawing with a non-dotted 
line, and choose that special pattern you've drawn as 
the ink for the line by holding down Option while 
selecting the pattern. 
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Try drawing a few diagonal or dotted lines. Later, you 
can choose the special pattern for better control. 

Create Original Patterns Easily 
Want interesting, original patterns in MacPaint? Use 
MacDraft to create them. 

First, create a patterned object in MacPaint, then copy 
an area of the pattern and paste it into MacDraft. With 
the object selected, experiment with choosing different 
patterns from the Fill menu. The MacDraft pattern will 
overlap the MacPaint pattern, with almost limitless 
new patterns resulting. 

MACDUWII 
Creating A Pixel Ruler 
One of the oversights in Claris' MacDraw II is the lack 
of a standard ruler for measuring in pixels. You can 
create your own just by setting the scale ratio to 1:72 
inches, setting Divisions/inch to 1, and unchecking 
the Show Unit Name check box. 

'liimming File Space 
The grouping information stored in MacDraw II files 
for complex grouped graphics can cause the files to 
increase in size - sometimes dramatically. If you need 
to trim some fat off a file, ungroup the grouped 
objects and then save the file. 

This works for all the major object -oriented graphics 
programs, including Cricket Draw, Illustrator 88, and 
FreeHand. 

MACDUWPRO 
Installing MacDraw Pro 
If you have MacWrite II, Claris CAD, FileMaker Pro, or 
an earlier version of MacDraw already installed, check 
to see if you have the Claris XTND System document 
in your System Folder. If so, throw it out before run­
ning the MacDraw Pro installer, which will automati­
cally install the XTND document in the Claris Folder 
in the System Folder. If you have more than one XTND 
document installed, you'll have difficulty opening 
MacDraw Pro. (Claris XTND is the technology that lets 
you import and export graphics and text files.) 
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Speeding Up Functions 
If performance is sluggish, go to the Apple menu and 
check your memory allocation in the About MacDraw 
Pro box. If the box says "Available colors are currently 
limited by memory," here are some ways to increase 
availabe memory and speed: 

- Use fewer colors. 

-Decrease the size of document windows on-screen. 

- Increase the memory allocation for Multifinder or 
System 7 by selecting the MacDraw Pro icon in the 
Finder and choosing Get Info from the File menu 
( Command-1). Type a slightly larger amount of mem­
ory in place of the amount presently allocated. 

- If you're using gradients, turn on "Fast display of 
gradients" in the Preference dialog box, which you 
access via the Layout menu (gradients will appear 
banded rather than dithered). You can toggle this 
option on and off with Command-Option-G. 

-Turn off "Kerning by pairs" in the Preferences dialog 
box. 

- Use the Layers feature to structure complex docu­
ments. Hiding layers lessens the time the Mac takes to 
redraw the screen. 

- If you're using System 7 with a 68030-based Mac, 
turn on virtual memory. If not, close applications and 
documents you're not using. 

Keyboard Shortcuts 
If you hold down the Command key in a dialog box 
for a moment, you will see keyboard command equiv­
alents for dialog-box items. For additional drawing 
shortcuts, turn on "Typing activates shortcuts" 
(Command-Option-S) in the Preferences dialog box. 
You can then select tools by using the keyboard (R for 
rectangle, T for text, and so on). 

Controlling Letterspacing 
If you're working with text, you can control letter-spac­
ing (kerning) automatically or manually. To adjust 
letterspacing automatically, tum on "Kerning by 
pairs" in the Preferences dialog box. 

To controlletterspacing manually, make sure that this 
option is turned off. Select a range of characters by 
using the text tool, and hold down the Option key 
while pressing one of the arrow keys. The left arrow 



moves the characters closer together, the right arrow 
moves them apart, and the up arrow returns the letters 
to their default spacing. Adjust letterspacing through­
out a large block of text by selecting it, holding down 
the Option key, and pressing the appropriate arrow key. 

Splitting An Object Into Sections 
Although MacDraw Pro doesn't include a tool for split­
ting objects in two, you can use copying and pasting 
to cut an object into two or more parts. Say, for exam­
ple, you've drawn a map and want to split into regions. 
Here's how you do it: 

Select the object, and choose Reshape (Command-R) 
from the Edit menu. This shows all the reshaping 
handles along the object's sides. Click at the point 
where you want to split the object, adding a new han­
dle. Select the handles of the part of the object you 
want to cut off-including the point you just 
added- by Shift-clicking. 

Copy the handles to the Clipboard. Deselect (Shift­
click) the new handle you created, but make sure 
other handles are still selected. Use the Delete key to 
get rid of the remaining selected handles (make sure 
you don't cut them by using Command-X, though, 
because you'll just copy them over the Clipboard's 
contents). Click away from the object, and paste in the 
contents of the Clipboard. You now have an object 
split into two sections. 

Adjusting Colors In An Imported Image 
If your Mac is capable of only 8-bit color, imported 
images that were created in 24-bit color won't look as 
good as they could. 1b get around this, select the image, 
bring up the Color Editor from the Layout menu, and 
choose Image Colors from the color palette's Special 
menu. This creates a new palette from the colors in the 
image. The image will then map to its own palette and 
look much better on-screen. 

Creating Custom Color Blends 
By using the Blend feature in the Color Editor, you can 
create custom colors within a selected range (for 
example, a series of orange shades that range from 
deep red to pale yellow). 

To do this, first choose Colors from the Layout menu. 
Unlock the padlock icon on the top right corner of the 
Color Editor, and click on the flag icon in the lower 
right corner (this brings up editing options such as 

Blend and Warmer). 1b create a linear blend of colors, 
drag the color from which you want the blend to start 
to the bottom of the palette. 

Next drag the color to which you want to blend, and 
place it next to the starting color. Figure out how 
many intermediate shades you want between the 
starting and ending colors, and then Shift-click to 
select that number of cells in the palette (you can use 
any colors-they're just being used as placeholders). 
Drag these shades down to the bottom of the palette, 
and place them on top of the ending color (this forces 
the ending color to the end of the range). Select the 
entire range, and click on Blend. You now have a series 
of colors ranging in color from the starting-color cell to 
the ending-color cell. 

Using Gradients For Special Effects 
You can use gradients to create special effects such 
as background texture or a 3-D look. The Gradient 
Editor (which you access via the Layout menu) lets 
you add color to a gradient as well as change its 
angle and focus. Here's how to generate a gradient 
that gives objects a silver-metallic look. 

With the Gradient Editor selected, choose View by 
Name in both the Claris Colors and the Gradients 
palettes. In the Gradients palette, choose one of the 
diagonal gradients (such as 45 degrees directional) 
and choose New Gradient from the palette's Edit 
menu. Give the gradient a name in the Gradient 
Editor dialog box, select the first of the four Colors 
boxes, and click on 60% black in the Claris Colors 
palette. In the second and fourth Colors boxes, 
place 10% black. Place 60% black in the third Colors 
box. You can create a gold-metallic look in a simi­
lar fashion by assigning shades of orange/yellow to 
the gradient. 

MACPAINT 2.0 
Using ResEdit 'fu Change Default 'fu Pixel 
Measurement 
You can change MacPaint's default measurement 
from inches to pixels, which is particularly useful to 
programmers and to desktop publishers. Make a 
copy of MacPaint, and use ResEdit for a little surgery 
on the copy. 
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First, use ResEdit to open your copy of MacPaint. Open 
the PREF resource. Open PREF ID= 128. On the line: 

00000008 0008 017B 0009 0001 

... change "0178" to 007B': 

In this position, 00 is for pixels, 01 is for inches, and 
02 is for centimeters. 

When you've made the change, Quit ResEdit and 
type Y to save the changes. 

PHOTOSHOP 
Emulating Dodging And Burning Of Images 
Adobe Photoshop could use a more intuitive approach 
to the conventional photographic processes of dodg­
ing and burning, which lighten and darken parts of 
an image, respectively. Of course, you can select part 
of an image and apply adjustments to it via the Image 
menu, but this lacks the spontaneity of using an 
enlarger in a darkroom. Here's how to create burning 
and dodging tools that mimic the darkroom process: 

1. Open a copy of the image you want to alter, and 
select all (Command-A). 

2. Copy the image to the Clipboard. 

3. Deselect all. 

4. Select the Adjust Brightness/Contrast command 
from the Image menu (Command-B), and reduce the 
brightness by 75 percent to create a burning tool; 
increase the brightness by 75 percent to create a dodg­
ing tool. Save the adjusted image in Photoshop format. 

5. Paste the copy of the original image from the 
Clipboard on top of the saved adjusted image. Deselect 
the image. 

6. Double-click on the rubber-stamp tool, and set it to 
Revert mode at 25-percent opacity. Now when you use 
the rubber stamp, you can create subtle burning or 
dodging effects. 
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PHOTOSHOP 2.0 
Viewing 24-Bit Color Images Without The 
Video Card 
Even if you don't have a 24-bit-color card for your 
monitor, you can still make use of a "poor man's" 24-
bit color when you're in Adobe Photoshop. Whenever 
you want to see a "best" version of the color image on 
the monitor during a demo or presentation of a 
design, for example, simply choose Indexed Color 
from the Mode menu and then click on OK. Sure 
looks like 24-bit color! You can do very little editing 
while in this mode, so use it only to view your image, 
and then return to RGB or whatever you use as your 
standard mode. 

Copying The Apple Icon Color Palette 
If you make custom icons and want to have Apple's 
official icon colors handy for reference within a pro­
gram such as Photoshop (see Figure 3), here's how: 

Launch ResEdit, and open a file that has a color 
icon. Next, open a color-icon resource (for example, 
the ic18 resource). The icon appears in ResEdit's 
color-icon editor. Thar off the Icon Color palette (the 
top rectangle near the bottom left side of the editor), 
and do a screen capture (Command-Shift-3). Copy 
the resulting PICT file in a graphics program, and save it 

Now whenever you need to pick icon colors, you'll 
have the official palette to choose from. 

Comparing Original And Adjusted Images 
When you are using one of the functions under the 
Image Adjust menu, you can toggle between the cur­
rent adjusted image (while you are working on it) and 
the original by clicking on the title bar of the dialog 
box. What is happening is that by clicking on the title 
bar, you are temporarily turning off the Video LUT ani­
mation and the original image (without adjustment) 
is being displayed. This can make minor adjustments 
easier to assess on-screen. 

Fine-tuning Palette Tools 
To use the tools in the Adobe Photoshop palette with 
greater accuracy and precision, turn on the Caps Lock 
key. This converts the standard tools into cross-hair 
tools. 



Ghosting With The Alpha Channel 
Photoshop's alpha channels are 8-bit gray-scale 
images, so you can use them to do complex 8-bit mask­
ing .8-bit masking lets you create soft-edged (or feath­
ered) selections that blend in with the rest of the image 
-vital if you're creating subtle photo-realistic effects. 

To obtain the "ghosting effect'; paste a gray-scale 
image into an alpha channel, and then make it the 
active selection mask. By using the Levels control to 
change the contrast, you can make the letters ghost 
through the image. 

Creating A 'textured Mask Using 
The Alpha Channel 
To create a textured mask, select a pattern or picture 
and choose the Define Pattern command from the 
Edit menu to make it a Photoshop pattern. Fill an 
alpha channel with this pattern (using the Fill com­
mand from the Edit menu), and make it a selection 
mask with the Alpha->Selection command. (Because 
of the complexity of the selection at this point, you 
may want to suppress its flickering edges with the Hide 
Edges command.) 

You now get a textured effect when you paint on the 
image, because the paint flows only into the areas of 
the pattern that were white within the alpha channel. 

You can vary this effect by using the Hue/Saturation 
controls to dramatically colorize the image (the 
changes are applied only to the white areas of the 
alpha-channel pattern). Or you can take another 
image and, using the Paste Into command, on the Edit 
menu, paste it into the selection. The image will flow 
only into the areas of the pattern that were white with­
in the alpha channel. 

Creating A Montage With 
The Alpha Channel 
To create a montage with one image gradually 
blending into another, you must modify one of the 
images so that it behaves like a gradient fill- that is, 
the pixels are opaque at one side of the image and 
transparent at the other, with a transition area in the 
middle. 

To do this, create a linear-gradient fill in a new alpha 
channel and make this channel the active selection 
mask. The mask will be applied to the entire image, 
giving it the same properties as the gradient fill. This 

means that the image's pixels will now follow a gra­
dient from opaque to transparent, matching that of 
the alpha channel. 

Copy the selection to the Clipboard, and then paste it 
on top of a second image. The pasted image will 
merge with the background artwork to create the 
effect of one image blending into the other. The 
background art will be hidden where the first 
image's pixels are opaque and will show through 
where its pixels are transparent. 

Creating A Vignette With The 
Alpha Channel 
The same principle lets you create a vignette (a pic­
ture that shades gradually into the background). Use 
the New Channel command to create an alpha chan­
nel, and create a radial blend going from black (in 
the middle) to white. 

Make the alpha channel the active selection mask, 
and apply the Gaus~ian Blur filter to the image. The 
selection mask controls the strength of the filter's 
effect- the image is intensely blurred toward the edge 
(where the alpha selection is white) and unchanged 
in the center (where it is black), following the gradient 
created in the alpha channel. 

SUPERPAINT 
Making Shadowed 'text 
You can create interesting shadowed effects on your 
text by selecting the font and style while in the draw 
mode, and then typing your text. (Hint: bold text 
looks best with this effect.) 

Switch to the Paint layer and choose a brush pattern, 
such as a simple dithered gray. Then, choose Text 
Pattern from the Style menu, and on another part of 
the page, type the text exactly the same as the text in 
the Draw layer. Now, switch back to the Draw layer and 
move the original text to create a shadowed effect. 
When you get the effect you like, copy the shadowed 
text on to the Draw layet 

Using The Lasso While The Marquee Is 
Selected 
While in the Paint layer, you can have the marquee 
tool selected and still be able to use the lasso tool. just 
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hold down the Option key to tum the cursor into a 
lasso, making it easy to select odd-shaped bit maps on 
the screen. 

"Nudging" Selected Graphics 
By A Single Pixel 
While any item is selected with either the lasso or the 
marquee, you can "nudge" it in any direction by using 
the arrow keys. If your keyboard has no directional 
arrow keys, use Command-Y to nudge upwards; 
Command-) to nudge left; Command-K to nudge right; 
and Command-D to shift downwards. 

Closing All Open Windows At Once 
Hold down Option while selecting Close from th~ File 
menu and all windows that are currently open will 
close. 

Crosshairs Can Help You Paint From A 
Centered Point 
Instead of choosing Draw (Paint) From Center before 
drawing one of the QuickDraw primitives to paint the 
shape from a centered point, you can double-click on 
the palette tool you select instead of just clicking. The 
icons in the palette will then show crosshairs to iden­
tify the difference. 

Reversing The Pattern 
When editing paint patterns or paint brush shapes, 
hold down Command while clicking the mouse any­
where in the pixel editing box to reverse the pattern, 
making black white, and white black. 

Creating A Spattered Effect 
You can create an interesting "spattering" effect by 
choosing the paint brush pattern that youtllike to 
spatter and then painting with the spray can while 
holding down Option. The faster you move the mouse, 
the further apart the spatters will paint. 

Creating a "Screening'' Effect 
A great "screening" effect can be created by using 
Paint On Black and the selection rectangle, especially 
in conjunction with the Laser Grey patterns. If you 
don't like the effect, try moving the marquee one pixel 
up or down to change most of the screen effects. 

Lower Detail Level Speeds Smoothing 
When using FatBits, don't immediately jump to the 
finest detail level. Instead, use the left side of the 
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screen, which displays the actual appearance of the 
work, as your guide. If you can see all of the object 
you'll be working on, stay on that magnification level 
unless you really need a finer one. You'll save time 
smoothing work if you work in the lowest possible 
magnification. 

Creating An Accurate Display Of 
Proportional Rectangle Resizing 
1b accurately see the proportional resizing of rectan­
gular objects, draw a diagonal line from one comer of 
the object to the other, and extend it, keeping it lined 
up against the two handles. 

NO\v, grab a comer handle at the end of the diagonal 
line and resize the object while keeping the handle on 
that line. 

Finally, delete the line. As long as the handle is on the 
diagonal line, the object is in proportion. 

HARDWARE 

5.25·1NCH DRIVE 
Compatibility With Mac Models 
Apple's 5.25-inch external floppy drives are compatible 
with the Mac SE and II; they don't work on any other 
Mac models. 

ADB 
(APPLE DESKTOP BUS) 
Extending The ADB Chain 
Apple designed ADB (Apple Desktop Bus) under the 
assumption that the length of the entire chain 
(cables, devices, the whole shebang) wouldn't exceed 
five meters, and some devices (trackballs especially) 
reduce this capacity further, so don't be surprised if at 
some point, this cabling system ceases to work. 

You can extend your ADB chain by using S-video 
cables instead of ADB cables. S-video cables, found in 
your better home-electronics stores, are typically used 
to hook up high-end laserdisc players and VCRs to 



high-end televisions, but the wiring and connectors 
are identical to those of ADB cables. 

ADB PORT 
Expanding The Single ADD Port 
Because some Macs, such as the Mac Classic, LC and 
Ilsi, have only one ADB port, you can't plug in more 
than one pointing device. 

To get around this, replace the coil cable on your key­
board with the cable that comes with Sophisticated 
Circuit's PowerKey. This cable is an L connector you 
can plug into the back of your Macintosh (where you 
would nonnally plug in the keyboard) that gives you 
an extra connector for a pointing device. Plug one end 
of the connector into the back of the Mac and another 
into the keyboard. Plug your mouse (or other point­
ing device) into the other ADB port on the keyboard, 
and plug your second pointing device into the second 
connector on the PowerKey cable. 

You don't need to buy PowerKey to get the cable: 
Sophisticated Circuits sells it separately for $10. You 
can reach the company at 800-827-4669. 

AUDIO OUTPUT 
Connecting A Stereo To The Mac 
The proper cable to connect the Mac's audio output to 
a stereo system is often hard to find. Fortunately all it 
takes is a trip to your local Radio Shack. Look for Part 
Number 42-2153. It's a Y adapter with a mini mono 
phone plug at one end and a pair of RCA phono plugs 
at the other end. You may need more than 42-2153's 
9-inch length. To extend this cable, use Radio Shack's 
42-2472 You can use several of these if necessary. 

BAnERY 
Is Your lithium Stressed? 
You can tell if the batteries in your Mac need replac­
ing by checking the voltage of the lithium batteries 
with a digital voltmeter. Good batteries will read 3.2 
to 3.85 volts; marginal batteries, 2.3 to 3.1 volts. 

Replace the batteries if they read 2.3 volts or less. 

CD· ROM 
Driverless CD-ROM 
If the maker of your CD-ROM drive went out of busi­
ness, and the driver's not System 7-compatible, try a 
company, Trantor Systems Ltd. of Fremont, California. 
They supply what surely must be a majority of CD-ROM 
drive vendors with their drivers. Trantor also sells its 
software alone. For $99 you get an intelligent, self-con­
figuring driver that will work with any current SCSI CD­
ROM drive. You can reach Trantor at (510) 770-1400. 

COLOR 
Upgrading For Color 
If you need a coloF-capable Mac, you should set your 
sights on a 68020-based model such as the LC or a 
68030-based model such as a Mac II -series machine. 

If you're still limping along with an old Mac Plus or 
SE, it's time to upgrade. The ROMs of these relics of the 
original Mac family don't have Color Quick.Draw, 
which allows you to manipulate color images. No 
amount of system-software upgrading can help. 

The original color Macs required a separate video card, 
but the Ilci, LC, Ilsi, and Quadras ship with color video 
built in, so you don't have to buy a separate card 
Depending on its video circuitry, each of these Macs can 
support a different monitor size and number of colors. fts 
shipped, for example, the LC can support the Apple 12-
inch RGB monitor at 16 bits, for 32,768 colors. With addi­
tional VRAM (video random-access memory), the 
Quadra 700 and 900 can support a 16-inch color moni­
tor at 24 bits, for a full16,772,216 colors. 

8 or 24-Bit Color? 
The 256 colors of 8-bit color are plenty for most business 
projects, but for the type of color control necessary for a 
color catalog-with the use of image-retouching and 
graphics applications, you'll want the broad range of 
hues and tones of 24-bit color. You'll probably also find it 
convenient to work with a monitor larger than 16 inches, 
such as a 19- or 21-inch monitor, which lets you work with 
two pages simultaneously. 
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Unfortunately, working with 24-bit images at large screen 
sizes taxes the Mac's processing power- and your 
patience. The Mac's main processor bears the burden of 
manipulating all that image data, and the result is an 
annoying time lag between when you move the mouse 
and when the shifted object finally drops anchor. An 
accelerated-video card speeds up the processing of 
QuickDraw commands, so if you're planning to produce 
a catalog regularly, you might consider getting one. 

DAISYWHEEL PRINTERS 
Connecting Daisywheel Printers 1b The 
Mac 
Would you like to hook up your old daisywheel printer 
to a Mac to get the letter-quality output. 

First thing to know is that only a printer with a serial 
interface can be connected to the Mac. If your printer is 
serial, then you need a Mac-to-Image Writer printer 
cable. If it's parallel, you'll have to find a way to convert 
the signal. There are a bunch of parallel-to-serial con­
verters on the market, selling for anything from $50 to 
$150. Depending on how you set it up, the converter will 
either translate serial to parallel or (if you're using a 
dot matrix printer) it'll translate the ImageWriteF-type 
printer codes into your printer's codes. 

Another problem you may encounter is persuading 
the Mac that it's not hooked up to an Image Writer or 
LaserWriter. One of the Mac's high-scoring concepts is 
that each Mac program doesn't have to know how to 
deal with several different printers. As long as the pro­
gram plays by the rules, it can print on any printer 
whatsoever, assuming there's a driver for that printer 
in the System Folder (the driver describes the printer, 
its features, and how it operates). That's the good 
news. The bad news is that the only drivers Apple gives 
away (or even officially supports) are the drivers for its 
own printers, which are Image Writers and 
LaserWriters. 

Fortunately, drivers for non-Apple printers are avail­
able from lots of non-Apple companies, notably GDT 
Softworks. Its MacDaisy Link (about $80) is a set of 
drivers designed for use with more or less generic 
daisywheel printers. 
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DISKS 
Magnets Are Lethal To Disks 
Never expose your disks to any magnetic force, since it 
can wipe your data clean off the disk. If possible, store 
disks away from metals such as file cabinets. 

Also, avoid placing hard disks and floppy drives to the 
left of a Macintosh, since the power source has mag­
netic qualities. (Most, but not all, Macs have the 
power source on the left.) 

X Rays and Your Disks 
You may be wondering whether it is safe for diskettes 
to be scanned by an airport X-ray machine. Experi­
ence has shown that you shouldn't trust your flop­
pies to airport-security machines; the same caution 
should apply to hard-disk drives as well. 

But fear not for the safety of your data whilst traips­
ing through airports. Simply put your hard-disk 
drive and your floppies into a separate bag, and 
allow 20 minutes for a hand search procedure. In 
general, you may be expected to fieldstrip your bag 
and prove that your drive works by plugging it in 
and starting it up. 

While we're on the subject of data predators, the 
anti-theft systems in public libraries and bookstores 
are unlikely to blitz your data. But beware of the 
desensitizing machines at checkout stands. These 
machines (decorated with festive "DO NOT PLACE 
CREDIT CARDS ON THIS .1.\IACHINE!" stickers) con­
tain powerful electromagnets. 

ERROR TONES 
Diagnosing The Tones 
The Mac has a cryptic system of error ID codes, which 
is supplemented by a system of cryptic error tones. If 
there's a hardware problem, on startup you'll hear the 
specific tone indicating the relative hardware prob­
lem. For example, one tone indicates that your RAM 
has a problem. 

To learn more about the Mac's error tones, there is a 
program called Diagnostic Sound Sampler, that plays 
all the tones and explains what they mean. You 



should be able to get a copy of this program from a 
user group or on-line service. 

FAIMODEMS 
ATM Type For Faxmodems 
The best way to image type for a faxmodem is 
through Adobe Type Manager. ATM uses the power of 
PostScript to create crisp text on-screen at any size, 
and the faxmodem transmits that scaled type directly. 
If you don't use ATM, the only way to avoid jagged­
looking type is to install bit-mapped screen fonts that 
are three times the size of those in your document. 
The faxmodem software uses the oversized fonts to 
scale the type correctly for transmission, but this 
option can be limiting. 

Only a few faxmodem vendors supply the necessary 
triple-sized fonts, and those that do usually provide 
only a limited selection of sizes and faces (often just 
Times, Helvetica, and Courier). If you want to use 11-
or 13-point type for legibility (easy to do with ATM), 
you'll first have to find or make 33- or 39-point bit 
maps. With ATM, you avoid all these problems. (Keep 
in mind, however, that ATM works only with Type 1 
PostScript fonts. Chicago, New York, and other bit­
mapped faces will still suffer from the jaggies if you 
don't have triple-sized fonts installed.) 

FILE CONVERSION 
Setting Up A Null Modem Cable Between A 
PC Laptop And A Mac 
If your portable device has an RS-232 connector, you 
should have no problem transferring data between the 
laptop and your Mac. 

Plug a Mac modem cable in to your Macintosh. Plug 
an IBM-type modem cable in to the laptop. Each of 
these cables will end in a standard 25-pin connector. 
To link the two, get a null-modem adapter (can be 
purchased at your local electronics store). You may 
have to stick a gender changer in there, too. 

Next, run communications software on both comput­
ers. A generic telecommunications program such as 
ZThrm (freeware you can get from on-line services or 

Macintosh user groups) doesn't have the friendly face 
of a custom-written laptop-to-Macintosh file-transfer 
program, but it does precisely the same job. Get this 
program running on each machine, with identical 
communication settings (transmission rate, data bits, 
stop bits, parity). The actual settings aren't important 
at this stage; you just want to find out whether or not 
your cable configuration works. For the sake of accu­
racy, though, set the transmission rate to something 
slow, either 300 or 1,200 bits per second. 

Now type on the laptop's keyboard. If everything's 
hunky-dory, the words should appear on your 
Macintosh's screen. Try it the other way around too. 
If you can type from the Macintosh's keyboard to 
the laptop's screen, you will know you have a solid 
connection for transmitting files. 

Don't be surprised if either or both of the computers 
don't echo what's being typed on their own keyboard. 
Normally you won't see what's being typed "locally" 
unless the program's local-echo feature has been 
enabled. 

All that remains is to jack up the transmission speed 
as high as you can and transfer the file. In theory, you 
should be able to zip the file through at 57,600 bps, 
but in practice, you'll find that things will begin to go 
haywire once you've broken 9,600. 

Finally, choose a good file-transfer protocol that's 
common to both machines. Give the command for 
one machine to transmit a file, and then tell the other 
one to start receiving. A few seconds later, the transfer 
will finish. Things shouldn't really go wrong at this 
point if you're using the same transfer protocol on 
both machines; if they do go wrong, reverify that the 
communications settings are correct and that your 
cables haven't come loose. 

FLOATING POINT UNIT 
(FPU) 
What Applications Benefit From An FPU? 
The FPU (floating-point unit), also known as the 
math chip or math co-processor, speeds up most 
arithmetic computations on the Macintosh. Some 
operations, such as transcendental functions, are 
hundreds of times faster, but few programs spend a 
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significant portion of their time performing the type 
of calculations an FPU accelerates. 

Examples of users whotllikely notice the difference 
are a power spreadsheet user or someone using 3-D 
rendering or drafting packages. 

For most Macintosh tasks, such as word processing, 
telecommunications, simpler spreadsheet work and 
painting or drawing, the performance improvement 
imparted by an FPU won't be obvious. 

Although there are many companies making FPUs 
in the PC-compatible world, in the Macintosh world 
there's only Motorola Inc., with its 68881 and 68882 
chips. Everyone uses these (the 68882 is somewhat 
faster), so different vendors' units will perform simi­
larly. 

FLOPPY DISKS 
Disks That Won't Format 
If you get errors writing to a disk or a disk that won't 
format, your best bet is to recover any data and throw 
the disk into the garbage. Why tempt fate? Floppy 
disks are relatively inexpensive these days, so if a disk 
won't initialize or if it displays errors when you use it, 
the safest action is to toss it. 

If you're bound and determined to use the disk, try 
launching Norton Utilities' Disk Doctor (or Apple's 
Disk First Aid) before you insert the disk. Most disk­
recovery programs allow you to work on a disk that 
can't be used in the Finder, if you launch them before 
inserting the disk. 

By the way, some brands of floppy disks have a 
replacement warranty- if the disk fails, the compa­
ny will replace it for fee. 

Noisy Disks Signal 'Jloouble 
If your disk makes more noise than usual upon being 
inserted into the disk drive, it might not have been 
aligned properly by the Mac. Eject it and try to boot it 
again. If a certain disk consistently makes unusual 
noise, back it up as soon as possible and don't save 
new data to it- the data may be corrupted. 

'Jlooubleshooting Problems 
Below are some techniques and questions to ask 
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when troubleshooting a floppy disk drive problem. If 
your Mac is still under warranty, leave repairs to your 
dealer, don't attempt anything you aren't comfort­
able with, shut down before opening the case, and 
handle all components with the greatest care. 

1. Good BOOK floppy disks suddenly become unread­
able, and you can't initialize blank floppy disks. If you 
have a modular Mac (Mac II series), you can easily 
take the cover off and check to see that the ribbon 
cable connecting the floppy-disk drive to the mother­
board is firmly seated. There's also a chance that the 
drive has dirty heads. You can buy cleaning diskettes 
from your local computer store. They look like regular 
diskettes except that they have a felt disk instead of a 
plastic one. Insert the premoistened cleaning diskette 
into the drive, and wait the prescribed time. 

2. You have the problem described in No. 1, cleaning 
hasn't solved the problem, and other floppy disk drives 
connected to the same computer work fine. You (or 
someone else) may have damaged the heads by 
forcibly removing a stuck disk. You can't fix this your­
self, but you can remove the drive to have it repaired. 

The floppy-disk drives on the Mac II, Ilx and Ilfx are fas­
tened to a horizontal mounting plate by a single 
Phillips-head screw. Unplug the data cable, remove the 
screw, and take out the drive. On the Ilcx and Ilci, this 
operation is not as straightforward: Unscrew the Phillips­
head screw on the corner of the floppy-disk/hard-drive 
assembly, and remove the power supply and cables, and 
the two drives will pop out. Rebuilding an BOOK drive 
(with new heads) costs about $100. 

GENEUL 
Credit Card Warranties On Hardware And 
Software 
Before buying new hardware or software, check with 
your credit -card company to see if it offers an extended 
warranty on purchases (usually for a year beyond the 
warranty that already covers the product). If so, use 
your credit card to make your purchases- but find out 
first whether you need to register the merchandise in 
order to qualify for the extended warranty. 

For example, if you use your credit card to buy a laser 
printer whose manufacturer provides a one-year war-



ranty, the warranty is now extended by another year at 
no cost to you. 

HARD DISKS 
How Loud Is Tho Loud? 
With a hard drive, it's not so much what noise it 
makes; it's when it makes the noise that's significant. 
Rattling noises at startup or shutdown are usually 
nothing to worry about. 

The vecy first thing a hard-drive mechanism does 
when it's powered up is to make sure that its 
read/write arm is accurately positioned at the outer­
most edge of the drive's platters (the stack of disks 
where your data is stored). Hence the noise. You may 
hear the same sort of noise at shutdown-this time 
the hard-drive controller is making sure the arm is in 
its "parked" position, safely away from the platter. 

More serious are any nasty, cat-in-a-blender type of 
noises the drive may make during the hours between 
startup and shutdown. So if you hear really nasty 
noises from your hard drive- anything worse than a 
whir and an occasional blick-blick-blick -- take it 
back to the dealer. 

Data Errors Caused By RFI 
Some external hard disk data errors are caused by the 
RFI (radio-frequency interference) of fluorescent 
lights. 

To eliminate RFI problems, use double-shielded, 
twisted-pair SCSI cables. Make sure that all the cables 
have a separate drain line running the entire length 
of the cable and that the shielding connects directly to 
the metal shell of the connectors at both ends of the 
cable. 

Old Apple Serial Still Works 
Though we certainly wouldn't recommend it to any­
one as a primary storage device, Apple's old non-SCSI 
Hard Disk 20 is compatible with some of the latest Mac 
models. According to Apple, the Mac 512KE, Plus, SE, 
Classic, Portable and Ilci all work fine with the turtle­
slow serial drive. All other Macs (aside from the origi­
nal and Fat Mac) do not work. 

Interleave Factor And Hard Disk 
Performance 
The perfonnance of your hard disk relates to its inter­
leave factor. If you change machines or add an accel­
erator card, you may need to change the interleave. As 
a rule, drives attached to a Mac Plus work best with a 
3:1 interleave; those attached to an SE require 2:1; 
and Mac lis, Ilx's, SE/30s, and all accelerated Pluses 
and SEs work best if the disk has a 1:1 interleave. 

To see what that interleave is and to change it, use the 
latest version of Apple's HD SC Setup (which is part of 
the System Tools 5, 6 or 7 package). Hold down 
Command-I after you arrive at the application's win­
dow to access the interleave areas of the program. 
Remember to back up your entire disk before chang­
ing the interleave. Changing the interleave requires 
reformatting the disk- an operation that destroys 
all the data on the disk. 

'&oublesbooting Hard Disk Problems 
Below are some techniques and questions to ask when 
troubleshooting a hard drive problem. If your Mac is 
still under warranty, leave repairs to your dealer, don't 
attempt anything you aren't comfortable with, shut 
down before opening the case, and handle all compo­
nents with great care. 

1. You can't get past the Welcome to Macintosh mes­
sage when you start up. This symptom can indicate 
that you have a corrupted Finder. Start up from a flop­
py containing the same versions of the System and 
Finder that are on your hard drive, drag a fresh copy of 
the Finder from the floppy to the System Folder on the 
drive, and choose Restart from the Special menu. If 
the hard drive boots normally, the problem is fixed. 
(You can also try installing a new System, using the 
System-installer disks that came with your Mac.) You 
may need to completely trash the System and Finder 
file before copying or reinstalling the new ones. 

2. You can't get past the blinking question-mark icon, 
and you're sure that the hard drive is spinning. Check 
for any SCSI problems such as an ID conflict, a termi­
nation problem, or a loose cable. To check the SCSI ID 
number, look on the switch on the back of each device 
or use a utility such as SCSI Probe (a freeware utility 
available from ZiffNeVMac and other on-line services 
and user groups). Each device should have a unique 
number from 0 to 6, inclusive. 
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W'hen checking termination, be aware that only the 
first and last SCSI devices on a chain should be termi­
nated. Some products are shipped with internal termi­
nation, however, and if you have one of these devices 
in the middle of a chain, you' II have problems. Check 
with the manufacturer to find out if a device is inter­
nally terminated. If it isn't, check to see if there is a 
50-pin flow-through terminator plug on the SCSI con­
nector. Remove the plug if the device is in the middle 
of the chain; add a plug if it's the first or last device on 
the chain. 

3. You can't get past the blinking question-mark icon, 
and you've ruled out SCSI problems. You may have 
corrupted boot blocks. First, try using a hard-disk­
recovery utility such as Norton Utilities for the 
Macintosh to examine the disk. 

If you still have problems, your next step is to try SCSI­
formatting software, such as Apple's Disk First Aid or 
Silverlining from LaCie. Start up from a floppy disk 
containing the SCSI -formatting software. If it recog­
nizes the drive, there's a good chance you can fix it. 
Look for a menu item that verifies blocks and runs a 
drive test. If a dialog box at the end of the test reveals 
that bad blocks were found and successfully reas­
signed, try to mount the drive (your software may let 
you do this from within the program). If you're suc­
cessful, you'll have solved the problem and saved most 
of your data. If you can't mount the drive, your for­
matting software gives you a couple of options: reini­
tializing (which overwrites the directory) or reformat­
ting (which overwrites the entire drive and tests the 
blocks). You' lllose all your data if you do either of 
these operations, so make sure you back up your files 
regularly. 

4. You can't get past the blinking question-mark icon, 
and you can't hear the internal hard drive spinning. If 
this happens, the bearing lubricant may have thick­
ened or the heads may have stuck to the medium. 
Either way, there's a good chance you can fix it. On the 
II, Ilx, and Ilfx, the hard drive is fastened to a metal 
mounting bracket by two Phillips-head screws. (On 
the Ilcx and Ilci, the hard drive isn't screwed in, so you 
can simply pop it out.) Unplug the data and power 
cables, remove the mounting screws if necessary, and 
briefly place the drive in direct sunlight. More often 
than not, a few hours of the sun's heat will thin the 
lubricant or free the heads, at which point the drive 
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should work fine. A variant on this procedure is to 
carefully tum the computer upside down or on its side 
and leave it somewhere warm (about 70 degrees) 
overnight. 

5. You can't get past the blinking question-mark icon; 
the drive makes strange scraping noises, the stepper 
motor ticks, or the drive isn't spinning, and you have 
reason to believe it's not a power-supply or mother­
board problem. Send the whole drive module to be 
repaired. Some repair shops will retrieve all or some of 
your data. Prices vary with drive size, hours of time 
spent in recovery and overnight service. 

Resetting SCSI ID Clears Up Mac 
Boot-Up Knot 
If, when you turn on your Mac, it doesn't boot from 
the hard disk, it just displays the blinking question 
mark, but then upon restarting your Mac it boots fine, 
read on. 

This is happening because the disk isn't ready by the 
time your Mac gets around to checking for boo table 
devices. It takes time for the disk to go from a dead 
stop to operating speed, and in some cases this time 
will increase as the disk ages. 

One fix is to stuff your Mac full of RAM- say, 32 
Mbytes. The Mac performs a memory test every time 
it's turned on, and the more memory you have, the 
longer this test takes. 

A more prosaic solution is to change your disk's SCSI 
ID to zero. The Mac handles this ID as a special case 
and will wait as long as need be for a device at ID 0 to 
become ready. 

Does Defragmenting Improve 
Performance? 
A fragmented file is one whose data is scattered across 
the disk, rather than being in a single, contiguous 
section. Fragmented files take longer to read and write 
to because the disk head has to move to different 
areas of the disk to find different parts of the file -
and the Mac can't do anything except wait while the 
disk head is in motion. 

According to Karl B. Young, unsung author of Apple's 
Disk First Aid, disk defragmenting is rarely necessary 
unless your disk is so full you must often resort to 
deleting files just to make room. 



If you do want to defragment your disk, there are several 
utilities out there, including Norton Utilities and 
MacTools Deluxe. 

Sticktion Affiiction 
When your hard drive suffers from sticktion, the 
read/write heads are sticking to the surface of the 
platters (where your data is stored) inside the hard 
drive and the platters can't spin. Some of Apple's 
Quantum drives were notorious for this, and Apple had 
to replace the drives' ROMs with ones that kept the 
heads moving at all times. 

A less famous but equally troubling problem is when 
the read/write arm itself gets stuck- the platters in 
the drive spin freely, but the arm can't maneuver itself 
to read in the correct data. 

Usually, sticktion rears its ugly head at startup; you 
tum on the drive and hear nothing but the whir of 
the fan, and the drive fails to mount. The motors that 
spin the platters generate almost trivial torque (as 
they should), so even minor sticking results in plat­
ters that just won't tum. Another symptom is that the 
hard drive boots but the arm subsequently sticks in 
position and no longer reads or writes files. 

Some causes: Improper cleaning of the platters dur­
ing production, use of a verboten lubricant in the 
mechanism, or poor hard-drive design. The best fix: 
Buy a new hard drive, or get the drive manufacturer to 
replace the mechanism. If you bought an Apple hard 
drive (internal or external), call the Apple Customer 
Assistance line (800-776-2333) or your local Apple 
dealer. 

Noisy Fans 
There are several things you can do about a noisy fan, 
none of them for the faint of heart: 

- Replace it with a quieter fan. This involves removing 
the fan, which is generally a square "muffin fan," 
after looking around Radio Shack or an electronics 
surplus store for something that is physically the same 
size and runs on the same current. Since there's rarely 
a way to test the fan in the store, it's a gamble. 

- If you're especially intrepid, you can wire a resistor 
in-line with the fan's power to slow it down. The value 
of the resistor will depend on the type of fan. 

- Bring the hardware in for service and pay for both 

labor and any part replacements. 

What Is A Look-Ahead Cache? 
As you may know, a cache is a small amount of fast 
memory that acts as a buffer between the CPU and slower 
memory. Some hard disks include a small amount of 
cache RAM on their controllers. 

A look-ahead cache goes one step further than a regu­
lar cache: It anticipates and pre loads the data it 
thinks you'll need next; which, in this case, is gener­
ally the data on the next sectors or tracks of the hard 
disk. 

A look-ahead cache is a good idea, but since the 
amount of cache RAM on the hard disk controller is 
generally pretty small- 32 Kbytes or so- it won't 
help with large files. 

Which Utility Will Ftx What? 
Among the several disk-repair utilities, sometimes 
one will report that a disk is OK, while another will 
insist there's a problem. Disk-repair utilities- such 
as Symantec Corp.'s S. U.M., The Peter Norton Utilities 
for the Macintosh, and Apple's Disk First Aid- all 
have different sets of criteria for what constitutes a 
"problem.'' It's hard to know whose utility to believe 
when two or more utilities disagree because no com­
pany documents exactly what its utility looks for and 
can repair. 

Disk-repair utilities exploit the redundancy in the 
disk's directory and file structure, which sometimes 
can be sufficient to reconstruct the missing informa­
tion. However, it's possible for a disk to be scrambled to 
the point where no utility can repair it, in which case 
your only defense is a good backup. 

Jasmine and System 7 
Unfortunately, jasmine declared Chapter 7 bankruptcy 
in October 1991. 

Fortunately, System 7-compatible formatting software for 
Jasmine dri~ is available from at least three companies. 
Hard Disk Tholkit (FWB, Inc., 2040 Polk Street, Suite 215, 
San Francisco, CA94109; [415] 474-8055) andDrive7 
(CasaBlanca Works, Inc., 148 Bon Air Center, Greenbrae, 
CA 94904; [ 415] 461-2227) can both do the trick. just 
format your jasmine drive with either one, and you 
should have no further trouble installing System 7. 

Seagull Software, at ( 415) 361-0928, is the only source 
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for jasmine Driveware 2.0, which has been buffed for 
System 7. 

If you're a jasmine orphan (or even if you're not), 
keep this name and number handy: Drive-Savers 
(30-D Pamaron Way, Novato, CA 94949; 
[ 415) 883-4232). DriveSavers, run by former jasmine 
executive Scott Gaidano, can recover data from and 
repair all jasmine models. The company provides a copy 
of Drive 7 at no charge with any jasmine data recovery. 

HIGH·DENSITY DRIVE 
Adding A Super Drive (FDHD) To A Mac Plus 
If you have a Mac Plus or SE and would like to add 
SuperDrive capability to it, the Apple external FDHD 
won't work. 

What you can use are a pair of peripherals, Rapport 
and Drive 2.4 (Kennect 'Iechnology). Rapport is a plug­
in microprocessor and drive controller that lets your 
Mac read 3.5-inch, 720KMS-DOS, OS/2, and ProDOS 
disks (low density), using the existing 800K internal 
drive. Drive 2.4 is an external drive that, in addition to 
supporting all existing Apple and IBM 3.5-inch disk 
formats, supports two high-density formats that pro­
vide 1.2 megabytes of storage on BOOK disks and 2.4 
megabytes on high-density disks. Rapport supports 
the Mac 512KE, Plus, and SE. The Drive 2.4 supports 
the 512KE, Plus, SE/30, II, Ilx, Hex, and Ilci and Ilfx. 

Such wizardry is possible because the products are the 
brainchild of Wendel Sanders, a major contributor to 
the Apple III team and codesigner of the SWIM disk­
controller chip that controls the floppy drive in Macs 
that have FDHDs. (Interesting Macintosh trivia: SWIM 
stands for Sanders/Wozniak Integrated Machine, not 
Super Wozniak Integrated Machine or Steve Wozniak 
Integrated Machine.) 

HP·95 
HP-95-to-Mac Connectivity 
Data Viz Inc., makers of the MacLinkPlus file-format 
translators, has a version for the HP-95LX. The pack­
age makes file transfer between the machines trivially 
easy and includes all the regular Data Viz translators. 
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MacLinkPlus for the HP-95LX is available now at an 
introductory price of $99. Data Viz Inc. is at 
55 Corporate Drive, Trumbull, Conn. 06611. 
Phone (203) 268-0030; fax (203) 268-4345. 

IMAGEWRITER 
What You See Isn't Always What You Print 
When you print, the Image Writer (I & II) uses a font 
twice the selected size (if it's available in the System) 
and then scales it down to produce high quality out­
put. Fonts usually don't change from one size to the 
next. But Geneva is the exception that proves the rule: 
its lower case "y" in 12 point has a distinctly different 
descender than the 9-point "y" and both have differ­
ent forms than the 24-point character. That means, 
when you print high quality in Geneva, you'll often 
get some characters that print quite differently than 
they display on-screen. 

How To Access The SeH-1est Mode 
The ImageWriter II can run self-test samples of all 
three printing modes. To do this, tum the printer off 
and hold down the Fonn Feed button while turning it 
back on. This starts the draft mode self-test. While it's 
printing, deselect the printer by pushing the Line Feed 
button and then push the Print Quality button to 
select a new mode. Then reselect the printer by push­
ing Line Feed. When the print head begins a new line, 
it will print in standard quality. Repeat step two to 
enter high quality mode. 

A Quick Tuneup 
If your Image Writer printer is more than two years 
old, it will benefit from a quick tuneup. All you need 
do is tum off the power, remove the ribbon, and clean 
the pin mechanism. Here's how: 

1. After removing the ribbon, locate the white plastic 
retaining clip, which is to the right of the printing 
mechanism. Gently pull the clip to the right so that 
you can lift the assembly up and out of the carriage. 

2. Using a general-purpose cleaner on a cotton swab, 
carefully clean any ink residue from around the 
pins. On the underside of the unit is a small cutout 
that allows lubrication of the pins. You can add a 
small amount of lubricant (such as WD-40) here. 



3. Gently replace the assembly and the ribbon. You're 
now ready for another two years of printing. 

How To Obtain Best Print Quality Fast 
Here's a way to obtain the fastest and best print quality 
from your ImageWriter II. You can access the 
ImageWriter II's built-in proportional fonts from 
within MacWrite or Microsoft Word. Certain fonts 
when printed with the "draft" quality access the print­
er's internal proportional fonts. These internal pro­
portional fonts are: Boston II 10 and 12 point, Thronto 
12 point, Chicago 12 point, Venice 14 point, London 18 
point, Athens 18 point, and San Francisco 18 point. 
Other fonts, such as Geneva, use a monospaced font in 
draft mode that produces awkward spacing. 

IMAGEWRITER II 
Using The Image Writer And The liP PainUet 
Ftlm Produces A 'Ihmsparency 
If you've ever needed an overhead transparency in a 
hurry (and in color, no less), here's an inexpensive 
solution. 

By using HP Paintjet transparency film and an 
Image Writer II printer, you can easily make a color 
(or black-and-white) overhead. 

IMAGEWRITER LQ 
Extending The Ufe Of Image Writer LQ 
Ribbons 
Here is one way of extending the life of an LQ ribbon. 

On the left side of the LQ (where the controls are), there 
is a small switch. When this switch is depressed, the 
printer knows that a one-color (black) ribbon is load­
ed The black ribbons have a tab protruding that should 
depress this switch. Color ribbons do not have this tab. 
Make sure that the tab is depressing the switch. Then 
most of the ribbon surface will be used for printing. 

Seating The Image Writer LQ Ribbon 
Properly 
If the top edge of your ribbon is receiving the brunt of 
the printing load, you may not have the ribbon seated 
properly. 

A well-worn LQ ribbon has four parallel wear lines 
spaced evenly up and down on its surface reflecting 
the up and down movement of the print head. An 
improperly seated ribbon defeats this motion, and 
the result is the characteristic top-edge fraying. In 
other words, you're using only one-fourth of your 
ribbon. 

If you set up the printer as the manual instructs, there's 
every chance that you won't seat the ribbon properly, 
because doing so requires a degree of force and thumb 
pressure that most people will not instinctively apply to a 
new $1,300 printer. 

To seat your ribbon properly, you must apply very 
strong thumb or finger pressure to the extreme end of 
each of the little arms that extend out from each end 
of the cartridge. You will feel a very satisfying click 
when it is properly installed. 

INTERRUPT AND RESET 
SWITCH 
Where Are The Macintosh llsi's Switches? 
On most Macintosh computers, the reset and interrupt 
switches are activated by a small plastic button found 
on the front or side of the computer. The Macintosh 
Ilsi has a keyboard-based set of switches. To activate 
the reset switch, press Command-Control-Power On; 
to activate the interrupt switch, press Command­
PowerOn. 

KEYBOARD 
Using The Key Caps DA During 
Keyboard Pailure 
If one or more of the keys on your keyboard ceases to 
function or in the middle of a letter or document and 
something similar happens to you, simply go to the 
Key Caps DA Click the mouse on the inoperative key 
and that letter, number, or symbol will be shown in 
the text area at the top of the DA Simply copy it from 
there and paste it where needed. 

Another option, which works in any program that has 
a global search and replace feature, is to use a symbol 
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that you ordinarily don't use in place of whatever the 
keyboard won't produce throughout the document. 
When you're done, use the Change command under 
the Search menu to have the program substitute the 
correct letter (or whatever) for the symbol. Paste the 
correct letter from the Key Caps DA straight to the 
Change To area of the Change dialog. 

Cheap Keyboard Protection 
If you want a really cheap and easy way to protect 
your keyboard from dust or coffee spills, try wrapping 
it in plastic cling wrap. It will last two to three 
months, and as long as you dont't wrap it too tightly, 
the keyboard "touch" is the same. 

Running A Mac With A Copilot 
Did you know that you can run Macs with a real live 
copilot at your side? just have your nearest Mac expert 
bring a second keyboard (and mouse) to your desk 
and plug it into one of the Apple Desktop bus (ADB) 
ports on the back of your Mac. 

The extra keyboard and mouse tum your Macintosh 
into a state-of-the-art training system, complete with 
room for a copilot. Your resident expert can sit beside 
you and demonstrate various techniques. This gives 
you the chance to try out the techniques yourself 
without having to share the keyboard or mouse. 

The Keyboard Remembers What You Type 
The Macintosh has a very effective keyboard memory 
buffer. So, when you launch an application, you only 
have to wait about four seconds before starting to 
type, even if the application isn't fully set up on the 
screen yet. 

Having A Numeric Keypad With 
The Pre-Mac Plus Keyboards 
Here's a simple tip for those of us with pre-Plus key­
boards, which don't have numeric keypads: Use a 
macro program to redefine the backslash \ key to be a 
plus sign +. This saves a whole lot of shifting in 
spreadsheets, calculators, and other frequently used 
programs and basically doesn't cost you anything, 
since you seldom need to use the backslash key­
unless you're running MS-DOS. 

Curing Keys With WD-40 
There comes a time in the life of every Mac keyboard 
when one of the keys fails to work. How-to articles 
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describe how to repair the keyboard by breaking out 
the trusty ol' soldering pencil, tearing the keyboard 
apart, and replacing the individual key with one 
purchased from the local Apple dealer. Although this 
method does an admirable job, you may be uncom­
fortable doing this kind of minor keyboard surgery. 
There is an easier method that requires no solder­
ing, based on the assumption that the key is proba­
bly suffering from a dirty contact and that the con­
tact can be cleaned with a judicious application of a 
solvent. 

Disconnect the keyboard from the Mac and carefully 
pry the key cap off the offending key. Now take a can 
ofWD-40 (available at most hardware stores), insert 
the small straw that comes with the lubricant into 
the nozzle, and direct as short a spritz of WD-40 as 
possible at the point where the white key plunger 
enters the black body of the key. 

Work the key plunger several times and then recon­
nect the keyboard to see if the key works. The first 
application of WD-40 may not do the trick, but the 
key should be resurrected by the second or third try. 

LASERWRITER IISC 
Keeping a I.aserWriter Running 
If you own a LaserWriter IISC, you will need to tum it 
on before starting up your Mac and leave it running 
as long as the Mac is turned on. This is because this 
printer connects via the SCSI port; most SCSI devices 
need to be turned on before you turn on your 
Macintosh. 

LASER PRINTER 
Printer Care and Feeding 
Three hazards face a sheet of paper, labels, trans­
parencies, etc. as it meanders through the 
LaserWriter's intestines. First, the page makes a 
U-turn as it travels from the paper bin into the 
printing mechanism. If the page is a sheet of 
labels, some stickers may peel off while making 
the turn and get stuck among the innards of the 
machine. The solution is to feed the page manu­
ally to avoid the U-turn. 



Another problem is page thickness. Approximately a 
60-pound cardboard (business-card stock) is the 
thickest stuff that can make it through the printer 
unscathed. 

Finally, there's heat from the fusion rollers at the end 
of the paper path. It can tum a happy sheet of trans­
parency material into a hard glob of plastic nastiness 
that's terminally fused to the printing mechanism. 
Because the lowest temperature of the heat rollers is 
typically about 150 degrees, you can test a sheet of 
material by setting an iron to 140 degrees or so and 
passing it over the sheet a few times. If the iron 
becomes pennanently fastened to the ironing board, 
well, you have the answer. 

Most office-supply stores sell special labels and trans­
parency film for use with plain-paper copiers, which 
are very similar to laser printers; Avery 535llabels and 
Scotch 503 transparency film are commonly used for 
this purpose. 

Printing The Screen 
Most 300 dpi printers -laser and inkjet- don't sup­
port Command-Shift-4, which sends the contents of 
the active window to an Image Writer printer. 

Never fear. Your Mac has a built-in print-screen-to-disk 
command. If you have a black -and-white monitor or 
color under System 7, Command-Shift-3 will create an 
editable and printable paint document of the current 
screen, not just the active window. The document 
appears on the Startup disk as Screen X, where X repre­
sents a number between 0 and 9, inclusive. You can 
take up to ten screen shots (Screen 0 through Screen 
9) before you have to renumber them. Once you've cre­
ated a document this way, simply open the file with 
MacPaint (or any program that reads MacPaint files) 
and print it. 

If you have a color Macintosh system with System 6.x 
or earlier, Command-Shift-3 works only if your moni­
tor is set to black-and-white (use the Monitors cdev in 
your Control Panel to do this). System 7 will let you 
create color screen images when you use Command­
Shift-3. 

An alternative is to use a special screen-printing utili­
ties for any non-Image Writer printer if you want to 
print the active window directly to the printer. The 
good news is that there are a lot of alternative screen­
dump INITs and Fkeys out there. One example is Nobu 

Toge's shareware Flash-It INIT/cdev (available from 
user groups, Zmac, or other shareware sources). 

Avoiding The Startup Page Using The Paper 
'Iray 
One way to stop your LaserWriter from printing a page 
each time it's started on a temporary basis is to pull 
the paper tray out an inch or so (the distance isn't 
critical) when you start the LaserWriter. When the 
green light stops flashing, indicating the printer is 
wanned up and ready to go, push the tray back in. 

Preprinted Paper And The LaserWriter 
Here are some suggestions about using preprinted 
paper in a Laser\Vriter, such as paper that is offset­
printed or copied on a copying machine. 

You shouldn't use paper that has been printed with 
thennography (raised lettering), because the heat 
generated by the printer can melt the ink, which can 
cause problems .. Depending on the chemical makeup 
of the ink, when the paper runs through the printer's 
fusing process, it tends to melt and can damage the 
fusing unit. It is better to be safe than sorry: letter­
head or other paper printed with thennography is 
not recommended with any laser printer. 

On the other hand, Apple says you can use most pre­
copied, or colored paper in a laser printer. If you're 
not sure whether you should use a certain paper, 
Apple recommends that you consider the following 
characteristics: 

Don't use paper with a colored coating that was added 
after the paper was produced, because the pigments 
used on the paper might not be able to withstand the 
392-degree temperature of the printer's fusing process. 
(You should also keep in mind that colored paper 
should be the same quality as regular photocopy paper.) 

To avoid problems with offset-printed paper, make 
sure the inks used are heat-resistant and will not 
melt, vaporize, or release hazardous emissions when 
subjected to the printer's fusing process. Whoever did 
the original printing should be able to help you in 
finding out about this. 

Copiers use the same electrophotographic process as a 
laser printer does, so running copied paper through 
shouldn't be a problem. Remember, however, that 
depending on the makeup of the copier's toner and 
the Laser\Vriter's cleaning process (which scrapes the 
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paper), you may get toner droppings in the bottom of 
your printer. 

To be safe, Apple says, you should avoid using the fol­
lowing in your printer: glossy paper, heavily textured 
or embossed paper (laser printing doesn't adhere as 
well to this kind of paper), carbon less or chemically 
coated paper, and paper and ink that are not compati­
ble with the heat and pressure of the printer's fusing 
process. 

Using Word To Disable The LaserWriter 'lest 
Page 
While in Microsoft Word, you can creat a document 
containing the following Postscript code, which 
when downloaded to the printer will disable the test 
page: 

serverdict begin 0 exitserver 

statusdict begin false setdostartpage 

The important step here is to set the style of the code 
to Postscript style. To do this, select the text and then 
type PostScript in the style box in the lower left corner 
of the ruler (you can either select it with your mouse 
or press Command-Shift-S). 

There are also some shareware and commercial utili­
ties that switch the test page on and off, most notably 
CE Software's Widgets program. You may want to 
check out Apple's LaserWriter Reference and Adobe's 
PostScript Language Reference Manual, which con­
tain other PostScript commands and conditions for 
manipulating LaserWriter features. 

No Toner Is Forever 
Keeping important documents around for years or 
decades can be a little tricky. You should always use 
pH-neutral paper stock for archival printing and 
always store the documents in a cool, dry place away 
from light. 

And one more thing: If the documents were printed on 
a Hewlett-Packard Laserjet, don't store them with vinyl 
binders or notebooks. Vinyl reacts with the syrene plas­
tic in the toner and breaks it down over time. 

A Manual FIX For Envelope jamming 
Envelopes frequently jam when going through a 
LaserWriter because they are too stiff to bend around 
the mechanism of the paper path. 
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The low-tech solution is extraordinarily simple and 
takes about two seconds. Before printing, break the 
spine of the envelope. Run the flap edge of the enve­
lope between your thumb and forefinger, bending it at 
about a 45-degree angle as it passes through. Do this 
twice, bending once in each direction so that the enve­
lope ends up flat. Avoid paper cuts entirely by folding 
the flap over backwards. 

For an even better pass through the printer, break the 
stiffness along both long edges. This makes the enve­
lope more flexible and the likelihood of jamming is 
substantially reduced. 

Keeping A Laser Writer Running 
You do not necessarily need to turn on a LaserWriter 
while you are using your Mac until you need it. Then, 
depending on whether you expect to do more print­
ing, you can either turn it off or leave it on. Turning 
your printer on and off a few times a day cannot harm 
anything, and it might even save a bit of energy. 

If we're talking more than two or three times a day, 
you wouldn't want to switch any piece of equipment 
on and off much more than that. Cycling a power sup­
ply (nerdspeak for "switching the thing on") causes a 
certain amount of stress on any circuit, and if you 
really go overboard, you can shorten the life of the 
printer. Admittedly, we're only talking about taking six 
months (at the most) off your printer's eight-year life 
span, but it's something to think about. 

Paper 'Ihlys For Legal And Letter Size Paper 
If you regularly use two kinds of letter size paper in 
your LaserWriter (for example, letterhead and regular 
paper), it's a good idea to get a second paper tray to 
avoid taking paper out and putting the other paper in 
constantly. However, don't get a legal size tray, on the 
theory that it would be handy to have both tray sizes. 
You' II discover your pages print misaligned. That's 
because the LaserWriter doesn't check to see what kind 
of paper is in the tray, but, instead, checks to see 
which size tray is inserted! 

Jamming With Envelopes In The 
LaserWriter II 
A simple solution to jamming envelopes in the 
LaserWriter II is to open the door at the end of the 
LaserWriter II so the paper path is straight. 



Feeding Label Sheets 
Anyone who has ever fed a sheet of labels into a laser 
printer has feared that somehow a label is going to 
wreak havoc by peeling off its backing and adhering 
to the innards of the printer. 

If you print and remove a single label, the remaining 
sheet starts to curl at that end, increasing the likeli­
hood that the sheet will jam the next time it's fed into 
the printer. The solution is to print from the bottom of 
the sheet, not the leading edge. Most label-printing 
utilities allow you to specify which label to begin 
printing so that you can-theoretically-use an 
entire sheet, one label at a time, starting anywhere on 
the sheet. Don't use the default setting of the first label 
on the sheet, but rather switch to the last one at the 
trailing end of the sheet. That way, even if the sheet 
starts to curl, the leading edge will remain straight 
and you'll have fewer problems each time you feed it 
into the printer. 

MACINTOSH II 
Using The Latest With The Oldest And Not­
So-Greatest 
The original ROIVls (Rev. A ROM) in original-issue 
1987 Mac lis won't work with the current crop of Apple 
video cards. A free ROM upgrade is still available from 
your Apple dealer if you've somehow managed to go 
this long without it. 

Vertical Or Horizontal? 
Whether or not you can safely turn a Mac II on its 
side, lies with the disk drive. If you're going to vertical­
ize your Mac II, do the following: 

1. Perform a low-level format on the drive in the posi­
tion you will use it in. 

2. Don't keep changing the orientation- once vertical, 
always vertical; once horizontal, always horizontal. 

3. Pay careful attention to air flow, especially with the 
Mac II, Ilx, and Ilfx, which aren't designed to sit on 
their sides. If you want to put one of these models on its 
side, youtl better get a special stand for it. The Ilcx and 
Ilci, on the other hand, were designed to go either way. 

~~ 
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The Upgrade Path To A Ilfx 
Thinking of upgrading your Mac II to a Ilfx at some 
point? Any monitor, keyboard, or color board that 
works in your Mac II will also work in the Ilfx. As for 
RAM, any memory that you have for your Mac II will 
be utterly useless in the IIfx, because the latter 
machine uses different (64-pin SIMMS) SO­
nanosecond RAM chips that won't fit, much less 
work, in your I I. 

MACINTOSH IISI 
Sound Output Goes Away 
If you find that the sound output on your Mac Ilsi 
goes away at random intervals, you're not alone. 
Nobody seems to know either the cause or a perma­
nent fix for this vexing problem, although people 
have reported some success from cleaning the con­
tacts between the speaker and the logic board, rein­
stalling system software, and unplugging and replug­
ging the microphone. Opening the Sound control 
panel and dragging the volume control to the end of 
its range and then back seems to work in most cases. 

The real story is that it's a problem with the contacts 
between speaker and motherboard, which can be 
addressed with an electrical cleaning and lubrication 
solution, such as Cramolin from CAl G. The head­
phone jack should always work, since the problem is 
with the speaker connection only. 

MACINTOSH CLASSIC II 
Setting Brightness With The Keyboard 
When Brightness is open, typing any number between 
one and nine will jump the control panel's slider to 
that setting. Nine is the brightest screen setting and 
one is the darkest. 

Brightness In The ROMs 
If you set the brightness level less than four on a 
Classic II, it will reset to just more than four after the 
next restart. This "feature" protects against users set­
ting their screens too dark and then thinking their 
computers are not booting when the screen doesn't 
light up at start-up. 
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MACINTOSH CLASSIC 
Upgrade The Classic to The Classic II? 
Apple offers a souped-up model of the Classic with a 
68030 processor, called the Classic II (the Classic has 
a 68000 processor). 

The upgrade costs about $700. There is a socket for an 
optional math coprocessor; however, there isn't an 
expansion slot. Having the 68030 processor means 
you can take advantage of some neat System 7 fea­
tures such as 32-bit addressing, virtual memory and 
Quick Time: If you want to watch the Three Stooges in 
a HyperCard stack, you'll need a 68030 processor and 
32-bit Color QuickDraw in ROM. 

MAC PLUS 
The Vents On The Thp Of A Mac Plus 
Don't block the vents on the top or the sides of the Mac 
Plus, since it interferes with the circulation of cool air 
to the inside. Without adequate ventilation, the Mac 
Plus (and other models as well) may be permanently 
damaged. 

When The Calendar And Clock Aren't 
Working On A Mac Plus 
The alarm clock and calendar functions are regulated 
by the Mac's internal battery. In the Mac Plus, its com­
partment is located in the upper right side on the back 
of the machine. After about two years, the battery will 
give out. Replace it with an Even-eady 523BP, Ray-0-
Vac RPX21, Duracell PX21 or Panasonic PX21, all of 
which are 4.5 volt batteries. You can find them at an 
electronics specialty store and through some Mac 
mail-order houses. 

If the above symptoms are occurring on a Mac other 
than the Plus, the battery is a lithium battery, which 
lasts about 7 years and requires a Certified Apple 
Thchnician to replace it. 

Esc For Old Keyboards 
If you need to use an escape key on the Macintosh 
Plus keyboards you will have to use a work- around. 
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An easy solution is to use QuicKeys II. You'll find it 
useful in almost every application. With QuicKeys, 
you can create a key set with the alias for the Escape 
key on a Mac with a newer keyboard and then save the 
key set and install it on your Plus. 

Or, CE Software has created a QuicKeys key set called 
Control. KEYS that contains aliases for keys not avail­
able on the Plus keyboard- the Escape key (along 
with Shift-Esc, Command-Esc, and so on) and 
Control-A through Control-Z. You'll find a copy in 
the ZiffNeV.Mac library on-line. 

Yet another solution is to look into buying a third­
party extended keyboard, such as Datadesk's Mac-101. 
It's an IBM PC/ AT-style keyboard complete with 
Control, Escape, function, and a slew of other keys, 
thus bypassing the need for clumsy key alternatives 
in most situations. 

MAC PORTABLE 
Turning Off The Power Conservation 
Feature 
Mac Portable users who try to use the machine for 
automated, time-consuming operations may find it 
performs far below their expectations. Without user 
interaction or peripheral communication, the system 
will slow down to a crawl after 15 seconds to conserve 
power. You can tum off this feature from the Portable 
Control Panel device (cdev): Hold down the 
Command and Option keys while clicking on the 
words "Minutes Until Automatic Sleep" at the top of 
the cdev window. A dialog will appear with the Don't 
Rest option, which will keep the Portable on full 
power until reset. 

Using A Screen-Saver Program On The Mac 
Portable 
Although the portable has an LCD screen, they are 
subject to bum-in the way CRTs are. You should use a 
screen saver if your Portable spends a lot of time with 
the same image on its screen. 

Avoid The Control Panel 
Every time you open the Control Panel, the Mac access­
es the startup drive. If you must make changes to the 
Control Panel settings, do them all at once. 



Don't Shut Down 
The Portable consumes the same amount of power in 
the Shut Down and Sleep modes. The only reason to 
choose Shut Down is if you are going to install an 
expansion card or attach a device to one of the ports 
on the back of the computer. (Apple does recommend 
that you shut down at least once a month.) 

Otherwise, choose Sleep so that all of your applica­
tions and documents are instantly available when you 
issue the wake-up call by touching a key. Aside from 
this convenience factor, you save the power required to 
spin up the hard disk and reload files from disk. 

Open Ftles In Batches 
The hard and floppy drives are the most power-hungry 
components of the Macinstosh Portable. Both require 
roughly the same amount of power to spin for any 
given length of time. 

Whenever possible, open simultaneously any of the 
documents that you plan to use in a session. 1b do so, 
use the shift -click method to select more than one 
document in a folder and choose Open from the File 
menu or press Command-O. This launches the parent 
applications and opens the designated documents all 
in one step. 

Create A Startup RAM Disk 
Whether you configure memory as a RAM disk or 
leave it available for applications doesn't affect how 
much power the Portable uses, so if you have at least 2 
megabytes of memory, specify a RAM disk, using the 
Portable Control Panel (cdev). 

Make it large enough to hold the required System files 
plus any heavily used applications and documents. 
Click on the Ram-disk icon on the Finder's desktop, 
and then choose Set Startup from the Special menu. 
Now instead of spinning the hard disk on startup, the 
Portable can quickly fetch these files from the very 
low-power RAM disk. 

Although the RAM disk retains its contents even when 
you choose Shut Down from the Special menu, save 
any really important files to a diskette every once in a 
while for peace of mind. 

Use A RAM Cache 
The General Control Panel (cdev) has an option for 
designating a portion of memory as a RAM cache. 

Frequently requested data resides in the cache, so if it 
is asked for again, it can be accessed much more 
quickly from RAM than if it has to be retrieved from a 
disk drive. Because the drive needn't be accessed, you 
won't waste power. 

Load Entire Applications Into Memory 
Some applications (such as Microsoft Word) let you 
specify whether the entire application should be load­
ed into memory when launched. Say yes. Forcing the 
whole program to load at once means that you avoid 
unnecessary disk access later on. 

Turn Off The Speaker 
The higher you set the sound volume, the more power is 
necessary to drive the speaker. Use the General Control 
Panel (cdev) to lower the volume of the internal speaker 
as far as it will go. With the speaker thus disabled, the 
Mac flashes the menu bar whenever a system beep 
occurs. 

Use Any Desktop Pattern You Want 
Some people suggest using the General Control Panel 
(cdev) to change the desktop pattern to all white. The 
assumption is that black pixels are "on" and therefore 
require more power to display than white pixels. In 
actuality, the Portable uses an active-matrix LCD (liq­
uid-crystal display) panel, with each pixel controlled 
by its own transistor. It requires power only to change 
the state of a pixel, and even then, the amount of 
power involved is negligible. 

Quit 'Ielecom Apps When Not In Use 
Open telecommunications applications require the 
Portable to supply power to the internal modem even 
if you aren't connected to an on-line service. But if 
you quit the application, the Portable saves power by 
turning off the modem. 

Force The Hard Drive To Sleep 
Nonnally, after you access the hard drive, you must wait 
for it to delay until the amount of time has passed that 
you specified in the Minutes Until Automatic Sleep in 
the Portable cdev, before it turns itself off. But clicking 
on Sleep at the bottom of the Battery DA immediately 
puts the system into sleep mode, thereby shutting off the 
hard drive. Just press any key (except Caps Lock), and · 
the system wakes up exactly as you left it but the hard 
drive remains off. 
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If you get Andrew Welch's shareware INIT called 
Portable Siesta-putting your Portable to sleep is even 
easier- just press a user-specified key combination 
(the default is the Escape key). Portable Siesta is avail­
able from ZiffNet/Mac; the shareware fee is $5. 

Don't Save As Often 
The Mac Portable is a robust piece of hardware, so you 
needn't worry too much about losing work in progress. 
If you have a macro utility that saves to disk automat­
ically at periodic intervals, or if the applications you 
see have this as an option, disable it. 

MICROPHONE 
Macs Without The Built-In Microphone 
You can't use the microphone that comes with Macs 
such as the Mac Ilsi with older Macs such as the Ilcx. 
The older Macs don't have the sound input and digitiz­
ing circuitry that the newer Macs do. 

So what if your Mac doesn't have a built-in micro­
phone? Don't worry; several good recording devices 
are available. The MacRecorder Sound System Pro, 
from Macromedia (formerly MacroMindParacomp, 
600 Townsend Street, San Francisco, CA 94103; 
[ 415] 442-0200; $349, including the excellent 
SoundEdit Pro software) contains a microphone that 
connects to a serial port and provides software to cap­
ture and edit sound. 

Articulate Systems ( 6000 Cummings Park, Suite 4500, 
Woburn, MA 01801; [617] 935-5656) also makes 
recording devices. Choose from the no-frills 
Voicelmpact ($119) or the full-featured Voicelmpact 
Pro ($299). 

MODEM 
Why Buy A Modem? 
A modem is not only affordable these days, it's virtual­
ly indispensable. With a modem, you can use your 
Mac to access on-line services such as CompuServe­
America Online, and Mac User's own ZiffNet/Mac as 
well as professional services such as Lexis (for 
lawyers) and small bulletin-board services. You can 
also use it with software such as AppleTalk Remote 
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Access to access the power of your office Mac (and 
servers and printers) while on the road or at home. 
Even better, modems are getting faster and cheaper: 
What used to be top-of-the-line -a 2~00-bps 
modem-is now standard, and some 9,600-bps 
modems have come down in price enough to be a 
good buy for personal-Mac users. 

Buying For Speed 
Modems are rated by how fast they send data over 
phone lines: their speed is measured in baud or bps 
(bits per second). 

Although you can pick up secondhand 300- and 
1,200-bps modems for much less than $100, it's worth 
spending $250 or so to buy a 2,400-bps modem with 
built-in error correction (which guards against phone 
line disturbances and the resulting garbled data) and 
data compression (which lets your modem transmit at 
speeds as high as 9,600 bps). 

Buying 9600 Baud And Beyond 
When buying a 9,600-bps or faster modem, make sure 
it's configured for the Mac and has a cable capable of 
hardware handshaking, which controls the data flow 
between your Mac and your modem. Hardware hand­
shaking is less likely to result in garbled data than is 
software flow control (the XON/XOFF option in your 
telecommunications software's settings file). 

Surge Protection For Your Modem 
Resist the temptation to buy a surge suppressor for your 
modem. Unless you live in an area prone to severe light­
ning storms, you probably don't need one for your 
modem. If you do, have your telephone company install 
a protector on the phone line going into your house or 
business-you'll get more effective protection. 

Buy An Long RJll Cord 
Buy a replacement RJ-11 phone cord when you buy 
your modem. Most modems come with a 7- to 13-foot 
cord; a 25-foot cord is much more convenient. You can 
pick one up wherever telephone equipment is sold. 

Check Out The Power Before Buying It 
When comparing modems, check out the power cube 
that plugs into the electrical socket. Some cubes are so 
large that they can't fit into a power strip or outlet 
without blocking other outlets. 



Looking For A Bargain 
If you are looking for a bargain but don't want to sac­
rifice quality, you can get a low-cost 2,400-bps modem 
for around $100. To complete the package, buy a serial 
cable from an electronics store for about $10 and get a 
public-domain telecom program, such as ZThrm, from 
a user group or an on-line service. 

Buying For The Bundle 
Find out what software is bundled with the modems 
you're looking at. You'll get the most use out of full­
featured telecommunications software such as 
Smartcom II, MicroPhone II, and White Knight rather 
than a generic terminal-emulation program. 

Consider buying a modem that can send faxes. For 
this extra convenience, you'll add only $25 to $50 to 
the price of a 2,400-bps modem. 

The Best Data Compression To Buy 
The data-compression standard to look for is MNP 
Class 5 or V.42bis. Your best bet is a modem that has 
both standards; if that's not possible, go for V.42bis, 
which advertises compression ratios of up to 4:1. Class 
MNP 5 offers up to 2:1 compression. 

Pinouts For Serial Connectors 
Below are two standard pinouts for the serial interface 
on modem cables, the Macintosh serial port pinout 
and the common PC RS-232 connections. 

Macintosh Serial-Port Pinout 
Pin Name function 
1 DTR Data Thrminal Ready 
2 CTS Clear To Send 
3 SD Send Data 
4 SG Signal Ground 
5 RD Receive Data 
The Most Popular RS-232 Connections 
Pin Name Function 
1 PG Protective Ground 
2 TD Transmit Data 
3 RD Receive Data 
4 RTS Request 1b Send 
5 CTS Clear To Send 
6 DSR Data Set Ready 
7 SG Signal Ground 
8 CD Carrier Detect 
20 DTR Data Thrminal Ready 
24 (E)TC External Transmitter Clock 

MONITOR 
The Thin Black Line 
The Apple 13-inch high-resolution RGB monitor has a 
dark thin line that runs horizontally across the screen 
approximately two inches from the bottom. 

This is a specific design in the Sony tube, and nothing 
can be done about it. According to a technical note on 
AppleLink (Apple's on-line service), Sony's design for 
this monitor's tube causes a single thin black horizon­
talline to appear one-third of the way up from the 
bottom of the screen. It's caused by the horizontal sta­
bilizing wire for the colormask grid (the grid is a set of 
vertical wires that blocks the electron beam from hit­
ting color phosphors other than the intended one). 
This is inherent in the monitor technology, which, 
according to Apple Computer, is the best there is. 

Despite this, the Apple monitor is one of the best. How 
pronounced the black lines is varies among monitors. 

Preventing Video Burnout 
'Ibm the screen intensity down when you're not using 
the machine. This prevents images from burning into 
the video tube. If you have a separate monitor, you 
can tum it off without disrupting your files. Using a 
program like After Dark or Pyro accomplishes the 
same thing. 

Cleaning The Screen 
Do not forget that your Mac screen is extremely sus­
ceptible to inadvertent damage. Never use glass clean­
er on it or touch it with anything but a very soft cloth. 
Better still, use a commercial CRT cleaning product 
designed specifically for use on computer monitors. 

Two Or More Monitors, Simultaneously 
One of the nicest features of the Mac II series is that 
you can have as many as six monitors hooked up at 
the same time (each one requires a separate NuBus 
card), and you can arrange them any way you like, 
using the Monitors Control Panel (cdev). 

To specify which monitor will show the Startup screen, 
choose Monitors from the Control Panel and hold 
down the Option key. When the Happy Mac icon 
appears, drag it to the monitor you want to specify as 
the main monitor and then reboot. 

~[ 
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Monitor Annoyances 
There are several factors that can make your life in 
front of a monitor either pleasant or hellish. One of 
these so-called nuisance factors is glare. A monitor 
with good glare protection lets you reduce brightness 
and preserve focus. 

Also, check a monitor for flicker, jitter (image insta­
bility), bandwidth problems, screen shrinkage, and 
noise. Refresh rates above 65 hertz are usually suffi­
cient to eliminate visible flicker. 

Monitor Resolution 
Exactly how much infonnation a monitor can display 
depends on its resolution, which is measured in pixel 
dimensions and dpi (dots per inch). Pixel dimensions 
are the height and width of the active screen as mea­
sured in pixels (picture elements, or dots); the dpi figure 
indicates how closely these pixels are packed togethet: 

Most of the monitors have screen resolutions of 72 dpi, 
the standard set by Apple for a one-to-one (WYSIWYG) 
match with what appears on paper. A higher dpi yields 
images that are smaller on-screen than they are on 
paper; a lower dpi magnifies the display. Higher reso­
lutions can make the screen appear sharper, although 
text may be almost too small to read; a lower resolu­
tion lets you work farther from the screen and is good 
for presentations. 

Bouncy Image 
If your monitor's image jerks or bounces occasionally, 
your monitor's high-voltage regulation circuit has a 
problem, which is evident when large areas of the 
screen change from white to a darker color. It's a 
harmless problem and can be adjusted if you wish, 
although the monitor's focus and linearity will need 
to be tweaked afterward. 

Two Monitors Interfere With Each Other 
There really isn't much you can do if you have two 
monitors side-by-side and they are interfering with 
each other. The interference is most severe between 
monitors with different refresh rates, in which case, 
the one with the highest refresh rate suffers the most. 

Metal shields between the monitors are ineffective, 
and poor electrical grounding can exacerbate the 
problem. You can try positioning the monitors so that 
the rears are as far apart as possible, with the screens 
angled in toward each other. But the best policy 
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remains one of prevention: if possible, check the mon­
itors you'll be using together beforehand to 
see if they interfere with each other. 

Games Get Less Coverage On A 12- Inch 
Monitor? 
Few applications are written to work well with Apple's 
12-inch color monitor. Most word processors, database 
managers and spreadsheet programs don't care what 
size monitor you're using. Users can always resize 
windows and scroll; the tool palettes can fit in even 
the tiniest screen; and anyone who designs a menu 
bar that's wider than 512 pixels should have his pro­
grammer's beanie taken away immediately. 

But games generally don't take advantage of the Mac 
interface; they paint and animate all over the screen, 
so special versions have to be written for each monitor 
type. Most games are written for a 13-inch color dis­
play (640 x 480 pixels), and when you try to play 'em 
on a 12-inch screen (512 x 342 pixels). 

One solution may be Stepping Out II, from Berkeley 
Systems (1700 Shattuck Avenue, Berkeley, CA 94709; 
[510] 540-5536). It sets up a virtual screen of just 
about any size. When your mouse pointer reaches the 
edge of the real screen, the display will scroll to reveal 
additional real estate. It works just dandy in programs 
such as PageMaker and Excel, but it's less of a smash 
hit ~ith games. You still won't be able to see more 
thru1512 x 342 dots at once, and if the Lizard King is 
setting up a mortar off-screen, you're going to wish 
youtl spent the $800 for a 13-inch monitor. 

To save money, look at third-party monitors such as 
the Sony CPD-1304, the Seiko CM-1445, or the NEC 
3FGX. To save a lot of money, buy an IBM-type VGA 
color monitor instead. Apple made sure that the 
Mac LC's video port would be compatible with these 
popular (and cheap!) monitors. You'll need an 
adapter such as the Mac VGA ($25), manufactured 
by james Engineering ([510] 525-7350), to use one 
of these monitors. 

MOUSE 
Solving Mouse Ball Sticking 
1b keep your mouse on the ball, check the ball your 
mouse is on. If your mouse sticks and hesitates even after 



a thorough cleaning, it may be the ball tl1at needs replac­
ing. Thke it out and examine it closely. If you see any 
small bumps or irregularities, you've found the culprits. 
You can get a new ball from your Apple dealer (Apple part 
number 699-8001 for the Plus or 699-8038 for the ADB) 
for about $9. 

The Frozen-Mouse Syndrome 
One of the most irritating software crashes occurs 
when your mouse becomes paralyzed. The keyboard 
continues to work, the screen is still functioning 
(clocks and screen savers work fine), and you can 
continue to direct the Mac with keyboard commands, 
but the blinking cursor or arrow controlled by the 
mouse doesn't move. 

There are several possible explanations for this, so let's 
start at the beginning. A lot depends on whether or 
not your Macintosh has ADB (Apple Desktop Bus) 
connectors for the mouse and the keyboard. Mouse 
deaths occur far more frequently on ADB machines, 
because the mouse is just a single element in a some­
what fragile chain of devices. 

There are many ways for the mouse to get lost in the 
chain. You may have too many devices daisy-chained 
together- if you have more than three devices con­
nected at once, there might not be enough juice in the 
bus to keep track of all those mice, trackballs, and 
keyboards. Or perhaps your mouse was disconnected 
from the bus and reconnected with the Mac still 
turned on -once an ADB device has been removed 
from the chain, the Mac usually can't find it when it's 
plugged in again. Or perhaps one of the ADB connec­
tors on the chain is dirty-you can clean it (careful­
ly) with isopropyl alcohol. 

It's also possible that something has broken (most 
likely the mouse, the ADB connector, or the device it's 
plugged into). Another possibility is that the program 
you're running isn't compatible with an INIT or cdev 
that works with your mouse, such as the Mouse cdev 
(Control Panel Device) or the cdevs that come with 
some third-party pointing devices. If you have a third­
party device, call the manufacturer and ask if there 
have been similar complaints. 

If you have a Mac that doesn't use ADB (the Mac Plus 
or earlier), then the list of potential problems is some­
what narrower Hardware-wise, it might be a dirty 
mouse connector or a loose connection in the mouse 

itself. In these cases, all you can really do (short of­
shudder- taking the Mac to your dealer for a check­
up) is clean the mouse connectors or borrow a pal's 
mouse and see if it works on your Mac. Some software 
can clobber the mouse on the Plus, too. One such 
error is so common that Greg Dudek wrote a share­
ware Fkey for Mac Plus owners called Defrost that can 
(sometimes) bring your mouse back to life after it 
freezes on-screen. 

If mouse-freezing is so common on your Mac that it 
really cramps your style, take some preventive mea­
sures. Install the Easy Access INIT that's part of Apple 
system software. Once it's installed, press Command­
Shift -Clear at anytime and Easy Access turns your 
numeric keypad into a mouse (the 8 key is up, 2 is 
down, and so on-the details are in your system soft­
ware manual). Easy Access works well enough for you 
to calmly save all your work if the mouse freezes, quit 
the current application, and politely restart your 
machine. 

One last tip: never plug in or unplug an ADB device 
without first shutting down your Mac. If you do, the 
mouse freezing might occur as a result of a damaged 
ADB chip. If that's the case, a trip to an Apple dealer for 
repair is necessary. 

Making Your Mouse A 'lhlcing Tool 
Here's a low-tech way to transfom1 your bulky mouse 
into a halfway decent tracing tool. 

Let's say you want to draw something moderately diffi­
cult such as a map of]amaica to include in a letter with 
directions to your estate in Spanish Town. 

1. Get a paper clip. (Mac tips don't come much simpler 
than this.) 

2. Bend the clip so that one end comes away from the 
rest at 90 degrees. Bend that point down 90 degrees. 

3. Tape it to the top of your mouse. 

4. Use the overhanging end of the paper clip to trace 
the map from an atlas or a map of a decent size. The 
mouse will "draw" along. The flatter the surface, the 
better It takes a little practice, but it works and 
enables someone with no artistic flair to do a fairly 
creditable job. 

79 



PARTITIONS 
Caveats About Partitioning A Hard Disk 
1\vo caveats: First, most partitioning software doesn't 
allow you to create or resize partitions without reini­
tializing the whole disk first (destroying any and all 
data already there), so you may have to invest some 
time in backing up your hard disk before the magic of 
partitioning can take place. 

Second, you need to make sure the partitioning pro­
gram creates true SCSI partitions. Fake, or "soft," par­
titions require that you install an INIT before you can 
mount and access the partitions, so they aren't nearly 
as convenient. 

POWER 
What Happens When You Turn Off Your 
Mac? 
Information sits in two places in a computer. You've 
got your system memory (RAM), and you've got your 
disk memory. System memory is in SIMM modules in 
your Mac, but information stays in place only while 
there's current flowing. Disk memory (a floppy-disk 
drive, a hard-disk drive, a tape drive, a cartridge drive) 
stores info by recording patterns of magnetism on the 
disk, cartridge, or whatever It's a slower process, but 
the selling point is that the info will stay put whether 
currents flowing or not. 

So what happens when you turn off your Mac? 
Everything in system memory is erased, but stuff you 
saved onto your hard disk stays put. So, if that word­
processing document you're working on is of any 
importance, youtl better save it to disk. Save early 
and save often, too; you never know when a system 
crash or a power fluctuation will force you to switch 
off your Mac. 

Never just cut the power to your Mac; always do a civi­
lized shutdown from the Finder's Special menu first, 
or you might find things in considerable disarray 
when you fire your pal back up. Also, when you first 
buy a Mac keep it turned on for a while (more than a 
few days) -and do that with all the electronic 
equipment you buy. If there's a defect or a weak solder 
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joint or something, it'll force the defect to surface 
while the unit's still under warranty. 

POWER SWITCH 
'&oubleshooting Power-On Problems 
Below are some techniques and questions to ask when 
troubleshooting poweF-switch problems. If your Mac is 
still under warranty, leave repairs to your dealer. Don't 
attempt anything you aren't comfortable with, shut 
down before opening the case, and handle all compo­
nents with the greatest care. 

If pressing the power-on switch intermittently fails to 
start your Macintosh II, Ilx, or Ilfx, read further. The 
usual problem is a weak battery on the motherboard. 
On the II, Ilx, and Ilfx, there are two 112M lithium 
cells located under the drive bay. (One battery powers 
the power-on key, and the other powers the clock and 
PRAM. The Ilcx and Ilci's power-on keys are powered 
by a 5-volt "trickle" line on pin 10 of the power supply.) 

To test the cells, press the poweF-on key and read the 
batteries' voltage with a digital multi meter (available 
from Radio Shack or other electronics-supply stores 
for about $40). Good cells generally read from 3.2 to 
3.7 volts and weak cells read from 2.3 to 3.2 volts. Any 
cell that falls to less than 2.15 volts is considered dead. 
Newer Macintoshes have a battery box that lets you 
simply pop the batteries out to replace them. On older 
Macintoshes the original batteries are soldered in, but 
you may be able to find a dealer who can retrofit your 
board with a removable battery holder. 

POWERBOOK 
linking The PowerBook To SCSI Devices 
To connect the PowerBook (100, 140 and 170) to a 
SCSI device that has the smaller 25-pin connectors 
instead of normal 50-pin SCSI connectors, what you 
need is the HDI-30 SCSI Disk Adapter cable - the 
one designed to allow the PowerBook to be used as a 
SCSI disk when connected to a desktop Mac- and a 
standard Apple SCSI System Cable. (The Apple part 
numbers are M253911JA and M0206, respectively.) 
Plug the HD.I -30 cable into the PowerBook, the sys­
tem cable into the SCSI device, and connect the 



ends, with a terminator or two in the middle. 

Another solution is from La Cie Ltd. of Thalatin, Ore.; 
they have special both "male" and "female" varieties of 
an HDI -30 to 25-pin SCSI cable for $49 each. The part 
nwnbers are 285-0031-00 and 285-0030-00, respec­
tively. La Cie is at (503) 691-0771 or 800-999-0143. 

Booting When SCSI Devices Are Connected 
When an external SCSI disk is attached to a 
PowerBook, the computer will boot only if this disk 
is turned on. Unfortunately, that's pretty much the 
way things are with the PowerBooks. They don't have 
enough spare power to compensate for the added 
drain of the termination on the external SCSI chain. 
Turning on the external drive supplies this power. The 
original Mac Portable has the same problem, if that's 
any consolation. 

Using The Old Portable Power Supply 
It is not recommended that you use the power supply 
from an older Mac Portable with a PowerBook. The 
PowerBook power supplies are rated at 7.5 volts at 
2 amps; the old Portable supplies are 7.5 volts at 
1.5 amps. At best youtl have a very slow charge. 

Shutting Down The PowerBook 
Whether you've got a PowerBook, a Portable, or even 
an old Mac Plus, you should never tum off a Mac with­
out doing a shutdown from the Finder first- individ­
ual files and even the integrity of the whole hard disk 
may beoome corrupted. At best, nothing will happen, 
but at worst, the data structures recording important 
details about the disk's data will be completely hosed. 

So don't just switch the thing off by pressing the power but­
ton in the back of the PowerBook. If you don't have time to 
shut down and power off properly, the next safest thing is 
to switch into Sleep mode. The Official ~rd from 
Cupertino is that it's not safe to move a sleeping 
PowerBook, because you might crash the hard drive. In 
reality, it's highly unlikely that you'll do any damage to it 
unless you're one of the Flying Karamazov Brothers. 

Startup With The Battery Control Panel 
If you place an alias of the Battery control panel in 
the Startup Items folder, it will appear on the desktop 
when you start up, and you can easily tell how much 
power is left in the battery. 

What Is That Audible Click? 
Have you noticed that the PowerBook makes a click 
sound during the power-up chime or before playing or 
recording a sound? What you're hearing is a side effect 
of the PowerBook's power-management circuitry cut­
ting the power to the sound chip. This happens auto­
matically about 30 seconds after the last sound is 
played. When accessed again, the revival of current 
causes a brief audible click. 

Reducing Backlighting 
In a well-lit room, the 170's active-matrix screen can 
be used with backlighting turned completely off, but 
even partial dimming saves power. The 140 and 100 
screens are unusable without some backlighting, but 
keep it as low as you can. 

Determining The Cache Size 
The Memory control panel has a cache-size that 
should be adjusted, depending on how much memo­
ry is installed in your PowerBook. The cache size 
determines how often you access (and wake up) your 
hard-disk drive. 

R>r a 2-megabyte PowerBook, set the cache to 64K; for 
4 megabytes, set it to 128K; for 6 megabytes, 192K; and 
for 8 megabytes, 256K. 

Setting Up A RAM Disk 
If you have 6 or more megabytes of RAM, set up a RAM 
disk as a startup disk. This technique is especially use­
ful for PowerBook 100 owners, because they can shut 
down their Macs without losing the RAM disk. To find 
out how to create a RAM disk, see page 108 of the 
PowerBook User's Guide. 

Don't Battery Power Virtual Memory 
Don't use virtual memory when you're running on 
battery power. 

Draining The Batteries 
Apple recommends that you drain the nickel-cadmi­
um batteries that come with the Power Book 140 and 
170 once every three months. Whether this process 
actually improves performance is debatable, but it 
can't hurt. 

1b drain the battery, leave the PowerBook on and ignore 
the successive warning messages that you are about to 
run out of power. The PowerBook 100 uses lead-acid 
batteries, which should never drain completely. 
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Recharging The Batteries 
When you're recharging batteries, make sure that 
there's power coming from the electrical outlet. The 
charging indicator in the Battery DA tells you that a 
plug is physically inserted, not that any electricity is 
flowing through it. You might see a warning dialog 
box that tells you that the plug is inserted without any 
charging occurring, but this happens only if your bat­
tery level is already below a certain point. 

Battery Life 
Apple says that batteries should last a year if well cared 
for. That's probably a conservative estimate, but if a bat­
tery doesn't seem to hold a charge, it might be time to 
replace it. When the battery life is up, take it to your Apple 
dealer for recycling. 

Microprocessor (Clock) Speed 
For PowerBook 170 owners, an important part of 
extending battery life is turning the Power Saver 
option on in the Battery DA (you need to click on the 
flag at the right of the palette to display this option). 
This causes the microprocessor speed to switch from 
25 megahertz to 16 megahertz, which Apple says can 
extend battery time by 30 minutes. 

HardDrivePowerDndn 
The PowerBook's hard-disk drive is a big power drain, 
so the less you access it, the better. 

Use Sleep Mode 
Keep your drive in Sleep mode as much as possible. 
From the Portable control panel, set the hard disk's 
Minutes Until Automatic Sleep at between one and 
two minutes. This stops the drive from spinning auto­
matically when you aren't accessing it. 

Tuning The Sleep Mode 
The Portable control panel also lets you set how many 
minutes your PowerBook can be inactive before the 
entire system automatically goes to sleep. Set this con­
trol panel for convenience, but don't rely on it as a way 
to put your PowerBook to sleep. It's better to get in the 
habit of manually putting the PowerBook to sleep 
whenever you plan to stop working for more than a 
few minutes. 

Loading Disk-Intensive Applications Into 
Memory 
On the road, avoid using disk-intensive applications 
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such as HyperCard, database programs, or anything 
that uses QuickTime. If an application gives you the 
option of keeping the program or files in memory (as 
Microsoft Word does, for instance) and you have 
enough RAM, do it. 

Open Files In Batches 
Open files in batches rather than il;1dividually when 
you know you're going to be working on several docu­
ments simultaneously. This trick avoids making the 
disk spin up more than once. 

Don't Idle In 'Ielecommunications 
Applications 
Quit from telecommunications applications as soon as 
you're finished using them, because the modem con­
tinues to use power while the applications are open. 

Battery Charging Tune 
Battery charging times, like most things in life, are 
the result of compromise. With standard NiCad and 
lead-acid batteries, the life of the battery is almost 
inversely proportional to how fast it's charged. A bat­
tery good for, say, 1,000 charge/discharge cycles 
when charged over an eight-hour period might be 
good for only 500 when charged over a two-hour 
period. Nickel-metal-hydride batteries seem to take 
fast charges somewhat better. 

For most batteries, optimal charging times are in 
the 14- to 16-hour range, but few folks will put up 
with that. The four- to eight-hour charge times used 
by most portables are a reasonable compromise. Any 
computer that fully charges its batteries in an hour 
will fry them in relatively short order. 

SCSI'Iennination 
The PowerBooks offer a new twist in termination, 
which is all too easy to miss, potentially resulting in 
erratic behavior with external SCSI devices and dam­
age to files and directories. 

The rule for termination has always been, "You can 
have no more than two terminators in the entire SCSI 
chain." Any internal hard disk had to be tenninated and 
counted as one of the two tenninators. 

PowerBook internal hard disks, however, are not ter­
minated normally. When figuring out termination for 
PowerBooks, you must proceed as if there were no 
internal terminator. One external terminator should 



go on the HDI -30 SCSI System Cable, and a second 
terminator must be present at the end of the external 
SCSI chain- even if there is only one external device 
present. (In that case, you'll end up with two termina­
tors side by side.) 

Like the Mac Plus and Mac Portable, the PowerBooks 
are incapable of supplying tennination power to 
external devices. This means that some SCSI devices 
may work when connected to a Mac II -family comput­
er or a Mac SE but not with a Plus or PowerBook. The 
solution in this case is to modify or replace the SCSI 
device or to add an additional device that provides 
proper termination power. 

If you want to connect a PowerBook 100 to another 
Mac as an external disk, using the HDI -30 SCSI Disk 
Adapter, things get even more complicated. The num­
ber and location of tenninators in this situation 
depend on the exact model of the other Mac and 
whether or not it has an internal hard disk. 

The gory details are spelled out in the Macintosh 
User's Guide for Macintosh PowerBook Computers 
(see Chapter 15), along with the other rules described 
above. 

X Rays From Airport Luggage Scanners 
X rays don't affect magnetic media and can't hurt your 
PowerBook. Some worry that the magnetic fields from 
the electric motors that power the conveyor belt 
through the X ray machine can affect disks, but veri­
fied instances of this happening are few; and reports 
from pilots and travelers who run their laptops 
through airport X rays dozens of times per year indi­
cate there's really no problem at all. 

PowerBook Slow-Downs 
You may notice that your PowerBook slows down sud­
denly and randomly. This is caused by your 
PowerBook dropping into Rest Mode, a battery-saving 
feature that drops the clock speed of the system after a 
period of inactivity. It's not at all obvious, but you can 
disable this feature with the Portable control panel. 
Hold down the Option key and select "Minutes Until 
Automatic Sleep." A dialog box will appear explaining 
Rest Mode and giving you the option to disable it. 

Double-Check The Validity Of The 
Ughtning Bolt 
There are few things more frustrating than having 

your Power Book battery die 10 minutes after the plane 
takes off, especially when you charged it up the night 
before. Be careful- the lightning bolt charging indi­
cator will appear initially when you plug the charger 
into the PowerBook- even if the charger's not 
plugged into an outlet or the outlet's switched off. 

Power-Down 
If the PowerBook 100 gets stuck after a crash or a 
start-up problem in which you lose control of the 
computer, it can be tricky to get it to shut off power 
so you can disconnect a SCSI device safely. 

There are two ways to get it turned off. One is to push 
the Reset and Interrupt buttons simultaneously. A 
cruder technique is to switch off the "storage" switch, 
after removing the external AC power adapter if it is 
plugged in. 

Appletalk Advice: Don't Let Sleeping 
Powerbooks Lie 
If you take a Mac PowerBook outside the office, and 
then return and plug it into the network, you might 
have trouble using network services. The problem is 
AppleTalk's dynamic node addressing. Each AppleTalk 
device chooses a network node number when it starts 
up - usually the same one it had been using. 

But if something else on the network has taken over 
that number, then the device chooses a new one. 
PowerBooks coming out of Sleep mode, however, do 
not choose new node numbers. When you connect a 
sleeping notebook to a network, it might continue 
using a node number that's been reassigned. 

Restarting the PowerBook immediately after connect­
ing is the simplest solution. If you don't want to 
restart, you can do the following: wake the 
PowerBook, open the Chooser desk accessory and 
tum off AppleTalk; then connect the notebook to the 
network and tum on AppleTalk. 

Fax Modem Communications With 
AppleFax Modems 
just in case you were wondering, the new Power Book 
Fax/Data Modem cannot communicate with the older 
AppleFax modems in the latter's special data mode. 

Dim Your Screen Whenever Possible 
The PowerBooks' backlit screens are their biggest 
power consumers. The rule of thumb is to keep your 
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screen as dim as possible whenever your machine 
isn't plugged in. 

PRINTER 
Getting Manual Feed To Do Multiple Pages 
You can usually get a laser printer's manual feed to 
work with multiple pages automatically- if you 
master a simple technique. Fan your stack of letter­
head slightly, so that the leading edge of the stack 
looks like a little staircase. Gently slide the stack into 
the manual feeder, being careful not to disrupt the 
"staircase': The printer should feed the pages one at a 
time. 

Depending on your printer, you should be able to reli­
ably feed four to eight pages using this method. Don't 
make the stack too thick (five pages seems like the 
maximum), and don't overdo the fanning, because if 
the pages are staggered more tl1an aoouple of millimeters, 
they won't feed continuously. 

Splotching 
When printing, if some areas of black are splotched dark 
gray, you're probably running low on toner powder Take 
out the cartridge, and rock it back and forth along its 
long axis to redistribute the toner. 

Semi-regularly spaced splotches of black down the 
length of the page usually mean there's some debris 
on the fusion rollers. Let the printer cool down, and 
then gently attack the rollers with a cotton swab or the 
cleaning pad that comes with your printer. 

Why PhotoGrade Is Not Working 
PhotoGrade is the halftoning software built into 
Apple's LaserWriter Ilf and Ilg printers. There are two 
reasons why it might not have a visible effect. 

The most common reason is simply a lack of mem­
ory. The 2 Mbytes of RAM that comes standard in a 
llf, for example, isn't enough; PhotoGrade requires 
at least 5 Mbytes to image a standard 
8.5 by ll-inch page. PhotoGrade requires 8 Mbytes 
of RAM for a legal-size page of graphics. 

The second reason is less obvious. LaserWriters and 
other Mac printers don't print true grays; they fake it 
using patterns of black lines or dots. Many programs 
allow users to adjust some of the parameters used in 
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these halftoning patterns, and one of these parame­
ters, generally expressed as lines per inch, can effec­
tively kill PhotoGrade if it's set too low. Apparently, 
PhotoGrade starts to work at about 106lines per inch, 
but many programs default to half that resolution. 
Check your program and change this parameter if it's 
possible. 

Not Black Enough 
If expanses of solid black show up as gray (but type 
and other small areas are OK) when you print, you've 
got an older-style engine that doesn't produce great 
solid blacks. Live with it. 

Thin line Down The Page 
Are you noticing a thin line down your printed page? 
If you're lucky, there's just a blot of dried toner on the 
cleaning pad next to the fusion rollers. Replace the 
pad. More expensive to fix is a scratch on the drum, 
because you have to replace the cartridge. The most 
expensive problem to fix is a scratch on the fusion 
rollers, in which case they need to be replaced. 

If the smear is splotchy and runs down one edge of the 
paper, then your printer's separator belt is probably 
either dirty or broken. Replace it. 

Controlling PostScript's Use Of Printer RAM 
Virtually all PostScript printers come with enough 
RAM to image a full8.5 by 11-inch page at 300 dpi. 
Any additional RAM will be used for font caching as 
well as other tasks, such as imaging complex 
PostScript instructions and holding other code sent 
from the computer (for example, the Mac sends 
TrueType font imaging code to PostScript laser print­
ers). How RAM is used is under the control of the print­
er's processor, and there's no easy way to adjust it. 

Thin White Line 
If there's a white horizontal line on your pages and it 
seems to be exactly one printer dot high, then most 
likely some of the memory in your printer has blown 
out. Fixing this requires a trip to the dealer or manu­
facturer. 

If the whole page is a uniform gray wash, first check to 
see if you're out of toner or whether the print-density 
wheel on the printer is set too low. 

Another possibility is that you've refilled the toner car­
tridge once too often and the drum is so worn that toner 



can't stick to i~ or maybe the paper's too moist. Humid 
air makes it tough for toner to cling to a page. The coro­
na wire may also need cleaning-see your printer man­
ual for instructions on how to clean it. 

Flaky Type 
If the surface of your paper is too rough, toner won't 
stick to it properly and will begin to flake off eventual­
ly. Switch to a smoother stock. If you're committed to 
the rough stuff, keep the toner in place by blasting the 
page with a setting spray (found in art-supply stores) 
or hair spray after you've printed it. 

'lboBlack 
Check the print-density wheel; it may be set too 
high. Alternatively, yank out the toner cartridge 
and check the printer's grounding spring. 

See the manual for the exact position, but usually 
you'll find the spring in the printer's lid, where it's 
supposed to make contact with the center of the car­
tridge and act as an electrical ground. Make sure it 
hasn't slipped out of place. 

QUADRA 950 
A Quadra 950 Video FIX And Update 
A quote from Apple's tech-info database: "When a 
color monitor is connected to the on-board video 
circuitry of some early Macintosh Quadra 950 sys­
tems, and the Monitors control panel is set to mil­
lions of colors, certain color-manipulation com­
mands may not work in some graphics-application 
programs." Huh? This problem, whatever it really is, 
is solved by a 3.5-Kbyte extension called the 950 
Color Addition. Apple says it is available on-line as 
well as from dealers and user groups. 

Quadra Internal Video Speed 
The Quadra 950's internal video operates about 20 per­
cent faster than the 900's because some wait states were 
removed. The faster CPU speeds things up a little more. 

Recording Stereo Sound 
The Quadra 900 has stereo output- but only 
monaural input. So, although the 900 and 950 are 
capable of playing back stereo sound, you can't record 
such sound directly. 

Convolution 
Convolution, a pixel-averaging feature that makes Mac 
video look better on traditional1V screens, is built in to the 
Quadra 950. The feature is used when you connect a 'f\L 
style video cable and set your monitor to 16-bit color or less. 
Quadra convolution doesn't wolk in 24-bit-color mode. 

Card Power 
The beefy power supply in the 950 can support cards 
that take more than their fair share. According to 
Apple, the 950 will power two 25-watt cards and three 
normal15-watt ones. 

SCSI 'Iermination Seeks The Inner Path 
The Quadra 900's internal bus is terminated on the 
motherboard and on the internal cable itself, so all 
internal SCSI devices should be unterminated. In all 
other Macs, including the Quadra 700, the (usually 
sole) internal SCSI device should be terminated. 

The Quadra 900's external bus operates like other 
Mac SCSI buses. So in general, the external devices 
should be unterminated, and you add a gray plug-in 
terminator to the last device in the chain. 

QUADRA 700 
SCSI Internal'Iermination 
The Quadra 700 needs internal termination, which is 
normally supplied by an internal hard drive. If no 
internal hard drive is installed, an internal terminator 
must be installed instead. The Apple part number is 
630-0408. 

QUADRA 
1\vo External Sound-Input Connectors 
The Quadra has two external sound-input connectors: 
a microphone jack and a pair of "line" inputs typical 
of stereo equipment. You can use both simultaneous­
ly; the sounds will be mixed together (and flattened 
considerably). 
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RAM 
Recycling 256K SIMMs For Video RAM 
If you have leftover 256-Kbyte SIMMs (single in-line 
memory modules) and want to use them as extra 
video RAM for a Mac LC, think again. The video RAM 
for the Mac LC (and the Quadra 700 and 900) is dif­
ferent from ordinary system RAM. Video RAM is "dual 
ported" -it can be accessed by two circuits at the 
same time, so the on-board video circuitry can read 
data from VRAM to create the screen image at the 
same time that the Mac CPU writes new data into VRAM. 

Your 256-Kbyte RAM SIMMs can't do this trick and are 
electrically incompatible in other ways as well. It's a 
sign of the times that 256-Kbyte SIMMs are almost 
worthless as RAM. They do, however, make nifty high­
tech earrings. 

Using A Slower Speed SIMM 
SIMMs (the memory boards that make up RAM) come 
in all speeds, and each Mac requires a mimi mum 
SIMM speed; for example, the Mac Ilci requires a 
speed of 80 nanoseconds. 

Placing slow SIMMs in your Mac won't slow your Mac 
down, but it will undoubtedly result in system errors. 
Look for an 80 printed somewhere on one of the 
memory chips to check for 80 nanosecond SIMMs. 

Memory-Upgrade Options 
When you want to add more RAM (random access 
memory) to your Mac, you add SIMMs. A SIMM is a 
single in-line memory module, which is a bunch of 
little chips attached to a small circuit board. 

When selecting SIMMs you should consider two factors. 
The first is how the actual chip attaches to the board. 
The two methods are surface mount (low profile) and 
DIP (high profile). You want surface-mounted SIMMs, 
no matter which Mac model you own, because there's no 
longer a difference in price between the two (DIP SIMMs 
used to be somewhat cheaper); DIPs generate more heat; 
and DIPs are taller, which may interfere with the future 
installation of an internal hard-disk drive or other 
peripheral. 

The second factor is speed. RAM speed is measured in 
nanoseconds (nsec), which are billionths of a second. 
The RAM in a stock Plus, SE or Classic runs at 150 nsec; 
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the RAM in a Mac II, Ilx, Hex, Classic II, LC or SFJ30 
runs at 120 nsec; the Mac Ilsi uses 100 nsec or faster; 
the factory-installed RAM in a Ilci runs at 80 nsec; the 
Macintosh Portable uses special low-power-consump­
tion SRAM (static RAM); the PowerBooks use special 
pseudostatic RAM; the Quadra 700 and 900 support 80 
nsec and faster RAM. The Mac Ilfx requires special G4-
pin SIMMs, which run at 80 nsec but are not inter­
changeable with the SIMMs in the Ilci. When purchas­
ing a RAM upgrade, check with the vendor to make sure 
you are getting the correct SIMMs and speed. 

TypesOfRAM 
Have you been wondering what is the difference 
between static, pseudo-static and dynamic RAM? 

Static RAM retains its data as long as power is avail­
able. DRAM does, too, but it will forget in a few mil­
liseconds, power or no power, unless the data is 
"refreshed." Extra circuitry is required to perform this 
refresh function. Why would anyone ever use DRAM? 
Because even with the refresh circuitry it can be made 
much smaller and cheaper than static RAM. But the 
refresh circuitry drains more power. 

Pseudo-static RAM is DRAM with the refresh circuitry 
built in. It's a reasonable compromise from cost and 
power standpoints and works well in Power Books. 

Whose RAM Should You Buy? 
If you are wondering whether to use genuine Apple 
SIMMs or if there really is any difference between 
Apple and third-party SIMMs, then it is difficult to 
tell that one RAM is better than another. 

Some feel that third-party SIMMs are better- they're 
less expensive, and most vendors have a better war­
ranty than Apple's. Apple doesn't make its own - they 
purchase SIMMs from the open market and from a 
variety of sources. 

There is no technical reason why Apple's DRAM is any 
better than third-party DRAM. Apple published the 
specs for the SIMMs, and they're turning up all over 
the place. 

So save yourself a few bu~ks, and get your RAM from a 
reputable third-party supplier. 

What Is GWorld RAM 
GWorld (pronounced "gee world") stands for "graph­
ics world." It's a data structure in memory comprising 



a graphic image and other data associated with it, 
such as color palettes. Nonnally, a GWorld exists in the 
main memory of the Mac, and the contents of an 
image are copied to the video memory on your video 
card as necessary. If you're moving a lot of data 
between main memory and the video card, as is the 
case with a large 24-bit-color image, the transfer over 
NuBus can become a bottleneck. 

If the video card has its own GWorld RAM, the entire 
GWorld is stored on the card, so changes made to the 
image are displayed more quickly. Apple's Macintosh 
Display Card 8*24 GC is one example of a video card 
with GWNote. However, not all applications now avail­
able use on-card GWorld memory. System 7's Finder 
will, as will SuperMac's PixelPaint Pro, Aldus 
PageMaker and Adobe Photoshop. 

SCANNER 
Calibrate Your Monitor 
When you're working with scanned images, you have 
to make critical color:-editing decisions based on the 
tonal ranges and color balance you perceive on-screen. 
A calibrated monitor can help these values match the 
final print as closely as possible. Both software and 
hardware color calibrators are available. If your moni­
tor is uncalibrated, set the contrast control to its center 
position and the brightness to about 80 percent. 

What Scanners Can Do 
Scanners convert an image into digital infonnation 
that is understood by the Mac and can then be edited 
on your Mac with image-editing software or in the 
case of OCR- with a word processot 

Buying A Scanner: Comparing Scanner 
Quality 
When comparing similar scanners, take along the 
kind of photograph, document, or piece of art you' II 
be scanning so that you can compare ease of use and 
the quality of results. 

Buying A Scanner: Gray-Scale And Large 
Images Require Memory 
Working with large images or images that contain 
several grays or colors? Look for a scanner that saves 
the file to disk rather than to RAM -gray-scale and 

color scanning require lots of memory. 

Buying A Scanner: Picking Up Fine Details 
If you need to pick up fine details or type in the work 
you're scanning, go for a scanner with a high resolution 
(expressed as dots per inch, ordpi). Keep in mind that a 
scanner with high resolution picks up dirt and flaws on 
the original art. Standard resolution is 300 dpi. 

Buying A Scanner: Remote Scan Option 
If you' II be using a sheet -fed scanner to scan several 
documents in succession (for example, if you're doing 
OCR work), look for a scanner that has a remote scan 
button, which lets you press a button every time you 
insert a new page to be scanned, as you would with a 
photocopier, or one that has an automatic document 
feeder. This will let you load the documents, start the 
scanner, and then get on with other work. 

Buying A Scanner: Scanners Sold With 
Imaging Software 
You'll probably pay more if the scanner comes with 
image-editing software - it can be the company's 
own software or a commercially available product 
such as a special version of Adobe's Photoshop 
(Photoshop LE, which doesn't include separation 
capabilities) or Letraset's ColorStudio. The advantage 
of such software is that you can scan and edit the 
image without having to switch among programs. 

Buying A Scanner: Photosbop Scanner 
Support 
If you own Photoshop and are looking for a scanner, 
look for scanners that include a Photoshop plug-in­
software that enables you to scan from within the pro­
gram. 

Buying A Scanner: OCR Software Support 
If you want a scanner for OCR work, make sure the OCR 
software included is easy to use and scans in text accu­
rately- otherwise you may spend as much time edit­
ing the text as you would have spent typing it. 

Buying A Scanner: Cheap Scanners 
For bargain hunters, most monochrome hand scan­
ners cost less than $500. The good news is that they're 
small and convenient and even let you scan on verti­
cal surfaces; the bad news is that they're suitable only 
for scanning small items such as logos and aren't 
good for extensive OCR work. 

~[ 

87 



Buying A Scanner: Macintosh Connections 
Detennine how the scanner you're considering conw 
nects to your Mac. Most connect via the SCSI port 
(some require a special interface box to do so), a few 
are connected through the modem or printer (serial) 
ports, and others require the installation of a special 
carcl. A SCSI connection has the advantage of fast data 
transfer and is easy to install (all Macs from the Plus 
up have a SCSI port), but to avoid connection prob­
lems with other SCSI devices, find out if it has a pass­
through connection. Otherwise, the scanner may 
need to be at the end of the chain, which can be 
inconvenient. 

SCSI 
Quadras And Apple OneScanner 
The SCSI chip in the Quadra 700 and 900 isn't thor­
oughly compatible with the Apple OneScanner. If the 
scanner is on before you turn on one of these high­
end Macs, the Quadra won't recognize the device. The 
solution is simple: Thrn the scanner off and on again 
after the Quadra is up and running. 

SCSI Stats 
Apple's official stats for Mac SCSI port speeds: The 
Quadra's ports can transfer data rates up to 5 Mbytes 
per second; the Ilfx runs at 3 Mbytes per second; all 
other models of Mac run at 1.25 Mbytes per second. 
Pass the salt. 

Coping With Single-Connector SCSI Devices 
SCSI devices with a single connector are loathsome 
things whose vendors have decided that saving a few 
dollars in manufacturing costs is more important 
than your time, effort and frustration level. If an alter­
native device with two connectors exists, buy it 
instead. 

If you're stuck with a SCSI device \vith only a single con­
nector, it's best to put it on the end of the SCSI chain -
remember to insert a tenninator between the device and 
the SCSI cable, though. You may be tempted to use a Y­
connector; however, they often cause problems on a 
SCSI bus. Avoid them if possible. 

SCSI Devices Powered Off 
It is possible to have several SCSI devices connected 
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while keeping some of them switched off some of the 
time, depending on how the device was manufactured. 
Most SCSI devices shut down the entire SCSI chain 
unless power is supplied to them. Some devices con­
tain a diode that allows you to tum them off and still 
use other connected SCSI devices. Unfortunately, such 
devices are in the minority, and it's not a feature that 
many manufacturers place high on their priority lists. 

The only way to tell whether a device will shut down 
the SCSI chain when the power is off is to try it. If your 
device is like most, though, you'll need to keep it 
turned on when you're using any of your SCSI devices. 

SCSI Device Setup 
Small-computeF-system-interface (SCSI; pronounced 
"scuzzi") devices connect to the Macintosh by way of 
the SCSI port in the back of every Macintosh from the 
Mac Plus on up, but they also introduce complications 
in the way the Mac reads signals-even from an 
internal hard-disk drive. Some conflicts are serious 
enough to damage your data or Mac, but most are 
common and easy to fix. The two most common points 
of SCSI confusion are addressing and tennination. 

SCSI devices are connected in a single daisy chain. A 
single daisy chain should not exceed 18 feet in length 
and each device must have a unique numeric address 
between 0 and 7; the Macintosh is a SCSI device with 
address 7, and in an SE or II, an Apple-installed internal 
hard disk in an SE or II has a default SCSI address of 0. 

Different devices have their addresses set in different 
ways- through software, through external DIP 
switches or simple push buttons or dials. Addresses 
must be unique, and two devices with the same SCSI 
address can cause System crashes or devices not to 
appear. Choosing certain addresses for each device is 
also important. When the Mac starts up, it checks to 
see if there is a disk with a System Folder in the floppy 
disk drives, then it checks for serially connected hard 
drives, and finally starts checking the SCSI chain. It 
looks at SCSI address 0 first and then jumps to address 
6 and continues downward, booting off the first sys­
tem it finds. The physical order in which you connect 
the SCSI devices doesn't matter- just their SCSI 
addresses. 

Thnnination is another SCSI principle. A tenninator is 
a resistor that reduces signal echoing along a chain of 
SCSI devices. It is recommended that only the first and 



last SCSI device be terminated, for a total of two ter­
minators. 

The internal hard disk in an SE or II has an internal 
terminator, but if you have a Mac Plus or an SE with­
out an internal hard disk, then you need a terminator 
at both ends of a SCSI chain. 

Many SCSI devices (hard disks, scanners) have inter­
nal termination, and the easiest way to find out is to 
check the documentation or call the manufacturer. 
Avoid peripherals with unremovable terminators. 

If a device does not have internal termination, then 
an external terminator can be placed into one of the 
two SCSI ports of the peripheral device, or into the 
cable before placing the cable on the SCSI port. 

SIMMS (SYSTEM 7) 
Accessing Memory Beyond 8 Megabytes 
If you recently upgraded your Macintosh to hold more 
than 8 megabytes, for example, four 4-megabyte chips 
in a Macllsi in order to have 17 megabytes, make sure 
to tum on 32-bit addressing. 

If you haven't turned on 32-bit addressing when you 
look at the memory bar in the About This Macintosh 
box (accessible from the Apple menu), you will find 
that the system files are hogging more memory than 
when you had less than 9 megabytes. You can tum 
on 32-bit addressing by going to System 7's Memory 
control panel. 

This works with most Macs, such as the LC, LC II, 
Classic II, Ilsi, Ilci, Ilfx, or Quadra. The II, Ilx, Ilcx, 
and SE/30 require that you install Connectix's 
MODE32, which Apple and Connectix have made 
available free to Macintosh users. You can download 
MODE32 from an on-line service such as AppleUnk, 
America Online, or CompuServe or contact your user 
group or Macintosh dealer 

'&oubleshooting SIMM Problems 
You may have a SIMM problem (Single Inline Memory 
Modules, or your RAM) if you see a blinking question­
mark icon or hear an error tone on startup. 

Immediately after their power button is pressed on, all 
Macs run an internal diagnostic program. The more 

RAM you have, the longer it takes. If the Mac passes the 
test and there's a startup disk on-line, the computer 
boots to the desktop. Otherwise the blinking question­
mark icon is displayed. If you hear an error tone when 
you start up a Mac II, it can mean SIMM problems. 

'lest the SIMMs by replacing them with another set. 
Your SIMMs may be defective, in which case you need 
to replace them, or they may be too thick or too thin 
for the socket. It is possible to tighten the contacts on 
the sockets, but this is a sensitive operation and you 
need to use extreme care. To tighten the contacts, use 
a small, delicate tool such as a jeweler's screwdriver to 
move the contact wires closer together. 

SOUND 
Using Speakers 
If you're using a lot of sounds with your Macintosh, 
you might want to consider buying an external speak­
er or a pair of them. Almost any speaker will do, but 
you'll get the best results from a speaker with built-in 
amplification; if your speaker doesn't have a built-in 
amp, it won't be very loud. 

MacSpeakers are designed specifically for use with a 
Mac (Persona Thchnologies Division of Monster Cable, 
274 Wattis Way, South San Francisco, CA 94080; 
[ 415] 871-6000). They sound great, they look great, 
and they're packed with features: 10 watts per chan­
nel, external controls for bass and volume, simulated 
stereo, and sturdy shielded cases. 

For less expensive speakers, check your local Radio 
Shack store. Radio Shack carries several inexpensive 

. speakers with built-in amplification. They won't 
sound as good as the MacSpeakers, but they are a lot 
less expensive. 

STYLEWRITER 
Driver Versions 
According to Apple, all versions of the Style Writer driv­
er are compatible with all system-software versions 
since 6.0.7. 

The latest Style Writer driver is included with both ver­
sions of the System software. You also can purchase 
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the Style Writer drivers as part of an expanded 
True Type font set for $18 by calling Apple at 
800-974-5176. 

Reducing Printing Ttme For Large 'lext 
Documents 
Here's how Style Writer owners can reduce printing time 
for large word processing documents. The Style\Vriter is 
definitely no speed demon when used with any romputer 
less powedul than a Mac LC. But if you don't mind if the 
print quality is slightly less than the best, try this: 

Use a bold True Type font for your text. When the Print 
dialog box appears, choose the PrintFaster option. The 
document will print in about one-third of the time, 
and the output will be almost as good as that of the 
best printing quality. 

SURGE PROTECTORS 
What's The Best Kind Of Surge Protector 
For Your Mac? 
Surge protectors are designed to protect electrical 
equipment- such as your Macintosh- from sud­
den surges of electricity. You might find one very 
useful if you've been experiencing power problems, 
if your power cuts off suddenly, or if you have an old 
power system and have been experiencing sudden 
electricity cuts. 

Surge protector prices range from less than $30 to 
more than $200. The best surge protectors use silicon 
diodes, which have a reaction time of 5 billionths of a 
second and a clamp level of 220 volts. This technology 
apparently is superior to that of the standard MOVs 
(metal-oxide veristors) in all other surge protectors, 
which react too slowly and clamp at about 500 volts. 

Surge suppressors get hyped a lot. To avoid getting 
burned, make sure that both the packaging and the 
product carry the UL (Underwriters Laboratories) 1449 
trademark ( 1449 refers to the UL surge suppressor test). 
Counterfeit UL trademarks on some surge suppressors 
usually lack the 1449 designation. 

Also, look on the packaging for the designation "UL 
Usted 1449 Suppression Voltage LN 400/L-G 400/N-G 
400," which means that the suppressor clamps at 400 
volts when power surges across the line, neutral, and 
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ground wires of the circuit. This is appropriate for 
Macs and their peripherals. The best UL rating, 330 
volts, isn't mandatory. 

The response time needs to stay at less than one mil­
lisecond, and most, if not all, UL 1449 suppressors are 
this fast. Buying a faster suppressor is like putting pre­
mium fuel into an automobile that's rated for regular. 

No surge suppressor works against direct lightning 
strikes- for that, you need a surge arrestor. Your local 
power company can probably install one on the line 
leading into your home or office for less than $300. 

SYSTEM PERFORMANCE 
Speeding Up A Mac With A Cache Card 
For most Macs, a cache card gives you the most bang 
for the buck. For just a few hundred dollars, the real 
speed of your Mac can go up by about a third. 

A cache card is a card with special, wicked-fast RAM 
on it-information can move through it about four 
times as fast as through the RAM on the mother­
board- and the card uses this fast RAM to hold 
whatever information the CPU has just called up 
from memory. So, the next time the CPU asks for that 
same information, instead of reading it from the 
100- or SO-nanosecond RAM that makes up your 
regular system memory, it comes in from the 20-
nanosecond RAM on the cache card. 

The more expensive the cache card, the more cache 
memory you get. 

In theory, more cache memory equals more speed, but 
in practice, the jump in speed from a 32K cache to a 
256K cache isn't all that impressive, ronsidering the 
extra expense. Cache cards are available for most 
Macs and are already built in to some. 

Speeding Up Your Applications By Adding 
More Memory 
More memory won't inherently speed up your Mac. It's 
just that the more memory your applications have to 
play with, the fewer times they have to run all the way 
to the hard disk for data. 

Allocating more memory to important applications by 
changing the number in the application's Get Info box 



will speed up individual application performance. 
There's always a bare-minimum amount of memory 
an application needs to run, but bumping that num­
ber up allows the application to keep more of itself in 
memory and less of itself on-disk when running under 
System 7 or MultiFinder. A general rule of thumb is 
that when you increase the memory allocated to an 
application by 15 percent more than the minimum, 
you begin to see a speed improvement- 25 percent 
gets you the most bang for the buck, but increasing it 
by more than 30 percent probably wastes RAM. 

THUNDERSCAN 
Solving Distortion With Acetate 
If you're getting a lot of unwanted distortion from 
your ThunderScan, try putting a piece of clear acetate 
over the item to be scanned. 

Focus in the high 50s and great scanned images will 
reduce possible distortion. Be sure the acetate lines up 
with the left-hand edge of your document to be 
scanned. Also, clean the lens on your scanner and 
adjust the height of your scanner cartridge (according 
to your printer manual) for optimum focusing. 

Adjusting Lines In A ThunderScan Image 

If you sometimes have trouble with just a few lines of 
a ThunderScan image, it may be because the scan­
ner is having trouble with the end of the timing tape 
installed on the left end of the ImageWriter roller. 

The easiest way to see if this is your problem is to scan 
an image at least 3-114 inches long that contains a 
series of vertical lines. Watch the Image window closely 
as the end of the timing tape passes under the scanner. 
If you see part of the vertical lines displaced to the left, 
it is probably because the timing tape doesn't reflect 
light back to the scanner accurately and the scanner 
misses its timing for a line or two. The problem is more 
noticeable if you magnify the image being scanned. 

An easy way to fix the problem is to carefully apply 
some typewriter correction fluid even with the edge 
of the tape to fill the gap. If you accidentally get 
correction fluid on the rubber roller, it can be 
removed with isopropyl alcohol. 

VIDEO CARDS 
Old Models 'Iake Over The Screen 
Some old-model Mac color video cards will take over 
your screen on start-up. When placed in the same 
machine as a newer card, they will act as the default 
monitor, regardless of your preferences. The old-style 
card nearest the power supply wins. 

Speeding Redraws: CPU vs. Video 
Acceleration 
Speeding screen redraws depends on what you are 
doing, and can determine whether you want acceler­
ated-video card or a CPU accelerator. 

If you're looking for general increases in video speed, 
such as faster scrolling, faster drawing and selection­
dragging operations in a paint program, an accelerat­
ed-video card will help, often dramatically. Using an 
add-in card's processor to move the pixel data around 
in the card's memory is much faster than having the 
CPU access and manipulate data over NuB us. 

Graphics operations that involve more than just shuf­
fling pixels- for example, manipulating multiple 
shapes in a drawing program or performing complex 
fills or curve-drawing operations that aren't part of 
QuickDraw -won't be helped by a video accelerator, 
since most of the work is in computing how the draw­
ing will be performed rather than actually drawing. In 
these cases a CPU accelerator will provide the biggest 
performance increase. 

'ftoubleshooting Video Card Problems 
You see colored blotches, static, or buzz lines on the 
monitor display. Find out if the monitor is in trouble. 
Connect it to another Mac, and see if the problem per­
sists. The monitor may just require Degaussing, which 
quite often is handled with a button in the back of the 
monitor (check the monitor manual). 

If the monitor's OK, then the problem is in the video 
card. (With a I lei and other Mac I I series with no 
external video card, the problem may be the video cir­
cuitry on the motherboard). To remove the card, turn 
the power off, wait at least 20 seconds, and then pull 
straight up on the card. Component-level repair of a 
video card costs about $115. 

If you do not have a picture at all, but the monitor is 
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plugged in and the power is on, try straightening the 
cord connecting the monitor to the video card or Mac 
(in the case of built-in video). Sometimes the cord 
needs to be untangled. 

Turning Off The RasterOps Video Card 
If you use a RasterOps video card in an SE30, there's 
no way to turn off the RasterOps card, if your control 
panel is set to display the menu bar on the external 
monitor. When you take your Mac out of the office 
without the external monitor, you have to remember 
to change the control-panel setting to display the 
menu bar on the internal monitor before you shut 
down the machine. 

One way around this problem is to boot from a floppy 
disk, but a better way is Under System 7, put an alias 
of the Monitors control panel onto the desktop of the 
internal monitor. Also make sure that you place the 
Monitors control panel on the internal monitor so 
that it opens up there rather than on the external 
monitor. Now, if you travel without the external moni­
tor, you can just open the Monitors alias, reset the 
menu to display on the internal monitor, and restart. 

HYPERCARD 

HYPERCARD 
Creating A Gray Drop Shadow Around A 
Field 
You can create a drop shadow around a field in 
HyperCard by assigning the shadow style to the field, 
but this method offsets the drop shadow only one way 
and restricts you to a solid black shadow. Here's a sim­
ple trick that lets you create a gray drop shadow that 
you can place anywhere behind the field. 

1. Choose the Field tool, and click on the field you 
want to give a drop shadow: 

2. Copy the field, and then immediately paste it, thus 
creating the drop shadow. 

3. Drag the drop shadow to the desired location on the 
original field. 

4. Double-click on the field, or choose Field Info from 
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the Objects menu. Check the lDck Thxt, Show lines, and 
Transparent check boxes in the Field Info dialog box. 
Click on the Font button, choose a font, and type a 2 in 
the point-size box. Click on OK. 

5. Select Send Farther from the Objects menu so that 
the drop shadow you've created appears behind the 
original field. 

By using the Browse tool, you can see how the drop 
shadow will look to users of the stack. 

HYPERCARD 2 
Using Handlers 
If you're not an experienced HyperCard author, you 
may not be aware of the usefulness of HyperTalk han­
dlers, especially those in the Home stack. 

A script is divided into individual handlers, each of 
which is a miniprogram of its own, and the many 
helpful handlers in HyperCard 2's Home stack can be 
accessed for use in all other stacks. Most of these han­
dlers are shortcuts you can type into the message box 
to trigger a lengthy process such as changing the 
default font in script-editor windows; others are useful 
utilities that aid stack design and maintenance. 

Getting Quick Info 
You can set several properties for stacks, backgrounds, 
and cards via the Stack Info, Bkgnd Info, and Card 
Info dialog boxes, respectively, which you access 
through the Objects menu. However, there's a quicker 
way of accessing these dialog boxes, using handlers. 

Hrst, access the message box via the Go menu 
(Command-M); type the letters s (for stack info), b 
(for background info) or c (for card info); and then 
press Return or Enter. 

Stack Info Handler from the Home Stack 
The Stack Info shortcut handler below does a great 
deal more than issue an equivalent doMenu com­
mand. Instead, it summons help from two other han­
dlers in the script- setUserLevelFive and 
restoreUserLevel- and then returns you to the pre­
cise tool and UserLevel settings you were using when 
you requested the object's dialog box. 

Stack Info Handler from the Home Stack: 



on s 
put the tool into save Tool 
choose browse tool 
setUserlevel Five - another Home 
stack handler 
doMenu "Stack Info ... " 
restorUserlevel - put things back 
choose save Tool- ditto 

ends 
For experienced stack authors, this may seem like 
overkill, because your UserLevel is probably already 
set to 5 (the Scripting level) and you're quite adept at 
choosing tools in the Thols palette. But if you're a 
beginner, these commands are helpful- they let you 
do what you want and then return you to your previ­
ous userLevel. 

The XY Home Stack Handler 
The xy handler in the Home stack can be used to 
measure pixel counts for layouts, which is particularly 
useful if you're doing animation work that might 
require precise starting and ending coordinates. 

To start the handler, type xy into the message box and 
press Return or Enter. The cursor turns into a cross 
hair, and the message box displays coordinate infor­
mation about the center spot of the cross-hair cursor. 
A repeat loop in the handler keeps showing you the 
cursor's x,y coordinates in the format accepted by sev­
eral HyperCard-object properties as well as which 
coordinate is vertical and which is horizontal. 1b stop 
the loop, simply click the mouse button- the cursor 
coordinates at the mouse-click location remain in the 
message box. 

Notice that if you drag the activated x,y cursor above or 
to the left of the windO\v, the corresponding coordi­
nates tum negative. The coordinates -like locations 
and sizes of all objects inside a HyperCard window­
are relative to the window, not the screen. Also, the zero 
point for a window is the upper left comer of the active 
window area, not the window's title bar. 

Neat Navigator Palette 
To demonstrate HyperCard 2's palette feature, the 
Home stack includes the requisite resources (types 
PICT and PLTE) and message-box shortcut to display 
what is known as the Navigator palette. The buttons 

in this palette are the same as the commands in the 
Go menu and are an example of what authors can use 
palettes for- replacing a menu or saving space on 
stacks written for use on small screens, for example. 
1b access the Navigator palette, type nav into the mes­
sage box and press Return or Enter. 

Palettes in HyperCard float in a different window stra­
tum from that of card windows- palettes always stay 
on the top level, and card windows are in the docu­
ment-window domain. Within that domain, you can 
shuffle several HyperCard windows in any order while 
the Navigator palette in the palette-window domain 
stays in front of the HyperCard windows. To accommo­
date this, one of the buttons on the Navigator palette 
replicates the Window command, letting you cycle 
through open HyperCard windows while keeping the 
palette in front. Note that windows in the palette 
domain are hidden when you switch from HyperCard 
to another program under MultiFinder or System 7. 

Two Debugging Windows 
1\vo helpful HyperTalk debugging windows­
Message Watcher and Variable Watcher- are not 
normally available unless you get the HyperTalk 
debugger running (this happens after you've encoun­
tered a script error, set a debugging checkpoint, or 
typed Option-Command-period while a script is run­
ning). Once the debugger is going, menu choices in 
the Debug menu (the one with the bug icon, of 
course) let you view either or both watcher windows. 

The Message Watcher window, in particular, gives you 
an X-ray view of the inner workings of scripts as they 
run. As a handler chums, a list of all the messages 
being executed appears in the Message Watcher win­
dow. This is often a valuable debugging tool without 
the debugger -showing you duplicate executions of 
handlers in complex scripts, for example. 

The Variable Watcher window is especially helpful 
when you're not stepping through a debugger-con­
trolled handler, because it shows you the state of all 
global variables when no scripts are running. 

If you want to see either of these watchers indepen­
dently of the debugger, simply type mw (for Message 
Watcher) or vw (for Variable Watcher) into themes­
sage box and press Return or Enter. These two Home 
stack handlers perform no black magic - both the 
Variable and Message Watcher windows are opened 
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when you start HyperCard but are hidden until you 
ask to see them. These handlers simply show their 
respective windows, but with far fewer keystrokes than 
typing the full commands (show window "Message 
Watcher" and show window "Variable Watcher"). 

A Handler To Find That Script 
In the original HyperCard Home-stack script, there 
was a practical utility handler that helped scripters 
slice through the scripts of all objects in a stack in 
search of any word or phrase. That handler, 
searchScript, has been enhanced in HyperCard 2, and 
it now comes with its own shortcut handler, ss. 

The searchScript (or ss) command requires one 
parameter and accepts a second. The first parameter 
is the text, in quotes, for which the handler should 
search all object scripts. As an optional second param­
eter, you can also include the name of a stack to 
search, in case you want the search to be in a stack 
other than the one you're currently in. If you don't 
specify a stack, the handler will search only the cur­
rent stack. 

The ss handler is simply a shortcut to the searchScript 
handler. In fact, all ss does is call searchScript, pass­
ing along any parameters you've given the ss com­
mand. 

As the handler twirls away, it systematically looks into 
the script of each object in the following order: stack, 
background, background buttons, background fields, 
card, card buttons, and card fields. When the text is in 
an object's script, the handler opens the script-editor 
window to display that object's script. 

SearchScript does not control search behavior once 
the script -editor window opens - that's up to you. 
Fortunately, behind the scenes, the handler also puts 
the search text into a global variable called 
ScriptFindString. The script editor normally uses this 
variable to remember the last search performed inside 
a script. If you choose Find from the script editor's Edit 
menu (Command-F), you'll see your search text 
already entered for you. This means that when run­
ning searchScript, you can bypass the Find dialog box 
and simply choose Find Again (Command-G) to look 
for the match. 

When the script -editor window opens, you also won't 
know how many instances of your search text exist in 
the current script. Keep pressing Command-G until 
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you hear a beep, indicating that the entire script has 
been searched (unless you've turned on Wraparound 
Search in an earlier script Find dialog box). . 

Once you've examined your search text and made any 
changes to the script, the most efficient way to let 
searchScript continue its pursuit is to press the Enter 
key. Doing so saves changes to the script, closes the 
object's script, and lets the handler carry on searching 
in other scripts. 

Script-Editor Fonts 
You're not restricted to 9-point Monaco as the font for 
HyperCard script-editor windows. HyperCard 2 
includes adjustable script-editor font and size proper­
ties- scriptlextFont and scriptThxtSize. A Home­
stack shortcut handler reduces the long typing 
required to change these attributes to a simple matter 
of filling out a pair of dialog boxes. To start the han­
dler, type se and press Return or Enter. 

Without using fancy dialog boxes with pop-up lists of 
fonts and sizes, this handler displays two HyperCard 
ask dialog boxes, which require you to type the full 
name and size of the font you want. The next script­
editor window you open will use the new font. If you 
want to permanently change the font for your script 
editor, you can add some lines to the Home-stack 
script's getHomelnfo or startup handlers to automati­
cally set font and size properties each time HyperCard 
starts up. 

Danny Goodman's Home Stack Handlers 
Adding Home-stack utility handlers to your stacks can 
make your easily authoring environment more pro­
ductive and easier to use. Danny Goodman, the 
author of The Complete HyperCard 2.0 Handbook and 
cofounder of Concentrix Technology, has put together 
some tips on adding handlers to your scripts as well as 
some examples from his own scripts, which you can 
download from ZiffNeVMac-look for the file name 
HCHAND.SIT in the Mac User Forum's Library 3 
(Utilities), or send your request and a check ($5 in 
North America, $10 outside North America) to 
Concentrix Technology, Inc., 1875 S. Grant Street, 
Suite 760, San Mateo, CA 94402. 

Working With The Tools Menu On A 9-inch 
Classic-style Screen 
\Vhen you're authoring HyperCard stacks on a 9-inch 



screen, you don't always have a convenient spot to 
stash the tools menu. You can hit the Tab key to go 
from button or field mode to browse mode, but this 
has the sometimes undesirable side effect of selecting 
the first unlocked field. The contents of fields can be 
lost this way. This can be avoided by adding these lines 
to the Home Stack script: 

ontabKey 

get the tool 
if it is "button tool" or it is "field tool" 

then 
choose browse tool 
passtabkey 

end if 
end tabKey 
If you have the extended keyboard, you can change 
tools by using the function keys. Put the second group 
of lines below into the Home Stack script: 

on functionkey num 
put "browse, button, field, select" into 
fKeys 
if num > 4 and num < 8 then 
get "choose" && (item (num-4) of 
fKeys) && "tool" 
do it 

else 
pass function key 
end if 

end tunctionkey 
Don't use Fl through F4, since these are reserved for 
Undo/CuV Copy/Paste. 

Outlining Hidden Buttons 
Pressing the Command and Option keys simultane­
ously will outline all buttons. However, hidden but­
tons are only outlined in Button mode- other but­
tons will be shown in Button and Browse modes. 

While in Field mode, you can outline all fields, 
whether hidden or not, by pressing the Command, 
Option, and Shift keys simultaneously. This is very 
useful when learning programming techniques from 
other stacks. Version 1.2 has a command to show all 
buttons. 

Using Font/DAJuggler To Minimize Disk 
Space 
To use FonVDAjuggler to minimize the size of 
HyperCard stacks, first, use the Fkey/Sound mover, 
included with FonVDAjuggler, to create the sound 
files. Hold down the Option key while opening files 
to open a HyperCard stack. Then create new 
Fkey/Sound mover files, and copy the HyperCard 
sounds to the new files. Font/DAjuggler can open 
these new Sound files at any time. Up to 12 sound 
files can be opened. The only limitation on the 
number of sounds is disk space. You can switch sets 
of sounds quickly and easily. 

One problem: HyperCard can play only HyperCard 
sound resources. The Mac II beep sounds that come 
with FonVDAJuggler cannot be played in HyperCard. 

Reports 
While using HyperCard-compatible Reports, you can 
encounter an unusual problem. In the HyperCard script 
editor, using the Tab key simply realigns the indentation 
in the script. However, when using Reports' script editor, 
pressing the Thb key actually inserts a character (proba­
bly a tab character) that shows up as white space. When 
the script is executed, HyperCard cannot interpret the 
added character and this results in a 'tan't understand" 
errot 1b fix it, you must delete the added charactet So 
don't use the Thb key in HyperCard Reports' script editot 

Printing A Range Of Cards 
The HyperCard printing options allow only the print­
ing of the current card or the entire stack. But if you 
create a button on any card of your stack with the fol­
lowing script, you'll be able to print a range of cards 
that you specify. 

on mouseUp 
ask "First Card to Print? 
put It into Start 
ask ~~Last Card to Print?" 
Put It into Finish 
open printing with dialog 

repeat with counter= start to finish 
print card counter 

end repeat 
close printing 
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end mouseUp 

Opening A Card 1b The Current Date 
If youtllike an appointment stack that'll always show 
the current day's card whenever you open the stack, 
do this: make a copy of the Appointment stack con­
tained in Stack Ideas, create three months' worth of 
cards, then open the the stack's script via the Stack 
Info dialog box and enter this script: 

on openStack 
if field "date" is the long date then 

exit openStack 
else 
find the long date 
push card 
hide message box 

end openStack 
The next time you open the stack, the current day's 
card will be on top. If it's not, see if there's a card with 
today's date. If there isn't, open the Message box, type 
extend, and press Return. That should do it. Th check 
this, open the Message box again and enter find the 
long date, press Return, and the current day's card 
should appear. 

Adjusting The Fmd Command 
The Find command of HyperCard searches only for the 
first occurrence of a string in a stack. The Find menu 
item continues its search for the next occurrence of 
the string in the stack after the Return key is pressed. 

If you want to prompt the user of your stack with a 
personal message (not the standard Find of the 
Message box), and want to continue the search after 
the first match, use the "Ask" dialog box to enter the 
string to find. Then "type" it in the message box with 
the Type command. All this can be done with the mes­
sage box hidden if the BlindTyping is set to true. Here 
is an example of a script of a "Find" button: 

on mouseUp 
go first card 
ask "Find what word or group of 
words?" 
type "find" & quote & it & quote & 
return 

end mouseUp 
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If you type "Macintosh" as the string to find, 
HyperCard will itself type the string "Find Macintosh" 
in the visible or invisible message box, and will itself 
depress the Return key to begin the search. The next 
time you press the Return key, the search will contin­
ue, as with the Find menu item. With the command 
Find It (it = "Macintosh"), only the first occurrence of 
the string "Macintosh" would have been found, and 
the Return key as a "continue the search" command 
would not have worked. 

Adding A Phone Hang-Up Script 
When dialing numbers from the Address stack that 
comes with HyperCard, there is no obvious way to 
hang up once a number is being dialed or has been 
dialed. You can solve this problem by adding a back­
ground button to the address stack that sends a hang­
up message to the modem. The script is: 

on mouseUp 

send "dial " & quote & quote & "with 
modem " & ~ quote & "+++ ATHO" & 
quote to HyperCard 

end mouseUp 

This sends a hang-up message to the modem. If you 
have the phone off the hook, you will still be connect­
ed until you manually hang up. 

Dialing With A Prometheus Modem 
In HyperCard, using the dialing feature with a 
Prometheus modem can be a little difficult if the 
modem doesn't switch from data to voice transmission. 
Prometheus thinks this is a bug in HyperCard, bu~ not so. 

In the Phone Stack that is supplied with HyperCard, 
open the Stack script. Find the code that reads: then 
send "dial" & quote&- dialNumber & quote .. 
Change it to read: then send "dial" & quote & -
dial Number&" ;H" & quote ... 

Now the modem will switch to voice transmission 
immediately after dialing a number. 

Expanding The Cursors In HyperCard 
If you want to expand the cursors of HyperCard, 
make the ones you need with ResEdit, and call 
them from HyperCard by indicating the ID 
Number. The browse tool and all other HyperCard 
icons and cursors are in the Font resource of 



HyperCard, shown as a strange "12 ID 31756." 

You may not be able to open a resource with the ID 
number set so high. You can change the ID num­
ber, temporarily, to a lower number using Get Info 
from the menu bar. Now you can open the 
resource, make your changes, then reset the ID 
number to the the previous value. Be sure to save 
the changes. 

Printing A Card With Better Quality 
If you want to print a card from a stack with better quali­
ty, especially text, export the cam data to a Paint pro­
gram, and print in the best quality available. 

Getting The Name Of A Tool With Hyper'lhlk 
If you need HyperCard to select a tool or pattern from 
the Tool menu or the Patterns menu but you're not 
sure what it's called, follow this procedure: 

1. That off the menu that has the item in question. 

2. Select the tool or pattern that you plan to use. 

3. Type "get the tool" or "get the pattern" into the 
Message Box and press Return. 

4. Type "it" into the Message Box and press Return. 

The Message Box should contain the exact name (or, 
for patterns, a number) that HyperCard needs to iden­
tify that item. 

Uninterrupted Keying While Refreshing 
Settings 
Showing the time in a stack is nice, but it becomes a 
pain in the mouse if the stack is used for keyboard 
input. At the end of each minute, HyperCard updates 
the time. If you happen to be typing when the clock 
strikes, HyperCard abandons the text field to update 
the Time field. One way to ensure uninterrupted key­
ing is to have HyperCard only refresh the time when 
you are not keying. The following lines in your stack 
script will do just that (assuming a field named 
"Time" is in the background): 

on openField 

set lock Text of field "Time" to false 

end open Field 

on mouseleave 

set lock Text of field "Time" to true 

end mouseleave 

on idle 

if lock Text of field "Time" =true then 
put the time into field "Time" 

end idle 

Adding The Tune In Any Stack 
It's easy to show the time in any stack. Start by creal­
ing a field in the background called Time. Then add 
this short script to tlie existing background script, if 
any: 

on idle 

put the time into field "Time" 
pass idle 

end idle 

If you want to add this feature to a single card rather 
than to all the cards of a background, simply create a 
card field named "Time." The script should now be 
added to the card script, changing the second line to 
put the time into card field "Time': 

Compacting HyperCard Stacks With 
Hypertalk 
HyperCard stacks can be real memory hogs, especially 
if you modify them occasionally. The HyperCard man­
ual suggests you look at the amount of free space in the 
stack by selecting Stack Info from the Options menu. If 
there is a lot of free space, you can reclaim it by select­
ing Compact Stack from the File menu. If you forget to 
do this, your stack can grow to twice its normal size. 

Start by choosing the Authoring level from the home 
stack. Then go to the desired stack and choose Stack 
Info from the Options menu. Click on the Script but­
ton and add the following script: 

on closeStack 

if the freeSize of this stack>O then 
doMenu Compact Stack 

end closeStack 
Another alternative script is the following: 

on closeStack 

get the freeSize of this stack 
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if it> 1024 
1 0 then do-Menu Compact Stack 
end closeStack 
This script will automatically compact the stack if you 
exit it and it has more than lOK (1024 = lK) of free 
memory. If there is already a script for this stack just 
add the new part at the end, and if there is already an 
"on closeStack" script, just add the two lines before 
the "end closeStack." 

Changing The Default Font In HyperCard 
HyperCard uses the default (application) font to 
label icons as well as in the message window. It's 
also used as the default font for the Thxt tool and 
new fields. To make HyperCard use your favorite font 
as its default font, change your application font 
using any of the several excellent public domain 
and low-cost shareware programs that will do this. 
For example, to set the icon font to Geneva 9 you'll 
need to make the following changes using FEdit 
Plus or MacTools. 

Change: 6720 3F2D F31 E 

To: 6720 3F3C 0003 

The final 0003 is what sets Geneva. 

Using Alphanumeric Keys 1b Set 
Polygon Shapes 
When using the Polygon tool, it is not necessary to 
complete each polygon by clicking where you start­
ed drawing the polygon. If you are in the Fill mode, 
you can complete the polygon and fill it by typing 
any alphanumeric key. 

Outline mode acts differently. When you type an 
alphanumeric key in that mode, the polygon lines 
stop where you last clicked the mouse. These meth­
ods work in MacPaint also. 

Blind Typing Out Of A Jam 
The message box is always there, even when it's not 
visible, just blind type your message, such as "open 
resedit" or "go home." Don't worry about getting the 
capitals right, but be sure you put spaces where they 
belong. Using this technique can get you out of a jam, 
such as when you use Recent to go to a card which 
you then discover has no menu or working buttons. 
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Attaching FONT Resources To Stacks 
If you write a stack that includes text fields that use 
particular fonts, you can ensure that they will appear 
in your chosen font no matter what fonts other end 
users have available in their System. Using ResEdit, 
copy the Font ID number of the font you want to lock 
in from the System file. Then paste this ID number 
into the Font file in the stack you want that font used 
in. Even if there wasn't a Font file to begin with, past­
ing in the Font ID will create one. 

Now when others open your stack, the fonts included 
within that stack appear in the text menu in 
HyperCard, along with the System fonts. You no longer 
have to worry about your stack using the default fonts 
and not looking the way you had planned it. 
Remember that Fonts (and sods) take up large 
amounts of space in a stack. 

Seeing All Hidden And 'lhlnsparent Buttons 
It's easy to see where all the buttons are, including 
hidden and transparent buttons that have been paint­
ed over, on a HyperCard card. All you have to do is .. 
press the Command and Option keys at the same time. 
All buttons will be outlined with a dotted line. 

Returning 1b The Finder Instead Of 
HyperCard 
If you want to return to the Finder rather than to 
HyperCard when quitting applications or documents 
launched from HyperCard, hold down the Option key 
while quitting. 

Creating A Scrapbook Of Buttons 
Often when creating a new stack you'll want to use the 
same buttons on different cards, with different back­
grounds. If you save these buttons in the Scrapbook, 
you lose all identifying infonnation, and can easily 
forget which button is which. The solution is to create 
a "ScrapCard" on which to save these buttons. 

First, add a new card at the end of the stack. Paste any 
button you intend to use again onto this card. Now all 
you need to do is press Command-4 to get to the 
ScrapCard (be sure to leave it as the last card in the 
stack), choose and copy the appropriate button, press 
Command- to return to the card you were working 
on, and paste the button in. 



Setting Control-Key Combinations To 
Set The User Level 
An easy way for Mac SE and II owners to switch 
between user levels is to create Control-key combina­
tions by inserting the following lines into the Home 
stack: 

on controiKey x 

if x=49 then set the user Level to 1 
else if x=50 then set the user Level to 2 
else if x=51 then set the user Level to 3 
else if X=52 then set the user Level to 4 
else if X=53 then set the user Level to 5 
else pass control Key end control Key 

end if 
end controiKey 
Now you can press Control and any number from 1 to 
5 and be transferred to that user level. 

If you've ever wanted to make your HyperCard stacks 
like real Mac applications with an About ... com­
mand in the Apple menu, copy the following resources 
(with ResEdit) to your stack from HyperCard itself: 

DLOG '1\bout" ID=2002 

DI'IL '1\bout"' ID=2002 

SI'R# '1\bout" ID=2002 

ICON "Bill" ID=2002 

ICON "HyperCard" ID= 1001 

Once you've loaded the resources in your stack by 
means of the scary magic of ResEdit, you can alter 
them to your heart's content without actually modify­
ing the originals in HyperCard. To do so, make SfR# 
read whatever you want; move, add, or delete any of 
the icons; or place your own text inside the DITL. You 
can even move the DLOG box elsewhere. 

Now, when you open your HyperCard stack, the 
About ... command will really tell other users what 
your stack is all about. So if you're tired of the same old 
HyperCard programming team, add a little spice, delete 
Bill's lovely face- and put in whatever you want. 

Improving Performance By Turning Off 
Color · 
The speed of HyperCard varies depending on the color 

setting, but in general you will gain significant speed 
if you are using a color monitor and the color is 
turned off completely when you are moving a lot of 
monochrome images. For HyperCard, if you have 256 
colors, you should use either no color or 256 colors 
(2 colors or 256 colors). 

In the Control Panel, the Control Panel Device (CDEV) 
called Monitors lets you adjust the number of colors your 
monitor shows. If you have 256 colors, your monitor will 
typically be at 2, 4, 16 or 256 colors. 

Moving To The End Of A Scrolling Field 
Let's say you have been using a stack that requires 
switching from card to card and entering text- but 
always at the end of a scrolling field. The speed of text 
entry is hampered because when you open a card, you 
have to scroll to the end of the field and click after the 
last word before you can type the text. 

Here is a short background script that causes the cur­
sor to appear automatically at the end of the 
scrolling field whenever you switch to another card. 

on opencard 
select char (the number of chars in bg 
fld x) + 1 of bg fld x 
type selection 
end opencard 
If you want to make sure that the cursor always 
appears below the last line, even if the last line does 
not end in a carriage return, make the script read as it 
appears below 

on opencard 
if last char of bg tid x <> return then 
put return after bg tid x 
end if 
select char (the number of chars in bg 
fld x) + 1 of bg fld x 
type selection 
end opencard 

'&uly Hidden Buttons 
HyperCard lets you create hidden buttons, but anyone 
can "peek" at the button location by holding down 
the Command, Shift, and Option keys simultaneously. 
What if you want to create a hidden button that truly 
stays hidden? 
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The answer is to create two hidden buttons. Create the 
button you want, and then copy it and paste the copy 
directly on top of the original button. Neither button 
will be visible when Shift, Option, and Command are 
pressed, although you'll still be able to see them when 
the button tool is selected. 

Easy UserLevel Settings 
If you are tired of typing set Userlevel to 5 and set 
Userlevel to 2 when developing applications in HyperTh.lk, 
add the following into your Home-stack script on ux 

set userlevel to param (1) end u 

Now I just type u 6 or u 1 in the message box. 

HYPERCARD 1.2 AND 2 
HyperCard 1 And 2 Co-existing On Your 
Disk 
Some HyperCard 1 stacks can't successfully be con­
verted to Version 2. If you've got some of these, and 
you need to keep them around, here's an admittedly 
awkward trick for keeping both versions on your disk. 

Using a file-editing utility, change the creator of 
HyperCard 1 and any Version 1 stacks to something 
other than WILD. 

Once you've done this, double-clicking on a Version 1 
stack won't launch HyperCard 2, as is usually the case. 
In fact, double-clicking will result in an error mes­
sage. But you can launch the HyperCard 1 application 
and open your older stacks from inside it. Your new 
HyperCard 2 stacks and any stacks you've converted 
will continue to open with Version 2. 

Compacting 1.2 Stacks With Hyper'Ihlk 
Even before you have a chance to convert a 1.2 stack to 
2.0 (it's possible to run a 1.2 stack under 2.0 without 
converting it), you may encounter the script error 
message "Can't find menu item 'Compact Stack'." 
What's going on here? 

Some stack authors build in routines that compact a 
stack according to some time interval (say, once a 
week) or a calculation based on a stack's freeSize 
property (for example, if the size of the free space is 20 
percent larger than the stack size). Compacting a 
stack rearranges the current stack on the disk, remov-
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ing any unused space so that it fits into the smallest 
possible space. 

Although compacting regularly is highly recommend­
ed, a stack that has not yet been converted to 
HyperCard 2.0 simply doesn't have the Compact Stack 
menu item on the File menu. In its place is the 
Convert Stack menu item. Because compacting is 
dependent on the data structure of a stack, HyperCard 
2.0 cannot compact a 1.2-generation stack until the 
stack's data structure has been converted to the 2.0 for­
mat. After you've converted the stack to 2.0, the 
Compact Stack menu item returns and the stack's 
compact routine should run fine. 

Vision Problems 
Depending on what kind of Mac you use, the speed 
of visual effects may differ under HyperCard 2.0. You 
can set a stack's visual effects to slow, very slow, fast, 
or very fast. Except for the very fast speed (which 
works as fast as your Mac's CPU chip does), these 
speeds have been normalized across all Macs in 
HyperCard 2.0, so that visual effects will have roughly 
the same impact when run on a Mac Classic as on a 
Ilci. Because these speeds have been standardized to 
the slowest common denominator, if you use any­
thing faster than, say, a Macintosh SE, you'll proba­
bly notice slower visual effects when the stack is con­
verted to HyperCard 2.0 than you did under Version 
1.2. 

You can speed up these effects so that they're closer 
to what you're used to. To do this, start by using the 
searchScript command from the Message Box to let a 
helpful utility handler in the Home stack find the 
locations of the Visual Effect command. 

Show the Message Box by pressing Command-M. 
Then type searchScript "visual'; and press Return. If 
any object's script contains this command, the 
script-editor window will open to display the script. 
The script editor already knows what text you 
searched for with searchScript, so you can simply 
press Command-G to issue the Find Next command 
within that script. 

The search will find a line that looks something like 
this: visual effect wipe left (or whatever is being 
applied to the visual effect). To the end of the line, 
add fast or very fast, as in visual effect wipe left fast. 
Press Command-G in this script until you hear a 



beep, which means there are no more visual effects 
in the script. Press the Enter key to save the script 
change, and close the script window. 

Sound Problems 
As for sound, if you're running System 6.0.7 or later, 
you must use HyperCard 2.0 to ensure trouble-free 
sounds when using the Play command 

In addition, existingsoundXCMDs (external com­
mands), such as those provided in Farallon's 
HyperSound 1bolkit, need to be upgraded to work suc­
cessfullywith HyperCard 2.0 (you need to get the upgrade 
from the company that created the sound). You may get 
some sound out of the old XCMDs but not consistently. 

A note on XCMDs: Most existing XCMDs work in 
HyperCard 2.0 just fme. The ones that cause the most 
problems are those that create their own windows or 
are dependent on HyperCard 12 stack data structures. 
The Conner need to be redesigned around the new 
XCMD structure and libraries (both available from 
Claris); the latter need major overhauls. 

F"mding Missing 'Iext 
Some users have fretted over the apparent disappear­
ance of text in fields after converting a stack to 2.0. 1b 
encourage users to keep entries in this field to a maxi­
mum of four characters, the script author might have 
carefully sized the field so that the rectangular border 
allowed just a few pixels of white space to the right of 
the last character 

When a stack is converted to HyperCard 2.0, however, it 
looks as though the last character of the field has 
been cut off. The full text is still there - it's just 
wrapped to the next line. If you widen the field a cou­
ple of pixels, all the characters will return to the first, 
visible line (for best results, widen these fields after 
converting the stack). Although some word-wrapping 
oddities of HyperCard lx have been corrected in 2.0 
(for example, parentheses and quotes now stay with 
their associated words), a field still requires several 
pixels of white space between the last character and 
the right edge of the field rectangle for the character to 
be visible on that line. 

Crippled HyperCard 
Currently Macs come with a version of HyperCard 2 
that appears to be partially disabled. It really isn't; the 
Home stack is locked at the second level (Typing). 

To access the higher user levels, here is what to do: 

1. Launch HyperCard, and go to the last card 
( Command-4). 

2. Make the Message box visible (Command-M). 

3. Type "Set the UserLevel to 5"; press Return. 

4. Type "Magic"; then press Return. 

Your copy should now have all five user levels available. 

SUPERCARD 
Using Stand-alone Files Without The 
Application 
A lot of programs on the Mac market create stand­
alone applications or self-extracting archives. 1\vo 
good examples are SuperCard and Compact Pro. 

If you get a project-only version but do not own 
SuperCard, it is impossible for you to run it. The same 
goes for Compactor: If you get a Compact Pro file but 
do not have the program, you cannot extract the file's 
contents. 

The obvious answer is just to go out and purchase 
SuperCard or Compact Pro, but that's not always a 
cost-effective or timely solution. 

A different approach is to convert the SuperCard 
project into a SuperCard stand-alone application or to 
convert a Compact Pro file into a self-extracting 
archive. 

The following methods require Res Edit. If you're con­
verting a SuperCard project, it also requires a 
SuperCard stand-alone application. If you're convert­
ing a Compactor file, it also requires a self-extracting 
archive. 

Follow the steps (SuperCard project/Compactor file is 
referred to as the data file, and the SuperCard stand­
alone application/Compactor self-extracting archive 
as the app file): 

1. Run ResEdit. 

2. Open the data file. 

3. Open the app file. 

4. Select and copy all the resources in the app file. 
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5. Activate the data-file window. 

6. Paste the resources in. 

7. Close the app file. 

8. Save the data file. 

9. Issue a Get Info command (Command-O for the 
data file. 

10. Change its type to APPL. 

11. Quit to the Finder. 

Now run the SuperCard or the Compactor file, and it 
will work perfectly. 

MULTIMEDIA 

MACROMIND DIRECTOR 
Aligning Onstage 
1b align text or graphics onstage in Macro Mind 
Director, create QuickDraw shapes as registration tools 
and then discard them when the layout is done. Also, 
use your tool bar or cast window for quick vertical reg­
istration. 

joining Endpoints 
To make joining the endpoints of an open path easier, 
Option-select anywhere along the path and then use 
the Join command. This way, you don't have to go 
through the trouble of selecting both endpoints of the 
path. 

Drawing Concentric Circles 
Some graphics programs, such as MacroMind 
Director, don't provide a command for drawing con­
centric circles. Here's a quick and simple approach 
that works with any graphics program that doesn't 
include a concentric-circle command. 

Open the Paint window. Draw a 45-degree line, using 
the line tool (you can restrain the line tool to 0 degrees, 
45 degrees, or 90 degrees by holding down the Shift key). 
Choose the Sphere tool. Hold down the Shift key, and 
place the cross hairs on any point on the line. Draw the 
circle down or up at the same angel as the line. 
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Now choose another point further along on the same 
line, and draw out another circle in the same direc­
tion and angle as before. You now have perfect con­
centric circles. 

QUICKliME 
System 6.07 And Higher 
The QuickTime software defines a "movie" file format 
that can be played back on any 68020-or above 
(68030 and 68040) Mac equipped with color and run­
ning System 6.07 and higher. 

Startup Movie 
If you take your favorite QuickTime movie, rename it 
Startup Movie and place it loose in the System folder, 
the movie will play when the QuickTime extension 
loads during start-up. 

Cheap Introduction To QuickTune 
If you just want a collection of budget-priced 
QuickTime movies, check out TV ROM from BMUG 
(1442A Walnut Street #62, Berkeley, CA 94704; 
800-776-2684or [510] 549-2684; $35). It contains 
almost 400 MooV files (MooV is the file type for 
QuickTime movies). 

It's an eclectic collection, organized into categories 
such as animals, talking heads, traffic, computers, 
and others, with a nicely designed HyperCard stack 
that lets you find and preview movies quickly and eas­
ily. The disk even includes the QuickTime extension 
and the Popcorn QuickTime movie viewer. There are 
some gems in the collection, but the overall quality of 
the clips is uneven at best. Still, for $35 you won't find 
a better introduction to QuickTime. 

Voyager Movies 
One of the most prolific producers of QuickTime 
movies on CD-ROM is Voyager ( 1351 Pacific Coast 
Highway, Santa Monica, CA 9040; [310] 451-1383). 
Its batch of releases includes "You Can't Get There 
from Here" ( 1946-1960), which consists of motion-pic­
ture clips, cartoons, commercials, and educational films, 
all in QuickTime fbnnat. This CD-ROM even includes a 
classic high-school health-class film about "making out." 

Other Voyager titles include Poetry in Motion-



QuickTime movies of perfonnances by Charles 
Bukowski, John Cage, jim Carroll, Allen Ginsberg, 
Tom Waits, and others; and Baseball's Greatest Hits, a 
compendium of statistics, facts, and figures as well as 
pictures and QuickTime movies about America's 
national pastime. 

QuickTune Beeps 
VideoBeep, from Rock Ridge Enterprises ($40), lets you 
choose QuickTime movies to play when your Mac beeps 
as well as when you start up, shut down, restart, insert a 
disk, eject a disk, or empty the Trash. 

Memory 
Start off with as much RAM-disk space as you can 
muster. QuickTime software is RAM-hungry, and 
QuickTime-movie files can be big. 

Creating Your Own Movies 
Next you'll need software that lets you create your own 
QuickTime movies. Adobe Premiere is one such pro­
gram and it's powerful, feature-packed and sports an 
intuitive interface. Adobe Systems Inc., 1585 
Charleston Rd., P.O. Box 7900, Mountain View, CA 
94039-7900, ( 415) 961-4400. 

Turning Videos Into QuickTune Movies 
If you want to import video from tape or a camcorder, 
you'll need a digitizer. The VideoSpigot, from 
SuperMac is one such tool. It's inexpensive (less than 
$600 for NuBus; less than $500 for the LC or Ilsi), and 
it works flawlessly. 

Capturing Screen Activity 
If you plan to design Mac training videos or just 
want to record screen actions, check out Spectator 
(Rock Ridge Enterprises, 620 Hidden Valley# 102, 
Ann Arbor, MI 48104; [313] 663-0706; $200). It's a 
screen recorder that captures activity on your screen 
and makes a QuickTime movie of it. Although it has 
a basic feature that lets you add a soundtrack, it 
doesn't have editing capabilities, so you'll want to 
edit your Spectator-generated movies in Adobe 
Premiere, which lets you easily add sound and 
smooth out any rough spots. Adobe Systems Inc., 
1585 Charleston Rd., P.O. Box 7900, Mountain View, 
CA 94039-7900; ( 415) 961-4400. 

Presentations 
If you're in the marl<.et for a QuickTime presentation pro-

gram, check out Cinemation (Vividus, 651 Kendall 
Avenue, Palo Alto, CA 94306; [ 415] 494-2111; $495) or 
Magic (MacroMindParacomp, 600 1bwnsend Stree~ San 
Francisco, CA 94103; [ 415] 442-0200; $395). Cinemation 
and Magic let you do more than just paste in or import 
QuickTune movies. Each includes a full-blown animation 
program, painting and dra\\ing tools, and severn! 
megabytes worth of ready-to-use animation clips. 

Another benefit: Magic and Cinemation let you export 
your presentations as QuickTime movies. Cinemation 
even lets you import Persuasion and Power Point pre­
sentations and automatically animate the text. 

VIDEO 
Two Video Display Problems 
When creating a successful video presentation you 
need to recognize desktop video's limitations and 
know how to get around them by choosing the best 
graphics for your presentation. 

There are two display problems- overscanning and 
flickering -that you should take into consideration 
when designing a presentation. Overscanning occurs 
because a TV picture covers the screen from edge to 
edge, extending past the visible edges of the picture 
tube. You never see the outer edges of a broadcast 
image, but that usually doesn't matter. However, 
when you send a 640 x 480-pixel computer image to 
a Tv, overscanning magnifies the image, placing 
important items - such as the menu bar, Trash, 
and disk icons- at the edges of the TV's display 
area and practically out of sight. When designing 
your presentation, try to keep important items with­
in the viewable screen area. 

A bigger display problem is the flickering that occurs 
in display of thin horizontal lines, such as those in a 
spreadsheet. Computer monitors refresh the entire 
screen 60 times per second or faster. A TV, however, 
paints the screen only 30 times per second, in two 
interlaced passes. One pass lays down the even-num- · 
bered rows, and the next lays down the odd-num­
bered rows. Any thin horizontal line in a document 
occupies a single odd or even row, so it's painted only 
during odd or even passes- or just 15 times per sec­
ond, which creates a flickering effect. 
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An Expensive Flicker-Free Solution 
There's an expensive (about $2,500) flicker-free solu­
tion in the fonn of Video Logic's Mediator (a scan-con­
verter/NTSC-encoder-box combination). 

Reduce Flicker With 1\vo Video Cards 
1\vo video cards that correct flicker are Apple's 
Macintosh Display Card 8*24 and Macintosh Display 
Card 8*24 GC. These cards also produce a smaller 
desktop that compensates for overscanning on the 
TV display. 

To set the flicker-free option, go to the Monitors control 
panel and select the monitor icon that represents the 
video card you're using with the TV or VCR. Set the mon­
itor to black-and-white or 4, 16, or 256 colors (or grays). 
Select Options, and click on the Flicker Filter check box 
in the subsequent dialog box. Close the control panel, 
and restart. After startup, you'll see a smaller desktop on 
your video device and the image will be flicker-free. 

An Older Video Card Gives Flicker-Free 
Presen~tions 

You can also get a flicker-free presentation with the 
older (and discontinued) Macintosh High-Resolution 
Display Video Card. You need to use the Macintosh II 
Video Card Utility (available from user groups) to 
adjust this card's display rate for TV /VCR output. The 
utility's flicker correction works only in black-and­
white mode. 

Avoid Background Grids To Reduce Flicker 
If you're working without a flicker-fixing setup, avoid 
background grids when using graphics programs 
and don't display spreadsheet grid lines. Tuck the 
window's title bar as far as possible under the top of 
the screen or menu bar so that the horizontal lines 
won't flicker. 

Use 2-Pixel-Wide Unes 1b Reduce Flicker 
Try using 2-pixel-wide lines for drawing. This elimi­
nates most flicker. Lines angled at 20 degrees or more 
from horizontal don't flicker. 

Use A Colored Background 
Use a colored background to reduce the contrast 
between the foreground objects and the background. 

Avoid Using Patterns 
If you must use them, open your application's Pattern 
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palette and check it on the TV screen to see which pat­
terns flicker most. 

Reducing '!ext Contrast By Anti-Aliasing 
To reduce the contrast between the edges of the text 
and the background, use a program such as 
Photoshop to create anti-aliased (smooth-edged) text 
whenever possible. 

Design With The Equipment In Mind 
Design for the kind of equipment that will be used to 
display the presentation to an audience. Make 
allowances for the loss of quality from duplicated 
videotape. 

Measure The Distance 
Judge the size and readability of elements such as text 
and graphics on the TV display from the distance at 
which your audience will be viewing it. Make adjust­
ments accordingly. 

Fit Presentations To The Screen 
Compose presentations to fit the TV screen, not the 
Mac screen. If you don't want to work directly with a 
TV as your composition monitor, use a drawing pro­
gram to construct a 512 x 342-pixel rectangle and save 
it in the Scrapbook or in a template document. Use it 
as a guide for composition. 

Font Legibility 
Use larger font sizes than usual, because a TV display's 
lower resolution makes small font sizes hard to read. 
Try boldface styles. Font legibility depends upon the 
quality and compatibility of your video card, converter 
box, recording unit, and display system. The better 
they are, the smaller the point size you can get away 
with. Typically, 18 points is legible on most screens. 
12-point Geneva Bold and 12-point Chicago are good 
regular-sized starting fonts. 

Contrast With Shadowed 'Iext 
Use shadowed text occasionally to add contrast 
between text and the background. 

SpreadsheetFOntSbes 
For spreadsheets, use larger font sizes so that impor­
tant symbols such as + and = are clear. 

Record At The Standard-Play Setting (SP) 
Record your session at your VCR's st~ndard-play (SP) 



setting for the best playback quality. 

Adjust Your TV Or VCR 
At show time, use your TV or VCR sharpness control 
and adjust it until you get the best-looking image. 
This generally helps reduce residual flickering, false 
color, and ghost-edged pixels. 

Use A Good Microphone For Sound Capture 
Your video production will be a silent film unless you 
use a sound-capturing system that includes a good 
microphone (these cost $20 or so) and a tape desk 
and microphone amplifier or audio mixer. You don't 
need anything elaborate or expensive- you're not 
using the tape desk to record sound, only to accept 
and control the microphone input and send it 
through the Line-OUT or Play jack to the VCR's Audio­
IN jack. 

MUSIC 

DELUXE MUSIC 
CONSTRUCTION SET 
Hooking Older Mac Models Up To Your 
Stereo 
You can get really great sound from older (128K or 
512K) Macs when working with DMCS or other music 
software. Hook the Mac up to your stereo with a cable 
that has a mini-phone plug on one end and a pair of 
phono plugs on the other. Put the phono plugs into 
the equivalent AUX jacks on your stereo, then fit the 
mini-phone plug into the back of the Mac, near the 
modem port. 

When you do this, remember to tum the volume slider 
all the way down on the Control Panel or else the 
music will distort. You should also set the External 
Speaker option on. Then, set the stereo to Mono, tum 
it on, and make music to your heart's content. 

Don't Modify The Program's System Fonts 
Deluxe Music Construction Set uses special musical 
notation fonts which won't work properly after they've 
been modified. 

PROFESSIONAL 
COMPOSER 
Place Ties And Articulations After 
'Jloansposing Parts 
When working with transposing instruments, make 
sure to place your articulations and ties AFTER you 
Transpose Parts. This is because the program won't 
allow for the fact that the direction of note stems often 
change after transposition. Your articulations and ties 
will often end up on the wrong side of the notes, and 
redoing all of them can be tedious work. 

SPREADSHEETS 

1·2·3 
1-2-3 And Excel Differences 
Microsoft Corp.'s Excel and Lotus Development Corp.'s 
1-2-3 for Macintosh have a difference of opinion. 
Specifically, the Average and Integer functions behave 
differently in the two spreadsheets. 

Average. If you select a range of cells to be averaged in 
1-2-3, you have to be careful. If you include a cell with 
no number, either a blank cell or one containing text, 
1-2-3 treats the cell as if it held the number zero. Excel 
ignores non-numeric cells. 

Integer You use this function to round off numbers, but 
Excel always rounds down while 1-2-3 rounds to the 
nearest whole number. For example, the number t4 
becomes 1 in 1-2-3 and 2 in Excel. (The less-common 
.Modulus function, which returns the remainder of a 
division, also uses the Integer function.) 

EXCEL 
Avoiding The Prompt 1b Update References 
When opening an Excel file, it can be annoying to get 
an alert dialog box that tells you to update references 

105 



II 

to unopened documents. This is especially annoying 
when hidden macro sheets are associated with the 
"workspace." 

Here's how to avoid this unwanted prompt. Files are 
opened in alphabetical order as specified in the saved 
workspace. 1b make your macro sheets open before 
the worksheets that reference them (thus avoiding the 
prompt), simply add a zero at the beginning of each 
macro-sheet name. This technique also works for 
combinations of worksheets and charts that are 
opened by a single document. 

Working With Several Work Areas 
If you have several work areas on the same Excel 
worksheet (for example, one for expenses, one for 
income, and one for a summary), you can sometimes 
run into layout problems when you add columns or 
rows to one of the areas. To avoid this, stagger the var­
ious work areas along an invisible diagonal running 
through the worksheet. This ensures that adding rows 
or columns in one area will not affect any of the other 
areas. 

Insert New Row/Column Without Using Hie 
Menu 
You can select Insert to insert a new row or column 
without going back to the file menu every time. Hold 
down Option while clicking on the row or column in 
which you want to add a new area. 

Selecting The Entire Worksheet 
You can select an entire worksheet without using the 
mouse by typing Command-A. This is the equivalent 
of clicking in the upper left comer of the worksheet. 

Single-Letter Command Selection 
You can quickly select commands within most dialog 
boxes by typing the first letter of a radio button com­
mand. That often selects the command without your 
having to actually click the mouse on the button. 

Customizing Chart Formats 
If you use charts a lot and like to use custom chart 
formats built from those already available, this tip 
will make your charting chores more palatable. 

You can store libraries of custom chart formats, 
instead of re-creating a custom format every time 
you need it. Simply use the Clear command to 
empty the formulas of a chart with a format you 
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find particularly useful, and use Save As to store it 
to disk. 

To use your custom chart format, copy the data 
from the worksheet that you want to see in the 
chart and use Paste Special to paste the formulas 
into the formatted chart window. You now have the 
data illustrated in your custom chart format, with­
out spending an hour or so to re-create that custom 
format. 

If you encounter a situation where you can't copy the 
data directly (a discontinuous selection, for example), 
select the data you want charted and create a new 
chart file. Then open your customized chart file. Do a 
Select Chart on the customized chart file, use the Copy 
command, and then switch to the new chart file. Use 
Paste Special to paste the format of your customized 
chart file onto the new chart file. 

Displaying/Printing Columns Starting With 
Zero 
Some zip codes have leading zeros (for example, 05091 
for Woodstock, Vermont). If you always want Excel to 
display and print these zeros, select the row/column in 
question and select Numbet .. from the Format menu. 
Type in five zeros at the bottom of the dialog, then click 
OK. The selected area will now allow for zip codes with 
zeros as their first digits. 

Highlighting Multiple Cells 
Highlight a large number of cells by clicking on the 
top left cell of the range and choosing Go To ... from 
the Formula menu. Then specify the lower right cell of 
the desired range and press Shift while clicking OK or 
pressing Return. 

Cursor Key Movement 
When a group of cells is highlighted, you can't move 
the cursor outside the selected area if you're using the 
keyboard to control it. However, you can use the cursor 
keys to move around within the selected cells. When 
the cursor hits the bottom or the edges, it will wrap to 
the other side. 

Naming Cells In Columns Easily 
If you find yourself entering a column of labels, only 
to have to manually name each cell in the column 
just to the right of the labels for use in formulas, here's 
an easier way: 



Select the first cell that you want to have the same 
name as the contents of the label cell to its left. Then 
use Command-L (or choose Define Name from the 
Formula menu) and press Return. Excel will automat­
ically assign the contents of the label cell to the left as 
the selected cell's name. 

Centering 'Dlbles With Borders 
1b center a table with a border, increase or decrease 
the left margin. Check your centering by viewing the 
page with the Preview option in the Print dialog. The 
left and right margins will both appear if the table is 
centered. Only the left margin appears in the reduced 
view if it is not. 

Enter Some '!ext Strings As Formulas 
You might find that entering some text strings into a 
cell produces odd results. For example, pasting lOA 
into a cell results in Excel displaying 10:00 A.M. Work 
around this by entering the text as a formula. Instead 
of lOA, type= "lOK; and the cell will show lOA. 

For The Image Writer Page Setup Dialog ••• 
Command-U activates "US Letter" 
Command-A activates "A4 Letter" 
Command-I activates "International Fanfold" 
Command-T activates "Tall Adjusted" 
Command-5 activates "50% reduction" 
Command-N activates "No Gaps Between Pages" 
Command-P activates "Print Row and Column 
Headings" 

For The Image Writer Print Dialog ••• 
Command-8 activates "Best" 
Command-F activates "Faster" 
Command-O activates "Draft" 
Command-A activates 'J\11" 
Command-H activates "Hand Feed" 
Command-P marks "Preview" 

For The LaserWriter Page Setup Dialog ••. 
Command-U activates "US Letter" 
Command-A activates 'i\4 Letter" 
Command-8 activates "BS Letter" 
Command-F marks "Font Substitution" 
Command-S marks "Smoothing" 
Command-P marks "Print Row and Column 
Headings" 

For The LaserWriter Print Dialog .. 
Command-A activates '1\ll" 
Command-F activates "From ... Th" 
Command-M activates "Manual Feed" 
Command-P activates "Paper Cassette" 
Command-N activates "No" (for No Cover Page) 
Command-L activates "Last Page" (for cover page) 
Command-H activates "Help" 

Formatting Commands In Headers And 
Footers 
To embed formatting commands or other instructions 
in the header or footer of an Excel document, insert 
the commands in the Page Setup dialog box. The key­
board equivalents are: 

&L: Align the characters that follow at the left margin 

&C: Center the characters that follow 

&R: Align the characters that follow at the right 
margin 

&P: Print the page number 

&D: Print the current date 

&T: Print the current time 

&F: Print the document name 

&B: Print the left, center, or right side of the header or 
footer in boldface 

&I: Print the left, center, or right side of the header or 
footer in italics 

&&: Print a single ampersand 

Extra-Long '!ext In Headers Or Footers 
You can enter header or footer text that's longer than 
the box can display. If you need to edit this text later, 
view it by placing the cursor in the visible text near 
the rightmost end of the entry box and then dragging 
off the end. The text will scroll to the left and the extra 
text, already highlighted, will appear. 

Loading A Work Space By Default 
1b load a work space by default when opening Excel, 
save your worksheet, chart, macro sheet, or work space 
into a file, label it Excel Startup, and place it in your 
system R>lder. Excel then automatically opens that file 
whenever the application is started. 
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Inserting Cells Without The Dialog Box 
To insert cells without bringing up a dialog box that 
asks whether you want to shift cells up or to the right , 
do the following: 

Hold down the Option key, and select the range you 
want to insert. Excel will insert the range according to 
the default setting in the dialog box. 

Line Up Numbers With Mixed Fonnats 
You can line up the numbers exactly when using both 
the regular number format and the dollar format in 
the same column. Select the cells with the regular 
number format and choosing Number on the Format 
menu. Then select the dollar format, and delete the 
dollar signs in the Format Number dialog box. 

Using The SUM Function 1b Add Up TIOle 
How can you use the SUM function to add up individ­
ual times of less than 24 hours when the sum of the 
times exceeds Excel's clock limit of 24 hours? This is a 
frequently encountered problem for many Excel users, 
and the solution is a simple formula. 

Say you want to add three triathlon times, 14:10:00, 
16:15:00, and 13:23:00 and get an answer in hours and 
minutes. (14: 1 0:00 is 14 hours, 1 0 minutes, and 0 
seconds.) Type the times into cells A1 :A3. 

Enter the following formula in cell A4 in General for­
mat to sum the times in hh.mm.ss format: 

=INT(SUM(HOUR(A1 :A3)) 
+SUM(MINUTE(A 1 :A3))60) 
+(MOD(SUM(HOUR(A 1 :A3)) 
=SUM(MINUTE(A 1 :A3))/ 
60,1 )*.6)+MOD(SUM(MlNUTE 
(A 1 :A3)),60)/1 00 

In this case, the range is A 1 :A3-the cells in which 
you entered the times but you could substitute a dif­
ferent range for your own spreadsheet. 

To enter the formula as an array, press Command­
Enter after typing in the formula. The formula should 
give you a total of 43:48 ( 43 hours, 48 minutes). 

Inserting Lines Into A Chart Label 
1b insert more than one line of text into a chart label, 
go to the formula bar, press Command-Return. This 
creates a larger space in which you can type multiple 
lines of text. 
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Rearranging Linked Data 
When you link worksheets in Excel, you can rearrange 
the data on the supporting worksheet without affect­
ing the link. 

Let's say you have a total in cell CS ofWorksheetl 
(Wl) that is linked to cell 07 in Worksheet2 (W2), 
using the formula = Worksheetl! $C$5. If you insert a 
row into W 1, which pushes your total down to C6, the 
value in D7 of your second worksheet changes, 
because it's still linked to cell CS. You can adjust for 
rearrangements by using a name instead of a cell ref­
erence. For this example, select CS in WI. Choose 
Define Name from the Formula menu, type in a name 
such as Total, and click on OK. 

On W2, change your link to read: 
=Worksheet11Total. 

Now if you cut and paste the value in CS to some other 
area ofW1 or insert rows that push CS down, the 
name will follow the original value in CS wherever it 
goes and the link will be properly maintained. Note: 
This won't work if you sort the rows into a new order. 

Displaying Fonnulas 
You can display, in a cell, the formula that produced a 
value. Command-tilde (-) lets you toggle between 
showing a formula and displaying a value in a cell. 

Deleting Fonnulas While Maintaining 
Values 
1b delete formulas in selected cells on a spreadsheet 
while maintaining the values, select and copy the 
cells. With the same cells selected, choose Paste 
Special from the Edit menu and select Values from the 
resulting dialog box. 

Creating An X-Y Chart? 
You can plot an x-y chart for one or more series of y 
data by using the Scatter format from the Gallery 
menu. If your data is in columns, enter they data into 
the columns directly to the right of the x data on your 
worksheet. If your data is in rows, enter they data into 
the rows directly below the x data on your worksheet. 

Next, select the data you want to plot, including col­
umn headings if you want to plot them as well. Copy 
the data to the Clipboard. Open a new chart. Choose 
New from the File menu, and select Chart. Click on 
OK, and a blank chart will appear on your screen. 



Choose Paste Special from the Edit menu. If your data 
is in columns or rows), choose Values in Columns (or 
Rows) and Categories in First Column (or Row). If you 
have also copied column (or row) headings for inclu­
sion in the chart, click on Series Names in First 
Column (or Row). 

Click on OK, and the data will be plotted in a bar 
chart. Select Scatter from the Gallery menu, and the 
data will be plotted as an x-y chart. 

Hiding Sensitive Data From View 
Using the Cell Protection command only hides formu­
las from being viewed. To really protect sensitive infor­
mation, eliminate the column containing the data 
from view. Select all of the columns you want to hide, 
choose Column Width from the Format menu, and set 
the width to zero. Although hidden, the values will still 
be used in computations. 

Now, protect the document with a password. No one 
will be able to view the hidden data without knowing 
your password and unprotecting your document. 

Manipulating 11te Insertion Bar 
With Arrow Keys 
Editing the Excel Formula Bar with the mouse can be 
a test of dexterity. It might actually be impossible for a 
physically impaired user. 

The Microsoft manual does not mention that the 
insertion bar can be manipulated with arrow keys. 
The trick is to activate the Formula Bar first with 
Command-U instead of with the mouse. Once acti­
vated from the keyboard, the left and right arrows 
will then move the insertion point one character. 
With the Command prefix, the lefVright arrows 
move one field per stroke. This field can be a word, a 
space, a symbol, or a cell reference, for example. 
With the Shift prefix, the region through which the 
bar moves is extended and highlighted in the usual 
way. 

Quickly Returning To Where You Left Off 
When you're using several worksheets, charts and 
macros simultaneously, quitting the application and 
later returning to where you left off can be painful­
you have to open every worksheet, macro, and chart 
separately. 

However, Excel lets you return to where you left off 

with the Resume Excel icon, which is created after 
quitting Excel. It works only if you haven't tried to use 
Excel with another worksheet. 

If you want to save a configuration, drag the Resume 
Excel icon out of your System folder and rename it. 
Resume Excel remembers all the windows last 
opened, their positions, and the locations of all files. 

This also works in earlier versions of Excel, where the 
Resume Excel icon appears in the folder that was open 
when you launched the application. 

Using Excel To Simplify Word's Mail Merge 
If you are left intimidated by Word's mail-merge fea­
tures, Excel can simplify the mail-merge process for 
you and provide a simple flat-file database as well. 

Here's how to set things up: 

1. Create an Excel address database. You can sort, 
print, edit, or search it. Make sure you save a version 
in the CSV (Comma Separated Values) text format so 
Word will be able to access it. 

2. Set up a Word "main document" (see the Word 4.0 
manual) - not a difficult process. The first line con­
tains the DATA statement followed by the name of the 
"data document," or address database. Thxt prints as 
usual. Field names are enclosed in double-angle 
brackets (Option-\, Shift-Option-\}. 

3. Now here's the good part. See all those field names? 
They're common to both the Excel address database 
and the Word main document (the form letter).just 
make sure the name you use in the Word form letter is 
the same as the name you've given the Excel file saved 
in the CSV text format. 

To print form letters, open your main document in 
Word, select Print Merge, and choose which records 
(the row numbers in your Excel address database 
that contain the names and addresses you want) to 
print. Click on the Print button, and you're finished. 

EXCEL 3.0 
Incorporate Messages Into Macro 
Functions 
When creating a macro that will take 30 seconds or so, 
incorporate the MESSAGE function into the macro to 
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let users know, via the message/status bar, what to 
expect. R>r example: 

=MESSAGE(TRUE,"Values are being reset. Please 
wait ... ") 

is sufficient to describe what's taking so long. Be sure 
to use =MESSAGE (FALSE) to clear the status bar when 
the work is finished. 

Adding 1b And Subtracting From The Page 
Number Printed 
You can add or subtract from the &p command in 
Excel's Page Setup dialog box. For example, if you type 
&p+ 10 (there can be no spaces between the charac­
ters, or it won't work) in the Header or Footer section, 
the first page will have page 11 in its header or footer 
and so on. This is useful if you're printing spread­
sheets or graphs that need to be inserted in the middle 
of a report. 

and you, too, can have puffy buttons in your spread­
sheet. 

Suppressing Screen Updates In Macros 
You can suppress screen updating when creating 
macros, especially if other users will see only the end 
result or if the task takes a long time. For example, 
=ECHO(TRUE) displays all the actions until 
=ECHO(FALSE) is encountered. 

Using The Workgroup Command 
'IbSaveTune 
When working on dissimilar, multiple spreadsheets 
simultaneously in Excel, you may find that the 
Workgroup command saves critical time. Although the 
Workspace command brings up multiple spreadsheets, 
it doesn't let you work with them all at the same time. 
Workgroup, however, lets you save and print the dis­
similar spreadsheets without going into each separate 
sheet. For example, imagine you have 20 interactive 

Aligning Number Formats spreadsheets arranged on your screen and do not want 
It's possible to modify noncurrency number fonnats in to save and print 20 separate times. Simply select all 
Excel3.0 so that they align properly with currency for- . the spreadsheets in Workgroup, and with just two 
mats by using the Fonnat Number command. commands- Save and Print-all your work is done. 

In previous versions of Excel, the number in noncur­
rency cells didn't line up properly with cash or curren­
cy number in columns. This was because positive 
numbers formatted as currency included a space the 
width of a right parenthesis so that they aligned with 
negative currency amounts, which are always 
enclosed in parentheses. 

In order to avoid encountering this problem in Excel 
3.0, select the noncurrency number cells, and choose 
Number from the Fonnat menu. After the number for­
mat, which appears in the Fonnat box, type an under­
line character and a right parentheses: _). 

When you press Return, the noncurrency and currency 
numbers should align properly. Note: This tip does not 
work with the General number fonnat. 

Microsoft Excel Has A Special Look That 
Says System 7 
To make System 7 users feel extra special, Microsoft 
gave Excel3.0's Toolbar and outlines a 3-D, Excel-for­
Windows-style appearance when run under System 7. 
But System 6 users don't have to miss out on the fun. 
just hold down Shift -3-D when you start up Excel3.0 
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However, be careful not to make layout changes to one 
sheet or all the sheets will be changed. 

Keyboard Combinations For Modifying Bar 
Charts 
To modify the pattern, foreground, and/or border of 
one occurrence of a bar representing data in a bar 
chart, hold down the Command key and double-click 
on the desired area. Make your modifications, and 
click on OK. The other bars of the same original color 
will remain unchanged. 

Keyboard Combinations To Select A Group 
Of Rows 
Normally when you create a chart, you highlight all 
the columns and rows starting from the first cell and 
work your way down to the last cell. Sometimes, 
though, you might want to exclude a certain row 
between the first and the last cells. The Command key 
comes to the rescue once again. 

Select all the rows up to the row you want to exclude, 
in nonnal fashion. Now hold down the Command key, 
and choose only the rows after the excluded row. Click 
on the Chart button to create the chart. 



Improving Business Graphics With A 
Drawing Grid 
Excel3.0's drawing tools make Excel a fairly decent 
drawing environment for simple business graphics 
such as flowcharts. You can make this feature even 
better by setting up a grid similar to those found in 
most drawing programs. 

To do this, select the entire worksheet and use the 
Format menu to set the row heights to 12 and the col­
umn width to 1. Hold down the Control or Command 
key as you draw with one of Excel's drawing tools, and 
the object will automatically align to the grid. 
Experiment with the row-height and column-width 
settings to come up with a variety of grid sizes. 

Microsoft Excel Catches Up, Caches On 
Microsoft Corp.'s Excel3.0 has problems with the copy­
back cache on the 68040 chip used in the Quadra 700 
and 900. You can use Excel3.0 on a Quadra with the 
caches off, but your performance in this situation is 
equal to or less than that of a Mac Ilci. 

Microsoft has a free upgrade, Version 3.0a, that fixes 
the problem. If you have a Quadra- and, according 
to Microsoft, 3.0a has no advantages for anyone 
else -you should call Microsoft customer service at 
800-426-9400 and ask for the newer version. 

EXCEL 3.01 
Some Bug Fixes For Excel3.0 
Several little buglets crept into the 3.0 release of 
Excel, and Microsoft issued a maintenance upgrade, 
Version 3.0a. The update fixes include, among oth­
ers, making Excel compatible with the Quadras and 
corrected incompatibilities with version 1.3 of Apple's · 
DAL (Data Access Language). Registered users can 
get the update free from Microsoft Corp., One 
Microsoft Way, Redmond, WA 98052; 800-426-9400 
or (206) 882-8080. 

FILE CONVERSION 
'lab-Delimited Format 
The tab-delimited format, which most spreadsheet 
software can read, can be used to import and export 

data to and from a spreadsheet. A spreadsheet has 
each of its rows on a separate line, with tabs separat­
ing the data in individual columns. 

You can use your text editor to create and enter tab­
delimited data into your Macintosh spreadsheet. Just 
open the text file with the spreadsheet program and 
the data will flow into the spreadsheet cells. 

WINGZ 
Using HyperScript To Add Hide And Show 
Commands 
You can use HyperScript to easily add Hide and Show 
commands to the Sheet menu. 

First, select New Script from the Script menu, and then 
type the following script (the indents are unneces­
sary): 

select menu "sheet" 
add menu separator 
add menu item "Hide" command 

"repaint off 
hide sheet hide tool box hide entry 
bar 
select report border no line border 

repaint on 
repaint window" 

add menu item "Show" command . 
"repaint off 
show sheet show tool box show 
entry bar 
select report border single line 
border 

repaint on 
repaint window" 

The Repaint Off command in this script stops Wingz 
from redrawing the screen after hiding each element, 
which would slow down the script. The No Line Border 
command hides the border that Wingz normally 
draws around every printed sheet. 

Improved Date Formats 
Wingz's five date formats all use hyphens, but you may 
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prefer Excel's compact m/d!yy format. This script 
replaces the fourth date format (mm-dd-yy) with 
rnld!yy. The fourth format was chosen for modification 
because Wingz uses it by default for entering a date 
into a cell, but you can change the· script to substitute 
this new format for any of the five \Vingz formats: 

select menubar "main" 
select menu "format number" 
select menuitem "MM-DD-YY" 
rename menuitem to "MIDIYY" 
date 4 "rnld!yy" 

The new date format is not stored with spreadsheets­
to use it, the script must be executed each time you 
start the Wingz program, making it a good candidate 
for placement in your Startup script. 

Restoring Row Height And Column Width 
Wingz lets you adjust the height of rows, but this abili­
ty is a mixed blessing. Rows are narrow, and it's easy 
to accidentally change the height of a row when all 
you actually meant to do was select it. Once it's been 
changed, there is no simple way to restore a row to its 
original height. This script does exactly that- all 
selected rows are reset to their default height: 

row height 240 

The 240 measurement is in TWIPs, Wingz's standard 
unit of measure. One TWIP is V20 point, so 240 is 12 
points, the standard row height. A similar script 
restores default column widths: 

column width 1480 

Setting Row Height And Column Width 
This script allows you to set the height of all selected 
rows by simply entering the desired height, in points, 
into a dialog box: 

row height value(dg:dgask ("Enter height in points'; 
round (rowheight () I 20, 0), 5)) *20 

The dialog box initially displays the height of the first 
row in the selection. The dg:dgask function, which 
ships with Wingz, displays a dialog box with ames­
sage and a text field in which the user can enter a 
response. 

It takes three arguments: the message string, the ini­
tial value to display in the response field, and that 
field's desired size in characters. The multiplication 
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and division by 20 handle the conversion of values 
between points and 1WIPs. 

A similar script lets you set the width of all selected 
columns: 

column width value (dg:dgask ("Enter width in 
points'; round (columnwidth 0 I 20, 0), 5) )*20 

Tune Made Simple 
Wingz is not smart when it comes to accepting time 
values. For instance, if you enter 10:35 or 12:30pm into 
a cell, Wingz does not understand that you are enter­
ing a time - it interprets the entry as ordinary text. 

This script converts the text in the active cell to a gen­
uine time value and then formats the cell to use the 
HR:MN AM format: 

put timevalue (cell() into 

range ( makecell (col (), row ())) format 
time2 

Adding Additional IF Statements To 
Expressions 
WingZ's manual describes how to use the IF function 
to enter one of two expressions into a cell, depending 
on whether a given condition is true or false. For 
example, =IF(E2>=60, "Pass';"Fail") returns Pass if 
the value of cell E2 is greater than or equal to 60; oth­
erwise it returns Fail. 

The IF function may also contain additional IFs and 
criteria so that one of several expressions is placed 
into a cell. For example, the formula 
=IF(E2>=90,'1\'; IF(E2>=80,"B'; IF(E2>=70,"C'; 
IF(E2> =60, "D'; "F")))) returns the letter grade for 
the 90-80-70-60 percentage grading scale. 

A Goodies Menu 
Wingz features a HyperScript programming language, 
which lets you easily create custom features and 
menus. You don't have to be a programmer to use the 
following scripts. To enter a script into Wingz, select 
New Script from the Script menu; type the text of the 
script; and then save it, using whatever name you like. 
1b run the script, select Run Script from the Script 
menu and open the file containing your script. If you 
create a script named Startup and put it into the same 
folder as Wingz, it will be executed automatically each 
time Wingz is launched. 



This script combines several previously mentioned 
scripts and includes an additional script for selecting 
the last cell in a spreadsheet. Directly out of the box, 
Wingz won't let you select the last cell- this script 
defines the last cell. The Startup script provides the 
new date format and then creates a Goodies menu 
that has an entry for every one of the remaining com­
mands. Be especially careful to type the script exactly 
as it is shown here: Quotation marks in the scripts 
appear doubled when they are embedded as menu 
commands in the Startup script. Name this script 
Startup and put it into the same folder as Wingz; that 
way, you'll get the Goodies menu automatically each 
time you launch Wingz. 

{set 4th date format (the default date format) to 
m/d/yy} 

select 
menubar "main" 
select menu "format number" 
select menuitem ''MM-DD-YY" 
rename menuitem to ".WD/YY" 

date 4 "m/d/yy" 

{create Goodies Menu} 
add menu "Goodies" with 6 items 
{restore selected rows to default height} 
add menuitem "Fix Row Height" command "row 
height 240" 
{set row height in points} 
add menuitem "Set Row Height..." command "row 
height value (dg:dgask ("Enter height in points'; 
round (rowheight () I 20, 0)) *20" 
{restore selected columns to default width} 
add menuitem "Fix Column Width" command "col­
umn width 1480" 
{set column width in points} 
add menuitem "Set Column Width ... " command "col­
umn width value (dg:dgask ('"'Enter width in 
points"'; round (columnwidth ()I 20, 0)) *20" 
{convert current cell's text representing time to time 
value} 
add menuitem "Fix Time" command "put timevalue 
(cell () into range (makecell (col (),row ()))format 
time 2'' 

{select last cell in spreadsheet} 
add menuitem "Select Last Cell" command 
"define sel, lastrO\V, lastcol 
repaint off 
select Active Cells 
sel = selection (1) 

lastrow = rowof(sel) + rows(sel)- 1 
lastcol = colof(sel) +cols(sel) - 1 
select range range (makecell (lastcol, lastrow)) 
repaint on 
repaint window" 

WORKS 
'Ikking Advantage Of The Draw Module 
The Draw module is a hidden treasure that you can 
use only in conjunction with the word-processing or 
spreadsheet program of Microsoft Works. You can use 
it to dress up documents or as a graphics program. 
Objects and text created in the Draw module exist in a 
separate layer from the word-processing or spread­
sheet information - similar to an acetate overlay- so 
you can read underlying text through a graphic if you 
choose. 

The module lacks a vertical ruler and precise sizing 
tools- serious omissions, but you can precisely posi­
tion objects in two ways: A snap-to-grid system lets 
you specify grid increments down to 1136 inch or 1114 
centimeter, and the keyboard arrow keys and the 
directional arrows in the tool palette let you move 
objects one pixel at a time. 

Spreading 'lext With The Draw Module 
Works' Draw module has some exotic features. It can 
make text follow and spread evenly along an arc or 
diagonal line. You can also use this technique to 
adjust letter spacing. 

Cut or copy your chosen text to the Clipboard, and 
draw an arc or line in the Draw module. Make it 
invisible by selecting White or No Line on the Line 
Pattern menu, and then select the Spread Text com­
mand on the Format menu. Each letter becomes a 
separate draw object that you can move or size inde­
pendently. If you group the letters, using the Group 
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Picture command on the Fonnat menu, you can 
stretch or distort them. 

Desktop Publishing 
Yes, you can create multiple-column newsletter pages 
and fliers with Works. To create columns, select the 
text tool from the palette and hold down the Option 
key while you draw text frames, just as you would in a 
desktop publishing application. To link columns, hold 
down the Option key and, with the pointer, click on 
the columns in the order you want. Headings above 
each column indicate the name or number of the cur­
rent column and the column it is linked to. You can 
edit these headings manually with the text tool. 

Once you've created the columns, typed or pasted 
text flows from column to column. This doesn't work 
as smoothly as it does in conventional DTP applica­
tions -you must deselect a column before text 
reflow occurs- but for occasional use, Works is a 
competent desktop publishing application. 

Better-Looking Charts 
Works is at its best when you use two or more modules 
together. You can't edit a Works chart in its own window, 
but if you paste it into a spreadsheet, you can edit it by 
using standard draw techniques. 

To improve a chart's appearance, use the Ungroup 
Picture command on the Fonnat menu. This breaks 
the chart into individual draw objects. You can then 
pull a wedge out of a pie chart, change the fill or line 
patterns, add additional text labels, circle important 
infonnation, or draw lines with arrowheads. 

Make Works Desktop 
The Make Works Desktop commands on the File menu 
creates a file (its icon looks like a desk) that remem­
bers groups of Works documents: Open the file, and 
you automatically open the whole group. You can use 
this feature to file any kind of linked documents, such 
as letters or mailing labels. 

Creating a Works Desktop file is simple: Choose the 
Make Works Desktop command on the File menu 
while the files you want to include are open, and then 
name the new file. 

How can you put this feature to practical use? Try creat­
ing a check-writing module with the Make Works 
Desktop command. You'll need three Works files: 
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A database that contains all the infonnation that will 
appear on the check, another database containing a 
list of companies to whom you write checks regularly 
(including the check amount, in some cases), and a 
word-processor document that prints the checks by 
merging the data from the check-register file. Name 
this Works Desktop file Banking; double-clicking on it 
gives you instant access to the three files you need to 
write checks. 

Moving A Selected Range Of Cells In The 
Spreadsheet 
While in the spreadsheet, you can quickly move a 
selected range of cells by holding down Command­
Option while clicking in an empty cell. The cell that 
you click in will become the upper left cell of the 
moved range. 

Date and Ttme Shortcuts 
Works provides a shortcut- Command-O- for entering 
the current day's date into a date field in a database. For 
time fields, Command-T has an analogous effect. 

Alternatively, you can enter a date in the current year by 
typing month/date ( 12/22, for example), and Works 
automatically adds the year This shortcut works even if 
you want to display the date in medium or long fonnat; 
\'\brks will display the date in your chosen fonnat. 

Presentation Spreadsheets 
Like a high-end spreadsheet program, Works lets you 
insert charts within a spreadsheet. Starting with a 
chan window on-screen, select the Copy command, 
switch to the spreadsheet window, and paste in your 
chart. 

Works lets you ungroup your charts after you've drawn 
them. Select Ungroup Picture on the Format menu, 
and you can adjust the placement of bars, legends, 
titles, and so on. 

Spreadsheet Cell Notes 
Cell notes are like Post-it notes that you can attach to 
individual cells. Use them for comments about the 
calculation for the cell or instructions about what to 
enter. This information, although useful, is unneces­
sary in the main display. 

To create a cell note, select the cell you want, select 
the Open Cell Note command in the Edit menu, and 
type your message in the cell-note window. The notes 



are saved with the document, and a mark appears in 
the upper right corner of any cell that has an associ­
ated note. 

'J.elecommunications Sessions 
Many communications applications forget text that 
has scrolled beyond the top edge of the window. To 
review a session later, you must save the screen text to 
a disk file. This approach has two disadvantages: The 
file can't be read while the communications session is 
in progress, and you need a separate word processor or 
text editor to read the file. But what if you just want to 
reread information from three screens back? 

During a session, Works can remember up to 100 pre­
vious screens (the more screens you select, the more 
memory you need). 

Works also permits up to 14 windows to be open 
simultaneously and supports background communi­
cations, uploading, and downloading. You can save 
text from the screen into a new document, and you 
can also paste text you want to transmit into the com­
munications window. 

Using A Word Processor 1b Change Fonts 
Although the spreadsheet has no font changing capa­
bilities, you can move a block of cells from a spread­
sheet to a word processing document via the 
Clipboard, and then change the font, sizes or styles in 
the new word processing document. The only problem 
with this is that you lose the display grid, if you had 
one. Works' drawing functions allow you to easily 
reintroduce one. 

Microscrolling 
When horizontally scrolling, your view usually shifts a 
fixed length. Scrolling in the word processor happens 
one inch at a time, while scrolling in the database or 
spreadsheet moves you one column. 

Hold down Shift while scrolling to microscroll, allow­
ing you to position all or parts of a window more 
exactly. 

Hanging Up Pdst In 'J.elecommunications 
Mode 
While in the communications mode, you can 
quickly hang up the phone or modem by typing 
Command-=. 

\ 
Pasting In Data Without Field Names 
If you have cut or copied information from the 
database, hold down Option while pasting it into a 
word processor to avoid pasting in the field names 
along with the data. 

Saving Ftles With Return 
At End Of Each Line 
Hold down Option while saving a word processor file 
as text (Export File) to save the file with Return char­
acters at the end of each line. This will come in handy 
when transmitting text files. 

Bringing The Bottom-Most Window 
'lbTheFront 
When working with multiple documents, type 
Command-comma to bring the bottom-most window 
to the front. Use this to quickly switch between differ­
ent documents you're currently working on. 

Entering Page Breaks From The Keyboard 
Enter a page break without having to go to the Fonnat 
menu by hitting Shift-Enterwhile you're typing. The 
page break will be entered at that point. 

Quickly Accessing Graph Specifications 
Dialog 
Double-dick in a chart window to quickly bring up 
the graph specifications dialog box, which allows you 
to change the graph. 

WORKS 2.01 
Going From Works 1.1 to 2.0a 
If you would like to transfer all information from 
Microsoft Works Version 1.1 to version 2.0a, it's sim­
ple. First, launch Version 2.0a. Now use the Open 
command on the File menu to open any file you cre­
ated with Version 1.1. Once the file is open, select 
Save from the File menu. That's it. The file is now in 
Works 2.0a format. 

Microsoft Works·2.0a Patch 
Microsoft Corp., while working on Version 3 of Works, 
released Version 2.0e. This update fixed a strange bug: 
If a folder's directory ID (a number the operating sys­
tem uses internally to identify a folder) was out of 
bounds, Works would fail to save documents in that 

II 

115 



ffiFil 
8 

folder. Directory IDs can be out of bounds on really old 
hard disks and some non-AppleShare file servers. 

A patcher application updates Works 2.0a or later to 
Version 2.0e; the patch is available in Microsoft sup­
port forums on AppleLink, CompuServe, GEnie, 
America Online and from Microsoft customer service 
at 800-426-9400 or Works technical support at 
(206) 635-7160. 

WORKS 2.0 
Rounding Off Numbers 
The Microsoft Works database and spreadsheet mod­
ules don't round off numbers consistently. 

Here's a fonnula used initially to round off test grades: 

=Round(((B7 + C7)/200),2) 

When this formula averages the test scores of 87 and 
84, it rounds up the result, 85.5, to 86. But with scores 
of 91 and 100, the average, 95.5, is instead rounded 
down to 95. By adding a very small number 
(.0000001) to the fonnula, as in 

=Round(((B7 + C7)1200) + .0000001),2) 

you can force Works to consistently round up to the next­
higher whole number. 

Navigation Commands When Without The 
Extended Keyboard 
Here are some undocumented navigation tips for any­
one who is using Microsoft Works 2.0 without an 
extended keyboard: 

To go to the top of a document, press Command-A. 

To go to the end of a document, press Command-D. 

1b move up approximately one page at a time, press 
Command-K. 

SYSTEM SOFTWARE 

32·BIT ADDRESSING 
Accessing More Thank 8 MB Of RAM 
Without 32-Bit Addressing 
In order to use more than 8 megabytes of RAM on any 
Mac, you must tum 32-bit addressing on. That's the 
simple answer, but, of course, there's an exception to 
the rule. If you use Maxima, RAM-disk software from 
Connectix (125 Constitution Drive, Menlo Park, CA 
94025; 800-950-5880 or [415] 324-0727), you can 
access as much as 14 megabytes of RAM without turn­
ing on 32-bit addressing. Maxima requires a 68030 
processor or a Mac II with a PMMU chip installed. 

ALARM CLOCK DA 
Why Your Menu Bar Or Apple Is Flashing 
If your menu bar (or the Apple icon at the top left of 
the screen) is flashing and you don't know why, 
chances are it's because someone set your alarm 
clock. Choose Alann Clock from under the Apple 
menu and click on the tiny flag at the far right side of 
the window. From there, choose the alann clock icon 
(in the far right corner). Look into the middle section 
of the window- see that small switch image on the 
left? Set it to the up position by clicking on it, and 
your alarm should stop flashing. 

APPLE DESKTOP BUS 
(ADB) 
Power Down First 

To move down one screen at a time, press Command-L. Never connect or disconnect anything without first 
shutting down your Mac and all the peripherals. You 
may get away with it some of the time, but there's 
always a chance of damaging an internal component 
when you connect a peripheral without first powering 
everything down. 

Don't worry about turning your Macintosh on and off 

116 



a few extra times. Also, don't forget to use the Shut 
Down command before you tum off the power. 

APPLE FILE EXCHANGE 
Recovering Ales From A Damaged Disk 
Occasionally the Desktop file on a floppy disk will 
become damaged so that it can't be rebuilt in the usual 
way. You can tell that the file is damaged when there is 
a long pause after you insert the disk into the drive, 
followed by an alert dialog box that says the disk needs 
minor repairs and asks if you want to repair it. 

If you click on OK to repair the disk, however, often 
the head shuffles around a bit and the disk is ejected 
without being read. 

Although you may loose the disk, you can retrieve all 
the files, not with an expensive recovery application but 
with an application. AFE (Apple File exchange), that 
comes free with the System software. 

Launch AFE, and the entire file list appears. Now 
transfer all the files safely off the damaged disk to 
another floppy or hard disk. Other programs could 
probably do the same, but AFE is fast and efficient­
and the price is right! 

Fooling The SuperDrive 
Here's a tip aimed at people who do a lot of MS-DOS­
to-Macintosh conversion, using the Apple File 
Exchange. IBM PS/2s and compatibles that use a 
3.5-inch 1.44-megabyte drive can read, write, and for­
mat a high-density disk at the lower 720K density. 
Unfortunately, when trying to read these disks on a 
SuperDrive-equipped Macintosh, Apple File Exchange 
assumes that it fonnatted at the 1,440K density. AFE is 
looking at the extra notch on the disk before it 
attempts to read the actual fonnat. 

You can fool the SuperDrive hardware into thinking it 
has a standard DS/DD (double-sided/double-density) 
disk by using a piece of tape to cover the extra notch (or 
to further confuse the issue, you can use a write-protect 
sticker, as used on those archaic 5.25-inch floppies). 

Also, AFE displays hidden files, such as the desktop, 
and seemingly transfers them to an MS-DOS disk. 
However, the only thing that gets transferred is an 
empty file that is hidden on the MS-DOS side (i.e., the 

file's contents are not transferred, but a hidden file is 
created). If you make a habit of hiding your data files 
under a security program, youtl best un-hide them 
before trying to transfer them to an MS-DOS disk. 

APPLE INSTALLER 
Reducing Disk Swapping 
When using Apple's Installer under System 7 (or 
MultiFinder) to create startup disks, you nonnally 
have to put up with a lot of disk swapping- especially 
if you're working from a hard disk and your system 
has only one floppy drive. You can reduce the number 
of disk swaps by increasing the amount of memory 
allocated to the Installer program, so that each of the 
four System disks needs to be inserted only once to 
obtain the necessary infonnation. Here's what to do: 

Select the Installer icon, and choose Get Info from the 
File menu (or press Command-I). Increase the 
amount of memory allocated to the Installer in the 
Application Memory Size box. Give the Installer at 
least 1 megabyte of RAM to work with. 

Using the same method, you can increase the amount of 
memory allocated to Font/DA Mover. This will reduce the 
number of system crashes when you're copying or delet­
ing large font or DA files. 

AU/13 
Can't Spool To Non-PostScript 
A/UX 3 can't spool printing jobs to non-PostScript 
printers, such as the Style Writer and Personal 
LaserWriter LS. 

CLIPBOARD 
Creating A Macro 1b Edit Clipboard Items 
One shortcoming of the Mac's Clipboard is that you 
can't add to it or edit it. You can create a set of macros 
that alleviates the problem by turning an ordinary 
untitled window into a quasi-Clipboard. 

First, create a macro (using any macro program) to 
open a new document that will be "under" the doc-
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ument you're working on: Press Command-N, and 
go back to your original document by choosing it 
from the Window menu in the application you're 
using. Because both this and the macro that follows 
depend on mouse position, make sure your untitled 
document is below the original one on the Window 
menu. (Unless the filename begins with a letter that 
comes after T, just leaving the Untitled name is OK.) 
This untitled hidden window is your new Clipboard. 

Next, create a macro that copies text from the origi­
nal document: Press Command C, select Untitled 
from the Window menu, then press Command-V, and 
finally, select the document you are working on 
from the Window menu. You can create a separate 
macro that cuts from the original, by substituting 
Command-X for Command-C in the sequence. 

The Copy macro, which you can call Library Paste, is 
especially handy for selecting items from a long 
general list (such as a large bibliography) for inclu­
sion on a specialized list. The Cut macro, which you 
can call Gather, is useful for collecting and moving 
material in a document. As a companion to the 
Gather macro, you might want to create a fourth 
macro, Spill, that places the newly assembled infor­
mation in your document at the desired insertion 
point and empties the fake Clipboard. Before begin­
ning to record the macro, click on the insertion 
point and select Untitled from the Window menu, 
press the command that selects all in the applica­
tion, press Command-X, select your original docu­
ment, and press Command-V. 

COLOR 
Cycling 24-Bit Color On And Off 
A good rule for using 24-bit-color in your system is: 
Don't use it all the time. 

For example, when you have 24-bit color active, what­
ever program you're using may develop the annoying 
habit of flashing as you scroll or as the screen 
redraws. Tum off 24-bit color off while working with 
programs that aren't dependent on color, such as word 
processors or spreadsheets. As a side benefit, you get 
faster scrolling and graphics drawing. 

How do you tum 24-bit color oft? If you think the only 
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way is to pull down the Apple menu, choose the Control 
Panel, and go to the Monitors cdev, you're wrong. 
Fortunately, tl1ere's a much easier method. The second 
rule for using a 24-bit-colo~:-system (indeed, any color 
system) is: Get a copy of Switch-A-Roo. Similar utilities 
are available, Screen Flipper, for example. 

Switch-A-Roo is simple, and it's free (you can get it 
from Zmac and other freeware sources). Switch-A-Roo 
is an Fkey that lets you configure Command-Shift-as 9 
and toggle between two video parameters, and set the 
toggle between 24-bit and 8-bit color. Switching to the 
lower color resolution results in faster screen updates 
(and gets rid of those annoying screen flashes). Then 
when you're manipulating color or touching up color 
transitions in a graphic with Adobe Photoshop, for 
example- you can tum on 24-bit color. 

CONTROL PANEL 
Controlling The Happy Mac At Startup 
If you use a Mac with more than one monitor, here is 
a way to select which monitor you want to use as the 
main one for the Welcome to Macintosh dialog box or 
a Startup screen. Choose Monitors from the Control 
Panel, and hold down the Option key. When the Happy 
Mac appears, drag it to your main monitor and 
reboot. 

DESK ACCESSORIES 
(SYSTEM 7) 
Receiving Error -97 
If, after upgrading to System 7.0, you get a -97 error 
when trying to invoke a desk accessory (DA) or exten­
sion, this error occurs because the DA or extension 
grabs DRVR slot 12, which System 7.0 wants for its own 
purposes. Contact the Company's customer service 
department for an upgrade. 



DESKTOP (SYSTEM 7) 
Replacing Your Desktop Picture 
If you want to change your desktop to a favorite pic­
ture, but do not want to fool around with ResEdit, there 
are a couple of utilities out there that will do the trick. 

Clay Maeckel's venerable DeskPict is free and it 
works under System 6. BigPat, a System 7-compati­
ble control panel written by Charles Dunn that lets 
you create desktop patterns made up of 32 x 32-bit 
elements (as opposed to the normalS x 8), and 
that makes for undreamed-of realism in brick-wall 
designs. If you want these public-domain programs, 
try your user group or an on-line service. 

DeskPicture is a System 7-compatible utility 
that lets you replace your desktop with a picture; 
DeskPicture comes with Now Utilities- which 
includes Super Boomerang (an Open-and -Save-dia­
log-box enhancer), Startup Manager (an INIT and 
control-panel manager), and Now Menus (for sub­
menus in your Apple menu), among other things. 

Also, check out Wallpaper, from Thought I Could 
([212] 673-9724). It's a control panel that lets you 
create your own desktop pattern with patterns mea­
suring up to 128 x 128 pixels (64 x 64 under 
System 6). It includes hundreds of patterns, and you 
can create your own with its built-in drawing tools. 
You can even import pictures from most Mac graph­
ics programs. 

Rebuilding The Desktop Without Hies 
Present 
Before System 7, you could quickly regain extra space 
on an empty floppy by rebuilding the desktop, but 
this doesn't seem to work under System 7. 

Finder 7 apparently won't rebuild the desktop info 
on a floppy that contains no files. Solutions: You can 
reinitialize the disk, or drag a single file over to it, 
rebuild the desktop and then throw the file away. 

Rebuilding Multiple Desktops 
If you have more than one hard disk or partition, 
when you rebuild the desktop, hold the Command 
and Option keys down longer. If these keys are 
pressed when the partition is first mounted, you 
should see the ''Are you sure you want to rebuild the 

desktop" dialog box for each partition or disk. 

DESKTOP FILES 
(SYSTEM 7) 
Recovering Disk Space By Removing An Old 
Desktop Ftle 
If you've upgraded to System 7, you can save many 
kilobytes of space on your hard disk by deleting your 
old Desktop file with a package such as CE Software's 
DiskThp. 

Alternatively, you can make the normally invisible 
Desktop file visible with ResEdit and then just drag 
it to the Trash. Be careful, however, that you don't 
delete the files Desktop DB or Desktop DE These are 
the files System 7 uses instead of the single Desktop 
file used by previous systems. (Note: If you frequent­
ly switch between System 6 and System 7, don't 
delete the old Desktop file or you may find yourself 
waiting three or four minutes for your hard drive to 
mount when you start up with System 6.) 

DIRECTORY DIALOG 
BOX 
Three Ways To Search The Directory Dialog 
Box 
You have just selected Open from the File menu to find 
yourself staring at a folder with multitudes of files. How 
can you speed up your search for a file that's in the mid­
dle or toward the bottom of the list? 

1. Scrolling or using the arrow keys lets you see every 
file in a folder, but these are also the slowest ways to 
search the directory dialog box. 

2 No matter how you have your view set in the Finder 
windows, the directory dialog box always lists files in 
alphabetical/numerical order. Typing the beginning 
letter (or number) of the filename takes you right to 
the file or to a range close to it. If the file is near the 
bottom, try typing Z. 

3. Typing the tilde (-) key takes you to the very bot­
tom of the list. 
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These techniques also work on windows in Res Edit, 
Symantec Tools, DiskTop, and DiskTools II, but they 
don't work with all file editors. You might find other 
instances in which these work. 

Press On The Drive Name 
If you want to go upwards in the hierarchy of a drive 
while in a dialog box, click on the name of the drive. 

DISK FIRST AID 
Get More Info 
Apple's Disk First Aid gives a few clues about various 
catalog components if you use the secret key combi­
nation, Command-S, to display a status window after 
opening a volume. 

Each disk volume has an invisible ''catalog" (also 
known as the "directory"). This critical data is what 
actually enables the Finder and other programs to 
find files on the disk. The catalog and its associated 
"extents" data are private to the operating system and 
invisible to all normal applications. 

DOS EMULATION 
Running DOS Programs On The Old Mac SE 
To run DOS programs on an old Mac SE, you can use a 
program called SoftPC, from Insignia Solutions. You 
have to upgrade to at least 2.5 megabytes of RAM to 
run it, but going to 4 megabytes is recommended for 
the best results. 

That solves only half of your problem, though, 
because the old SE doesn't have the DOS-reading 
SuperDrive that's standard equipment on all newer 
Macs. The old Mac SE lacks the SWIM chip that would 
enable it to use Apple's cheap external SuperDrive. 
However, you can get a 3.5-inch and/or 5.25-inch SCSI 
floppy drive called the DaynaFile from Dayna 
Communications that will work just fine. 

SoCtPC Or Mac286, 386? 
Since it uses a real80286 or 80386 processor, 
Anaheim, California-based Orange Micro Inc.'s 
Mac286 NuB us card is faster than Sunnyvale, 
California-based Insignia Solutions Inc.'s SoftPC, 
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which is a software emulation of a processor. Typically, 
the Mac286 will be four to five times as fast in raw CPU 
throughput. Depending on the case, SoftPC can deliver 
close to the same performance as the Mac286, and it's a 
lot cheaper. 

EASY ACCESS 
Using Easy Access 
Easy Access is a startup utility, which comes with the 
Macintosh System software, for those who can't use a 
mouse. Easy Access turns the numeric keypad into a 
substitute mouse. 

Put Easy Access into your System Folder and restart 
your Mac. Command-Shift-Clear invokes the Easy 
Access-mode mouse keys. The 5 key performs the 
mouse-button functions (clicks and double-clicks), 
and the other numeral keys from 1 through 9 move 
the mouse. The 0 key locks the mouse button down, 
and the period key unlocks it. This is documented in 
the system documentation which comes with every 
Macintosh. 

Sticky Keys Feature Of Easy Access 
Sticky Keys is a feature of Easy Access that allows 
single-finger operation of the keyboard. 

To tum the Sticky Keys feature on, press the Shift key 
five times in a row. Be careful not to move the mouse at 
all while pressing Shift, or you'll have to start all over. 

A Frozen Screen May Really Be Easy Access 
Here is a simple tip for those who often use cursor keys 
in Easy Access. If your screen freezes and it appears 
that your Mac has bombed, always try pressing the 
period key on the numeric keypad. You may have acci­
dentally hit the keypad 0 key, causing the mouse to 
stay clicked and creating the illusion of a System error. 

With Sticky Keys turned on, the "modifier" keys 
(such as Shift) can be pressed before the key they 
modify, rather than at the same time. Pressing the 
modifier key once modifies the next keystroke only; 
pressing it twice locks it on until it is turned off by 
being pressed again. Multiple-modifier key 
sequences (like Shift-Option) can be executed using 
Sticky Keys. An indicator in the menu bar shows you 
which modifier key is active. 



With Sticky Keys turned on, you type as usual until 
you want to type a multiple-character keystroke. 
Instead of pressing the keys together, you can now 
press one of the modifier keys, and the icon in the 
menu changes to a down arrow indicating that the 
last key you typed is still pressed. 

The other half of Easy Access, Mouse Keys, uses the 
numerical keypad for mouse movements by pressing 
the keystroke combination Command-Shift-Ciea[ 

Using Easy Access For Fine Tuning Graphics 
Easy Access was meant primarily to aid physically 
impaired Mac users who have trouble using the key­
board and the mouse. But any user can profitably 
use the utility from time to time. For example, using 
the Mouse Keys function of Easy Access, you can eas­
ily implement a "nudge" command, which moves a 
selected object one pixel at a time in any direction. 
Such a command exists in SuperPaint and Cricket 
Draw but is sadly lacking in many other draw pro­
grams - like FreeHand. Here are the steps: 

1. Make sure Easy Access is in the System folder when 
you start (or restart) your computer. You have to be 
using System 4.1 or late[ 

2. Open your draw program and position the pointer 
over the item you want to nudge. Click the item to 
select it. 

3. Press Command-Shift-Clear to turn Mouse Keys on. 
With Mouse Keys on, the numeric keypad operates as 
a mouse substitute. 

4. Press the keypad's 0 key to lock the mouse button 
down. (This is an electronic locking, not a physical 
one.) 

5. Tap any of the keys surrounding the 5 key to move 
the selected item exactly one pixel in the direction 
specified by the position of the key. For example, the 2 
key moves the item straight down, the 8 key moves it 
up, and the 6 key moves it to the right. 

6. When you've nudged the object into place, press the 
keypad period key to unlock the mouse button. 

You can leave Mouse Keys on as long as you don't need 
to use the keypad for regular input (the Enter key is 
unaffected by Mouse Keys, however).Th turn Mouse 
Keys off, press Clear on the keypad. 

Mouse Keys can be incredibly useful for very fine mouse 
movement- and it's lots of fun once you get used to it. 

EXTENSIONS 
What Is The A/ROSE extension? 
A/ROSE is used by a few Apple NuBus boards- an 
example is Apple's Token Ring card- that have their 
own 68000 processor and memory and are, in fact, 
separate computers. A/ROSE is their operating system. 
The System 7.0 Installer will copy A/ROSE to your disk 
if you tell it you're using a Token Ring card; some 
other third-party cards may use it as well. If you're not 
using one of these cards, you don't need it. 

Dialog Box For Extensions 
Do you see a dialog box telling you what a system 
extension is when you boot up your Mac? Extension is 
a generic System 7 term used to describe the software 
we used to call Startup documents (INITs), Chooser 
devices and the like. System 7 maintains a lot of spe­
cial folders inside the System folder for extensions. In 
your case, an extension is in the Startup Items folder 
inside your System folde[ Drag the extension out, 
then drag it onto the System folder icon and let the 
Finder put your extension where it belongs. 

'&asbing Active Extensions 
If you attempt to trash a system extension and get a 
message saying the application is locked or busy, it is 
because the extension was in the System Folder at 
startup time, and so it is activated. Many extension 
cannot be removed while they're active. (Most exten­
sions are found in the Extensions or Control Panels 
folders in the System folder.) 

There are several ways to deactivate them and then 
trash them. 

The easiest is to boot from a floppy disk with a System 
folder on it and then drag the extension from the 
System folder on your hard disk to the trash. Another 
way is to use an extension manager, such as 
Extensions Manager. Turn the extension off, reboot, 
and then drag it into the trash. 

Finally, you can move the extension out of your System 
folder and onto the desktop (or into another folder) 
and restart your Macintosh. 
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FILE SHARING 
(SYSTEM 7) 
How It Works 
File sharing is a personal version of AppleShare- it 
lets you share volumes and folders (and the files 
inside them) with other users on an AppleTalk net­
work. With your permission, other users can view or 
edit documents that are on your hard-disk drive from 
their Macs. File sharing includes some security fea­
tures that provide password control over who can see 
or change files on your hard disk. 

What you get here, as a part of System 7, is distributed 
(also known as peer-to-peer) file sharing- mean­
ing that it doesn't require a dedicated file server as 
AppleShare does. (With distributed file sharing, any 
user on the network can make his files available to 
any others; dedicated file sharing, in comparison, 
requires that one machine, the server, contain all 
shared files.) 

There are five easy-to-use components: the Sharing 
Setup, Users & Groups, and File Sharing Monitor con­
trol panels; the Chooser; and the Sharing command 
on the File menu. 

Installing Ftle Sharing 
Installing file sharing is a breeze- it's automatically 
installed when you install System 7 (unless you per­
form a custom System installation, in which case you 
need to install the file-sharing software). 

Getting Started 
Open the Sharing Setup control panel and type in 
your name, a password, and your computer's name. 
Your name is your account name for the network. It 
lets you log on to your Mac's shared folders and vol­
umes if you want to access them from another Mac on 
the network. The computer name you enter is the 
name that will appear in the list of available file 
servers on the network when another user clicks on 
the AppleShare icon in the Chooser. Click on the Start 
button for file sharing, and close the Sharing Setup 
window: File sharing is now turned on. 

Next, select a folder to share, and choose Sharing from 
the File menu. After the privileges window appears, 
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click on the check box next to "Share this item and its 
contents," and your name appears as the folder's 
owner. You can set the following privileges: See 
Folders, See Files, and Make Changes (these are usual­
ly selected as defaults). Close the window, and click on 
the Save button when you're prompted. That's all you 
have to do to make a folder available for sharing. 

Accessing Your Own Computer 
Accessing a shared folder or disk is the same as access­
ing an AppleShare server. Simply go to another Mac 
on the network, use the Chooser to select AppleShare, 
select your computer's name, and click on OK. Type ir 
your name and password; click on OK; and when the 
dialog box appears, select the shared folder and click 
on OK. An icon (the same one youtl see if you accessec 
an AppleShare server) with the name of the folder 
appears on the desktop, and you can access anything 
in the folder, although you're using someone else's 
Mac. You can even use file sharing to access your 
entire hard disk across the network by making your 
hard disk a shared volume. 

Restricting Access With Users & Groups 
Generally, you're going to want to make volumes and 
folders available to other users. The Sharing com­
mand lets you give privileges to everyone on the net­
work. You can also restrict access to certain users or 
groups, however. To do this, go to the Users & Groups 
control panel, choose New User from the File menu, 
type in the name of the user to whom you want to give 
access to the folder, and then double-click on the icon 
with that user's name. The dialog box that appears lets 
you assign a password and privileges to that user (now 
a registered user). Close the window, and save your 
changes. To make a shared folder available to the new 
user, select the folder, choose Sharing from the File 
menu, and select the new user's name in the pop-up 
User/Group menu. 

If you want to create a group of registered users, the 
process is similar: Select New Group from the Users 
& Groups control panel's File menu, and then give it 
a name. When the New Group icon appears, drag in 
the icons of the users you want to make members of 
that group. 

Mixing Systems 6 And 7 Users 
If you have a mixed System 6/System 7 network, you 
can still use file sharing. Although System 6 users 



can't share folders from their Macs, they can access 
shared volumes and folders that are on Macs running 
under System 7. The procedure is exactly the same as 
accessing a normal AppleShare server, so if they don't 
have it yet System 6 users must install the AppleShare 
client software, which is part of the Mac's System 
software. 

Sharing Removable Media 
If you use removable media, such as CD-ROMs or 
SyQuest cartridges, and you have file sharing turned 
on, the removable media are shared automatically 
(only you have privileges, however, until you give priv­
ileges to other users). This means that all mounted 
volumes on your desktop are available to you from 
other Macs on the network, but it also means that to 
eject these disks or cartridges, you must tum file shar­
ing off. 

Removable Volume 'Iroubles 
You may have trouble with removable volumes when 
file sharing is tumed off. Some of these troubles stem 
from a bug in System 7's file sharing; others are sub­
tleties in its operation whose purposes aren't immedi­
ately obvious. 

The bug: In some cases, the Mac may report that the 
volume you're trying to remove can't be ejected 
because it's being shared, even though file sharing is 
tumed off. This can happen if a file was copied to the 
volume when file sharing was tumed on. Sometimes 
turning file sharing on, then off again, will let you 
remove the volume; other times it might be necessary 
to restart. 

Subtle feature: Ejectable volumes such as optical disks 
or SyQuest cartridges are reported as shared when file 
sharing is on, even if you haven't explicitly shared 
them. Why? Because they are being shared - kind of. 
Sign on to your Mac from another Mac on the net­
work, using your user name and password, and you'll 
discover that all your volumes are available, even the 
ones that aren't explicitly shared. 

User limitation 
A limitation that will affect most users is the fact that 
file sharing lets you share only ten folders at a time. 
furthermore, only ten users can simultaneously be con­
nected to any shared volume. If you need more capacity 
than this, you need more-powerful file-sharing software. 

If your network is big, heavily used, or complex, it's prob­
ably better to use AppleShare--Apple's heavy-duty 
dedicated file-server software- or a third-party 
alternative such as Novell Net Ware for Mac. 

File Sharing Performance 
According to Apple, using System Ts personal file 
sharing is slower than using a dedicated server. File 
sharing is optimized for small workgroups, and you 
get the best performance when traffic isn't too heavy. 
Dedicated file servers, on the other hand, are designed 
for high traffic and many users, so depending on your 
network configuration, an AppleShare server can be 
about 25 percent faster than a Mac using file sharing. 
If performance is an issue, look beyond System Ts 
built-in file sharing. 

Unoriginal Names May Be A Bane For File 
Sharing 
Many people give names to hard disks to personalize 
the company computers sitting on their desks. Others 
leave their hard disk with the name Apple gives to all 
such devices: Macintosh HD. 

In a world connected via System Ts file sharing, those 
whose desktops are graced with Macintosh HDs may be 
in for a little trouble. Some programs, notably Microsoft 
Excel and Lotus Development Corp.'s 1-2-3 for 
Macintosh, cannot open files on a shared disk that has 
the same name as a local disk. The solution is to rename 
one of the hard disks. 

File-Sharing Workstation Performance 
A drawback, particularly if you have a Mac Classic or 
an LC, is a perceptible performance degradation when 
other users are accessing your files over the network. 
Some of the symptoms include erratic cursor control 
and windows that flicker as they open or close. If this 
is bothersome, switch to a dedicated file server. 

Decentralized Administration 
File sharing doesn't involve any kind of centralized 
administration. All administrative responsibility 
(deciding who has access to files and who can make 
changes, for example) is in the hands of individual 
users. There's no network-administration software, no 
way to monitor which users are added and deleted, no 
systemized backups, and so on. Although such a 
democratic system can work for small groups, it is dis­
couraged for larger networks, where good network 
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administration is vital for a smooth-functioning net­
work. 

Another potential problem is the unavailability of 
files on Macs that are shut down or disconnected from 
the network. A dedicated file server eliminates this 
problem, because when it's on, all files are available. 

FINDER 7 
Setting The Memory Allocation 
\Vhile operating under System 7, you cannot set the 
amount of memory that Finder uses, even if \mrlting on a 
copy of the file. No "Suggested Size'' or "Current Size'' boxes 
appear if you select Get Inh (This is true even if you look at 
a System 6 Fimler file while started under System 7.) 

Instead, the amount of RAM that the Finder uses is 
dynamically set under System 7. If it needs more 
memory and there is unused memory available, the 
system heap will expand to accommodate the Finder. 
It increases the size of the system software, which you 
can see under About this Macintosh. Conversely, when 
the system needs to free up memory, it will close 
Finder windows to allow other applications to open. 

However, you can start your Mac under System 6, in 
which case the Suggested Memory Size and 
Application Memory Size boxes will appear and allow 
the adjustment of the application memory size of the 
System 7 Finder file. (Although the box names are dif­
ferent than System 7, they serve the same function.) By 
default, the System 7 Finder is set to 295 Kbytes. If 
allocated a greater amount of memory, the Finder can 
keep more windows open, but that additional memory 
is then reserved solely for the Finder's use. 

Closing Finder windows will not free up that reserved 
RAM to allow launching of other applications. This 
can be especially frustrating when working on a low­
memory configuration where the Finder has been set 
to use significantly more memory than normal. Your 
system-software allocation will appear inflated, pre­
venting other applications from launching, and nor­
mal memory-saving techniques such as turning off 
extensions (Shift key held down at start -up) will not 
fix the problem. To detect and correct this situation, 
you need to keep a System 6 start up disk handy to 
look at the Finder's Get Info window and reset Finder 
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memory to a lesser amount. 

Using ResEdit To Reduce Ftle Naming Delay 
The length of the delay after you click on an icon 
name varies with the setting of the mouse's double­
click speed in the General Controls control panel: the 
longer the double-click time, the longer the delay. 

There is no direct user control over this rename delay, 
but there is a way to make the adjustments by using a 
resource editor on Finder 7. 

If you wish to try this unsupported patch, you should 
work only on a copy of the Finder. You make the 
changes to CODE resource No. 11. 

The following values can be substituted for the origi­
nal value of E388 at offset A28 of the resource to short­
en the delay time: 

-One-half normal delay: 4E71 

-One-quarter delay: E288 

-One-eighth delay: E488 

The double-click setting still has an effect on the 
delay after modifying the resource. 

Other values are also possible, and the delay time may 
be lengthened, although that seems counterproduc­
tive. A better alternative may be to eliminate the delay 
entirely. This is accomplished by changing the value 
at location ASA from 5DCO to SOCO. 

FINDER 
An Inherent Organization Tool 

This tip provides a quick and easy To-Do List function 
for the Finder There are other list generators, outliners, 
and organizers - both applications and DAs- but in 
most cases you have to open the program or the DA to 
look at your list. Although a program such as Smart 
Alarms solves that problem for a certain price -in 
money, INIT conflicts, and memory- here's a free 
and easy way to keep organized lists on your desktop: 

Press Command-N to get a new folder. Then, in 31 
characters or fewer, enter a brief description of your 
memo. Do this for each item on your list. Drag these 
folders onto the desktop, where they're constantly 
under your nose as a reminder of some important 



activity or event. Or you can neatly arrange these 
folders inside other folders appropriately entitled To 
Do Today, Letters, Appointments, and so on. You can 
easily create, trash, rearrange, and modify these fold­
ers as needed. They're also useful as repositories of 
further information on a particular project. 

Easy Editing Of File Names 
There's a quick and easy method for adding prefixes or 
suffixes to a file name without carefully placing the 
insertion point. Select the file/folder you want to mbd­
ify by clicking on it once. Press the left -arrow key, and 
when the blinking insertion point precedes the file­
name, type your prefix. Press the right-arrow key to 
deposit the blinking insertion point at the end of the 
filename, and then type in your suffix. 

If you press the arrow keys and no insertion point is 
deposited, the file is locked. If that's the case, make 
sure the file is selected and choose Get Info from the 
File menu (or press Command-I), click on the Locked 
check box, and close the Get Info window. The tip will 
now work. 

Ejecting Disks 
There are keyboard shortcuts to eject disks from disk 
drives using the Command-Shift keys. 

Command-Shift-1 ejects a disk from the first drive; 
Command-Shift-2 ejects a disk from the second 
drive; 
Command-Shift-0 ejects a disk from a third drive. 
To just eject a selected drive, press Command-E. 

Ejecting Floppy Disks Without Ghosting 
When you eject a selected floppy disk using the key­
board shortcut Command-E, a ghosted image of the 
floppy remains on the desktop and your Mac can 
demand that you insert the floppy when you least 
want to. To keep that from happening under System 6, 
press Option-Command-E or hold down the Option 
key when you select Eject From the File menu, when 
you want to eject a disk. Under System 7 press 
Command-Y. 

You can use the Option key for the same purpose when 
you click on the Eject button in the standard Open 
dialog box; Option-click on that button to ensure that 
the Mac doesn't pester you again for that floppy during 
your work session. 

Printing From The Finder 
To print a document directly from the Finder without 
opening it, select the document and use the Print 
command on the Finder's File menu. The Finder will 
run whatever application created the file and print it 
out. This is really useful if you have a whole folder full 
of documents you want to print. If you select them all 
and print from the Finder, many applications, such as 
Word, will show you only one Print dialog box and 
then print the documents in succession. 

The requirement is that you must have a copy of the 
correct application on a mounted disk, of course, or 
you get the dreaded "the application is busy or miss­
ing ... " error message. You can't select two files from 
different applications- this works with only one 
application at a time. Many applications, such as 
Word, won't let you print from the Finder if the appli­
cation is already open. 

Use Special Characters To Arrange Files 
Add special characters to the beginning of filenames 
to force grouping in the Apple menu (or in list views). 
For example, placing an exclamation point (!) in 
front of application names groups them at the top of 
the Apple menu, and adding the grave accent 0 char­
acter to folder names moves them to the bottom. You 
can also start a filename with a space, numerals ( 0, 1, 
2, 3 ... ) or an asterisk. 

Rebuilding The Desktop Of A Disk 
Holding down the Option and Command keys when 
the Finder launches rebuilds a disk's desktop. 
Rebuilding the desktop speeds up the process of 
launching applications. Be aware that you will loose 
any comments in the Get Info box of all documents 
and applications when you rebuild the desktop. 

Keep Folders Small 
The more items there are in a folder, the longer it 
takes to open it, so you want to keep folders small. On 
the other hand, when folders contain fewer items, 
folder nesting becomes deeper. You'll want to find a 
balance between too many items in a folder and too 
many levels of nested folders. Some programs locate 
files by using their full pathname. This includes the 
name of the volume the file is in and every folder 
name, in order, on the path to the file, with each 
name separated from the next by a colon (:). 
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For example, the full pathname to WriteNow in the hier­
archical organization might be like this- Hard Disk: 
Applications: Word Processing: WriteNow: WriteNow. As 
you can see, the more deeply folders are nested, the 
longer the pathnames get. Most programs can't handle 
full pathnames longer than 255 characters. TI1is 255-
character limit is also a reason not to make file or folder 
names too long. 

Why Isn't My Memory Reclaimed 
When I Quit? 
Sometimes, when you quit a program, it seems as if 
the memory it was using isn't reclaimed- at least 
according to the About the Finder window. Why? 

Actually, the memory's really there. If you look at 
About the Finder under the Apple menu, you will 
see that the second number isn't Total Memory 
Available; it's Largest Unused Block. 

When you run a program under System 7 (or 
Multifinder), the program is run as high up in memory 
as it can. When you run another program, it loads under 
the first program. When you quit the first program, its 
memory is available, but the size of the largest unused 
block of memory might not change, since the second 
program is sitting there with free memory both above 
and below it. MultiFinder can't move running programs, 
so your memory remains fragmented until you quit the 
second program or reboot. 

In this situation, the amount of memory available 
could be as much as twice the memory shown as the 
Largest Unused Block. But no more than the amount 
indicated could be used by any one program. If a pro­
gram crashes under MultiFinder, it may leave parts of 
memory allocated even though it's not running any 
more, which results in even more fragmentation. 

Organizing Icons Alphabetically 
Here's a quick way to alphabetize a column of icons: 

Select them, drag them to a new folder, set that folder to 
View by Name, then reselect all the files and drag them 
back to the original folder, And don't forget that you can 
make a column look tidy by dragging a selection rect­
angle around it and then choosing Clean Up Selection 
from the Special menu. 

Neatness Counts 
It's worth the effort to arrange your desktop neatly-
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and to keep it that way. You can size and place win­
dows so that as you open nested folders, the display is 
compact and all the windows are visible. You can also 
drag a folder to the desktop and keep it there over the 
span of your project, making it easily accessible. Later, 
you can select the folder and use the Put Away com­
mand in the File menu to return it to its home location. 

Closing All The Windows On The Desktop 
By holding down the Option key while closing a window, 
you can make all the windows on the desktop close. 

Moving Windows Without Activating Them 
When you hold down the Command key and click in 
the title bar of an inactive window, you can move that 
window on the desktop without activating it and 
bringing it to the front. 

Cleaning Up Windows In The Finder 
Want to neaten the appearance of the application and 
document icons inhabiting windows in the Finder? 
Open the window you want to tidy up. Go to the View 
menu and set it so that the window is showing your 
applications and documents by Name and not Icon or 
Small Icon. Use the Select All command under the 
Edit menu. Drag everything out onto the Desktop and 
wait a second or two while the Finder catches up with 
you. Go back to the View menu and reselect By Icon or 
By Small leon -whichever you prefer. Then go to the 
File menu and select Put Away. Your applications and 
documents will begin quickly arranging themselves 
in the window in alphabetical order. 

Drag-Selecting In List View 
When viewing a folderful of files by icon, you can click 
and drag to create a selection rectangle that scoops up 
a bunch of icons all at once. You can use this tip when 
using any of the text-list views (name, date, size, kind 
or color) as well. 

Speed Up Folder Copying 
If your Mac takes too long to copy a folder full of small 
files from a floppy disk to your hard disk, open the 
folder first, use the Select All command, and drag all 
the files to the hard disk. 

Preventing Pirating Of Applications From 
Your Hard Disk or Network 
Here's a way to stop people from pirating applications 
from a hard disk or a network: 



First, create a blank document with the application 
you want to protect and give it a name similar to that 
of the application (such as "Word 5" for Microsoft 
Word 5.0) 

Next, use ResEdit to make the program invisible 
(highlight the application name, choose Get Info 
from ResEdit's File menu, and click on the Invisible 
box). Quit ResEdit and restart. 

Copying Disks From The Finder 
When using the Finder to copy a disk, you can avoid 
typing the new disk name. Simply click on the icon of 
the original disk and select Copy from the Edit menu 
(Command-C), then click on the icon of the disk. 

Virus Protection 
Here's a very simple and effective way to protect pro­
grams on your hard disk from virus infection. 

While in the Finder, do a Get Info on each of the pro­
grams on your disk and click in the Locked box at the 
upper-right corner of the window. This usually protects 
the selected file from accidental deletion, but it also 
guards it against virus contamination, since it pre­
vents new resources from being written to the applica­
tion. 

Quick Disk Erase 
The quickest and easiest way to erase a disk is to copy a 
blank disk over it. To do this, just insert a blank, for­
matted disk in a drive and drag its icon onto that of the 
disk you want to erase. You'll usually save a minute or 
so over using the Special menu's Erase Disk command. 

Activating A New System Folder 
To bless or select a new active System Folder, hold 
down the Option and Command keys while double­
clicking on the Finder icon in the desired System 
Folder. 

Get Info To Stay 
It is a good idea to rebuild the desktop occasionally by 
holding down the Command and Option keys when 
turning on your Mac. The only drawback is that 
rebuilding your desktop deletes the Get Info com­
ments permanently. (To see the Get Info window, 
select a file and choose Get Info from the File menu 
while in the Finder.) 

DiskTop (CE Software) has a feature called CD 

Comments that lets you rebuild your desktop without 
losing the Get Info comments. 

Closing All Open Windows With The Close 
Box 
In the Finder, holding down the Option key while 
clicking on a window's close box closes all open win­
dows. 

Closing All Windows After Quitting An 
Application 
After you quit an application, holding down the 
Option key closes all windows that were left open on 
the desktop before returning to the Finder. 

Problems 1rashing Files? 
If a file won't budge, like when you try to move it or 
to send it to the Great Trash Icon in the Corner, the 
following alert comes up: "Cannot be duplicated or 
moved'; you may have a locked or protected file.In 
this instance, the file's attribute File Protected or 
File Busy flag has been checked. (File Protected 
means that the file cannot be copied or deleted; File 
Busy means it's currently being used by some appli­
cation, such as the AppleShare.) 

To change a file's attributes, you need a program 
such as DiskTop or ResEdit. If the File Protected or 
the File Busy flag is set, try turning it off (after 
you've made a note of which attributes were turned 
on before you started making changes). A document 
generally has just its Inited flag set; an application 
usually has its Inited and its Bundle bits set. Use a 
little caution at first- maybe another application 
really is using that file, and trashing it could ruin 
your whole day. 

Ideally, file attributes should be modified only by the 
System, the Finder, and other programs that know 
what they're doing. 

Still can't trash the file? Maybe there's an INIT that's 
struggling to keep the file open, such as Suitcase II or 
a networking INIT. Disable all your I NITs, and try 
again. 

Changing The Application Memory Size 
When in the Finder, if you highlight a file and choose 
Get Info from the File menu, a window about the file 
appears. 
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On the bottom of the window are the Suggested 
Memory Size and the Application Memory Size. 

How much memory-minimum- does a program 
need to run? The answer is more complicated than it 
might appear What you see in Suggested Memory Size is 
what the publisher officially says is the minimum memo­
ry required to run the application under MultiFindet: You 
can always assign a program a greater slice of the RAM 
pie, but you should not try to run it with less memory 
than is listed here. 

Application Memory Size, a user-modifiable field, lets 
you change the amount of memory assigned to a pro­
gram while it is running under MultiFinder. When 
you launch a program under MultiFinder, it claims a 
c~rtain amount of RAM real estate as its own. 

There is no correct answer to the question of how 
much memory an application needs. It depends on 
how much RAM you have to divvy up, what other 
applications you will be using at the same time, and 
what demands you will be placing on the application 
while you are using it. The best strategy is trial and 
error: Start out with the recommended amount 
(which should be the default setting anyway). If you 
find you are running out of memory at critical 
moments, start increasing the amount of memory by 
small increments until your problems cease or you 
run out of memory and have to buy more, whichever 
comes first. 

Many people forget that the Finder itself is an 
application and that it can be assigned an amount of 
memory to be used. In some situations -when you 
are using a large hard disk or a CD-ROM disc, for 
example- you might find yourself running out of 
Finder memory. Increasing the Finder memory not 
only solves that problem but also improves file-copy­
ing performance in general. 

Keeping Get Info Comments Using ResEdit 
Rebuilding the desktop from time to time can save 
some hard-disk space, but it causes the comments in 
the Get Info boxes to be erased. Here is a way around 
this problem for anyone who is comfortable with 
ResEdit or some other resource editor: 

1. Start Apple File Exchange or any other program that 
lets you see and copy invisible files. 

2. Make a copy of the file called Desktop, giving it a dif-
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ferent name if the application you are using allows you 
to. If it does not, save the copy to a different folder so that 
you will not overwrite the original Desktop file. With 
Apple Ftle Exchange, choose Rename Destination Hies 
from the Ftle menu to change the name. 

3. Rebuild the desktop by holding down the Option 
and Command keys while your Mac is starting. just 
before your hard disk is mounted, you will get a con­
firmation dialog box asking whether or not you want 
to rebuild the desktop. Click on OK. 

4. Once the desktop has been rebuilt, open ResF..dit and 
open the copy of the Desktop file that you made in Step 2. 
Find the FCMT resouoce in the list of resources. This 
resource oontains the Get Info information that was erased 
when the desktop was rebuilt. Select and copy it. 

5. While still in ResEdit, open the rebuilt Desktop file 
and paste the FCMT resource into it. Now select the 
copy you made of the Desktop file and choose Clear 
from the Edit menu. 

6. Quit ResEdit, and answer Yes to "Save 'Desktop' 
before closing?': Your Get Info boxes will now have 
their comments restored. 

Using Put Away 1b Eject Disks 
The File menu's Put Away command ( Command-Y) 
ejects and/or dismounts disks, removable media, or 
file-sharing volumes. 

Adding Keyboard Commands With ResEdit 
Several of the commands in System 7's Finder lack 
keyboard command equivalents. Some obvious ones 
spring to mind- Command-M for Make Alias and 
Command-P for Page Setup. You can easily add these 
keyboard shortcuts to the Finder's Edit menu with 
ResEdit. (ResEdit can be obtained from on-line ser­
vices and local user groups.) 

1. Make a copy of the Finder, and work only with the 
copy- editing an active file with Res Edit is always a 
bad idea. Open the copy of the Finder in ResEdit. 

2. Locate the fmnu resources (resources are listed 
alphabetically). Double-click on the icon, and then 
double-click on ID 1252. This brings up a window 
filled with arcane text and numbers. 

3. The far-right column contains some familiar strings 
of text, such as New R:llder, Close Window, and other 
Finder menu commands. The keyboard command 



equivalents for these (and other Finder menu items) 
are stored in the third character before the name of 
each item- the N before New Folder and theW before 
Close Window; for example, are what determine the 
keyboard command equivalents for these options. A 
menu item without a keyboard command equivalent 
has only a box in this place. 

4. To change or add a keyboard-command equivalent, 
select the appropriate character in the far-right col­
umn and type in uppercase the character you want 
instead. It's important that you select only the charac­
ter you want to replace. If you delete the character and 
then replace it, the Finder may reorder your menus or 
behave in other unpredictable ways. 

5. Save the changes, and quit ResEdit. To restart with 
the newly customized Finder, move the current Finder 
out of the System Folder, rename the Finder copy so it's 
called Fmder, and restart your Mac. 

The new keyboard command equivalents should 
appear on the menus once the new Finder has loaded. 

Editing Icons On ~biders 
There is a way to edit or colorize icons in System 7 
with nothing more complicated than a paint pro­
gram. Here's how: 

1 Select an icon, and choose Get Info from the File 
menu (Command- I). 

2. In the Get Info window, click on the icon once to 
select it, and copy it. 

3. Open a new document in a paint program, and 
paste the icon into the document. 

4. Modify the icon in any way you want, and then 
select it, and copy it. 

5. Return to the icon's Get Info window, and paste in 
the new icon. 

Desktop Manager Is A Part Of Ftnder 7 
In System 7, Apple finally fixed the nasty problems­
including delays, freezes, crashes and error messages 
-that had long plagued people using many applica­
tions (or other files with resources) on a single disk 
volume. The new Finder uses the same approach as 
Desktop Manager, software Apple developed years ago 
to eliminate the problem on AppleShare servers. The 
software, which many users with large disks had 

installed on their personal systems, bypasses the 
Resource Manager, which was at the heart of the 
problem. 

Using Desktop Manager on your System 6 disks avoids 
the hassle of rebuilding the desktop every time you 
switch between the old and new systems, since they 
can share the same invisible Desktop DB and Desktop 
DF files. Finder 7 needs to make some one-time modi­
fications to the old Desktop Manager's files, but there­
after you can switch freely between the two systems, as 
long as Desktop Manager is installed on the System 6 
disk. 

Rebuilding The Desktop 
Whenever you rebuild the desktop under System 6, even 
with Desktop Manager installed, it must be proressed 
once again the first time you restart with Finder 7. 

1b rebuild the desktop manually in System 7, hold 
down the Command and Option keys during the last 
part of the start-up process. just as you do with Finder 
6. (The option of rebuilding the desktop by holding 
these same keys down when quitting an application is 
no longer available). 

Under System 7, there is another, quicker way to 
rebuild the desktop, but it is not recommended. 
System Ts abort key combination -Command­
Option-Escape- will quit from the Finder, letting you 
hold down Command-Option to rebuild the desktop 
immediately as Finder 7 starts back up again. 

Saving Desktop Patterns Under Finder 7 
If you like to create custom patterns for your desktop 
instead of using the default patterns in the General 
cdev, you now can save them by double-clicking on 
the cdev's miniature desktop. No longer will your 
handiwork disappear forever as soon as you choose 
another pattern. 

Color Screen Shots In System 7 
Pressing Command-Shift-3 takes a color PICT snapshot of 
your screen, complete with a camera- shutter sound effect. 
(In previous Systems, this command produced only a 
black-and-white MacPaint file.) 

Emptying The 'Irash 
If you don't want a warning message every time you 
empty the Trash, turn off the appropriate button in 
the Get Info dialog box. To do this, highlight the Trash 
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and choose Get Info from the File menu or type 
Command-I. 

Renaming Ftles Pdster Under Finder 7 
Some people are feeling a little disoriented since 
Apple changed the way users rename files, folders 
and whatnot in the Finder. Under System 6, you sim­
ply select an item and type the new name, but under 
System 7, typing selects files instead of renaming 
them. 

If you select an item and wait, however, System 7 
eventually will present you with a text-editing box 
around the item's name. The length of the delay is 
determined by the double-click speed set in the 
Mouse control panel. For the really impatient, 
selecting the item and hitting the Return key or 
moving the mouse slightly make that box appear 
immediately. 

Keyboard Shortcuts In Finder Windows 
Under System 7 
You can navigate within a window by using the arrow 
keys. Command-down arrow opens a selected file or 
folder (additionally holding down the Option key clos­
es the current folder); Command-up arrow opens the 
parent folder or volume window (adding the Option 
key closes the current folder). 

The Tab key moves you through files alphabetically. 
Type the first characters of a filename to jump to a 
particular file. Command-W closes the active window. 
In list views, press Command-Option-right arrow to 
expand the entire outline and Command-Option-left 
arrow to collapse it. (More shortcuts are now listed on 
the Finder's Help menu.) 

Sorting Icons 
Holding down the Option key while selecting the 
Clean Up command lets you sort file icons. 1b choose 
the type of sort, select a list view (such as View by 
Date) immediately before selecting View by Icon or 
View by Small Icon. Using the View control panel's 
Staggered Grid and Snap To Grid options helps Finder 
windows stay tidy even before cleanup. Holding down 
the Command key as you drag icons toggles the Snap 
To Grid option on and off temporarily. In list views, 
clicking on a column title sorts files by that field. 

Background Copying 
You can copy files in the background while continu-
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ing to work in an open application. You can't launch a 
new application while copying is in progress, however. 

Opening Documents In System 7 
You can open a document by dragging its icon onto the 
icon of an application, provided that the program sup­
ports the document's format. This lets you open a file 
in programs other than the one that created it (for 
example, open a MacWrite file in Word). 

Locating The Original File For An Alias 
Need to find the real McCoy? Go to the Get Info dialog 
box for the alias, and click on Find Original. The 
Finder window containing the original file opens and 
the icon is highlighted. 

Closing/Hiding Windows 
The Option key brings flexibility to window manage­
ment in the Finder. Holding down the Option key when 
you launch an application closes the window contain­
ing the application icon. Using it as you bring a back­
ground application to the foreground hides the current 
application. Pressing the Option key and clicking on 
the desktop hides all the open application windows. 

Reducing The File-Naming Delay 
In Finder 7, you can no longer simply click on an icon 
and immediately type a new name for it. The standard 
procedure in Finder 7 is to click on the name itself 
and then wait until the Finder lets you edit or replace 
the text. The new Finder actually has a separate 
rename mode, which you can get into in several ways. 

If you select an icon, either by clicking directly on it or 
by typing its name, pressing the Return or Enter key 
puts you in rename mode; hitting the same key again 
lets you exit from this mode. 

If you click on the icon name instead of the icon itself, 
you must either wait for rename mode to appear auto­
matically or move the mouse to make it happen 
immediately. (Return and Enter also switch modes in 
this scenario.) 

Fonnatting More Than One Disk At A Tune 
Many applications include utilities or commands for 
erasing and reformatting a series of floppy disks. Yet 
there are occasions when you have to rely on the 
Erase Disk command of the Special menu in the 
Finder. Here's a trick to speed things up if you have 
two floppy drives: 



Insert the two floppies you want to refonnat or erase, 
and highlight the icons of both disks on the desktop. 
Now you can use a single Erase Disk command for 
both disks, with only two prompts required during the 
process. This shortcut is also useful for reformatting 
multiple partitions on a hard disk. 

Why Do Disk File Aliases Lose Their Icons? 
Icon infonnation for items on a disk is stored in the 
disk's desktop files, but these normally won't have icons 
for, say, a MacWrite document unless Claris Corp.'s 
MacWrite program is also on that particular disk. 

If you have the MacWrite application on, say; a 
SyQuest cartridge and a MacWrite document on your 
internal disk, the document will be shown with its 
proper icon only when the SyQuest cartridge is 
mounted - as you noticed. When it's removed, the 
Finder no longer has access to the desktop files with 
the proper icons. 

You can force the Finder to add any file's icon infonna­
tion to the desktop files on your internal hard disk by 
copying the creating application to your disk and then 
throwing it away. Since the Finder never removes 
information (on its own) from the desktop files, the 
icon info that is added when you drag the application 
over will be available until the next time you rebuild 
the desktop. 

Speeding Up On-Disk Backup 
If you like to create on-disk backup versions of 
PageMaker or Word files in addition to your working 
versions, you can save some time by duplicating the 
main version at the Finder level instead of using the 
Save As command Saving a large PageMaker or Word 
file under a new name can be a time-consuming pro­
cess, but the Finder removes a couple layers of over­
head and gets the job done faster. 

Deleting Busy Folders And Ftles 
Sometimes you just can't throw a folder away: You 
place it in the Trash and select Empty Trash, and you 
keep getting a message reading, "The Trash couldn't 
be emptied (a file was busy or a folder was not 
empty)." Shortly thereafter, the (nonempty) folder 
reappears on your desktop. Even though there are no 
"busy" files in the folder, there isn't anything you can 
do to throw it away. 

Sometimes this happens when a document has been 

closed within an application but you haven't yet quit 
the application. In such a situation, the Finder lets 
you throw away the closed document directly, but if 
you try to throw away a folder containing the docu­
ment, you run into this snag: Although the file itself 
has been trashed, there is no way to throw the folder 
away until you've quit the application. 

Th get around this when you're trashing a folder, 
remember to select its contents by opening the folder 
and pressing Command-A. Throw away the selected 
files, empty the Trash, and then throw the folder away. 
This procedure may work and will save you the time 
spent resorting to the nuclear weapons that are avail­
able for unlocking files. 

If you do want to resort to "nuclear weapons," try 
HellFolderFix, a utility available from freeware 
sources such as on-line services and user groups. You 
can download HellFolderFix from the Application 
Library of ZiffNeVMac's Download & Support Forum 
(HEllFL.SIT is the filename). 

FINDER (SYSTEM 7) 
No More Physical Icons 
Physical icons were a feature of Finder 6. Instead of 
showing a floppy disk as a generic disk icon, the Finder 
showed a little picture of the appropriate Mac model 
with an arrow pointing to the appropriate floppy disk 
drive. Alas, physical icons are not supported in Finder 7 
and are probably gone for good. 

Creating Window Headers 
One of the more productive things you can do with 
System 7 is create dividers or headers in a window 
that's in icon view. Here's how: 

Create a new folder ( Command-N), and name it; 
using bullets (Option-S) or other symbols works well 
for creating dividers. Use a drawing program to create 
a borderless white rectangle that will fit over the fold­
er's icon in the Get Info box (accessible from the File 
menu or by pressing Command-1). Copy the rectangle 
to the Clipboard, select the folder's icon in the Get Info 
box, and paste the rectangle over the icon. Now when 
you view this folder by icon, you'll see only its name. 
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Keyboard Commands To Expand And 
Contract Folders 
A hot but not very obvious feature: You can expand 
and contract folders in the outline views (View By 
Name, Size, Kind, or Date), using Command/left 
arrow and Command/right arrO\v. 

Using Keyboard Equivalents In The Finder 

The keyboard command equivalents in System 7 are 
among of its best features, yet some people don't use 
them, because they haven't noticed the shortcuts or 
they haven't practiced using them. 

If you're not already doing it, try using only keyboard 
command equivalents in the Finder for a few days. 
Resist the urge to reach for the mouse. The arrow keys 
select icons in the window or the desktop, the Tab key 
select icons in aplphabetical order, Shift-Tab selects 
icons in reverse alphabetical order, typing the first few 
letters of an icon's name selects it, and windows scroll 
automatically to the selected icon! 

Why The Finder Won't Play A Sound 
When you play a sound in the Finder, the entire sound 
is loaded into the system heap, then played. If there's 
not enough room in the system heap, and the heap 
can't expand enough to make room available, the 
sound won't be played. Generally, this means you're 
either very low on memory or trying to play a very 
large sound. 

Finder Settings Not Sticking 
If you find that you change the way the Finder dis­
plays some items, but the next time you boot the 
changes are gone, you have a damaged Finder 
Preferences file. 

Open the Preferences folder in your System folder, find 
the Finder Preferences file, throw it away and reboot. 
Now make the changes you want in Views, and they'll 
stay around between restarts. 

Using Labels To Keep 'Jloack Of Files Copied 
When copying lots of files onto various disks or fold­
ers, it becomes difficult to keep track of which files 
have already been copied and which remain. Here's an 
easier way to keep track of them. 

Use the Labels control panel to create a new category 
-say, Copied- in a bright color. Then go to the folder 
with the files you want to copy, and highlight the ones 
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you'll copy first, just as you would before dragging 
them to the target disk or folder. But before dragging 
them, go to the Label menu and choose the new 
Copied categol)~ Now copy the files. Repeat the process 
for each set of files you need to copy. 

It's easy to see which files have already been copied, by 
either the color or the label name. Of course you won't 
want to use this method if you need to preserve the 
labels the files already have. If you don't regularly use 
the Labels feature, the Copied label can keep track of 
the files that have been backed up onto a floppy. 

FLOPPY DISKS 
Requests For Disks Long Gone 
Have you ever been plagued by requests for a disk after 
the floppy is long gone? 

Type Command-period, and if the alert box doesn't go 
away, type it again. You may have to do it several 
times, but it will usually end the plague. 

Command-period is versatile and has lots of other 
uses. Think of it as yelling "Halt!" at your Mac. If you 
double-click on an icon and then change your mind, 
Command-period will abort its launch. Command­
period also stops most print jobs. 

To avoid those floppy requests in the future, make sure 
to eject and dismount a floppy disk. There is a differ-

. ence between ejecting and dismounting. If you eject a 
disk (using Command-Shift-1, Command-Shift-2, 
Command-E, or Eject Disk on the Special menu), the 
disk's dimmed icon remains on the desktop. 
Dismounting removes the dimmed icon and makes 
your Mac forget completely about that disk. 

Here are a couple of ways (besides dragging the disk's 
icon to the Trash) to dismount disks under System 6 and 
System 7: 

System 6: 

1. Hold down the Option key, and choose Eject from 
the File menu. 

2 Use the Command-key shortcut Command-Option-E. 

System 7: 

1. Choose Put Away from the File menu. 



2. Use the Command-key shortcut Command-Y. 

Another way to avoid floppy requests is to lock your 
disks before inserting them. More often than not, the 
Finder wants to see a disk again only so it can update 
its invisible Desktop file, but if the disk's been write­
protected, the Finder will leave it alone. 

Formatting 400K Disks As HFS 
There is a key combination that lets you format 400K 
disks as HFS (Hierarchical File System) disks. 

In the old days, all Macs came equipped with 400K 
drives, and all floppy disks were formatted with MFS. 
When ·the Mac Plus appeared in 1987, Apple intro­
duced HFS, the now-familiar system that allows fold­
ers within folders. The difference between the two sys­
tems is that MFS was a flat-filing system (every file on 
a disk was at the same level, as if there were no fold­
ers) and HFS is, well, hierarchical (files are separated 
by the folders they're in). With MFS, folders were visible 
only when you looked at the disk in the Finder, and 
they disappeared in the Open and Save dialog boxes. 

It is not recommended to store important information 
on disks formatted this way, because 400K disks are 
tested only on one side during manufacturing: To for­
mat a 400K disk as an HFS disk, simply hold down the 
Option key when you click on the One-Sided button in 
the disk-initialization dialog box and continue to 
hold it down while the disk is being initialized. 

FOLDERS (SYSTEM 7) 
Using Folders 1b Post Messages 
You can use folders under System 7 to post handy mes­
sages to yourself on the desktop. 

First, select a small block of blank or white pixels from 
a new document in a painting or image-editing pro­
gram or select a nonfilled, nonstroke object in any 
drawing or page-layout program. Copy this selection 
to the Clipboard (in Illustrator hold down the Option 
key when you copy). Go to the Finder, create a new 
folder (Command-N), and choose Get Info from the 
File menu with the folder selected Now click on the 
folder icon in the Get Info window, and paste in your 
selection from the Clipboard. The folder you've creat­
ed has no icon, but you can type as many as 31 char-

acters in the folder name to serve as your message. 

You can post the message anywhere on-screen and, 
because there is no icon, you can put it at the very top 
of your desktop. The message stands out, because it's 
unusual for text to be on the desktop without an icon. 

To make the message even more obvious, precede it 
with some bullets (Option-S). You can also copy and 
paste this non-icon from one Get Info window to 
another to remove icons from folder, files, or applica­
tions to save space in a window. You can open an icon­
less file, application, or folder by simply double-click­
ing on the text. 

FONTS 
Using Both '&ueType And ATM 
It is not advisable to use both True Type and Adobe 
Systems Inc.'s Adobe Type Manager on your Mac. You 
are better off sticking with only one font-imaging 
technology; it'll make your life easier. If you have a 
PostScript printer, stay with ATM. But if you want to 
keep them both, here's the order in which screen and 
printer fonts are handled. 

For the screen, the first choice is an existing bit-mapped 
font of the correct size, followed by a True Type font, 
followed by an ATM font, followed by the last resort, a 
scaled bit-mapped font. 

On a non-PostScript printer, it's TrueType, followed by 
ATM, followed by a bitmap of the correct size, followed 
by a scaled bitmap. 

On a PostScript printer, it's internal PostScript font, 
downloaded PostScript font, TrueType, bitmap of the 
correct size and scaled bitmap. 

GENEUL 
The Application Has Unexpectedly Quit 
In many cases, unexpected quitting can be fixed sim­
ply by increasing the application-memory size of the 
offending program. If a program unexpectedly quits, 
try giving it more memory. To do this, select its icon in 
the Finder, issue the Get Info command (Command-
1), and type a larger value into the Current Size box 
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(called Application Memory Size under System 6). 

Increase the memory size by at least 10 percent, and 
then see if the problem recurs. If it does, try increasing 
the size some more. This technique won't hurt any­
thing; it'll just make that particular program use 
more RAM. If your application still quits unexpectedly 
after this, it's likely that something is seriously wrong. 
Try replacing the application and any support files 
with fresh ones from locked master disks, and if that 
doesn't fix things, call technical support. 

ICONS 
Switching Hands On The Generic 
Application Icons 
Generic application icons in System 7 are left-handed 
for DAs but right-handed for applications. If you're a 
left-handed user, you can copy and paste the left­
handed DA icon into other applications by using the 
Get Info dialog box. 

INTERRUPT SWITCH 
A Crash Recovery 'llick 
There are two "switches" on all Macs, the reset and 
interrupt switches. One serves as a restart switch and 
the other is programmers switch. When you press the 
interrupt key, the machine enters a very simple 
debugger. In it, you can type G for Go, SM for Set 
Memory, and a few other commands. 

Programmers who need a real debugger for the Mac 
can use MacsBug, which is available from Apple 
Programmer and Developer Association (APDA can be 
reached at 800-282-2732; ( 408) 562-3910 
International). MacsBug is a complete, full-feature 
debugger with breakpoints, tracing, and so on. 

Here is a trick for using the interrupt switch: If you've 
crashed or the cursor is frozen, press the interrupt 
switch and then type G FINDER at the >prompt. Leave 
a space after the G, and type a carriage return after the 
R. If the crash wasn't too severe, you' II be returned to 
the Finder, where you can use the Restart or Shut 
Down commands to close things up tidily. You'll prob­
ably see a message telling you that the application 
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you were working in has "unexpectedly quit." That's 
OK. Even though you'll probably lose any work you've 
done since your last Save, chances are your file won't 
be damaged. (See also System Errors) 

KEYBOARD 
Keyboard Secrets! 
Option key : Hold down the Option key while dragging 
a file from one location to another within a single 
volume, and the file is copied to the new location, not 
moved. 

Option- Command: Hold down these keys and dou­
ble-click on a Finder file to switch to a different Finder 
without restarting your Mac. 

Option- Command: Hold down these keys when you 
mount a hard disk to rebuild the Desktop file. 

Option : Holding down the Option key while dragging 
a file into the Trash overrides any file lock or query 
from the System about whether you really want to 
throw away an application. 

Option: Holding down the Option key when opening 
folders that contain folders will close the previous 
folder- a great way to keep your desktop uncluttered 
with open folders. 

Option: When running DOS software on the Mac, the 
Option key doubles as an Alt key. 

Option: Press the Option and the semicolon key, and 
you'll discover this is where Apple hid the ellipsis 
(. .. ). 

ESC Key: Cancel an action (in some applications) (same 
as Command -period) 

Tab Key: Move through fields in a dialog box 

Shift-Tab: Move through fields backwards in dialog 
box 

LASERWRITER DRIVER 
Different Versions Of The LaserWriter 
Driver On A Network 
\Vhen using AppleTalk on a network, make sure all 



Macs have the same version of the LaserWriter driver 
in their System Folder, assuming you are using aver­
sion of the Laser\Vriter driver which is less than ver­
sion 5.2. The LaserWriter driver series 6.0x can be 
mixed across a network, for example 6.01 and 6.02. 

If you are upgrading computers to System 7, all the 
computers accessing the same printer should have the 
System 7 printer drivers, whether or not they are 
upgraded to System 7. 

MAP 
Changing The Map Figure 
The world map image in Apple's CDEV Map can be 
copied to the Clipboard simply by choosing Copy from 
the Edit menu when Map is on- screen. Make sure the 
city name box is not highlighted (or you will copy the 
name instead of the map). So what's so great about 
that? Several things. 

First, if you have a color system, you can copy and 
paste the map image into a program like Photoshop, 
color it, and then copy and paste the colored version 
back into the cdev's window. Oceans could be blue, 
continents in contrasting colors, and so on. 

If you live in a black-and-white world, you can still 
modify the map in MacPaint, using patterns instead 
of colors. 

And in any case, you have a fairly decent world map 
that you can store separately with your clip art for use 
in other documents. 

And, by the way, you don't have to worry about cutting 
or clearing the map image accidentally- only Copy 
and Paste work from the Edit menu while you have 
the cdev open. 

MONITOR CONTROL 
PANEL 
Changing The Pixel Depth On The Fly 
You may have several applications that require a given 
pixel depth or number of colors to run or launch 
smoothly. Switching among the number of colors can 

be a real headache; however, there are shareware and 
commercial products that can customize applications 
for the correct setting so you don't have to constantly 
use the Monitors control panel. 

The freeware solution is Switch-A-Roo, an Fkey by Bill 
(Pyro) Steinberg that lets you switch between any two 
pixel depths- say, black-and-white and 256 colors­
using a keyboard command equivalent. 

On the shareware front, you've got your choice of Michael 
(Screen Shot/Exposure Pro) Whittingham's Screen 
Flipper !NIT or Chris Sanchez's PixelFlipper INIT/control 
panel. Both let you change the pixel depth of any moni­
tor simply by holding down a userdefined command­
equivalent key and clicking anywhere on-screen. 

Switch-A-Roo, Screen Flipper, and PixelFlipper are 
available from on-line services such as ZiffNeVMac 
and other shareware sources. 

At the high end, we have the commercial products 
HAND-Off II, from Connectix (2655 Campus Drive, 
San Mateo, CA 94403; 800-950-5880 or 
[ 415] 571-5195), and Multi-Master, part of Now 
Utilities, from Now Software (520 S.W. Harrison Street, 
Suite 435, Portland, OR 97209; 800-237-3611 or 
[503] 274-2800). Both are file launchers and the 
only products that let you set pixel depth on an appli­
cation-by-application basis. So, for example, if you 
always want Apache Strike to run in the black-and­
white mode, just tell HAND-Off II or MultiMaster. 
Then every time you launch Apache Strike, using 
HAND-Off II or MultiMaster, your monitor will auto­
matically switch into the black-and-white mode. 

The cool thing about HAND-Off II and MultiMaster is 
that they can control other aspects of your Mac's envi­
ronment, too, such as cranking the volume way up 
when they launch a game and then bumping it back 
down again when you open up your spreadsheet pro­
gram. 

PARAMETER RAM 
Resetting The PRAM In The Mac Under 
System6 
The parameter RAM (PRAM) is where the Mac stores 
basic information like the time and default font (and 
other things) that it must know when you start it up. It's 
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powered by the battery. And occasionally it gets fouled up 
and must be reset. 

If you are running System 6 on a Mac Plus resetting, 
the PRAM is simple. just shut the machine off and 
remove the battery for 5 or 10 minutes. It's impossi­
ble to do that on theSE or the II, however. But Apple 
has provided another way to reset the PRAM. Here's 
what to do: 

In System 6, as you select the Control Panel, hold 
down the Shift, Option, and Command keys. You'll get 
a dialog box asking if you want to zap (reset) the 
parameter RAM. Select Yes, and then Restart your Mac. 
This will set most of the PRAM to zero, and will 
change all your Control Panel settings to default set­
tings, but will not reset the clock. Reset all your other 
options as they were or as you wish. 

Resetting The PRAM In The Mac Under 
System 7 
Under System 7, the secret trick for rebuilding parame­
ter RAM is more unfriendly and obscure than in 
System 6. (PRAM is a special chunk of battery-backed 
memory that retains data such as your control panel 
settings even when the computer is shut off.) 

In System 6, you could reset almost all of this special 
memory by selecting the Control Panel DA while hold­
ing down Command-Option-Shift. In System 7, you 
must hold down Command-Option-P-R while restart­
ing the computer. When the system sees this key com­
bination, it resets PRAM and restarts the compute[ 

POWERBOOK 
A Bigger Cursor 
There is a way to make the 1-beam cursor bigge[ The 
I -beam cursor is a resource in the System file, which 
you can edit with Apple's ResEdit program, but it's also 
a resource in the ROMs of the Power Book. Therefore, 
you also will have to alter a ROM-override resource to 
force the PowerBook to use the edited cursor resource 
rather than the ROM version. 

First, make a backup of your PowerBook's System file. 
Then run ResEdit and open the running System file 
on your PowerBook. You'll see a window full of strange 
icons with weird four-character labels. Look for the 
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one labeled CURS and double-click on it. It will open 
into a small window with several icons, one of which 
will be the 1-beam text cursor. Double-click on the cur­
sor -you'll get a message that it's a compressed resourre 
and tl1at it'll be saved unrompressed if you change it. Click 
OK, and you'll be in a simple iron editor tl1at will allow 
you to change the icon to better suit the fuwerBook's 
screen. Edit the icon (making it three pixels thick seems to 
work well) and close the editor and CURS windows. 

Now open the ROv# resource and double-click on item 
No. 1660. Scroll to the bottom of the display and click 
on the last item, labeled*~'***. Select Insert New 
Fields from the Resource menu, and blank text fields 
labeled Type and Resourc' ID will appear. 

Type in CURS (all caps) for the Type field and 1 for 
the Resource ID field. Now you're done. Quit Res Edit, 
answering all the questions it poses with OK, and 
you'll have your thick 1-beam curso[ 

Some applications, such as Claris Corp.'s Mac\Vrite II, 
have their own I -beam cursors that you'll have to edit 
separately. And some, such as Microsoft Word, have cur­
sors you can't easily edit. Experimentation (on a copy 
of the program) is the key. 

Powering Up System 6 On Your PowerBook 
Running System 7 with only 2 Mbytes of RAM on a 
PowerBook doesn't leave room for much else. System 
6.0.8 requires several hundred Kbytes less RAM than 
System 7, and several brave pioneers who've installed 
it report that System 6.0.8 seems to run fine on the 
PowerBook; however, the Brightness control panel no 
longer works. 

This is a problem because the physical brightness con­
trol beneath the I£0 screen really just signals software 
to lower the brightness rather than controlling it direct­
ly. Under System 6.0.8, your PowerBook screen will be 
locked at maximum brightness, which will reduce your 
battery life. Other than this one quirk, everything 
seems to work fine. 

PRINTING (SYSTEM 7) 
How To Work Around Printing Problems In 
System 7.01 
If you have some documents that don't print correctly 



under System 7.01, here are some work-arounds that may 
be effective: 

-Try turning off the Background Printing option in 
the Chooser. 

- Switch back to the LaserWriter 7.0 driver or even a 
driver from System 6. (Put both the LaserWriter and 
Laser Prep files in the Extensions folder.) 

- If you can isolate the printing error to a given page, 
try changing the fonts on that page. Pay special atten­
tion to TrueType fonts, which seem to be implicated in 
some of these problems. 

PRINTMONITOR 
Queuing Print jobs While The Printer Is Off 
1b queue documents when the printer is off under 
System 7, place an alias of the PrintMonitor applica­
tion in the Apple Menu Items folder. Before queueing 
anything to print, select PrintMonitor from the Apple 
menu and select Stop Printing from the File menu. 
You can then "print" documents to your heart's con­
tent without having to tum on the printer. 

When you're ready to print, tum on the printer, wait 
for it to eject its startup page, go to the PrintMonitor 
application, and select Resume Printing from the File 
menu. 

You can do the same thing under System 6 by placing 
a copy of PrintMonitor on the desktop, going to the 
Finder from your application, and clicking on 
PrintMonitor. 

Making Print Monitor 7 A Little Less Pushy 
System 6 users who have turned on Background 
Printing and who also print manual-feed pages may 
complain. After they switch to System 7's LaserWriter 
drivers, they receive annoying alerts that "the 
LaserWriter is waiting for a sheet of paper." As they say, 
this is a feature, not a bug. 

To tum off these prompts, choose the Preferences com­
mand in the PrintMonitor application (you can do 
this while printing) and click the "Give no notifica­
tion" radio button. 

Allocated Memory In The Finder 
The PrintMonitor is allocated its own memory in both 

System 6 under Multi Finder and System 7. It does not 
use the Finder's nor the system's RAM allocation. Note 
that under close-to-the-limit low-memory configura­
tions, the Finder will try to make RAM available (by 
closing windows) to open up PrintMonitor, just as it 
would for any other application. 

Manually increasing RAM assigned to PrintMonitor 
enables it to handle more-complex files. 

How to Tum On The Print Spooler 
1b tum on the PrintMonitor spooler, open the 
Chooser, select your printer, and click on the On but­
ton next to Background Printing. If you're using aver­
sion of the system software earlier than System 7, print 
spooling works only in the MultiFinder mode; you 
can't use if you're running under the Finder. 

PRINTMONITOR 
(SYSTEM 7) 
Support For The Style Writer 
Apple's system level print spooler, the PrintMonitor, 
works only for laser printers! Background printing 
with the PrintMonitor is, for some reason, unsupport­
ed for ImageWriter users. 

Under System 7, the spooler also works with Apple's 
Style Writer inkjet printer, which is the logical succes­
sor to the Image Writer. 

PRINTER DRIVER 
Changing The Default Printer Settings In 
Page Setup 
Using Res Edit, you can change the default settings in 
a Page Setup dialog box so that they're the defaults for 
future printing. 

With Res Edit, open your printer driver (it's in the 
Extensions folders of System 7 users, or in the main 
level of your System folders for System 6 users) and 
look at the PREC resources. PREC 0 is the default 
resource; PREC 1 is the one containing the settings 
you used last. Copy PREC 1, delete PREC 0, then paste 
PREC 1 and renumber it to 0. Quit ResEdit, save the 
changes, and you're done. 
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PUBLISH/SUBSCRIBE 
Publisher/Subscriber Options In 
System 7 
You can see what material in a document has been 
published or subscribed to by selecting the Show 
Borders command. This places a gray border around 
all the sections that are published or subscribed to. 
Double-clicking on this border brings up either the 
Publisher or Subscriber Options dialog box - depend­
ing whether the text has been published or subscribed 
to- which includes options for updating or canceling 
editions. 

SOUND 
Sound Recordings Are Memory Intensive 
The biggest problem with sound on the Mac is that it 
eats up disk space and can require a lot of RAM to 
record. Adding a mere two-word voice annotation to a 
2,000-word Word 5.0 document causes the file size to 
balloon from 15K to 200K. This can be a problem if 
you have limited disk space or limited RAM or plan to 
send such a file across a network. 

You can reduce a sound's RAM and disk-space require­
ments by recording it at the lowest quality level your 
program allows. Most programs offer a choice of 
recording qualities, such as good, better, or best. The 
better the recording quality, the more disk space the 
sound consumes and the more RAM it takes to record 
it. A sound recorded at the best setting is bigger and 
requires more RAM to record but sounds great; sounds 
recorded at the good or better setting use less disk 
space and need less RAM to record but don't sound as 
good. Play around with these quality settings. For 
most voice recording, the lowest quality is good 
enough to help you make your point. 

System 7 Sound Format 
System 7 brought with it a new sound-file format 
known, cleverly enough, as System 7 Sound. Older file 
formats included SoundEdit, snd, and sound resource. 

You can easily tell the difference System 7 sounds are 
the only ones that make noise when you double-click 
on their icons in the Finder. 

138 

SYSTEM 7 
Making Files Invisible 
You can make a file invisible without using a software 
utility. Open the Labels control panel, in the Control 
Panels folder. Double-click on a label color you don't 
use. Enter 0 in the hue and saturation boxes, and then 
type 65535 as the brightness. Apply this label color to a 
file you want to protect, and change the name of the 
file to one or more spaces. Provided that the file is kept 
in a folder, it will appear to be invisible. 

Turning Color Off To Speed Application 
Performance 
If your work doesn't depend on color, you should tum 
off the color display. Color can really cost you time in 
ordinary operations such as scrolling. The two main 
time consumers are: 

1- the cost in time required to put the color in, includ­
ing the time needed to make appropriate color choices 
and 

2- the cost incurred in using the color file, which will 
take up more disk space and time than a monochro­
matic document. 

In the Control Panels folder in the System folder, the 
Control Panel Device called Monitors lets you adjust 
the number of colors your monitor shows. 

Clicking On Installer Scripts 
Don't double-click on a script to open the Installer 
application. Unlike most applications, the Installer 
doesn't pay attention to how it was launched and 
opens only the documents it wants to. If you've copied 
the program to your hard disk, the script that it reads 
might not be the one you double-clicked on. 

Aliases Multiply Ftle Sharing Options 
If you need to share the same application programs or 
files with several groups of people, you may want each 
group to have its own set of file sharing privileges. 
System 7lets you define different privileges for a 
group of owners and one other group. The way to 
accommodate more than two workgroups is through 
System Ts aliases. 

First, you make aliases of the files you want to share 
and put them in a folder. Then you share that folder, 



and give it a set of access privileges. For a second 
group of users, make another set of aliases, put them 
in a different folder and give that folder its own privi­
leges. You can repeat this process as many times as 
you like within the system's limit of 10 shared items. 

System Utilities Upgraded For System 7 
This software is incompatible with System 7, but com­
patible versions are included with the System 7, or 
available through a user group or on-line service: 

Apple File Exchange (prior to 7.0) 

Disk First Aid (prior to 1.5) 

LaserWriter Font Utility(prior to 6.0) 

ThachThxt (prior to 7.0) 

QuickMount (prior to 1.0.7) 

Apple CD-ROM (prior to 3.0) 

The Namer (prior to 2.1) 

Invisible Applications Under System 7 
In System 7, an application that is marked invisible 
will not be found when you try to open one of its docu­
ments, and the result is an error message. 

Under System 6, documents are always connected with 
applications, even if the application is invisible. 

Each approach has its advantages. Under System 6 
you could set up your Macs so naive users couldn't 
delete, rename or move applications, but could still 
run them by double-clicking on a document. 

Under System 7, the applications are more completely 
hidden, and you can open them only with the help of 
a utility such as the DiskThp desk accessory from CE 
Software Inc. (DiskTop is convenient both for launch­
ing applications and for setting the Invisible 
attribute.) 

Software No Longer Needed Under System 7 
The following software is no longer needed under 
System 7 because Apple has incorporated its function­
ality into System 7: 

800K Eject INIT 
Font/DA Mover 
Memory Manager INIT 
True'fype INIT 

No Need To Initialize Your Hard Disk For 
System 7 
There is no need to re-initialize any hard disk on 
which you plan to run System 7, unless the disk has 
been damaged in some way, or it is a third-party drive 
that requires initialization. Check with your third­
party hard-drive vendor for more information on that 
specific drive. 

If you plan to use virtual memory, the SCSI driver will 
need to be updated using HD SC Setup v7 or above. 
This requires that you boot from the Disk Tools floppy, 
choose the target drive, and click on "Update': This 
process takes a second or two to complete, and does 
NOT require any reformatting, or re-initializing of 
your hard drive. 

Disabling Extensions 
Holding down the Shift key while the Mac starts will 
prevent the launch of all INITs in the Extensions, 
Control Panels, and System folders. You must restart 
the machine to tum them back on. 

With Virtual Memory, Is There Any Reason 
1b Buy More Real RAM? 
Virtual memory (disk space used to simulate RAM) is 
obviously cheaper than real memory. It's also a lot 
slower. SIMMs (single in-line memory modules) with 
1 Mbyte of RAM are cheap enough these days to make 
real memory readily available, at least up to 8 Mbytes. 

Using virtual memory in a low-RAM configuration 
can make sense if you use one or two programs that 
benefit from the extra memory or if you use several 
programs but switch between them infrequently. In 
these cases, virtual memory might make more sense 
than paying for rarely used RAM, and the performance 
penalties will be minimal. 

In other cases, virtual memory doesn't work well. Using a 
graphics program to edit a large 24-bit-color image will 
be slow if most of the image was stored in virtual memo­
ry, resulting in continual thrashing of the disk as parts of 
the image were swapped into and out of RAM. 'fry out 
System 7's virtual memory to see how it works for you; 
after all, it's free. 

Crash Recovery Using The Keyboard 
If you crash in any application under System 7, you 
can usually recover to the Finder by pressing 
Command-Option-Shift-Escape and clicking on OK 

139 

~ 
~ 



rn 
~ 

in the resulting Force Quit? dialog box. To be safe, you 
should then immediately close all applications and 
reboot the machine. 

Hidden Viewing Options 
The Clean Up command in the Finder's Special menu 
has always had some more-or-less secret options. 
Under System 6, holding down the Option key while 
selecting this command force-fits all the icons in a 
window into an orderly pattern. Under System 7, Clean 
Up options let you sort icon or small icon views by any 
other available viewing criteria (date, size, label, etc.). 

First, you select one of the non-icon views from the 
View menu. Then you switch to one of the icon views 
- poof! The icons lose their sorted order. 

But if you then hold down the Option key while select­
ing the Clean Up command, the icon view will be sort­
ed by whatever criteria you had chosen for your earlier 
list view. 

Opening Desk Accessories In The 
Application Heap Under System 7 
Under System 6 with MultiFinder, holding down the 
Option key while choosing aDA causes the DA to open 
in the application's memory partition instead of the 
system heap. This trick is useful with DAs that depend­
ed, for example, on the current program's color envi­
ronment. 

DAs installed via the Apple Menu Items folder under 
System 7 are unaffected by the Option key. But if the 
DA is in a file opened with Fifth Generation Systems 
Inc.'s Suitcase II, the old trick still works. You also can 
use FonVDA Mover 4.1 (available from CompuServe 
and local user groups) to install the DA in a specific 
application. 

Apple's System 7 Answerline 
For further information regarding System 7, don't forget 
the System 7 Answerline at 900-535-2775 or the 
toll-free number available to purchasers of the Apple 
System 7 Personal and Group Upgrade Kits. 

Dialog Shortcuts 
Command-up arrow moves you up one level, to the 
parent of the current folder. 

Command-left arrow or Command-right arrow cycles 
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through all available drives the same way the Thb key did 
inSystem6. 

The tilde key takes you to the bottom of the list. 

The System 7 Save dialog box has two components: 
the file list and the name field. The Tab key toggles 
between them. 

Typing any letter takes you to the first item in the cur­
rent folder that starts with that letter. (In a Save dialog 
box, the file list must be active for this to work; see the 
previous tip.) If you're quick about it, you can type the 
first two or three letters and get directly to the first file 
that starts with those two or three letters. 

Typing Command-period is the same as clicking on 
the Cancel button. 

Clicking on the volume name is the same as 
Command-up arrow: it moves you up one level, to the 
parent of the current folder. (The volume name is the 
name of the current disk. It usually appears just above 
the buttons on the right side of the dialog box.) 

Alternating Between Systems 6 And 7 Hard 
Disks 
Would you like to alternate the designation of your 
startup device between an internal hard drive that's 
loaded with System 6 and an external hard drive that 
has System 7? If so, it isn't necessary to keep using the 
Startup Device control panel and rebooting. I have 
System 6 on my internal drive, which is the Startup 
device, and System 7 is installed on an external drive. 

When you want to use System 7, boot the Macintosh 
while holding down the Delete Option-Command­
Shift keys, which makes the Macintosh by pass the 
internal drive at startup. When the disk icon with the 
flashing question mark appears, release the key and 
the external drive kicks in with System 7! A more ele­
gant solution, which is also easier on the fingers, is to 
obtain a copy of System Switcher 1.1, a shareware utili­
ty that lets you designate which system will boot when 
you restart the Mac. 

Invisible Desktop And 'Irasb Folders 
If you have both System 6 and 7 on your hard disk, 
when you boot under System 6 you will discover two 
new folders called Desktop Folder and Trash. These 
residual files are required by System 7. They store the 



files and folders located on the desktop and in the 
Trash. If you delete these files, System 7 will recreate 
them, but they clutter the desktop. Do not trash either 
folder if they contain files. 

If you don't want to see these folders under System 6, 
you can make them invisible by using ResEdit, DiskTop, 
or another program that lets you edit folder attributes. 
(If you use DiskTop, for example, simply check the 
Invisible attribute in the folders' Get Info dialog box.) 
When you're running under System 6, you won't see 
these folders, and System 7 uses them without any 
problem when the Invisible attribute is turned on. 

One note of caution: If you make System Ts Desktop 
Folder invisible and then leave files on the desktop, 
you won't be able to see the files when your Mac's run­
ning under System 6. For example, you can't see or 
double-click on an application that's on the invisible 
System 7 desktop. You can still see and open invisible 
files in applications, howeve~ in their Open dialog box. 
Also, aliases don't wotk if their original files are in invisi­
ble folders. 

Using Aliases To Free Up Hard Disk Space 
System Ts aliases provide a unique way of archiving 
infrequently used files and freeing up space on your 
hard disk. First, get a few floppy disks and label them 
clearly (as an example: Archive I, Archive2, and so on). 

Next, go through your hard disk and copy to the floppy 
disks files you don't often use. Finally, make aliases of 
the files on the floppies, and copy the aliases back 
onto your hard disk. Now, whenever you need one of 
these files, double-click on its alias on your hard disk. 
Your Mac will ask you to insert the proper floppy disk. 

Hidden Fun Stuff In The Monitor Control 
Panel 
Here's a System 7 secret that no one needs to know but 
that's fun to try. Open the Control Panels folder, and 
then open the Monitors control panel. Click on the 7.0 
in the upper right -hand comer of that window, and 
you'll see the names of the programmers who worked 
on this part of System 7. Then, while holding down the 
mouse button, press the Option key. You'll see the 
happy face move its eyes and stick its tongue out. If 
you press the Option key several more times while 
continuing to hold down the mouse button, you'll see 
the names change. 

Zapping The PRAM 
To zap the parameter RAM (PRAM) under System 7, 
hold down the Option, Command, P, and R keys when 
starting up. 

Speeding Up System 7 
Apple has released its System 7 Tune-Up, and says that 
using it will improve memory management, fix bugs, 
and generally speed things up. It's being distributed 
free, and is a highly recommended upgrade. Here are 
some other techniques for speeding up System 7. 

First, make sure the Calculate Folder Sizes option in 
the Views control panel is turned off. Calculating 
Folder Sizes slows the Finder to a crawl. 

Second, try increasing the size of your disk cache in 
the Memory control panel in System 7. Chances are it's 
set to 256K right now, which is the default for an 8-
megabyte machine. Try increasing it to at least 384K, 
and then reboot. The speed improvement is subtle, so 
if you don't notice that your Mac runs faster after a 
day or so, return to the control panel, increase the set­
ling some more, and reboot. If you don't notice a dif­
ference by the time you get to 768K or 1,024K, return to 
the control panel and set it back to the default­
there's no sense in wasting perfectly good RAM on the 
cache if you don't see any improvement. 

Finally, you may notice that whenever you double­
click on an icon in the Finder, you see animated 
zooming rectangles before it opens. These are called 
ZoomRects, and they slow the Finder down quite a bit. 
Luckily, if you're handy with Res Edit, you can turn 
ZoomRects off. (Of course, the standard ResEdit dis­
claimer applies. In case you've forgotten here it is 
again: ResEdit can do lots of really cool stuff, but it 
can also destroy your files. Never use Res Edit on a 
master or original file; always wotk on a copy.) Here's 
how to turn ZoomRects off: 

1. Open a copy of the Finder with ResEdit 21 or later. 

2. Open the CODE resource. 

3. Open CODE ID = 4 (you'll need to decompress it). 

4. Select Find Hex on the Find menu, and then look for 
4E56 FFEO 48E71F38. 

5. Select these bytes. 

6. Replace them with 205F 700A DECO 4EDO. 
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7. Save the copy of the Finder, and close ResEdit. 

8. Move the modified Finder into your System R>lder, 
and reboot. (You can boot from a floppy to perfonn 
this step.) 

Switching Between Systems 6 An~ 7 
You can have System 7 and System 6 on your Mac at 
the same time; normally however, the Mac becomes 
profoundly befuddled when it goes through its startup 
procedure and finds more than one System Folder on 
the same volume. At best, you'll have no control over 
which System Folder the Mac boots from- although 
typically it's the folder that was created first- and at 
worst you'll get a cheerful system error. 

There are a variety of solutions. A shareware program 
called System Picker searches for folders that contain 
a System file and then lets you reboot the Macintosh 
with the System R>lder you select. 

A simple solution is to make a System 6 or System 7 
startup disk by creating a minimal system folder on a 
floppy disk. The System 7 installer program has an 
option to create a miniature system. 

Another solution is to have the old and new Systems 
on separate volumes and then use the Startup Device 
control panel (called the Startup Disk under System 
7) to select which volume your Mac should boot with. 
If you have more than one hard drive (say an internal 
and an external drive), you can install a different sys­
tem-software version on each one without further 
muss or fuss. If you have only one hard drive, then 
partition its disk into separate volumes, using a parti­
tion utility. Then put a folder with System 6 onto one 
volume and System 7 onto another. 

Unfortunately, the Mac Plus, because it lacks the spe­
cial section of PRAM (parameter RAM) where the con­
trol panel records the startup info, can't use the 
Startup Disk Control panel. 

Yet another solution is a freeware.INIT called 
Switch Boot. It lets you choose which volume you want 
to boot from at startup time. Without it, you have to 
wait for the Mac to boot, use the Startup Disk control 
panel, and then restart. With SwitchBoot, if you hold 
down the S key during startup, you'll see a dialog box 
with a list of your boo table hard drives. Choose one 
and click on the Reboot button, and your Mac will 
start up with the System on that volume. SwitchBoot 
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doesn't work with a Plus or earlier Mac models. 

SwitchBoot and System Picker are available from user 
groups and on-line services. · 

Cleaning Up The View By Icon 
System 7 makes it easy to sort a window's contents by 
Size, Kind, Label, Date, or Name while you're in the 
View by Icon mode. To sort a window by Name while in 
the Icon view, pull down the View menu and select by 
Name. Return to the Icon view. Hold down the Option 
key, and select Clean Up by Name from the Special 
menu. Now your icons are oganized alphabetically 
within the window. The same procedure works for the 
view by Size, Kind, Label, and Date modes. 

Using The 'Jioue Gray Dimming In Dialogs 
System 7 uses true gray to represent dimmed items in 
menus and dialog boxes instead of using the old 
black-and-white dithered pattern. Many application 
menus use this new standard, but most dialog-box 
items still use the old pattern. If you have ResEdit, you 
can update your applications to use true gray in 
dimmed dialog-box items, too. 

Open a copy of the application in ResEdit (never work 
on an original application), and double-dick on the 
DWG-resource icon. It lists the ID number (and often 
the name) of all the application's dialog boxes. Find 
the dialog box you want to alter, and double-click on 
its ID number. A dialog box that shows a miniature 
version of the dialog box you want to change appears 
on the left of the screen, and two buttons (Default and 
Custom) appear on the right. Click on the Default 
button, and change one of the colors the dialog box 
uses by double-clicking on the color and selecting a 
new color in the resulting Color palette. I usually 
change one of the blacks to a dark gray. 

When you change the colors, Res Edit asks if you want 
to create a dctb resource, which is needed to store the 
color information. Click on OK (if you want to remove 
the color and revert to the default, simply delete the 
dctb resource). Then save your changes, and replace 
the old application with the altered version. 

Tune It Up! 
Apple's System 7 Tune-Up will tune up your Mac. You 
can get it at no charge from on-line services, user 
groups, and Apple dealers, and it's packaged with new 
Macs. 



System 7 Tune-Up is easy to install: just double-click on 
the installer icon, and the program does the rest. Once 
you've installed it, you'll see fewer "out of memory" 
messages and you'll have more memory available for 
application programs. You'll also experience faster, 
more reliable printing. )bu can check to see if System 7 
Tune-Up is already installed on your Mac by going to 
About This Macintosh on the Apple menu. If there's a 
dot to the right of the system software version number 
in the top right comer of the dialog box, the program is 
installed. 

System 7 Tune-Up consists of a new Chooser, a new File 
Sharing extension, and new printer drivers for the 
LaserWriter and StyleWriter as well as an extension 
called System 7 Tuner that provides better memory 
management, particularly if you have four or fewer 
megabytes of RAM. 

Loading Extensions 
System 7 extensions, otherwise known as control pan­
els (cdevs) and extensions (IN ITs), live in your system 
folder. When you drag a file of either type into your 
System Folder, the Finder informs you that these items 
need to be stored in special places inside the System 
Folder in order to be available to the Mac. It politely 
asks if it may put them where they belong. Once that's 
done, your Mac tells you where it's stashed the files. 

As you may recall, under System 6, IN ITs and cdevs 
were commingled in the System Folder and there was 
no Control Panels folder or Extensions folder. \Vhen 
you started up your Mac, INITs (in the Extensions 
folder) and cdevs (in the Control Panels folder) load­
ed in alphabetical order. The loading order was some­
thing like this: Aardvark (INIT), Badger (cdev), Cobra 
(INIT), Deer (cdev), and so on. 

System 71oads extensions and control panels differ­
ently: First it goes through the Extensions folder and 
loads its contents alphabetically. Then it loads the 
contents of the Control Panels folder alphabetically. 
Finally, it looks in the System Folder itself and alpha­
betically loads any extensions or control panels it 
finds there. Under System 7, the loading order looks 
something like this: Aardvark (extension), Cobra 
(extension), Badger (control panel), Deer (control 
panel), and so on. 

Controlling The Loading Order Of 
Extensions 
On startup of your Macintosh, system extensions load 
first and then control panels. A problem can arise 
when certain extensions and control panels want to 
be loaded first or last. This category includes exten­
sion managers (more about this type of program in a 
moment); virus detectors; and drivers for removable­
media devices such as SyQuest, Bernoulli, or optical 
storage drives, all of which need to load first. These 
programs generally arrive from their manufacturers 
with a space inserted before their names, which forces 
them to load first. Other extensions and control pan­
els, such as Adobe Type Manager, like being loaded 
last. Their names are usually preceded by a z or a tilde 
(-). 

You must place a control panel that needs to load first 
in the Extensions folder, or else all the extensions will 
load before it. But if you just drag it into the System 
Folder, the Finder will put it into the Control Panels 
folder. Here's how to work around this apparent 
impasse: First, double-click on the System Folder to 
open it, and then drag the extension or control panel 
into the appropria.te folder or into the System Folder's 
open window if you want the control panel to load 
after everything in the Control Panels and Extensions 
folders. 

Using this technique, you can place an extension in 
the Control Panels folder, a control panel in the 
Extensions folder, or either type of file in the System 
Folder rather than in the Control Panels or Extensions 
folder. If you do move a control panel to the Extensions 
folder to force it to load earlier, it's convenient to put an 
alias of it into the Control Panels folder so you can still 
access it to change settings. 

Holding Down The Shift Key Disables More 
Than Extensions 
Holding down the Shift key disables more than just 
the items in the Extensions folder. Any file with an 
IN IT resource -whether that file is in the Extensions 
folder, the Control Panels folder or loose in your 
System folder -is disabled. With the Shift key held 
down, anything placed in the Startup Items folder is 
bypassed, too. 

Background Copying 
Under System 7, you can copy files in the background 
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while continuing to work in an open application. If 
you're a longtime Mac user, however, you may be so 
accustomed to being unable to do anything during a 
copy operation that you forget to launch a program 
before you start the copying process. As a result, you 
still can't do anything, because the Finder doesn't let 
you launch an application while it's copying files. 

If you have QuicKeys 2.1, you can perfonn almost any 
task that has a QuicKeys macro assigned to it while 
your files are copying in the background. For instance, 
you can launch your favorite word processor or 
spreadsheet program while you copy files from your 
hard disk to a floppy in the background. 

Also remember that if you have your application run­
ning in the background when you begin copying, you 
can choose it from the Applications menu or click on 
any of its windows, which lets you continue working 
while your files are copying in the background. 

Easy Startup Sounds 
Do you want your Mac to play the opening phrase of 
the "Star Trek" theme whenever you boot it? If you're 
running System 7, this is a cinch- just place the 
(double-clickable) sound file (or an Alias of the file) 
in the Startup Items folder. Voila! 

If you decide you don't want to hear the startup sound, 
hold down the Shift key just before the desktop 
appears. If you do it too soon, your extensions won't 
load, but if you time the use of the Shift key just right, 
it will prevent everything in your Startup Items folder 
from executing. 

Smart Apple-Menu 'nicks 
Many users complain that Apple didn't make it easy to 
put items other than DAs onto the Apple menu -they 
don't like having to open the System Folder to add 
things to the Apple Menu Items folder. You can, howev­
er, make an alias of the Apple Menu Items folder and 
put it inside the Apple Menu Items folder. When you 
want to add something to the Apple menu, simply 
select the alias for the Apple Menu Items folder from 
the Apple menu and drop the item inside, just as you 
do with control panels. 

Protected Ftle Sharing 
Once you've configured a Mac for file sharing, you can 
use ResEdit or DiskTop to make the Sharing Setup 
control panel invisible, which will prevent other users 
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from changing its configuration. just tum on the 
Invisible file attribute. 

Suppressing The Startup Items 
If you load startup items by placing them in the 
Startup Items folder in the System 7 folder, hold down 
the Shift key just before the desktop appears. If you do 
it too soon, your extensions won't load, but if you time 
the use of the Shift key just right, it will prevent every­
thing in your Startup Items folder from executing. 

Hierarchical Apple Menus 
1b make this tip work, you need a utility that creates 
hierarchical menus for your Apple menu. Make an 
alias of your hard disk, and put into the Apple Menu 
Items folder. That's it. Now you have instant, single­
point access for every folder and file on your hard disk. 

1b get your hierarchial Apple menu, you need Now 
Menus (part of Now Utilities 3.0), from Now Software 
(800-237-3611 or [503] 274-2800); Super Menu 
(part of HAND-Off II), from Connectix 
([415] 571-5100); or HAM, from Microseeds 
Publishing ([813] 882-8635). 

Keyboard Commands In Dialogs 
In the Open and Save dialog boxes, Command-O takes 
you directly to the desktop level, Command/ right arrow 
and Command/left arrow cycle through all mounted 
volumes, and Command/up arrow and 
Command/down arrow move you up or down one folder. 

Easy Access On The Apple Menu 
The icons on System 7's Apple menu slow down the 
scrolling process. 1b avoid scrolling, move your fre­
quently used items to the top of the menu by putting a 
space before their name. For example, create an 
_Applications folder on your desktop and put an alias 
for it into the Apple Menu Items folder (the_ charac­
ter stands for a space) and then place all your pro­
grams in the folder. Because the Applications alias 
starts with a space, it appears at the top of the Apple 
menu, giving you easy access to its contents. 

Placing Spaces 
The first 15 items on my Apple menu have one or more 
spaces before their names. The more often I use a file 
or folder, the more spaces before its name. The more 
spaces I put before its name, the higher the item 
appears on the menu. 



If you use Microseeds' HAM, you don't have to bother 
with the spaces. In addition to its hierarchical Apple 
menu, HAM has a very Mac-like list (implemented as 
a control panel) that lets you rearrange items on the 
Apple menu by clicking and dragging them. 

Editing Icon Names 
When you edit an icon name, pressing the down­
arrow key places the cursor at the end of the icon's 
name. This is helpful if you're trying to delete the word 
alias from all your aliases. Mter all, the names are 
already in italic, so the word is redundant- and 
besides, it takes up valuable space. 

Organizing the Apple Menu 
One of System Ts best features is its customizable 
Apple menu. When creating several aliases of your 
most often used applications and files and putting the 
aliases into the Apple Menu Items folder, you will find 
that they are listed alphabetically among your DAs. 
Although DAs are treated just like applications under 
System 7, you may prefer to find Calculator near the 
top of the list, where it's always been- not mixed in 
with a bunch of other items in a long list. 

One solution is to rename DAs so that they appear in 
the order you want them. Instead of renaming the 
DAs, you can rename the aliases of the DAs by making 
the apple character (Shift-Option-K) the first charac­
ter in their names. Now your Apple menu will have an 
alphabetical list of DAs, followed by a list of aliases, 
each of which is flagged with a little apple. 

In a similar vein, if you want a file to appear at the 
top of the Apple menu, use one or more spaces as its 
first character(s). You can use this technique to group 
files and folders on the Apple menu. 

Copying System Files 1b The System Folder 
System 7.0 creates several folders inside your System 
folder and uses them for specific purposes. When you 
drag a file onto the System folder icon, the Finder will 
tell you where it's going to put the file. The Finder 
makes its choice based on the file's type and it's gener­
ally right. 

Specifically, the maintenance of the Extensions and 
Control Panels folders should be left up to the Finder, 
unless you have good reason to disagree. In the case 
when you want to override the Finder's default desti­
nation, simply double-click on the System folder icon 

to open its window and drag the file into this window 
while avoiding any of the folders inside. 

A Busy Hard Disk 
If your hard disk seems to be almost constantly busy, 
even when you're not doing anything, this is probably 
because you have turned on "Calculate folder sizes" in 
the Views control panel. When this option is enabled, 
the Finder seems to compute folder sizes constantly, so 
it can display them in list views, such as By Name. 
Unless you really need to see the folder sizes- which 
you can always do by selecting a folder and choosing 
Get Info- disable this option. Your disk will be a lot 
quieter. 

Creating An Alias 
Aliases are one of System Ts best organizational fea­
tures. Let's say you create a memo to the marketing 
department about joe Client. Do you store it in the 
Memo folder, the Marketing folder, or the joe Client 
folder? With aliases you don't have to decide- sim­
ply store the actual file wherever you like, and put 
aliases into the other folders. Then, no matter which 
of the folders you look in, you'll be able to find and 
open the memo. 

Creating aliases is easy: Select the file that needs the alias, 
go to the Finder's File menu, and choose Make Alias. Then 
you can move the alias to the desired location. 

Aliases For Frequendy Used Ftles 
Keep aliases of frequently used files and folders on the 
desktop or in the Apple Menu Items folder (or in both 
places- aliases consume very little disk space). You 
can keep aliases of folders on your desktop that per­
tain to projects you're currently working on as well as 
aliases for your contacts database and to-do list. 

Although the actual folders and files are buried three 
or four levels deep, use the desktop aliases to get at 
them with a double-click. Items on the desktop are 
also easy to find when you're in an Open or Save dia­
log box- simply click on the Desktop button or type 
Command-D. 

Aliasing The Apple Menu Folder 
Keep an alias of the Apple Menu Items folder somewhere 
convenient such as on the desktop or inside the Apple 
Menu Items folder itself. This lets you add files and fold­
ers to the Apple menu by putting them into the folder. 
Conversely, you can weed out the folder without having 
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to wade through the System f'Older to find it. 

Aliasing Applications For The Desktop 
Because System 7 lets you launch files by dragging 
them over an application's icon (or an alias of an 
application's icon), keep aliases of frequently used 
applications on the desktop. That's where I keep my 
graphics program (Canvas), because it lets me open 
several file types even if they weren't saved in 
Canvas. You can open any file (regardless of the 
file's creator, by dragging it over the application's 
icon. Back in the pre-System 7 days, you had to 
launch the program first and then use the Open 
command to access the file. 

Perfonning Multiple-Criteria Searches 
With Find 
The Find function lets you perfonn multiple-criteria 
searches. For example, to find all the file names that 
contain the word doc; are smaller than lOK; and were 
created after june 4, 1991, all you have to do is press 
Command-F and click on the More Choices button. 
Choose the volume you want to search from the Search 
pop-up menu, check the All at Once box, and click on 
OK. When the search is complete, and without clicking 
in the window containing the found items, choose Size 
from the Find pop-up menu, choose Is Less Than from 
the Criteria pop-up menu, and type 10 in the size field. 
Choose The Selected Items from the Search pop-up 
menu, and click on OK. 

When this search is complete and without clicking in 
the window containing the found items, choose Date 
Created from the Find pop-up menu, choose Is After 
from the Criteria pop-up menu, and set the date to 
4/4/91. Choose The Selected Items from the Search 
pop-up menu, and click on OK. 

When the search is complete, all the files that meet all 
your search criteria are selected. The only limitation is 
that multiple-criteria searches can be perfonned on 
only one volume at a time. 

Once you've gotten the hang of this technique, it's 
almost impossible to lose files- if it's somewhere on 
your hard disk, you'll find it easily. 

Create Your Own System Beep 
The first thing you need is a way to get sound into 
your Mac. If you have one of the Macs that includes a 
microphone, adding sound is a piece of cake. 
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Otherwise, you will need to obtain a microphone that 
connects to the serial port. Here's all you have to do to 
create your own System beep: 

1. Open the Sound control panel, and click on the Add 
button. 

2. Click on the Record button, say "beep" into the 
microphone, and then click on the Stop button. 

3. Save the beep, give it a name, and click on OK. 

4. To hear your beep, either click on its name in the 
Sound control panel or double-click on its icon in the 
Finder. 

The beep you've just created is now a standard Mac 
document stored inside the System file. After you've 
created a sound, you can move it, copy it, or drag it 
into the Trash, just as you would any other file. You 
can even use the standard Copy and Paste commands 
to add sounds to the Scrapbook (to hear a sound, just 
click on the Play Sound button, on the Scrapbook 
page). If you don't want to store all your sounds in the 
System file, you can use Suitcase II, from Fifth 
Generation Systems, or Masterjuggler, from ALSoft, to 
manage sounds stored elsewhere on your hard disk. 

Aliasing AppleShare Volumes 
If you're on a network and frequently access an 
AppleShare volume or a shared folder on another Mac, 
make an alias of that volume or folder. Whenever you 
need to access that volume or folder, all you have to do 
is double-click on its alias- you don't have to go to 
the Chooser first to mount it. 

Conflicting Extensions And Control Panels 
Conflicts can occur between an extension and a control 
panel. When this happens, your Mac may crash when 
you boot up or even refuse to start up at all. 
Unfortunately, even System 7 can't diagnose or resolve a 
conflict between an extension and a control panel. 
Fortunately, you can often resolve conflicts among 
these system files by simply changing the loading order 

To force an extension or control panel to load first, 
preface its name with one or more spaces and move it 
manually to the Extensions folder if it's not already 
there. To force an extension or control panel to load 
last, move it outside the Control Panels or Extensions 
folder into the System Folder itself and precede its 
name with one or more tildes. Experimenting with the 



loading order usually gets things working or at least it 
does so most of the time. 

If a conflict prevents your Macintosh from starting up 
properly, holding down the Shift key during the start­
up process disables all extensions and control panels, 
which allows you to rename the files. 

Disabling Extensions And Control Panels At 
Startup 
Holding down the Shift key during the Macintosh 
startup process disables all extensions and control 
panels. You will have to restart the Macintosh for them 
to load into RAM again. 

Extension Utilities 
If you use a lot of extensions or control panels, an 
extension management utility such as Now Software's 
Startup Manager (part of the highly recommended 
Now Utilities package), Baseline's I NIT Manager, 
Microseeds' !NITPicker, Icom Simulations' On Startup 
(part of the On Cue II package), or Apple's Extension 
Manager can make life a lot easier. These utilities let 
you turn extensions and control panels on and off, 
change their loading order without renaming or mov­
ing them, enable or disable extensions before each 
startup, and automatically disable whichever exten­
sion or control panel causes a crash on startup. 

Aliases In The Apple Menu Items 
You can put aliases for frequently used applications, 
documents, and folders in there. Once you've done 
this, your most frequently used files will always be 
handy when you need them -just pull down the 
Apple menu, and there they are. (To create an alias, 
highlight the file and choose Make Alias under the 
File menu in the Finder. ) 

Making Your Apple Menu Hierarchial 
As excellent as System Ts Apple menu is, there are sev­
eral inexpensive utilities that make it even better. The 
best of these are extensions that add hierarchical 
menus to the Apple menu. Look for Now Menus (part 
of Now Utilities), HAM (Microseeds), SuperMenu (part 
of Connectix's HandOff II package), or MenuChoice 
(shareware; available from user groups or on-line ser­
vices such as MacUser's ZiftNeVMac). 

When you install one of these utilities, any folder 
or alias of a folder in your Apple menu sprouts a 
hierarchical arrow so you can open any file or 

folder it contains by merely clicking and holding 
down the mouse as you scroll through the Apple 
menu. 

Each of these utilities has slightly different features. 
For example, HAM and MenuChoice create a folder 
in your Apple Menu Items folder called Recent and 
store a list of recently opened folders there for easier 
access. SuperMenu and Now Menus let you pop up 
the Apple menu anywhere on the desktop by click­
ing while holding down a modifier key or keys. This 
feature is particularly useful if you have a large 
monitor or more than one monitor. Super Menu has 
another nice feature that lets you choose a smaller 
font for displaying its pop-up menu. 

Installing Fonts 
The FonVDA Mover is not necessary under System 7.01. 
Installing a font is as easy as dragging its icon (or 
icons, if it's a PostScript font) onto the System Folder. 
The Finder automatically places the files where they 
belong -screen (or bit-mapped) fonts in the System 
file itself, PostScript printer (or outline) fonts in the 
Extensions folder. 

With 7.1, things have changed a little bit. The system 
now contains a special folder, f'Onts. \Vhen you drag 
any type of font file- bit-mapped, True Type, or Type 
1-onto the System Folder icon, the file automati­
cally gets placed in the Fonts folder. 

The Floating Desktop Window 
Many applications open their windows to full-screen 
size. This can be a nuisance when you switch to the 
Finder and discover that all the disk icons are covered 
by inactive windows from open applications. It's par­
ticularly annoying on the PowerBook, where screen 
space is at a premium. 

Instead of hiding and showing or resizing windows, 
you can use a floating desktop window. Here's how it 
works: 

First, create a folder, and name it Floating Desktop. 
Next, make aliases for all your disk (or volume) icons 
and the Trash icon, and put them into the Floating 
Desktop folder (you can also put aliases for remote 
volumes into the folder). Open the folder, size the win­
dow, and move it to a convenient location. 

Now when you switch to the Finder, clicking on this win­
dowgivesyou access to all your disks (or volumes) and 
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the trash, even when an inactive-application window is 
covering the icons on the right side of the desktop. Put an 
alias of the Floating Desktop folder into the Startup Items 
folder, so that it opens eve!)' time you start up your Mac. 
You can also make a QuicKey (with QuicKeys from CE 
Software) that pops this window to tl1e front 

Mac-To-DOS And Back File Exchange 
Utitilies 
Apple File Exchange is a utility for PC interoperability 
that ships with every Mac, and is a foreground applica­
tion that enables a Mac to read a file from a DOS 
floppy disk. 

Third-party programs that read the DOS files auto­
matically in the background may provide better solu­
tions depending on how often you interchange 
between formats; these include DOS Mounter, $89.95 
from Dayna Communications ([801] 531-0600), and 
AccessPC, $99 from Insignia Solutions 
([ 415] 694-7600). Apple also sells a program called 
Macintosh PC Exchange (800-538-9696, ext 180). 

A PC-based program that reads Mac disks, called 
Mac-in-DOS, is available from Pacific 
Microelectronics ([ 415] 948-6200) for a list price 
of $199. 

Using Font Management Utilities 

As simple as System Ts font installation is, if you use a 
lot of fonts, there is an alternative: a font manager 
such as Masterjuggler or Suitcase II. 

Installing fonts under System 7 has two major draw­
backs. First, it's painfully slow, especially on slower Macs. 
When you drag a font into or out of the System folder, you 
can wait a long, long time to regain control of your Mac. 
The second problem is that if you use a lot of fonts, your 
System folder soon ~wells to massive proportions with all 
the screen (orTrueType) fonts it contains. Having many 
fonts installed can be inconvenient and can chew up disk 
spare at an alarming rate. 

Masterjuggler, from ALSoft, and Suitcase II, from Fifth 
Generation Systems, address both of these problems: 
Both install and uninstall fonts far more quickly than 
System 7 does and compress your fonts so they take up 
less disk space. They also let you put any type of font 
screen, TrueType, PostScript-printer font in any folder 
on any volume. 
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Creating Screen Shots In A Drawing 
Program's Format 
To do this you will need to change the System file so 
that screen snapshots are created in your favorite 
drawing program's native format: 

1. Launch ResEdit, and open a copy of the System file 
(do this on a copy of the System file, not the active 
System file). 

2. Open the FKEY resource. 

3. Open FKEY resource ID 3. Click on OK when warned 
about saving your changes uncompressed. 

4. Choose Find ASCII from the Find menu. 

5. Type PICT into the first text field of the window, and click 
on the Find Next button. 

6. Close the window, and examine the highlighted 
string in the FKEY ID = 3 window. 

7. Click on the down arrow, and examine the four:- letter 
creator type for ThachThxt (th1) directly under the boxed 
PICT string. 

8. To find out the creator type of your drawing pro­
gram, use ResEdit to open a document created by that 
application and choose Get File/Folder Info from the 
File menu. Copy the four-letter creator string in the 
window that appears, and close that window. 

9. Select the ttxt string in the FKEY ID = 3 window, 
and paste. 

10. Choose Save from the File menu, and quit ResEdit. 

11. Move your old System file out of the System Folder, 
and replace it with the new one. Make sure the new 
file is named System. 

12. Restart to activate your changes. 

Now when you double-click on a document you've 
created by pressing Command-Shift-3, it's opened by 
the specified drawing program. 

Using RAM Cache To Speed Up Your Mac 
Try tweaking the RAM cache: Start with a setting of 
256K, and add another 32K for every megabyte of RAM 
you have over 2 megabytes. The RAM cache setting in 
in the General Control Panel under System 6, and in 
the Memory Control Panel under System 7. 



Enhancing Scrolling Speed 
You can also greatly enhance scrolling speed and even 
(to a lesser extent) system performance by dropping 
down to a less impressive video mode. If you do most 
of your work in 256-color mode or 24-bit mode, you'll 
see a vast improvement if you switch to simple black­
and-white mode. 

SYSTEM 
'len Basic, Good-Natured Dps 
Here are ten tips for using your System (or your sys­
tem) wisely. They're so fundamental that you're prob­
ably already honoring some of them now and can 
check them off immediately. 

1. Save your work often enough. 

So often that it becomes a reflex. If you press 
Command-S whenever you get up to refill your coffee 
cup, if you press Command-S before answering when 
asked a question, if you press Command-S whenever 
you pause to gather your thoughts or wool, yours is 
the world and everything in it, and that's not bad. 

2. Back up all your work adequately. 

There are a lot of strategies for backing up files. 1\vo is 
the minimum for any files you really care about, but 
if you think you need five, make them. 

3. Organize your files somehow. 

Pay attention when the Save As dialog box comes up 
the first time you try to save a newly created file. That 
way, you can save the file into the folder in which it 
belongs rather than into whatever folder you happen 
to have opened most recently, which is exactly what 
will happen unless you specify otherwise. 

4. Use spelling checkers often. 

5. Rebuild your desktop annually (if not sooner). 

Rebuilding the desktop improves your system perfor­
mance. 

6. Don't use commercial software or shareware with­
out paying for it. 

Commercial software and shareware authors deserve 
compensation and sometimes even respect for their 

efforts. It's a matter of payment for value received. If 
you use it, pay for it. 

7. Send in your registration cards promptly. 

Sending in your registration cards is just good sense; it 
makes it possible for the company to reach you in the 
event of a product upgrade or recall. 

8. Keep your computer reasonably clean. 

What this means is that you shouldn't crush potato 
chips into the keyboard or pour liquids on the moth­
erboard. 

9. Experiment. 

Try new things. 

10. I.Dok out of the window now and then. 

Virus Checker Says "Encountered FCB 
Expansion" 
FCB stands for file control block, a data structure the 
Mac uses to reference an open file; there must be one 
FCB for each open file. Under System 6, the number of 
FCBs was fixed at start -up. Sometimes after opening 
lots of files, you can run out of FCBs, in which case 
you can't open any more files; applications often 
report this as a -42 error. 

System 7 automatically creates more FCBs as they're 
needed. This is what your virus checker is reporting, 
and it is harmless. 

Surviving A Crash 
In the event of a crash or a freeze, press the interrupt 
key. (Thchnically speaking, when you press the inter­
rupt key, you invoke the mini-, or built-in, debugger.) 
It usually brings up an empty dialog box that has a 
caret (>) prompt. If it does. try typing 

SM 0 A9F4 <Return> 

The 0 in this line and the next one you'll type are 
both numeric zero; <Return> means that you should 
press the Return key once. Type the characters exactly 
the way they appear here, including spaces. After the 
first return, the box fills with characters, but you can 
still type. Type this: 

GO <Return> 

That's it. If it works, you'll be returned to the Finder. 
This procedure works only with certain kinds of sys-

149 

~ 
~ 



n 
~ 

tern errors, and there's no way to tell beforehand 
whether it's going to work. But if you're hopelessly 
crashed, you might as well try it. 

Using this trick leaves your Mac in an unstable state. 
If you return to the desktop successfully, save all 
unsaved documents immediately and then restart 
your Mac, using the Restart command. 

The Mac's restart sequence is infinitely better than a 
crash -it shuts down the file system in an orderly 
fashion. Crashing doesn't. 

If you're really determined to recover from as many 
crashes as possible, check out Crash Barrier (Cassady 
& Greene, 22734 Portola Drive, Salinas, CA 93908; 
[ 408] 484-9228; $79.95), a nifty control panel that 
replaces the normal System Error message with its 
own friendly dialog box. If your Mac crashes, Crash 
Barrier pops up instead of the bomb dialog box and 
gives you a chance of recovering. Although it doesn't 
work every time, Crash Barrier is more effective than 
any mini-debugger voodoo. 

SYSTEM 6 
Zapping The PRAM 
To zap the parameter RAM (PRAM) under System 6, 
hold down Shift-Option-Command while selecting 
the Control Panel on the Apple menu. 

Typing A Space Character In Front Of A Ftle 
Name 
System 6 doesn't allow you to type a space character 
as the first character of a file/folder name; it doesn't 
test to see if the second character is blank if you try to 
delete the first. · 

If you want to add a space to the beginning of a file­
name or folder name under System 6, here's a sneaky 
way to do it: Type a character followed by a space at 
the beginning of the name. To get rid of the initial 
character, simply press the left-arrow key, the Delete 
key, and then Return- and there you have it. 

Too Many Files Open 
If you are getting the message "Too many files open" 
dialog box under System 6, you need to increase your 
Mac's open-file count, using either Suitcase II or 
Master)uggler. The Mac's default setting is 40 files 
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(documents, applications, font or DA suitcases, and so 
on). Both Suitcase II and Master)uggler let you reset 
this to any value as high as 99. 

Your problem is actually underallocation of FCBs (file 
control blocks), which are specified in the boot blocks 
on your hard drive. This results in an ID -42 error. In 
English, this means that somewhere in the boot 
blocks, there's a number that indicates how many files 
can be open at once. The Mac checks this number at 
startup and allocates a fixed number of FCBs. So if a 
program tries to open one file more than the limit, 
you get the "Too many files open" dialog box (system 
error ID -42). The term "files open" is a bit mislead­
ing, however. The number of open files involves not 
only how many documents you're working with but 
also all your fonts and DAs, every single application 
running at the time, and all the little files those appli­
cations have open behind the scenes; 40 open files 
can be exceeded pretty easily. 

Another solution is a freeware program from Peter 
Helme called Up Your FCBs. Pete has written a control 
panel that changes the open-files ceiling as you work. 
If one fatal file too many is about to be opened, Up Your 
FCBs automatically increases the maximum number 
of open files so the additional file can be opened with­
out incident. It's all done in memory rather than by 
writing to your boot blocks, so it's a bit safer. 

Another utility is called MaxFiles Fix. MaxFiles Fix is 
an application which allows you to change the maxi­
mum number of open files defined by your startup 
disk's boot blocks. MaxFiles Fix is available from 
online services and user groups. 

SYSTEM FOLDER 
(SYSTEM 7) 
Shrinking the System Folder 
If you are tight on hard disk space, you can look to 
your system folder to recover space. You can free up as 
much as a megabyte through judicious file deletion. 

For what it's worth, your Mac can function with noth­
ing more than a System and the Finder in the System 

. Folder. You don't need DAs, control panels, or exten­
sions, although doing without some of them- such 
as the Chooser and General Controls control panels-



would be inconvenient, to say the least. 

If you do decide to delete files and later realize that 
you need or want them, you can run the Installer 
once more to create fresh copies of them. (Some files, 
such as control panels, can be copied directly from the 
master system disks.) If reinstallation is too much 
trouble, copy each file to a floppy disk before you trash 
it. Then if you need it later, just drag it from the floppy 
to your System Folder. 

Removing Network Extensions 
Look inside the Extensions fOlder in the System folder. 
If you're not connected to a network and aren't sharing 
files, get rid of AppleShare (72K), File Sharing 
Extension ( 168K), and Network Extension (93K). These 
files, along with the File Sharing Monitor and Sharing 
Setup control panels (more about them later), are 
needed only if you share files with other Macs. Not only 
that, but file sharing uses about 300K of RAM when it's 
turned on. 

Removing Printer Drivers 
Look inside the Extensions folder in the System folder. 
Get rid of printer drivers for printers you'll never use. If 
you don't have an ImageWriter, trash the file named 
Image Writer ( 45K); if you don't have a Personal 
LaserWriter SC, trash its file (72K). And so on. 

Removing Miscellaneous Extensions 
Look inside the Extensions folder in the System folder. A 
couple of extensions you might want to trash are DAL 
(84K) and Finder Help (36K). DAL is used for accessing 
networked or remote databases; Finder Help contains the 
five screens you see when you choose Finder Shortcuts 
from the Help menu. (Read the screens before deleting 
Finder Help, though.) 

Reducing The Number Of Control Panels 
Look inside the Control Panels folder in the System 
folder. You can remove control panels that are inap­
propriate for your Mac. For example, if you have a 
black-and-white Mac, such as an SE, you don't need 
Color ( 12K). If you're not sharing files, get rid of File 
Sharing Monitor (SK), Sharing Setup (SK), and Users 
& Groups (SK). Map (29K) can also be removed. 

Another file you can probably do without is Easy 
Access (12K), which lets you control the cursor from 
the keyboard and/or use a Mac one-handed. A com­
plete description appears on page 354 of Macintosh 

Reference, the manual that comes with System 7 
upgrade kits. 

Slimming The Size Of The Apple Menu 
Items Folder 
The Apple Menu Items folder contains the standard 
DAs. With the exception of the Chooser, you don't need 
any of the Apple-supplied DAs: Alann Clock ( 12K), 
Calculator (8K), Key Caps (12K), Note Pad (9K), 
Puzzle (14K), or Scrapbook (UK). On the other hand, 
they're small and relatively useful (except for Puzzle), 
so you needn't toss them unless you're really hard­
pressed for disk space. 

Rescuing The Size Of The System Ftle 
Take a look inside the System file itself (double­
click on it). The Installer places about a megabyte of 
fonts and sounds inside the System file, but you 
don't actually need most of them. If you're really 
determined to whittle down your System Folder, get 
rid of your least-used fonts (3K to 68K each) and 
sounds (2K to BK each). 

SYSTEM INSTALLER 
(SYSTEM 7) 
Customizing the Installer 
If you choose Easy Install, as most users do, the 
Installer will install48 files, many of which you will 
never need. If you try to remedy the situation by choos­
ing Customize, you're presented with a list of almost 40 
items. Here's how to navigate through this list: 

Choose the ones you want to install by Shift-clicking 
on them - hold down the Shift key while you scroll 
and click on each item you want installed. 1b find out 
more about an item, click on it and an explanation 
appears below the scrolling list. 

Custom Selecting A System To Install 
In the Custom Install dialog of the installer, there are 
three categories of software- system software, printer 
software, and file sharing/networking software. They 
are arranged in five sections in the scrollable list. 

System software is broken up into System Software for 
any Macintosh (the first choice on the list) or System 
Software for [a specific Mac model]. 
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System Software for any Macintosh installs everything 
you need to start up any Mac model from your hard disk. 
System Software for [a specific Mac] installs only the 
resources that model requires. So, for example, if you 
choose System Software for Macintosh Plus, control pan­
els such as Monitors and Colors are not installed. If you 
never expect to use your hard drive with a different 
Macintosh model, choose System Software for [your par­
ticularmodel]. But ifthere's a chance you'll someday 
need to use your hard drive with a different Mac model, 
choose System Sofware for any Macintosh. 

Creating A Bootable Floppy Disk 
The last section of the Custom Install dialog list 
contains a set of items called Minimal Systems. 
These are used only to create high-density (FDHD) 
startup floppies. (Even a minimal installation of 
System 7 is too big to fit on an 800K floppy.) 

Min System for any Macintosh creates a startup flop­
py that works with any Mac model. Min System [for 
a specific Mac] creates a startup floppy that works 
with that particular model. Minimal System installs 
a System and the Finder and little else- no control 
panels, extensions, or DAs. The Installer does place 
the standard five subfolders (Apple Menu Items, 
Extensions, and so forth) inside the System Folder, 
however, and it provides an empty Control Panels 
folder as aDA. (It also installs a single font, 9-point 
Geneva in the System file.) 

Installing Printer Drivers 
In the Custom Install section of the installer, there is a 
section listing printer files to install. You can selec­
tively choose which printer drivers to install­
LaserWriter, Image Writer, Personal LaserWriter LS, 
StyleWriter, and so on. Shift-click on each one you'll 
need. You also can choose Software for all Apple 
Printers, which automatically installs all eight drivers. 

Installing Network Software 
In the Custom Install section of the installer, there is a 
section listing the network files to install in the 
System folder. If you're on a network and will be shar­
ing files, Shift-click on File Sharing Software. If you'll 
be using an EtherTalk or Token Talk network, 
Shiftclick on those items as well. 
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TECHNICAL 
INFORMATION 
How To Get The Macintosh 'Iechnical Notes 
The Macintosh Technical Notes are a resource for all 
Macintosh developers. Every time there's a topic that 
seems to be perplexing the developer community, 
Apple's DTS (Developer Technical Support) prepares 
a note that will cover the situation in detail. When 
bugs are discovered in system software or in ROM 
code, Technical Notes that fully describe the prob­
lems and how to solve them are written and dis­
tributed. When there's no other way to distribute 
documentation on certain system software (such as 
ThachThxt), it's disseminated as a Technical Note. 

DTS wants its Notes to get the widest distribution 
possible, so all the more than 300 notes can be 
downloaded from many on-line services. You can 
also buy them on-disk or in printed form from APDA 
(800-282-2732). 

TRUETYPE (SYSTEM 7) 
Changing The System Font Default With 
SetOudinePreferred 
The Chicago 12 font is the only font that's actually 
burned right into the Macintosh's ROMs, and it's the 
default font for menus and title bars and all kinds of 
other cool stuff. Whenever the System needs Chicago 
12, it ignores any disk files and just gets the bit maps 
from ROM. 

Apple included a new set of Font Manager routines 
with TrueType. One of them, appropriately called 
SetOutlinePreferred, tells the system always to use 
the TrueType version of a font instead of the bit­
mapped version, including 12-point Chicago in 
ROM. (The TrueType version of Chicago contains 
both the full extended character set and a large 
number of extra characters, including the 
Command-, Option-, Shift-, Tab-, and Delete-key 
symbols.) 

This routine needs to be turned on, and you can do 
so with an Fkey called SetOutlinePreferred, created 



by David Fowler, of Cotati, California. This Fkey lets 
you force the TrueType version of a font to be dis­
played and printed in any appl ication. It's "smile­
ware" (you can distribute it freely) and is avai lable 
from Mac User's on-line service, ZiffNeVMac. 

You can install this and other Fkeys by using utilities 
such as ALSoft's Masterjuggler or Fifth Generation's 
Suitcase II, or you can use Apple's resource-editing soft­
ware ResEdit (available from on-line services and user 
groups). If you have ResEdit 2.1 or later installed, just 
double-click on the FICEY icon and ResEdit will launch. 
Double-dick on the Fkey resource, highlight the ID 
number, and press Command-C to copy the Fkey to the 
Clipboard. NO\V, open a copy of your Mac's System file 
(move the original System file to a safe place outside 
the System Folder), double-click on the Fkey resource, 
and press Command-V to paste in the Fkey. Rename the 
copy of the System file, place it in the System Folder, 
and restart your Mac. 

TrueType Symbols For Control Keys 
The True Type version of Chicago font that ships with 
System 7 has numerous special symbols. lb get the 
Command-key cloverleaf, type Controi-Q. Typing 
Option-Controi-Shift-D gives you a Shift-key sym­
bol. Likewise, Option-Control-Shift-A produces the 
Option-keys symbol. The latter two symbols are not 
in the bit map Chicago font that came with older 
Macs and previous system versions. 

Because a bit map font has priority over a TrueType 
font for screen display and output, you should remove 
any bitmap versions of Chicago that are in your System 
file if you need to use any of the Option and Shift sym­
bols. This allows them to display and print properly. 
Furthern1ore, a 12-point bit map version of Chicago is 
built in to the Mac's ROM, so you won't be able to use 
the Shift and Option characters at that size. 

These symbols may not print properly in some appli­
cations, but they do appear on-screen. 

VIRUSES 
Virus Protection Across A Network 
If someone on your network has mounted your hard 
disk as a remote volume, it's possible that your disk 
could become infected by a virus on that person's hard 

disk, transmitted through the network. f'Or this rea­
son, any attempt at virus protection has to be applied 
to all the Macs on the network in order to be effective. 
Of course, if you install virus protection on every net­
worked Mac, you'll eliminate the problem entirely. 

UTILITIES 

32·BIT ADDRESSING 
Go 32-Bit Clean 
If you have a Mac II, Ilx, !lex, or SE/30 and run 
System 7, you may have heard that your computer's 
not 32-bit clean, which means that you can't take full 
advantage of System 7 features such as virtual memo­
ry. lb correct this problem, Apple bought MODE32, an 
extension from Connectix that adds 32-bit-addressing 
capabilities to these computers. Apple is giving 
MODE32 away through dozens of on-line services, 
BBSs, and user groups. f'Or more information, call 
Apple Customer Service Center at 800-776-2333 or 
( 408) 996-1010. 

ACCESSPC 
System 7 Invisible Files 
If you are using Access PC under System 7, and have 
mounted a DOS disk, you will find files created with 
names li ke DESKTOP&. 

What's happening is System 7.0 creates invisible fold­
ers and files as part of its nom1al operation. 1\vo such 
folders, called Trash and Desktop Folder, are created 
on every hard disk that is mounted on the Mac desk­
top. AccessPC lets you mount DOS disks as though 
they were Mac disks. 

But DOS allows only eight characters in a file name, 
so longer names (such as Desktop Folder) get truncat­
ed; AccessPC adds the trailing ampersand to indicate 
that the truncation has occurred. 
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ADD/STRIP 
Powerful File Filter And Converter 
Jon Wind's Add/Strip shareware application is a file fil­
ter that combines powedul conversion options, such as 
converting spaces to tabs, up to nine strings of charac­
ters to replacement strings, cleans up spaces, blank 
lines, double hyphens to em dashes and much more. 

Add/Strip also has built-in tables for conversion 
between DOS and Macintosh text fom1ats and a 
encryption/decryption system. Add/Strip is available 
on ZiffNeVMac and your local user group. 

AFTER DARK 2 
Editing The MultiModule 
Even After Dark 2's extensive collection of modules 
can fail to stimulate after a while. But the screen 
saver's MultiModule allows an amazing amount of 
customization without you having any programming 
knowledge whatsoever. One of my favorites is Stom1y 
Skyline. To tum Stormy Skyline into one hell of an 
electrical storm, simply follow these instructions: 

1. Duplicate the Zot! module twice while you're at the 
desktop, renaming the copies Zot!2 and Zot!3. 

2. Open the MultiModule to Stormy Skyline (a prede­
fined combination of Starry Skyline and Zot!), and 
click on the Edit button. Add Zot!2 and Zot!3 to this 
MultiModule, making them transparent instead of 
opaque. You should now have all three of the Zot! 
modules and the Starry Skyline module combined. 

3. Resize and reposition the Zot!s- it looks better to 
have them different sizes. 

4. Close the edited Multi Module, but first rename it 
something like Really Stormy Skyline. 

5. Open the individual Zot! modules, and edit the fork­
iness, kinkiness, and delay of each. 
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ALIAS 
Aliases Anonymous 
It doesn't take much effort to create aliases. You do, 
however, have to go through a few steps to create an 
alias and then put it where you want it. Wouldn't it 
be nice to have a one-step method of creating an 
alias and placing it anywhere on your hard disk? Well, 
Mac User has just the thing for you- it's 
Nom de Plume, developed exclusively for Mac User by 
Birmingham, Alabama, programmer Bill Monk, who 
also created Alias Assassin. 

Nom de Plume is a utility that lets you create an alias 
of a file, folder, or disk and choose its location on the 
hard drive from within one dialog box. Nom de Plume 
makes it so easy to create aliases that you'll probably 
need Alias Assassin before too long to get rid of your 
excess aliases. Luckily, both of these utilities are avail­
able on MacUser's on-line service, ZiffNeVMac, in 
Library 3 (Utilities) of the MacUser Forum. Nom de 
Plume's filename is PWME.Sit If you want to find 
Alias Assassin, its filename is ALIASASIT. 

Alias Assassin 
Aliases are a mixed blessing. Aliases are duplicate 
icons for files, folders, and volumes that are linked to 
an original file. Unfortunately, when you delete a file, 
the aliases remain, so you could easily have a hard 
disk full of aliases relating to nonexistent files. 

Apple hasn't provided an easy way of getting rid of 
''orphaned'' aliases, which is where Alias Assassin 
comes in. Alias Assassin, an application developed 
exclusively for Mac User, seeks out and destroys 
orphaned aliases. It scans your hard disk to find all 
unattached aliases and lets you choose whether the 
orphans should be trashed. If you have aliases relat­
ing to unmounted volumes, Alias Assassin asks you to 
mount the volume to confirm whether it still exists. 

Alias Assassin is smart. It attempts to reunite an alias 
with its parent file, even if the path between the two 
has been lost because you've shuffled files around on 
your hard disk. And if you're fed up with aliases entire­
ly, Assassin can kill them all at your discretion. 

Alias Assassin was programmed by Bill Monk, of 
Birmingham, Alabama. Alias Assassin can be found 



only on ZiffNeVMac, .Mac User's on-line service on 
CompuServe. The filename is AliasA.sn: and it's in 
Library 3 (Utilities) of the Mac User Forum or Library I 
(Applications) of the Download & Support Forum. 

Automate Your Aliases 
Nearly a dozen utilities can creat aliases. Here's a sam­
pling of the coolest. AKA (Fred's Finder Hacks) creates 
an alias when you control-drag an icon to a new fold­
er. Mac User's Nom de Plume, available on ZiffNet/Mac, 
creates an alias and automatically puts it into com­
mon folders such as the Apple Menu Items folder. 
MacUser's ZMakeAlias creates aliases from within an 
application's Save and Save As dialog boxes. 

Clean Up Alias Ftles 
Making aliases is a lot easier than getting rid of them. 
When you trash a file, its alias remains. Mac User's 
Alias Assassin combs through your hard disk, search­
ing for unattached aliases. A list displays the orphans, 
and you have the option to delete them or reattach 
them to lost files. TrashAlias, a freeware extension, 
provides a more automated solution. When you throw 
away a parent file, the alias follows it into the Trash. 

Load Extensions With Aliases 
You're out of luck if you want aliases to load exten­
sions that aren't kept in the System Folder, unless you 
have the freeware utility INITI.oader. INITI.oader even 
lets you load extensions across a network- a boon 
for network managers who want to keep everyone 
up-to-date on virus-detection extensions. 

ALARM CLOCK 
Get Message Alarms 
If you need to be reminded of impending appoint­
ments, then go a step further than Apple's Alann Clock 
with one of the many alann utilities. 

The shareware application CClock ( CClock, 2655 
S. Peoria, Aurora, CO 80014) alerts you with a cus­
tomized message when an alann sounds. Alarm Clock 
(Now Utilities, Now Software, Inc., 520 S.W. Harrison, 
Suite 435, Portland, OR 97201; 800-237-2800) 
and Easy Alanns let users enter alarm items that can 
repeat every hour, day, week, and so on. Alanning 
Events (CE Software, Inc., 1801 Industrial Circle, 

PO Box 65580, West Des Moines, lA 50265; 
800-523-7638) is a full-featured DA that adds 
detailed alann messages and a calendar. 

AMT 
One-Stop Modem-Tool Customization 
Information Electronics of Hammondsport, N.Y., has 
released a nifty, free utility for users of Apple's 
Macintosh Communications Toolbox. AMT Configure, 
a 38-Kbyte program available through on-line ser­
vices, lets you edit the modem initialization strings 
stored inside the Apple Modem Tool. 

Apple's tool lets you set custom strings, but each string 
you enter is tied to a particular use of the tool. You 
need to recreate your custom string in each applica­
tion or electronic-mail gateway that uses the tool. 
AMT Configure alters the resources of the tool itself, 
making your changes universal. With AMT Configure 
and knowledge of the modem's command set, you 
could, for instance, tum off a specific type of modem's 
speaker or tlow control. 

Version Note: AMT Configure 1.0 does not work with 
the Apple .Modem Tooll.l. 

APPLICATIONS 
Lauch Applications From Anywhere 
System 7lets you launch applications and documents 
from the Apple menu. HAND-Off II and MultiMaster 
(Now Utilities, Now Software, Inc., 520 S.W Harrison, 
Suite 435, Portland, OR 97201; 80{}-237-2800) let you 
launch files from anywhere on-screen through a pop­
up menu. HAND-Off II also includes a powerful set of 
hot keys for launching documents and programs. 

BACKUP 
CrashproofYour Data 
Your infonnation is only as safe as your last save. 
However, Last Resort (Working Software, PO Box 
1844, Santa Cruz, CA 95061; ( 408) 423-5696) gives 
you a second chance in the case of a system crash. 
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This unique utility saves every keystroke you type as 
you type it, saving everything to a text file, including 
symbols for such actions as a deletion or a backspace 
keystroke. If your system crashes, you can rebuild 
your document from the backup file. A new text file is 
created every time you tum on your computer. 

Back Up Data Continuously 
Increasingly, users are turning toward automatic 
backup systems that mirror their main disk as they 
work. These systems are extra safe and make it like­
lier that you'll get nearly all your files back after the 
inevitable crash. Auto Back (TerraNetics, 1538 N. 
Martel Avenue, Suite 413, Los Angeles, CA 90046; 
[818] 446-7692) and Twin-It (Golden Triangle, 
Computers, Inc., 4849 Ronson Court, San Diego, CA 
92111; [619] 279-2100) both give you the luxury of 
duplicating your disk on a second hard disk as you 
work. 

BACKUP SOFTWARE 
Why Doesn't Tune Stamp Work On Backups? 
Each Mac volume has a "date and time of last backup" 
parameter that's created when the volume is initialized. 
While a few backup programs set this date whenever 
you perform a backup, most newer software doesn't. 

This is not as bad as it seems, though. Modern backup 
software lets you pick and choose what to back up, so 
a single time stamp doesn't make that much sense 
anymore. All modem backup programs keep track of 
the date and time of the last backup internally. 

BALLOON HELP 
Use A Hot Key For Balloons 
On-screen Balloon Help is a good idea that is abun­
dantly annoying. Turning on Show Balloons activates 
every balloon your cursor travels over How many 
times do you need to be told what a menu bar is? 
Helium (Robert L. Mathews, PO Box 21271, Oakland, 
CA 94610) inflates Help Balloons when you hold down 
a hot key. Letting go of the key deactivates Show 
Balloons. 
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Hide The Balloon Icon 
If you are so frustrated by Balloon Help that youtl 
rather be rid of it altogether, then get 
NoBalloonsMenu, a freeware extension that removes 
the icon from the menu bar, thereby freeing up space 
on the right-hand side for other menu enhancements. 

BBEDIT 
The Programmer's Word Processor 
A word processor is not usually the best tool when you 
are writing source code for an application, converting 
files from one format to another or working with typi­
cal on-line information services. 

For such purposes, a text editor, one of those bare­
bones programs from the old days of graphics-free 
computing, is still a useful tool, even on the 
Macintosh. Fortunately, the humble nature of these 
applications has kept prices down. BBEdit, a great edi­
tor, is a freeware product. 

The program has plenty of programming features, 
such as balancing of parentheses, multifile searches 
and compatibility with such other tools as Macintosh 
Programmer's Workshop. What gives BBEdit a real 
kick, though, is grep, a sophisticated pattern-match­
ing and replacement language derived from Unix. 
It's already implemented on the Mac, in Paragon 
Concepts Inc.'s QUED/M and Nisus, but not at BBEdit's 
bargain price. 

The program and documentation are available from 
user groups and on-line services, including 
ZiffNeVMac, where they are compressed in file BBED­
IT.CPT in Library 1 at GO ZMC:DOWNLOAD. 

Siegel also accepts stamped, self-addressed mailers 
sent to the address listed belO\v. Include a floppy or $2 

Richard Siegel is at 6 Village Way, No. 23, Natick, Mass. 
01760. E-mail siegel @ world.std.com. 



CALCULATOR 
(SYSTEM 7) 
Customize Your Calculator 
The calculator that ships with System 7 hasn't 
changed its interface since the Mac was introduced, 
but a bevy of more complex calculators offers specific 
features geared toward the type of number crunching 
you do most. Desktop publishers and designers 
should check out Calc+ (Abbott System, Inc., 62 
Mountain Road, Pleasantville, NY 10570; 
800-552-9157), a calculator with an easy-to-use 
interface and the ability to automatically convert 
among different units of measurement such as picas, 
inches, and centimeters. Scientists and engineers will 
want to add RPN (reverse Polish notation) Calculator 
or Sci Calculator (both part of File Director). Each 
adds a host of functions and modes you're likely to 
find in a midlevel stand-alone calculator. As the 
name implies, 2000 Digit Calculator displays as 
many as 2,000 places for a calculation. 

CALENDAR 
Use A Desktop Calendar 
If you want a date keeper for your desktop, try out 
Calendar DA, a shareware DA that goes well into the 
next millennium. This monthly calendar has a 
notepad for each day. The commercial DiskTools 
Calendar (File Director, Fifth Generation Systems, 
10049 N. Reiger Road, Baton Rouge, LA 70809; 
800-873-4384) offers a similar layout and also has a 
Find command and the ability to archive daily notes. 

COLOR 
Color Your Menus 
Even with a color monitor, the Mac still ships with dull 
black-and-white system software. ClickChange (Dubl­
Click software, INc., 9316 Deering Ave, Chatsworth, CA 
91311; [818] 700-9525) and the shareware application 
Colorize add hue and shade to the common desktop. 
These applications color the Mac's basic elements-

such as windows, menus, dialog boxes, and scroll bars 
-with any of the Mac's 16.7 million available pig­
ments. ClickChange also replaces the Mac's factory­
issued cursor with something different, such as an 
index finger or a pointer of your own creation. 

CURSORANIMATOR 
Animating Your Cursor 
Remember how gee-whiz exciting it was when Apple 
first introduced animated wait cursors like the rotat­
ing watch and the spinning beach ball? You can 
recapture that excitement all over again and then 
some with CursorAnimator from Wilhelm Plotz and 
Alex Falk. 

CursorAnimator is a freeware control-panel/INIT 
combo that allows you to substitute various animated 
or static color and black-and-white cursors for any of 
the standard Apple system cursors (text insertion, 
crosshairs, plus sign, watch, and the arrow). The con­
trol-panel interface permits you to choose the cursors, 
import new CursorAnimator cursors you download 
from on-line services or create yourself, change the 
speed of animated cursors, and delete cursors you no 
longer want. 

Cursor Animator comes with several cursors pre in­
stalled. Changing the standard cursors is easy. You sim­
ply drag the new cursor from a scrolling list to a grid 
beneath representations of the standard system cursors. 
To create your own cursor, you must delve into the mys­
teries of ResEdit 2.1 or higher. CursorAnimator includes 
an extension for ResEdit that allows you to preview ani­
mated cursors while in ResEdit. And if you find ResEdit 
too intimidating, you' II be happy to discover that 
CursorAnimator comes with a collection of 27 black­
and-white and 23 color cursors you can import. There 
are even six cursors provided just for lefties. 

DESKTOP PRINTERS 
DTPrinter 
Desktop Printers were originally supposed to be part of 
System 7, but they dropped out along the way. Now the 
same idea is back with DTPrinter, a freeware extension. 
Desktop Printers are icons that represent various print-
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ers on a network. Drag a document or folder onto the 
icon to print from the Finder. 

DIALOGS 
Mouseless Dialog Boxes 
Keep your hands on the keyboard when dialog boxes 
pop up, with one of these three solutions. DialogKeys 
(QuicKeys 2, CE Software, Inc., 1801Industrial Circle, 
PO Box 65580, West Des Moines, lA 50265; 
800-523-7638) lets you cycle through buttons in a 
dialog box with Command-Tab. 

Dialog Power! ( QuickTools, Advanced Software, 1092 E. 
Duane Ave, Suite 103, Sunnyvale, Ca 94086; 
800-346-5392) and the Freeware extension Escapade 
assign a letter to a dialog-box button as the 
Equivalent of a click. Dialog Power! also lets you cut, 
copy, and paste into any dialog box- very handy if 
you're transferring information. 

DISK FIRST AID 
A Hidden Command 
Disk First Aid contains a hidden command that offers 
more information about the program's operations. 
Press Command-S after opening a disk in Disk First 
Aid, and a scrolling field appears below the normal 
dialog box. This field displays a list of actions per­
formed by Disk First Aid as they are executed. 

DISKSWITCH (SYSTEM 7) 
Switching Drives 
Some software upgrades sacrifice familiar features for 
new concepts. Take, for example, the Drive button in 
the System 6 Save dialog box. The Drive button lets 
you choose where to save a file by conveniently 
switching among mounted hard drivers, floppy drives, 
and AppleShare serves. 

In System 7, however, Apple replaced that button with 
one that takes you straight to the desktop, where you 
can view all volumes and folders simultaneously. An 
improvement? Yes, but some users now must perform 
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two operations, instead of one, to switch drives. 
Mac User's DiskSwitch utility adds an icon to all Open 
or Save dialog boxes; click on the icon, and you get a 
pull-down menu that lets you quickly select any flop­
PY drive, hard drive, Apple Share server, or other 
mounted volume without going through the desktop. 

DiskSwitch was programmed by Mike Throckmorton, 
an Ann Arbor, Michigan-based developer. DiskSwitch 
is available exclusively through ZiffNet/Mac, 
MacUser's on-line service. Look for DSKSWT.CPT in 
Ubrary 3 (Utilities) of the MacUser Forum or Ubrary 3 
(INITs) of the Download & Support Forum. 

DOS MOUNTER 
Initializing A Disk Across A Network 
If, when trying to mount a shared volume across the 
network, your Mac asks if you want to initialize the 
disk, you're probably running an old version of Dayna 
Communications Inc.'s DOS Mounter. DOS Mounter is 
an extension that enables you to read data off DOS 
disks in your SuperDrive-equipped Mac. Early versions 
conflict with System 7.0's file sharing. Contact Dayna 
at (801) 972-2000 for an upgrade. 

ENDNOTE PLUS 
'fracking Ftgure And 'Jhble Numbers 
EndNote Plus is wonderful for keeping a list of refer­
ences for a document, but it would be even better if it 
could keep track of figure and table numbers for a 
report. 

You can add this ability by copying the EndNote Plus 
application onto your hard disk. For references, figures 
and tables, you'll need two extra copies. Name the new 
versions EndNote B and EndNote C. These copies of 
EndNote Plus need to use unique characters to mark 
the temporary citations in your document. EndNote 
Plus stores these characters in a preferences file in the 
System Folder, so you must use ResEdit to rename the 
preference files the copies use. 

Open EndNote B in ResEdit, and open STR# resource 
number 128. The eighth string in this resource is the 
name of the preferences file. Change it from EndNote 



Prefs to EndNote B Prefs, and save it. Make a similar 
change for EndNote C. 

Next, launch EndNote B and select Citation Markers 
from the Edit menu. Change the markers from [and] 
to {and}. Similarly change the citation markers in 
EndNote C to < and >. 

Now, when you're writing your document, create a ref­
erence-list file in EndNote Plus, a figure-list file in 
EndNote B, and a table-list file in EndNote C. When 
the time comes to fonnat your document, open your 
base document in one copy of EndNote and fonnat it, 
open the first fonnatted document in the next copy of 
EndNote and fonnat it, and open the second fonnatted 
document in the third copy of EndNote and fonnat it. 
You can then open the final fonnatted document in 
your word processor and move the figure list and table 
list to wherever you want them. 

This workaround sounds quite complicated, but it's 
really not that bad once you start using it. The 
EndNote Plus application exists quite happily in a 
512K memory partition, so your three copies occupy 
about 1.5 megabytes of memory. Obviously, you can't 
do this on a !-megabyte Mac Plus, but it works well on 
an 8-megabyte Mac Ilcx. Each additional copy of 
EndNote Plus occupies 321 K of hard-disk space plus 
5K for the preferences file. 

EXTENSIONS 
Managing Extension Conflicts 
The only problem with extensions is that it's some­
times impossible to get them all to work together. 
Some conflicts may result in system crashes unless 
you pull the extension out of the System Folder. The 
freeware utility Extension Manager provides a 
checklist of extensions you can toggle on or off at 
startup or through a control panel. If you want 
more features, look to commercial products such as 
INIT Manager (BaseLine Publishing, 1770 Moriah 
Woods Blvd., Suite 14, Memphis, TN 38117; 
800-926-9677), !NITPicker (Microseeds 
Publishing, Inc., 5801 Benjamin Center Drive, Suite 
103, Tampa, FL 33634; [813] 882-8635), or StartUp 
Manager (Now Utilities, Now Software, Inc., 520 S.W. 
Harrison, Suite 435, Portland, OR 97201; 
800-237-2800). With these utilities, you can define 

and load groups of extensions that work with one 
another or make extensions dependent on each other. 

EXTENSION 
MANAGER 1.6 
Managing Extension Manager 
Apple's Extension Manager 1.6 utility lets you take 
care of extensions and control panels, but you can 
also use it to manage other items that are loose in 
your System Folder, such as applications, startup 
sounds or screens. Here's how: 

Open the Extension Manager control panel, click on 
the button labeled 1.6, and then click on the button 
labeled Configure. This brings up a window that lets 
you add new file types to Extension Manager's 
scrolling list of what's in your System Folder. You can 
find out what a file's type extension is by using 
ResEdit or a utility such as DiskTop. 

Here are a couple of ways to use this feature: 

1. Add the file extension for applications (APPL) to the 
lower list in the Configure dialog box (just ignore the 
upper list). Applications you have in the System Folder, 
such as PrintMonitor, will now show up in the list on 
Extension Manager's initial screen, letting you tum 
them on or off. 

2. Control the contents of your Startup Items folder by 
storing aliases of the programs and files you want to 
open on startup, rather than the programs themselves. 
By adding adrp (the type extension for a file alias) 
and fdrp (the type extension for a folder alias) to 
Extension Manager's list on the initial screen, you can 
disable these aliases if you don't want a particular 
program to open on startup. 

FILES 
Create Ftle Work Sets 
If you want to open multiple documents simultane­
ously, get Out to Launch, a freeware Fkey that lets you 
define groups of documents of the same type to launch 
at one time and lets you define "work sets" of multiple 
applications and documents that can be launched 
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with one command. HAM (Hierarchical Apple Menus, 
Microseeds Publishing, INc., 5801 Benjamin Center 
Drive, Suite 103, Tampa, FL 33634; (813) 882-8635) 
has the ability to take snapshots of open documents 
and store them as a work set, which can be launched 
later. Tiles is the most feature-laden application in this 
group. It manages dozens of work sets easily. 

Preview Graphics Files 
The process of opening a graphic from within a paint­
ing, drawing, or page-layout program can be time­
consuming. Screen redraws and color files combine to 
make the process slow. Opening the wrong file is even 
more frustrating. PickTURE (Right Answers, Box 
3699, Torrance, CA 90510; (310) 325-1311) solves the 
problem by letting you preview thumbnail graphics 
from within the Open dialog box, which gives you an 
idea of what the image looks like. 

Launch Files With Substitute Applications 
One of the more annoying dialog boxes is 
"Application not found," which you get when you 
double-click on a file in the Finder for which you 
don't have the application. 

Jump Start, a shareware program (Insanely Great 
Software, 126 Calvert Avenue E., Edison, NJ 08820), 
launches documents with a substitute program. For 
instance, it automatically launches Mac Write docu­
ments with Microsoft Word, or vice versa. HAND-Off I I 
(Connectix Corp., 2655 Campus Drive, San Mateo, CA 
94403; 800-950-5880) is the commercial alterna­
tive, and it adds a host of features - not the least of 
which is the ability to launch DOS documents. 

Get A List Of Recently Opened Files 
You usually don't realize that a file has been lost until 
you have the Open File dialog box on-screen. Shortcut 
and Super Boomerang (Now Utilities, Now Software, 
Inc., 520 S. W. Harrison, Suite 435, Portland, OR 97201; 
800-237-2800) build lists of commonly used files 
and folders so that you can easily "jump" to a differ­
ent folder from within the Open and Save dialog 
boxes. Super Boomerang is the stronger utility, but it 
comes at a higher price, because it's grouped with 
other applications. 
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FILE COMPRESSION 
Automatically Compress Files 
Hard disks may be getting larger, but so are files. Here 
are two programs to help keep your disk from over­
flowing by compressing files when you're not using 
them. DiskDoubler (Salient Software, 124 University 
Ave, # 103, Palo Alto, CA 94301; [ 415] 852-9567) puts a 
Compress File menu onto the Finder so that you can 
highlight files and squash them down to half their 
size. SuperDisk (Alysis, 1231 31st Avenue, San 
Francisco, CA 94122); [415] 566-2263) automatically 
compresses files or folders saved with the suffix.s. 

Compressed Mac 1b PC And Back 
If you worked in a mixed environment, Macs and PCs, 
you will eventually run into compressed files: primar­
ily ZIP or ARC archives on the PC side, and SEA, SIT, or 
CPT archives in the Mac domain. 

Without compression, graphics files, especially TIFFs, 
can be mammoth in size and must frequently be com­
pressed to shorten modem transfers to within one per­
son's lifetime or to make the file fit onto one floppy. How 
does a Mac user deal with ZIP or ARC files? Or a PC user 
with SIT and CPT archives? R>rtunately, there are some 
commercial and shareware/freeware solutions. 

Macintosh users stymied by an ARC or ZIP archive can 
tum to a couple of shareware or freeware programs: 
ArcMac or UnZIP. Both are available from the major 
on-line services. Both are older programs and may not 
always work on some ZIP or ARC files. If you own 
Stufflt Delux, a commercial Mac compression utility, 
you'll find it has menu commands for deARC-ing or 
UnZIP-ing archives. The program isn't free, but it's 
very dependable when it comes to PC-compressed 
files. 

DOS users, confronted with a SIT or CPT archive from 
a Mac colleague, can use either UnSIT or ExtractorPC 
to delve into Mac Stufflt (SIT) or Compact Pro (CPT) 
archives. Some caveats need to be heeded, however. 
SIT or Stufflt files come in a couple of flavors, since 
Stufflt exists both as a commercial product (Stufflt 
Deluxe) and as a shareware utility (Stufflt L5.1 or 
Stufflt Classic). UnSIT will only process SIT files saved 
in the 1.5.1 format. If you find yourself with a Stufflt 
Deluxe or Classic file, you're stuck. Luckily, both 



Stufflt Deluxe and Classic can save in the 1.5.1 format. 

The other chief Mac compression archive a PC user 
will encounter is one created with Compact Pro 
(a.k.a. Compactor). The file extension is usually CPT. 
Compact Pro's author, Bill Goodman, has himself pro­
vided a solution- Extractor PC. It extracts not only 
CPT archives, but also SEA (Self-Extracting Archives) 
files created on the Mac with Compact Pro. Stufflt 
Deluxe also generates SEA archives, but ExtractorPC 
will not process them. 

Generally speaking, try to avoid compressing files to 
be transferred unless it's absolutely necessary. If you 
must use compression, make sure the recipient can 
handle your method. 

FILE CONVERSION 
'Ihlnsporting PC TIFF Ales To The Mac 
TIFF (Tag Image File Format) is one of the best and 
most troublesome formats for transferring PC-based 
raster or scanned graphics to the Mac. TIFF is widely 
supported in both the Mac and PC environments, but 
the format differs on the Mac and PC which leads to 
some curious problems. 

Simply bringing a PC TIFF file over to the Mac can be 
quite frustrating at first. If you try to open a TIFF cre­
ated on the PC in a Mac graphics program, you're like­
ly to receive an error message telling you the program 
encountered an unexpected end-of-file error. What 
you need to do is run the file through Macintosh con­
version software, like MacLinkPlus/ Translators, 
before graphics programs will even take so much as a 
sniff at your TIFE 

Adobe PhotoShop and Deneba Canvas (for the 
Macintosh) can translate foreign graphics through an 
impressive variety of file filters that enable you to 
open, import, and edit graphics carried over from a 
different platform. 

If you don't want to do any editing with another pro­
gram, you' 11 discover that Aldus PageMaker 4.1 
imports PC TIFFs without prior processing or conver­
sion. This feature can speed up the layout cycle, 
although the PC TIFFs often import at about 25 per­
cent of their original size, making resizing necessary. 

'Ihmsporting Mac TIFF Files To The PC 
On the PC, Do DOT (Windows-based and raster or 
bitmap images only) from Halcyon and Hijaak (DOS, 
raster, and vector formats supported) from Inset 
Systems, are two screen-capture utilities for PCs that 
do double duty as graphics converters. There is dedi­
cated file-conversion software for the PC, such as The 
Graphics Link Plus+ from Harvard Systems, but for 
most mainstream graphics formats, such as EPS 
(Encapsulated PostScript), PCX (Paintbrush), PICT 
(Mac format), and TIFF (Tag Image File Format), you 
may find dedicated products unnecessary. 

Bringing Mac TIFFs· over to the PC does present some 
problems. PC programs like DoDOT or CorelDRAW! 
refuse to recognize Mac TIFFs saved with LZW com­
pression. Uncompressed Mac TIFFs, however, open or 
import quite well without prior massaging in a con­
version program. PC users should make sure that 
their video card and driver is supported and set to 256 
colors when working with color TIFF files. Otherwise, 
the imported TIFFs will appear distorted and substan­
dard. Likewise, Mac users should set the monitor's 
control panel to 256 color or grays for best results 
when viewing or editing TIFFs. 

'lhlnsporting EPS Ales To Macs And PCs 
EPS (Encapsulated PostScript) is nearly omnipresent 
on the Mac (and making considerable inroads in the 
DOS/Windows world); serious Macintosh graphics, 
especially good clip art, nearly always come in the 
form of EPS files. Suppose you want to bring Mac EPS 
clip art over to the PC? 

The answer is fairly simple. When an EPS Mac file is 
opened in a program like CorelDRAW! on the PC, you 
can even perform edits (modify colors, line widths, 
etc.). Here's a tip that will spare you some grief: 
CorelDRAW! will usually connect with just about any 
Mac EPS file you care to throw at it, but it fails some­
what more frequently with EPS files exported from 
Aldus FreeHand. 

Adobe Illustrator EPS works a bit better. CorelDRAW! usu­
ally works well with Illustrator files saved on the Mac in 
1.1 or 3.2 format with or without the PC Preview option 
selected It imports files saved with the Mac preview with­
out a shudder. But CorelDRAW! can sometimes choke 
even on Illustrator EPS with the alert thatthe file is too 
complex. Th almost always work around this, go back to 
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the Mac and save the file in the Illustrator 1.1. format 
with tl1e PC Preview option turned on. 

If you plan to bring the Mac graphic into a non­
graphics program, like Word for Windows 2.0, you'll 
quickly discover that they strike out on straight Mac 
EPS files. You must either translate the files within 
CoreiDRAW!, or export them from Illustrator or 
FreeHand with the appropriate PC Preview 
(Illustrator) or MS-DOS option (FreeHand) selected. 

EPS Files Containing Fonts 
If an EPS file contains text elements and the file is 
being used on a Mac and PC, make sure that both the 
PC and the Mac platforms have the same PostScript 
fonts installed. If not, you may find text strings miss­
ing in the graphic. 

If, for some reason, the same fonts aren't available on 
both machines, it's fairly easy to work around the prob­
lem. On the Mac side, you can use Adobe Illustrator's 
Create Outlines command to convert selected text 
strings into objects. TI1e font issue then becomes moot. 
Aldus FreeHand offers a similar function. 

If an EPS file is traveling from the PC to the Mac, you 
can rely upon PC-based CorelDRAW!'s Convert to 
Curves command in the same way. TI1is trick only 
works if the amount of text is relatively small-some 
legends or titles, perhaps. And it generally works better 
if the point size of the text is over 12 points. 

Another ruse is to open the EPS file in a program that 
can export as TIFF. The letters become part of the 
raster image and cease to be text. PhotoShop, Canvas, 
and CorelDRAW! all enable you to do this. 

GIF Converter 
The GIF file format is a graphical format originating 
from Compuserve. CompuServe offers tens of thou­
sands of GIF (Graphic Interchange Format) images in 
various forums throughout the service. This raster or 
bitmap fonnat is more well-known in the PC environ­
ment, but Mac users are depriving themselves of a pre­
cious and ready resource of graphics clip art and scanned 
images if they don't know how to access and use it. 

Fortunately, there's an outstanding Mac $40 shareware 
product and called GIF Converter that can handle GIF 
files (and many other raster graphics formats as well). 
It's available on all major on-line services. 
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Converting PCX And BMP Ftles 
1\vo common PC bit map formats are PCX 
(Paintbrush) and BMP (Windows bitmap) can be 
converted over to the Mac. When bringing BMP or PCX 
graphics from the PC over to the Mac, you'll probably 
either need to convert them into a Macintosh format 
on the PC or use a conversion program like 
MacLinkPlus/ Translators (MacLinkPlus/PC Data 
Viz, 55 Corporate Drive, Trumbull, CT 06611; 
(203) 268-0030; $199) to get the job done on the 
Mac. Adobe's PhotoShop, the "universal graphics 
translator" for the Mac, can handle PCX files through 
its Acquire command. BMPs require reprocessing in a 
separate conversion utility like MacLinkPlus before 
they can be used in Mac programs. 

Converting MacPaint Files To The PC 
To take a graphic saved in MacPaint file fonnat to a 
PC, you can transfer it over and convert it on the PC 
using the PC-based Do DOT in Windows; The Graphics 
Link Plus+ and Hijaak likewise come to the rescue 
from the DOS command line. 

Do DOT's MacPaint to PCX filter doesn't always func­
tion well if you're planning to do any editing in 
Paintbrush -the image opens as solid black. If you 
experience difficulties in this way, save the MacPaint 
file in the BMP format instead and the PC-based 
Paintbrush will handle it without a burp. And if you 
simply want to place the PCX-ed MacPaint graphic 
into a word processor or page-layout program, the 
DoDOT MacPaint-PCX conversion works fine. 

Converting PC CGM Files To Macintosh PICT 
The PC world is awash in CGMs (Computer Graphics 
Metafiles). How does a Macintosh user bring them 
over to the Mac? 

Unfortunately the CGM standard is not very standard, 
with different CGM "dialects" being generated accord­
ing to the program that created them. Once you final­
ly bring a CGM file over to your Mac, there are several 
options. 

The Mac program MacUnkPius/ Translators (from 
Data Viz) easily handles CGMs exported from Harvard 
Graphics and Lotus Freelance, but handles other CGM 
files poorly. Deneba's Canvas 3.0 draw program pro­
vides a CGM import filter that's fairly speedy on the 
import, but slow on the save. It opens CGM files well, 
but saves them as huge PICT files that can be 10 to 15 



times bigger than the original CGM file. 

The best solution for many Mac users is a small $179 
program called MetaPICT from GSC Associates that 
makes good on its promises to convert almost any 
CGM file into a PICT file on the Macintosh. The pro­
gram's ugly DOS-like interface will be jarring to the 
Mac user, but it gets the job done, bringing even com­
plex, poorly parsed CGM files over to the Mac quite 
well. One caveat: It sometimes creates lines that are 
too thick {1-point where hairline would be better), but 
this can be easily corrected by opening the converted 
PICT in a Macintosh draw program, selecting all, and 
applying a hairline width. This added step greatly 
improves CGMs converted with MetaPICT. 

One thing you should keep in mind when doing CGM 
to PICT conversions is that you will not, for the most 
part, be able to do any extensive editing of the PICT 
conversion, regardless of whether you use Canvas, 
MacLinkPius/Translators, or MetaPICT. Complex edit­
ing issues should always be resolved on the PC side 
before a file is ported to the Mac. 

FIND (SYSTEM 7) 
Get A List Of Found Hies 
The System 7 Find command lacks one critical ele­
ment - a list of found files. Several programs (some 
old and some new) have stepped in to fill the void. Mr. 
File builds a list of found files from which you can 
launch, copy, and delete files. DiskTools and 
MasterFinder (File Director) are faster alternatives 
with more search criteria, such as by file size and 
modification date. 

Add Your Own Command-Key Shortcuts 
Have you ever wanted a Command-key shortcut for 
Empty Trash or another Finder menu item that doesn't 
have one? The shareware program Finder 7 Menus! 
allows you to choose a menu and define a key without 
having to resort to ResEdit (Apple's powerful but tricky 
resource editor). 

Instandy Access The Comment Held 
The Get Info box in the Finder lets you add comments 
to a file, but those comments are relatively useless 
unless you are in the habit of having dozens of Get 
Info boxes open. The freeware utility SFComment 

makes the comment field instantly accessible by dis­
playing file comments in the Open dialog box of any 
application. 

FINDER 7 MENUS! 
If You Don't Want To Use ResEdit 
If you don't want to dirty your hands with ResEDit, 
check out Adam Stein's shareware program Finder 7 
Menus! You can download a demo version from 
Mac User's on-line service, ZiftNetMac, and other on­
line services and user groups, or you can send $11 to 
Stein at 126 Calvert Avenue E., F.dison, NJ 08820. 
Finder 7 Menus! lets you change Command-key com­
binations or add them to the menus of the System 7 
Finder without ResEdit. 

It's an easy-to-use little application- just double­
click on it, and open a copy of the Finder. The File, 
Edit, and Special menus appears. Enter a key, press 
OK, and quit. Now move the modified copy of the 
Finder into the System Folder, and reboot. That's all 
there is to it. 

FKEYS 
Install Your Own Fkeys 
Lots of great Fkeys are available for the Mac. The prob­
lem is that there's no easy way to install them, barring 
the use of ResEdit. The shareware extension Easy KEYS 
(Kerry Clendinning, PO Box 26061, Austin, TX 78755) 
comes to the rescue. It lets you assign Fkey documents 
(such as Balloon Printer or Out to Launch) to a key 
combination. The commercial equivalent is Suitcase 
(Fifth Generation Systems 10049 N. Reiger Road, Baton 
Rouge, LA 70809; 800-873-4384), which adds the 
ability to let you easily install sounds and fonts. 

FONTS 
Display Fonts In Menus 
Unless you know your fonts well, you may be left won­
dering what a particular typeface on your menu looks 
like. 1\vo products display menus in a font's native 
typeface. MenuRmts (Dubi-Ciick software, Inc., 
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9316 Deering Ave, Chatsworth, CA 91311; [818] 
700-9525) and WYSIWYG Menus (Now Utilities, Now 
Software, Inc., 520 S.W Harrison, Suite 435, Portland, 
OR 97201; 800-237-2800) let you group families 
and otherwise organize your Font menus across 
multiple applications. 

Keep Fonts In Suitcases 
Installing fonts in System 7 is as easy as dropping them 
into the System Folder. If your system goes south, 
though, so do the fonts. Also, a system with lots of fonts 
can get really slow. That's why the venerable font and DA 
loaders Suitcase (Fifth Generation Systems, 10049 N. 
Reiger Road, Baton Rouge, LA 70809; 800-873-4384) 
and Masterjuggler (ALSoft, P.O. Box 927, Spring, TX 
77383; [713] 353-4090) are still necessary tools for 
anyone who deals with lots of fonts. Both programs also 
include ways to avoid font-ID conflicts when you're 
switching documents among computers. 

GENERAL 
Claris Products 
Here's a time-saving tip for most Claris products: 

Hold down the Command key while launching the 
software, and instead of a new, empty document, you 
will get an Open dialog box that allows you to select 
an existing document. 

HARD DISK 
Change Your Hard-Disk Icon 
Tired of your boxy hard-disk icon? The shareware pro­
gram Visage (Scott Searle, 9025 6Ist Place W, 
Mukilteo, \VA 98275) lets you easily select a new hard­
disk icon from 24 images, including cartoon charac­
ters and groovy-looking hardware. 

Analyze Your Hard Disk 
You can take a look under the hood of your hard 
drive with F\VB's Hard Disk ToolKit (F\VB Inc., 2040 
Polk Street, Suite 215, San Francisco, CA 94109; 
[ 415] 474-8055). This disk-formatting and utility 
package includes an application that automatically 
analyzes your disk (no matter how mysterious the 
drive's origins) and installs an optimized System 7-
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savVy driver. The package's diagnostic utilities to 
ensure that you can find out everything there is to 
know about any storage devices you may have con­
nected to your Mac. 

Recovering Hard Disk Space 
A worthwhile option when disk space gets tight is to 
get your hands on a file-compression utility such as 
Stufflt Classic (shareware), Compact Pro (shareware), 
Stufflt Deluxe (from Aladdin Systems), or DiskDoubler 
(from Salient Software). Each of these programs can 
compress a file by as much as 90 percent, depending 
on the type of file. 

The Stufflt products and Compact Pro are totally 
manual- you choose files and then compress them. 
You must also decompress files manually before you 
use them. 

DiskDoubler, on the other hand, is semiautomatic. 
Once a file has been compressed with DiskDoubler, the 
file automatically decompresses and launches the 
appropriate application when you double-click on the 
file and recompresses itself when you close or quit the 
application. 

The latest generation of file-compression utilities­
AutoDoubler (Salient), Stufflt SpaceSaver (Aladdin), 
and More Disk Space (Alysis Software) -works in a way 
that is entirely transparent to the user. Merely install 
them and set a couple of parameters, and your files will 
be compressed and decompressed automatically as you 
use them. Not only that, but the programs can crunch 
files in the background when the computer is idle. 

IN TOUCH 1.1.5 
Removing The Publisher Name From The 
Ftrst Record 
In Touch 1.1.5 is a great program, but it has one annoy­
ing feature- the first record of the file is present 
with the name and address of the publisher, Advanced 
Software, and this information normally can't be 
modified or deleted. The following tip lets you change 
it to whatever you want: 

1. Open a copy of the In Touch DA suitcase with 
ResEdit. 

2. Open STR#-15999. 



3. Scroll down to string 17 and 18; these are the left 
and right sides of the first record, respectively. Change 
them to whatever you like. 

4. Quit ResEdit, saving your changes to the In Touch 
DAsuitcase. Install the modified InThuch DAsuitcase. 

5. InTouch creates the permanent first record when it 
creates a new InTouch file. Create a new InTouch file, 
and you'll have your personalized permanent record 
as the first record. You can then export your existing 
entries (if any) from your old InThuch files and 
import them to new ones. 

I NITS 
INIT Conflict Resolution Made Hasy 
There is a better way to resolve conflicts than by 
removing INI1's (extensions under System 7) one 
at a time. 

1\vo products attempt to make the process of finding 
software conflicts easier. The first is Baseline 
Publishing Inc.'s $69.95 INITinfo Pro, a collection of 
information on system configurations and conflicts 
written by Glenn Brown and Gary Ouellet. It was origi­
nally a shareware product built from reports of soft­
ware conflicts gathered on various online services. 

INITinfo Pro includes a 245-page book and a 
HyperCard stack, which duplicates most of the infor­
mation in the book. The stack allows you to look at 
System 6 information, System 7 information or both. 

While INITinfo Pro's HyperCard stack can produce a 
printed report of all the extensions and applications 
in your Mac system, you have to look up each one 
manually to check for conflicts. Help! from Thknosys 
Inc. ofThmpa, Fla., has taken the next step. Its $149-
product scans your system and attempts to spot poten­
tial software conflicts for you. Help! also will alert you 
to duplicate, out-of-date and damaged applications 
and files. The result of a Help! session is a detailed 
report, which may be read on screen or printed. 

In cases where out-of-date or incompatible software is 
detected, the Help! report provides information on 
contacting the company for an upgrade. 

JUST CLICK 
just Click Under System 7 To Switch 
Between Applications 
If you want to have the old MultiFinder-style applica­
tion switching (clicking in the upper right comer of 
the screen) to System 7, then Just Click ( a freeware 
utility) is a system extension for you. If you're tired of 
pulling down System Ts Application menu and long 
for the good old days, Just Click will bring them back. 
You can find Just Click on ZiffNeVMac and from local 
user groups. 

KEY CAPS 
Access Special Characters 
Can't remember what key combination creates a 
trademark or other obscure symbol? You've probably 
used Apple's Key Caps DA An easier and quicker route, 
however, is to use PopChar, a freeware Key Caps substi­
tute. PopChar displays the character set for the current 
font and then lets you select a character and paste it 
into your document without any complex Shift­
Option keystrokes. 

KEYBOARD 
Delete Flies From The Keyboard 
Basura (Fred's Finder Hacks) lets you highlight a file 
in the Finder and use Command-Delete to put it into 
the Trash. Command-Option-Delete puts the item 
into the can and empties it. 

List Command-Key Shortcuts 
Perhaps your problem is that you have too many 
Command-Key shortcuts and you can't remember 
which does what. When you invoke a hot key, the free­
ware program MenuKey displays a list of all available 
Command-key shortcuts for the application you're 
currently running. 
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KIWIENVELOPES! 3 
Bar Coding With Dot Matrix Printers 
KiwiEnvelopes! 3, an envelope-addressing DA, doesn't 
currently support bar coding on non-laser printers. 
The feature is disabled. 

If you own SuperGlue, though, you can print the bar 
coding on your dot-matrix printer. Open the DA, and 
select Super Glue's SuperlmageSaver II instead of 
your dot-matrix printer. Print your envelope from 
Kiwi Envelopes 3, and save the file in SuperGlue for­
mat. Reselect the printer from the Chooser DA. Open 
the SuperGlue file and print. 

Kiwi Software has stated that tests administered in 
close cooperation with the US. Postal Service indicate 
that dot-matrix printers cannot position a print job 
precisely enough to produce valid bar codes. Kiwi dis­
abled the bar-code feature for dot-matrix printers 
deliberately, and this is documented in their manual. 
A bad bar code may move your mail more slowly 
through the postal system than no bar code at all. 

LAYOUT 
Doesn't Work With System 7 
Mike O'Connor's freeware application, Layout, lets 
people control how Finder 6 handles the desktop, 
including how icons are staggered, how many win­
dows can be open at once, how text is displayed and 
much more. 

In Finder 7, Layout no longer works because the new 
Finder lacks the LAYO resource O'Connor's software 
modified. System 7 offers a Views control panel 
instead, with a few of the same functions, but far less 
flexibility. 

LIFEGUARD 
Eye and Body Saver 
You may have seen many screen savers, but have you 
heard of an eye and body saver? The National 
Academy of Sciences reports that more than half of all 
video-display and microcomputer users polled com-
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plained of eyestrain, headaches, and muscle pain, and 
Business Week reports that RSI (repetitive-strain 
injury) is the fastest-growing occupational disease of 
the 1990s. 

The best way to protect yourself is to take a break every 
so often and do something else. You can do this with a 
software product called LifeGuard. 

LifeGuard is an INIT and DA from Visionary Software 
that interrupts your work at customizable intervals­
with an audible or visual notification - and reminds 
you to do something else. It also keeps track of the 
number of keystrokes you've made in the past hour 
(according to the manual, experts recommend you 
keep your keystrokes to fewer than 12,000 per hour). 
The DA includes illustrated exercises for the eyes, 
neck, shoulders, back, arms, wrists, hands, and legs, 
plus ergonomic reference diagrams to help you create 
a workstation that won't cause you pain. 

MACROS (SYSTEM 7) 
User Scripting 
Apple used to ship a low-end macro program called 
Macro Maker with its OS, but it dropped it with the 
release of System 7. Macros define a set of actions 
(such as opening and printing a file) and activate 
them when you issue one command. Apple had favored 
a higher order of user macros called Apple Scripting; 
however, this too fell out of the final release of System 
7. Several third-party tools let you have low-, medium­
' or high-end macro and scripting capability. 

Macro Maker was picked up by GO Thchnology 
(PO Box 7667, Incline Village, NV 89450; 
800-468-5391), which markets a System 7-
compatible version. Thmpo II (Affinity Microsystem 
Ltd., 1050 Walnut Street, #425, Boulder, CO 80302; 
800-367-6771) is a higherend program that has 
conditional branching for its macros. 

QuicKeys is another scripting and macro creation 
programs. You can perform any task that has a 
macro assigned to it, including complex tasks such 
as program linking and batch processing of files. 
QuicKeys is from CE Software Inc., 1801 Industrial 
Circle, West Des Moines, Iowa, 50265; 
[ 515] 224-1995. 



One program has taken macros to the next -level 
scripting is Frontier (User Land Software, 490 
California Ave, Suite 202, Palo Alto, CA 94306; 
[ 415] 325-5700). Frontier is a high-end develop­
ment environment that provides sophisticated users 
with the tools to really tie applications together. 
With Frontier, you can write a script that searches a 
database for information, extracts that information, 
places it in a page-layout program, formats it, and 
then uploads the layout to a service bureau for 
printing- all without any user interaction. 

MAIL·ORDER 
Buying Software Overnight 
Buying from a mail-order company is the easiest way to 
shop for Mac hardware and software or a Mac itself, for 
that matter. just find the ad in the c ... , .puter magazine, 
get out your credit card, dial the number, and place 
your order. Most mail-order companies promise big 
savings, fast delivery, and, in some cases, money-back 
guarantees. For more on your consumer rights (and 
responsibilities) when buying from a mail-order com­
pany or dealer, see MacUser's "Buying Smart," january 
'91, page 174. 

Here are some tips on how to be a successful mail­
order consumer: 

Know exactly what you want before you call. It's hard 
to browse over the phone, and in many cases, the per­
son on the other end is trained to take your order only, 
not to help you make a decision. If possible, get some 
hands-on experience before you dial go to a dealer to 
comparison-shop, or borrow a friend or colleague's 
copy of the software package you're interested in. Your 
local user group may also be able to give you advice. 
Find out if the product you're interested in is compati­
ble with your system. You should be able to get help 
from an Apple dealer, or you can call Apple customer 
service at 800-776-2333 or (408) 996-1010. 

Use a credit card. Some credit-card companies will do 
such things as double your warranty or give you a 
refund if you find a lower price elsewhere. Even if your 
credit-card company won't go that far, it's worth using 
plastic to pay for your purchases. If the product is never 
delivered or is defective, you can contest the charge with 
your credit-card company and the credit-card company 

will deal with the mail-order company. 

Confirm the price when you place your order. 
Sometimes the printed price isn't current or there are 
hidden charges. If the price is higher than you thought 
it would be, ifs worth trying to see if the company will 
accept the lower price. You should also find out how 
much the delivery charge is. Some companies will 
waive the delivery charge if you order at a certain time 
of day (after 8 p.m., for example). The savings depend 
on what and how much you buy, but you may be able to 
shave at least $5 off the final cost. Ask about delivery 
methods, find out what carriers are used, how fast they 
are, and how much each one costs. 

Make sure the company has a return policy you're com­
fortable with. In most cases, a money-back guarantee 
or a trade-in policy is a must. Find out if you're respon­
sible for paying shipping charges on returned goods 
and whether you'll be charged a "restocking" fee. 

Before you use your new merchandise, make sure it's 
exactly what you ordered the correct model or version 
number, for example. Errors are not uncommon, and 
it's easier to return goods before they've been 
unpacked. 

If you're buying hardware, find out how the company 
handles repairs or replacements. Ask how quickly you 
can expect to get your equipment back if you have to 
send it in for service and whether the company offers 
loaner equipment. 

Thchnical support varies from company to company. 
W'hen buying memory, for example, you may find that 
some companies offer step-by-step installation and 
troubleshooting advice over the phone; others send 
written instructions only. Unless you happen to be a 
techno-expert, it's best to work with a company that 
offers free technical support. 

NODE CHECK 
No Ethernet Checking 
Node Check, Apple's simple address-checking utility 
for LocalTalk that used to be called NetCheck, won't 
give you any useful information about AppleTalk net­
works running on Ethernet. 
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NORTON UTILITIES 
Using The Fast Find DA 
\'V'hen you're using The Norton Utilities for the Mac's 
Fast Find DA, Command-T gives you access to a dialog 
box that allows you to search by type or creator - a 
useful feature for power users that's not mentioned in 
the manual. 

Fast Find Faster 
Although Norton Utilities' Fast Find command is 
extremely speedy, you can make it work even faster if 
you hold down the space bar while it's searching­
this stops the animated sprinting-man icon. 

NOTE PAD 
Better Note Pad DA? 
There's an excellent shareware notepad DA called 
Flash Write II (Andrew Welch, 29 Grey Rocks Road, 
Wilton, CT 06897; $15). It lets you create as many 
pages as you want, and each page can contain as 
many as 32,000 characters. Thxt can be shown in any 
font, size, or style. Flash Write II can import and export 
text files, find text on any page, and count words. 

ON LOCATION 
Calling On Source-Code Collections 
Using On Location is a dandy way to keep track of what's 
on your hard disk, and it's even dandier for program­
mers. For example, if you have megabytes of sample 
source code scattered throughout thousands of files, you 
can use On Location to fully index these files. 

When you need an example of how to use any func­
tion, just call up On Location and search for all the 
references to the function from the source-code collec­
tion. This also lets you view the text in each sample 
source-code file and cut and paste the sample into 
your O\'n program. It's fast and a great way to make 
your programming more efficient. 
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PARTITIONING 
SOFTWARE 
Organizing Your Hard Disk 
Partitioning software divides your disk into multiple 
volumes, each of which is its own "virtual" disk. You 
can use partitions to help organize your files. They're 
a great aid with most backup programs, which work 
volume by volume. If you create a small partition for 
your recent documents, you can back up that volume 
daily and the backups will go quickly. Keep older doc­
uments in a separate partition. For security, partitions 
can be password-protected, and if you share your hard 
disk, partitions can give all users their own private 
work areas. 

You can keep older versions of software in a separate 
partition for when it's necessary to use an old version 
of a program. You don't want both the old and new 
version on the same volume, because when you dou­
ble-click on a document, you don't know which ver­
sion of the application will open. 

The Finder also slows down when a disk has too many 
files and the System Desktop file gets too big- so 
partitioning your disk limits each volume to a size the 
Finder can manage. 

POSTSCRIPT PRINTER 
Finding PostScript Problems 
Many Mac users have yet to come to grips with the fact 
that their PostScript printers, far from being simple 
output devices, are separate computers of labyrinthine 
complexity. and that the printers' internal page 
description language is understood completely by only 
three people, all of whom work at Adobe Systems Inc. 

A company called Chesire Group has quietly been sell­
ing a killer utility called PinPoint Error Reporter. 
This little $89.50 gem is a program that loads into 
your PostScript printer, intercepts error conditions and 
produces a very detailed error report. PostScript hack­
ers will love it, but even those of us who don't know 
PostScript will find it useful since it isolates the loca­
tion on the page where the error occurred, letting you 



change your work to eliminate the error. 

Cheshire Group is at 321 S. Main St., Suite 36, 
Sebastopol, CA. 95472. Phone (707) 887-7510; fax 
(707) 887-2595. 

POWERBOOK 
CursorFtxer 
Dennis Brothers has written a handy extension that 
solves a problem for PowerBook users: the disappear­
ing I-beam cursor. His Cursor Fixer extension replaces 
the near-invisible-on-LeD-screens I-beam with a fat­
ter one that is easier to see. It also swaps a thicker 
cross-hair cursor for the one-pixel-wide one used in 
many graphics programs. Brothers has uploaded the 
free program to several on-line services. 

PowerSieep 
Although you can put the PowerBook to sleep from 
either the Battery DA or the Special menu, a better 
method is to use the freeware Fkey program 
PowerSleep (available from ZiffNeVMac and other on­
line services). PowerSleep lets you use a keyboard 
command equivalent to put the system to sleep, and 
unlike other methods of invoking Sleep, it won't wake 
up a sleeping hard disk, which can be a significant 
power drain. 

PRINTER (SYSTEM 7) 
View Printer Queues 
System 7 prints more slowly than does System 6. 
Maybe that's why Blue Parrot (CasaBlanca Works, 
Inc., 148 Bon Air Center, Greenbrae, CA 94904; 
[ 415] 461-2227) is such an attractive application. It 
lets you view who's printing what and in what order on 
a shared printer. With multiple printers on a network, 
you can choose the one that's less busy. 

QUICKEN 
Customizable Command Keys 
Hold down the Command key when you choose a 
menu item that lacks a keyboard command equiva-

lent. This action brings up a dialog box that lets you 
assign Command-key shortcuts. You can also use this 
technique to delete or change existing keyboard 
shortcuts. 

Keyboard Navigation In Lists 
When the Account, Category, Class, Memorized 
Transaction, or Transaction Group list is the active 
window, simply type the first letter or first few letters to 
select the desired item in that list. 

Adjust Date/Check Number. You can use the + key or 
the - key to increase or decrease the date and/or check 
number by 1. 

QUICKEYS 2 
Updating Application-Specific Macros 
QuicKeys 2lets you create program-specific macros 
that are stored according to the name of the individu­
al application. After you upgrade a program to a 
newer version, you may discover that all your 
QuicKeys macros for that program have disappeared. 
You can retrieve them by opening the QuicKeys 
resource and changing the program names and/or 
version numbers to the new ones. Here's how: 

Open the Preferences folder in your System Folder. 
Inside the QuicKeys folder is a QuicKeys Preferences 
folder, which contains a KeySets folder where all your 
macro sets are arranged by program name. Simply 
change the version number on the filename, and 
you're set. 

Using QuicKeys 1b Print 
If you program QuicKeys to scan the menus looking for 
"Print..." and find that it doesn't work in some applica­
tions, remember that some applications do the ellipsis 
after Print with three periods and some do it with 
Option-semicolon. They may appear the same on the 
screen, but to QuicKeys they're quite different. Solution: 
Define an application-specific QuicKeys file for each of 
these applications. 

Recovering After A Program Upgrade 
QuicKeys 2lets you create program-specific macros 
that are stored according to the name of the individ­
ual application. After you upgrade a program to a 
newer version, you may discover that all your 
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QuicKeys macros for that program have disappeared. 
You can retrieve them by opening the QuicKeys 
resource and changing the program names and/or 
version number to the new ones. Here's how: 

Open the Preferences folder in your System fulder. Inside 
the QuicKeys folder is a QuicKeys Preferences folder, 
which contains a KeySets folder where all your macro 
sets are arranged by program name. Simply change the 
version number on the filename, and you're set. 

QUICKEYS 2.1 
Timing QuicKeys To Empty The 'Jioash 
Since the Trash under System 7 doesn't automatical­
ly empty at shutdown or restart as it did under 
System 6, several freeware and shareware utilities 
have arrived to automate the process. QuicKeys 2 
can do this just as easily, however. Just create a 
Menu/DA macro that selects Empty Trash from the 
Special menu in the Finder, and click on the Timer 
Options button to set macro to be activated 0 seconds 
after your Macintosh starts. 

If you have any applications in your Startup Items· 
folder, you'll instead want to make a sequence in 
QuicKeys 2: First, set up a Menu/DA macro (look on 
the Define menu in the Sequences dialog box) that 
chooses the Finder from the Application menu in the 
upper right corner of the screen. Second, use the 
Menu/DA selection, on the Define menu, to choose 
Empty Trash from the Special menu. QuicKeys waits 
until everything in the Startup Items folder has been 
launched before it starts to execute any macros. [This 
QuicKeys macro is available in Library 5 (Scripts & 
Thmplates) of the ZiffNet/.Mac Download & Support 
Forum; the filename is QTRASH.CPT.] 

QUICKliME 
Add a Video Beep 
Video Beep, QuickTime freeware, replaces the standard 
system beep with a video of your choice. 
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READ MACWRITE 
Reading Mac Write Files Without The 
Application 
Many software developers continue to use MacWrite for­
mat as their standard for on-disk program documenta­
tion. This can be inconvenient if you don't have 
MacWrite. You have to open up Microsoft Word or some 
other word processor and import the file, even if all you 
want to do is take a peek at the documentation. 

You can modify Word's Creator to MSWD using 
ResEdit. However, if you're not comfortable with 
ResEdit or if text files are what you're after, there's a 
nice shareware utility, Read MacWrite, that opens 
MacWrite files and scrolls through them on the screen 
while saving the contents as a plain text file. Now if 
you need to take a look at some documentation on 
the fly, you can just open the file with a DA such as 
miniWRITER (which is also shareware). 

You can pause the scrolling, but Read MacWrite lacks a 
text buffer and elevator boxes for scrolling back over 
what you've read. Once the text has scrolled by, it's gone 
until you reopen the file and start at the beginning. 

Read MacWrite's quick production of text files from 
MacWrite-formatted documents would also come in 
handy if you had several Mac Write files that you need­
ed to get into plain-text format in a hurry. 

Read Mac Write is available in the Download Library 
Forum on ZiftNet/Mac. 

RES EDIT 
What Is ResEdit? 
ResEdit is Apple's resource-editing software. All Mac 
software contains resources, which create things such 
as menus, cursors, icons, dialog boxes, and so on. 
When you're adept with ResEdit, you can edit menu 
items, colors, desktop patterns, and keyboard com­
mand equivalents; alter wording in dialog boxes; cre­
ate and modify icons; and so on. 

You can get ResEdit directly from APDA (the Apple 
Programmers and Developers Association) for $49.95. 
Contact APDA at 800-282-2732 or 



( 408) 562-3910. And if you have a modem, you can 
download the latest version from CompuServe, 
America Online, or GEnie. Try your user group, too. 

If you don't have a modem or a user group, SMUG 
(Berkeley Macintosh User's Group) offers a $15 
package that includes ResEdit and SMUG's excellent 
book Zen and the Art of Resource Editing as well as 
several utilities and a beautiful collection of icons 
and jumbo desktop patterns. Contact SMUG at 
1442A Walnut Street, Suite 62, Berkeley, CA 94704; 
(510) 549-2684. 

A more sophisticated and full-featured resource 
editor is Resorcerer, available from 
Mathemaesthetics Inc. at P.O. Box 67156, Chestnut 
Hill, MA, 02167; (617) 738-8803. Developers will 
appreciate features such as scripting repetitive 
tasks, System 7 feature support, templates, editing 
of Apple-Events scripting resources and much 
more. 

NDS Across Your Startup Screen 
If you dislike those INIT startup icons goosestepping 
across your startup screen and the programmers didn't 
see fit to give you the option of disabling the icons, 
there is a simple solution: You can change the icon ID 
number, using an icon editor such as Icon Designer or 
a resource editor such as ResEdit, thereby eliminating 
the startup icon without affecting the IN IT itself. 

Use a consistent pattern when you change the num­
bers so that you can restore them later if you need to. 
For example, change ID number 128 to 12800 or 
change ID number -4023 to +4023. 

The patterns you use don't matter- just be consistent. 
After you've changed the ID numbers, your startup 
screen will be untrodden. 

Changing The Shutdown Screen 
If you want to change the Shut Down screen that says 
"You may now switch off your Macintosh safely," use a 
copy of ResEdit and follow the steps below: 

1. Make a copy of the System file, using the File 
menu's Duplicate command. 

2. Launch ResEdit, open the duplicate copy of the 
System file, and locate the DSAT resource. 

3. Double-click on this resource, and then double­
click on the ID 2 file. 

4. Scroll down until you see the "You may now ... " 
message in the narrow right column. 

5. Starting with the letter Y, highlight the message 
through the last character, a period. 

6. Carefully type in your message, using exactly 45 
characters, including spaces. Save your changes. 

7. Quit ResEdit, shut the Mac down, and restart from a 
floppy disk. 

8. Save a copy of your original System file on a floppy 
disk. Replace the hard disk's System file with the dupli­
cate copy, and change the copy's name to System. 

9. Restart your Mac from the hard drive, and choose 
Shut Down from the Special menu. 

10. Your message should appear the way you typed it. 
If you did something wrong, the Shut Down screen 
will flash, but that shouldn't cause any major prob­
lems. Simply trace these steps, and make sure that you 
typed exactly 45 characters. 

Deleting Sound Resources 1b Save Space 
Digitized-sound resources are fun but are also often 
very large and expendable. If you're running short of 
disk space or if you're looking for ways to reduce 
telecommunications time, you might want to use 
ResEdit to locate the snd resources on a copy of the 
application or stack. Delete the resource, save the 
program, and make sure the program still works. 
The About box or startup screen might be less enter­
taining, but the program will be a lot leaner. 

Reassigning The Shift-Period Key Combo 
If you've ever tried to type P.O. Box quickly on a typical 
Mac keyboard, you've probably wished that the Mac key­
board functioned more like a traditional typewriter, with 
Shift-period producing a period (instead of>) and 
Shift-comma producing a comma (instead of<). Here's 
a way to reassign these keys, using ResEdit 21 or later: 

1. Make a copy of the System file in the System Folder 
by, using the Duplicate command (Command-D) on 
the File menu. Remove the copy to a nonboot disk or 
partition (having two System files on your boot disk 
can cause problems). 

2. Open the copy with Res Edit, and open the KCHR 
resource, which controls the mapping of ASCII char­
acters to keyboard keys. 
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3. The keyboard display in the bottom third of the 
window changes as you press the modifier keys, in the 
same way as it does with the Key Caps DA. Hold down 
the Shift key to display the shifted keyboard map. 

4. Using the mouse, drag the desired character (in 
this case, the period) from the palette in the top two­
thirds of the window onto the key you want to repre­
sent it. Do the same with the comma. (Because this 
operation replaces the > and < symbols with the peri­
od and comma, you might want to assign the < and 
> symbols to the Option-Shift positions on their 
respective keys so they're still accessible.) 

5. Close the KCHR resource, and save the changes to 
the System file. Restart the Mac from a floppy disk, 
store the old System file in some place other than the 
boot disk, and place the edited version of the System 
file in the System Folder. Restart the Mac. This will 
eject the floppy disk, and your Mac will reboot with 
the new System file in place. 

This change affects the keyboard mapping, not the 
font information, so it should be font-independent. 

Customizing The Shutdown Message 
If you want to change the message in the Shut Down 
screen (the one that says, "You may now switch off 
your Macintosh safely.") - Here's how to do it, using 
ResEdit on a copy of your System file: 

1. Make a copy of the System file, using the File 
menu's Duplicate command. 

2. Launch ResEdit, open the duplicate copy of the 
System file, and locate the DSAT resource. 

3. Double-click on this resource, and then double-click 
on the ID 2 file. 4. Scroll down until you see the "You 
may now ... " message in the narrow right column. 

5. Starting with the letter Y, highlight the message 
through the last character, a period. 

6. Carefully type in your message, using exactly 45 
characters, including spaces. Save your changes. 

7. Quit ResEdit, shut the Mac down, and restart from a 
floppy disk. 

8. Save a copy of your original System file on a floppy 
disk. Replace the hard disk's System file with the 
duplicate copy, and change the copy's name to System. 
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9. Restart your Mac from the hard drive, and choose 
Shut Down from the Special menu. 

10. Your message should appear the way you typed it. 
If you did something wrong, the Shut Down screen 
will flash, but that shouldn't cause any major prob­
lems. Simply re-trace these steps, and make sure that 
you typed exactly 45 characters. 

Increasing The Desktop Pattern Pixel Grid 
Under normal circumstances, the desktop pattern 
contains a series of 8 x 8-pixel grids, which you can 
edit in the General Controls control panel (usually 
located on the Apple menu). You can use Res Edit to 
increase each grid's size to as much as 64 x 64 pix­
els, which allows you to create much more detailed 
desktop patterns (for example, you might re-create 
your company's logo as your desktop pattern). You 
can also paste in a picture (as large as 64 x 64 pix­
els) from the Clipboard and use that as your desktop 
pattern. Here's how: 

1. Launch ResEdit, and open a copy of the System file. 

2 Double-click on the ppat resource, and then double­
click on the resource with the ID number 16. This 
opens the pattern editor 

3. Choose Pattern Size from the ppat menu. Choose a 
new pattern size in the dialog box, and then click on 
the Resize button. 

4. Create a new pattern in the pattern editor, or paste in 
a picture from the Clipboard (If you paste in a picture 
that's bigger than the size you set, you'll see only one 
comer of it. To get around this, choose Command-A 
[Select All] from the Edit menu- ResEdit will resize 
the pasted picture to fit the area you've selected.) To see 
how your new desktop looks, choose Try Pattern from 
the ppat menu. 

5. When you're satisfied, choose Save from the File menu 
and quit ResEdit. Move the edited copy of the System file 
into your System R>lder (you may have to boot from a 
floppy to do this), and restart your Mac. 

Opening A Generic Document With A 
Specific Application 
When you double-click on a generic text or PICT docu­
ment in the Finder, you get a message that tells you 
that the document couldn't be opened because its 
application couldn't be found and then asks if you want 



to open the document in Teach Text. Most of the time, 
youtl rather open it with your word processing, paint­
ing, or retouching program, wouldn't you? If so, all you 
have to do is change the associated creator code in the 
Finder's fmap resource. Here's how to do it: 

1. Launch ResEdit, and open a copy of the Finder file. 

2. Double-click on the fmap resource, and then dou­
ble-click on resource ID 17010. 

3. Notice that the first line displayed on the far right 
side is TEXTttxt. Since ttxt is the creator code for 
Thach '!ext, all you have to do is drag-select those four 
characters and replace them by typing in the four­
character creator code of your favorite word-process­
ing program. For example, Word is MSWD, Nisus is 
NISI, and Mac\Vrite II is MWII. (To find an applica­
tion's creator code, use ResEdit to open a document 
created by that application and choose Get Info.) 

4. While you're messing around, change the ttxt after 
PICT in the second line to match the code of your 
favorite graphics application that can read PICT files. 
For example, MacDraw Pro is dPro, Canvas 3.0 is 
DAD2, and Photoshop is 8BIM. 

Note: Type the creator codes exactly as shown -using 
uppercase or lowercase letters actually matters here. 

5. Save the file, and quit ResEdit. Move the edited 
copy of the Finder file into your System Folder (you 
may have to boot from a floppy to do this), and restart. 

The Finder even knows to substitute the name of your 
application for Thach Thxt in the dialog box. Now it'll 
read, "The document X couldn't be opened, because 
the application program that created it couldn't be 
found. Do you want to open it using Microsoft Word?" 
(or whatever program you've chosen). 

Adding A Command-Key For Save As 
Command-key shortcut for Save As to a copy of Thach 
Thxt (you can extend this technique to many other 
applications). 

1. Launch ResEdit, and open a copy of Thach Text. 

2. Double-click on the MENU resource, and double­
click on the picture of the File menu (it should have a 
small figure 2 beneath it). This opens the menu editor. 

3. Click on Save As in the picture of the menu at the 
right of the menu editor, and then click in the text-

entry box next to Cmd-Key and type the Command­
key shortcut you want to assign to Save As. Be careful 
not to choose a key that is in use elsewhere in the pro­
gram. After examining all the menus and determin­
ing that it wasn't used elsewhere, I chose the letter E. 

4. When you're satisfied, quit from Res Edit, saving the 
file when prompted. 

That's all there is to it. The next time you use Thach 
Thxt, Command-E (or whatever you've chosen) will 
invoke the Save As command. By the way, you may 
have noticed that this resource lets you add color to the 
text and Command-key shortcuts as well as add icons. 

Editing The Finder's Menus 
Here's how to edit the Finder's File menus: 

1. Launch ResEdit, and open a copy of the Finder file. 

2. Double-click on the fmnu resource, and then dou­
ble-click on ID 1252. This brings up a window filled 
with arcane text and numbers. 

3. In the far right column of text, you'll notice some 
familiar strings from the Finder's File menu, such as 
New Folder, Close Window, and other commands. The 
Command-key shortcuts for these (and all other 
Finder menu items) are stored in the third character 
before the name of each item - the N before New 
Folder and theW before Close Window, for example, are 
what determine the Command-key shortcuts for these 
options. A menu item with no Command-key shortcut 
just has an empty box in the appropriate place. 

4. To change or add a Command-key shortcut, select 
the appropriate character in the right-hand column 
and type in capital letters the key you want. It's 
important that you select only the character you want 
to replace. If you put the cursor to the right of the 
character, delete it, and then replace it, the Finder 
may reorder your menus or behave in other unpre­
dictable ways. 

5. Save the changes, quit Res Edit, move the edited copy 
of the Finder file into your System Folder (you may 
have to boot from a floppy to do this), and restart your 
Mac. The new Command-key shortcuts should show 
up in the menus once the new Finder has loaded. 

This technique works on the other Finder menus as 
well. The Edit menu is ID 1253, and the Special menu 
is ID 1255. 
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RESEDIT 2 
Turning An EPS Image Into A Startup 
Screen 
If you want to turn your favorite EPS image into a 
startup screen, for example, or want to otherwise pro­
cess it on a pixel level, try ResEdit. 

Open the EPS file with Res Edit and you'll find a 
resource of type PI CT. Open it and click on the image 
and copy it to the clipboard (with Command-C). Open 
MacPaint (or any graphics program that can save files 
as startup screens), and paste (Command-V) the 
image into the MacPaint window. You can do this even 
if the original PICT image was in color- although it 
will be converted to black-and-white. 

RESEDIT (SYSTEM 7) 
Freeing The Finder 
Although it's true that System 7 can run on a 2-
megabyte Mac, you won't have room in memory to 
run much else. Here's how to make the Finder quit 
when you're running an application, thus freeing up 
(approximately) 300K of RAM: 

1. Make a copy of the Fin de[ (Never use Res Edit on an 
original file.) 

2. Launch ResEdit, and open the copy of the Finder file. 

3. Double-click on the fmny resource. 

4. Double-click on ID 1252. This will bring up a win­
dow filled with arcane text and numbers. 

5. Scroll to the bottom of the window. Click once to 
place your cursor just to the right of the characters 
016D. 

6. Type 7175697481000000045175697400 (ResEdit 
automatically inserts the spaces for you). 

7. Scroll back to the top of the window. In the upper 
left corner, you' II see 000000 and, just to the right of 
that, 0001 0011. Change 0011 to 0012. 

8. Save the changes, and quit ResEdit. Move the edit­
ed copy of the Finder file into your System Folder (you 
may have to boot from a floppy to do this), and then 
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restart your Mac. The Finder now sports a Quit com­
mand. 

Note: There are a couple of drawbacks to adding this 
command- mainly that you'll lose your Apple 
menu. You'll still have the Apple and probably the 
About menu item, but you won't be able to see any of 
the other goodies on that menu. The other major 
annoyance is that the only way to get the Finder run­
ning again is to quit all open applications. If you try 
to quit when no other application is open, the Finder 
will simply restart itself. 

SAVE 
Auto-Save Documents 
Unless you save documents meticulously every few 
minutes, it's likely that you've had a system crash 
destroy some of your work. Programs such as 
AutoSave II do a save for you at regular intervals. The 
same type of utility is being bundled with other pack­
ages -WorkSaver ( QuickThols, Advanced Software, 
1092 E. Duane Ave, Suite 103, Sunnyvale, CA 94086; 
800-346-5392), and NowSave (Now Utilities, Now 
Software, Inc., 520 S.W. Harrison, Suite 435, Portland, 
OR 97201; 800-237-2800), to name two. 

SECURITY 
Password-Protect Folders and Disks 
If you lock your file cabinet at work or home, then 
you'll want to do likewise with your Mac. It's easy to 
go overboard with complicated security packages, but 
a little basic protection may be good enough to serve 
as a deterrent for prying eyes. FolderBolt (Kent Marsh 
Ltd., 1200 Post Oak Blvd., Suite 210, P.O. Box 460289, 
Houston, TX 77056; 800-325-3587) simply locks 
designated folders through use of a password. 
DiskLock (Fifth Generation Systems, 10049 N. Reiger 
Road, Baton Rouge, LA 70809; 800-873-4384) 
and Barricade ( QuickTools, Advanced Software, 1092 
E. Duane Ave, Suite 103, Sunnyvale, Ca 94086; 
800-346-5392), on the other hand, require use of a 
password for you to mount a hard disk. 



SCREEN 
Enlarge Your Screen Area 
MaxAppleZoom (Naoto Horii, BP 1415, B-1000, Brussels, 
Belgium) eliminates the black border you usually see 
on an Apple 13-inch monitor so that you can use it as 
screen space. The utility uses some previously unused 
RAM on the video card to create an image with more 
pixels. fts a result, you can increase the display area of 
your Apple 13-inch monitor by about 20 percent­
from 640 x 480 to 704 x 512 pixels. 

Switch Among Screen Depths 
Some applications work better in black-and-white, 
and others demand color. If you want to avoid going 
to a control panel to switch among pixel-depth 
modes, then get Pixel Flipper or Screen Flipper, share­
ware extensions that provide a Command-key short­
cut to invoke a change. The commercial alternative, 
HAND-Off II (Connectix Corp., 2655 Campus Drive, 
San Mateo, CA 94403; 800-950-5880), is smarter. It 
lets you define the correct mode for each application 
and then switches to it automatically as you switch 
applications. 

Switch-A-Roo is a freeware utility that will do the 
same thing. See Switch-A-Roo later in this section. 

SCROLL BARS 
Add Bidirectional Scroll Bars 
The problem with Mac's scroll-bar arrows is that you 
have to travel to either end of the screen to go in a par­
ticular direction. Scroll2 (Mayson G. Lancaster, 1492 W 
Colorado Blvd., Pasadena, CA 91105) puts bidirectional 
arrows at both ends of the scroll bar so that you can go 
down even if your cursor is at the top of the screen. 

Another utility that will do this is AltCDEE AltCDEF, by 
Alexander Colwell, puts bidirectional arrows at each 
end of the scroll bars. Compared to other renditions 
of scroll bar enhancers, AltCDEF has the cleanest and 
most unobtrusive interlace, and it comes with special 
shift and option commands for added scrolling bene­
fits. AltCDEF is freeware, System 7 compatible and is 
available from on-line services and user groups. 

SEARCH UTILITIES 
Search All'ICxt on a Disk 
If you can't jog your memory for the filename you're 
after, you may need more powerful search software -
a text-retrieval program. Gofer (Microlytics, Inc., 1\vo 
Tobey Village Office Park, Pittsford, NY 14534; 
800-828-6293) and On Location (ON Thchnology, 
Inc., One Cambridge Center, Cambridge, MA 02142; 
[ 617] 225-2545) are two heavyweight applications 
that can scan the contents of files for a string, word, or 
phrase. 

On Location pre-indexes your entire hard disk (or 
other mass-storage device) to make text retrieval 
nearly instantaneous. For the "lite" version of text 
retrieval, look at Super Boomerang (Now Utilities, 
Now Software, Inc., 520 S.W Harrison, Suite 435, 
Portland, OR 97201; 800-237-2800). You use its Find 
command to search through files for a string. Super 
Boomerang doesn't have the feature set of the other 
programs, but it still gets the job done. 

SET CLOCK 
Recalibrating The Mac Clock 
If your Mac gains several minutes a month, you can 
recalibrate the internal clock with a program called 
Set Clock. It makes a 10-second call to an atomic 
clock in Toronto or Chesapeake, Va., and resets your 
Mac clock to match. It's available as SETCLK.SIT in 
the Utilities library of MacSys on CompuServe (GO 
CIS:MACSYS), as well as other on-line services and 
user groups. 

SHADOWWRITER 
Networking The Laserwriter LS, SC And 
Style Writer 
Gizmo Technologies of Fremont, California, sells soft­
ware called ShadowWriter that lets you network Apple's 
LaserWriter LS, SC and Style Writer 

The Mac to which the printer is connected sponsors 
the printer on the network, so other Macs can select 
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the device in the Chooser and print to it. Each Mac on 
the network must have the printer driver for the type of 
printer in use, and of course you need to make sure 
that the various fonts and font renderers, such as 
TrueType and Adobe Systems Inc.'s Adobe Type 
Manager, are consistent. 

SOFTPC 
Speeding Up The Display Screen 
There are a few things you can do to speed up SoftPC 
graphics besides upgrading to a faster Mac or an 
accelerated display card. Running in black-and-white 
mode will make text display a lot faster Another trick 
is to use a fast console driver replacement such as 
QCRT, which reportedly almost doubles SoftPC's text­
scrolling speed. The driver is available as QCRT2l.ZIP 
in the IBM Hardware forum on CompuServe (type GO 
CIS:IBMHW). 

SOUND CONVERTER 
Editing Sounds 
When you want to tum sounds into sound resource files, 
the sounds are often at the wrong sampling rate. A utility 
called Sound Converter converts SoundF..dit, SoundWave, 
or SoundCap files into sound resources and lets you 
choose the sampling rate when you convert sounds 
(although it doesn't let you change the sampling rate of 
an existing sound resource). 

Sound Manager is a sound-manipulating shareware 
utility that can do any type of conversion, play sounds, 
and let you do some light editing. But you'll also need 
SoundF.dit (one of the applications that is included 
with Farallon's MacRecorder sound digitizer) if you 
want to change the sampling rate of the resource. 
Sound Manager can convert sounds to SoundF.dit for­
mat; SoundEdit can save the sounds with a different 
sampling rate (although it can convert only from 
faster rates to slower rates). 
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SOUNDMASTER 
Add Sounds To Mac Actions 
Bruce Tomlin's SoundMaster, a popular shareware 
control panel, lets you add sound to most Mac actions. 
Install it, and you'll be able to specify a sound that 
will play when you start up; restart; shut down; insert 
a disk; eject a disk; press the Tab, Shift, Return, or 
Delete key; and more. 

Yes, SoundMaster is silly, but it sure makes using a 
Mac a lot more fun. If you want to use it with System 
7, however, make sure you get Version 1.7.3, now widely 
available from on-line services and user groups; you 
can download SoundMaster sounds plus some cool 
sounds and other sound-manipulating software by 
downloading a package of goodies on MacUser's 
on-line service, ZiffNeVMac. You'll find it in the 
Download & Support Forum (filename BTSSNS.CPT). 

STEPPING OUT II 
Disabling Stepping Out II Upon Launching 
An Application 
Stepping Out II is a useful addition to the Mac, giving 
the effect of a larger screen. Many people keep it on all 
the time. But some programs, particularly games and 
telecommunications software, are better off Without it. 
To save yourself a trip to the Control Panel, launch 
your program while holding down the Option key, and 
Stepping Out II will automatically shut off. You 
should use the Control Panel to turn it back on when 
you Quit, though. This is an undocumented and 
handy reversal of Stepping Out's QuickStart feature. 

Stepping Out As A Screen Shrinker 
Stepping Out II is a screen extender that allows the 
creation of large virtual screens on the Mac. Although 
most people can readily see the benefit of this (partic­
ularly for the 9-inch screen of the Plus and SE), there 
is another benefit for those who would rather use a 
larger monitor while developing applications for the 
smaller, standard screens. 

Stepping Out II also functions quite effectively as a 
screen shrinker. Creating a small screen size is simple. 
First, call up Stepping Out II from your Control Panel. 



Click New and enter the pixel count for the screen size 
you want (512 pixels wide by 342 high for the Mac SE). 
Then, enter a name for your screen definition (such as 
"Mac SE Screen") and click Save. Finally, highlight the 
name of your new screen setup and click Set. If you 
have enough memory reserved for the new screen (and 
assuming that Stepping Out II is active), the change 
takes place immediately. Otherwise, you will first need 
to reboot. 

Once all this is accomplished, you can easily switch 
from one screen size to the other by simply turning 
Stepping Out II on or off from the Control Panel. 

STUFF IT 
Automatically Unstuffing All Archived Ales 
Stufflt has a hidden (and very handy) feature. After 
selecting the archive you wish to open (or after click­
ing in the About box if you opened an archive and not 
the program itselO, hold down the Shift key and 
Stufflt will automatically select all the files, decom­
press them, and save them to disk. 

Halting Stuffit Operations 
Simply pressing Command-period - the usual 
method for halting operations on the Macintosh­
doesn't stop the stuffinglunstuffing operation in 
Stufflt. Instead, you need to hold down Command­
period continuously until the operation has stopped. 

Archiving Several Files 
If you need to send more than 20 files via modem, you 
will need to send data in at least two sessions. Save your­
self some time by enclosing all the files in one folder. 
Stufflt can archive entire folders of various sizes. 

SUITCASE II 
Distinguishing Between Bitmapped And 
Postscript Fonts 
If you can no longer remember which of your fonts are 
bitmapped and which are PostScript, you can use 
Suitcase II to find out. 

Select Suitcase II from the Apple menu, and click on 
the Fonts radio button or type Command-F. Select any 

font name and click on Show, or double-click on a 
fontname. 

Above the sample text, Suitcase will list the printer 
font filename if the font is PostScript. If the font cho­
sen is a bitmapped font, the message "This is a 
bitmapped font" will appear. 

SWITCH·A·ROO 
Switching Among More Than Two Screen 
Depths 
Switch-a-Roo is one of the most useful FKeys avail­
able for the Mac II. If you need to switch between 
more than two screen depths, however (because you 
have a 24-bit monitor, for instance), the FKey will 
come up short. If you need to switch among 2, 16,256, 
and 16 million colors often, you can modify Switch­
a-Roo to allow two copies of the program to run at 
the same time. Here's how: 

1. Make a copy of Switch-a-Roo. 

2. Using Res Edit, select the copy of the FKey. First, use 
the Get Info command to change the ID to a number 
other than 9 that your system isn't using currently. 

3. Next, open the file and scroll down to byte 2417. In 
the ASCII translation of the hex code, you will see Roo 
File. Change this filename to something that uses the 
same number of letters (for example, Row File). 

4. Save the file, and install it into your system, using 
ResEdit, or load it with Suitcase II. 

This modification will make the two copies of a 
Switch-a-Roo run concurrently, with each assigned to 
a different keystroke. You may want to make one copy 
switch between 2 and 256 colors and have the other 
switch between 16 and 16 millions colors. Even if you 
have to switch among only three screen depths, it's 
still easier to have two copies running concurrently 
than to go to the Monitors cdev or to call up the full 
screen to reconfigure Switch-a-Roo. In addition, you 
can assign these FKeys to the functions keys on the 
extended keyboard, so any screen depth is no more 
than one or two keystrokes away. 
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SYSTEM 
Analyze Your System Configuration 
If, for example, you have extension-management problems 
and you need to get advire from an expert, it helps to know 
exactly what sort of system you're using. Several report gen­
erators can tell you intimate details about your Mac. 
Profiler (Now Utilities, Now Software, Inc., ~S.WHarrison, 
Suite 43~ R>rtland, OR 97201; 800-237 -2800) and 
Thchnical Assistanre Assistant (distributed with most CE 
Software packages) give an exhaustic report on your system 
configuration, down to the number of bytes each extension 
takes up in the system heap. 1attleThle is a freeware DA that 
does all of the above and has an exrellent help system, ton 

SYSTEM ERROR 
TABLE DA 
Printing The Error 'lllble 
Pyro! co-author Bill Steinberg produces a concise list 
of system error and bomb-code definitions on the 
Macintosh in the form of aDA, called System Errors DA 

You can't order it directly, but you can download it 
from ZiffNeVMac or from CompuServe's MAUG forum .. 

You can view any error opening the DA, but you have to 
have a working Mac before you can use it! A good idea 
is to keep a printed list of codes tacked up by your desk. 

Here's how to do just that, if you have a copy of 
ResEdit. First, make a copy of the system Errors DA. 
(Always work on a copy when you're using Res Edit 

Launch ResEdit, and double-click on the System Errors 
DA. In the window that opens, double-click on the 
TEXT item. Now double-click on TEXT "SysErrorList 
2.1c ID=-15392 (it may have a slightly different name if 
you have a different version of the DA). 

Next, select all the text by either dragging from the 
beginning to the end or clicking just before the first 
character, scrolling to the end of the text, holding down 
the Shift key, and clicking after the very last character. 
Select Copy from the Edit menu. Now quit ResEdit, 
launch your favorite word processor, and paste. You 
now have a text version of the error codes. 
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SYSTEM PICKER 
You Can Keep System 6 And 7 On Your Hard 
Disk 
Yes, you can, although it's a little clumsy. If you have 
a disk that can be partitioned, one solution is to 
define separate partitions for the two systems and 
switch partitions to switch systems. 

If your disk can't be partitioned or you don't want to 
reformat it, the solution is a little more complex. You 
need to keep a separate System folder for each system 
and select which one you want to use with a little util­
ity called System Picker (previously known as 
Blesser), available from ZiffNeVMac, CompuServe and 
local user groups. 

First, install System 7. (To do this without erasing 
System 6, select your current System folder and choose 
Duplicate from the File menu before installing). You 
now can use System Picker to select which System 
folder will be used the next time you boot up. Note 
that you should always reboot the Mac immediately 
after using System Picker. Otherwise, your Mac can 
get confused. 

When you're running under System 6, you'll see extra 
folders on your disk called Desktop and Trash. Don't 
erase these; they're created and maintained by System 
7. When you switch back to System 7, you'll likely see it 
update the disk. This step is necessary to accommo .. 
date whatever changes you've made to the disk and file 
structure under System 6. 

TATTLETALE 
Great System Reporting Utility 
TattleTale is a desk accessory, from john Mancino, for 
examining Macintosh configuration details, and it's 
free. Mancino asks only that you do something posi­
tive for the environment in return for using the soft­
ware (it's also Ecoware). 

TattleTale details all aspects of a Macintosh configura­
tion, including NuBus cards, SCSI chain, memory; pro­
cessors, ROM and operating system versions, Desktop 
Bus devices, fonts, system extensions, open files, and 
active processes. 



TattleTale is also System 7 compatible, and also pro­
vides a special feature list for programmers that lists 
the "traps" that are available and those that are miss­
ing from the system. 

TUSH (SYSTEM 7) 
Empty 'Ihlsh on Shutdown 
Under System 6, trash gets thrown away when you shut 
down But under System 7, it keeps piling up until you 
select Empty Trash from the Special menu. Trash Chute is 
a freeware extension that empties the trash when you 
shut down. It also uses Apple events to delete files when 
you drag them over the application icon. 

USER GROUPS 
Obtaining Utilities Without A Modem 
If you want to obtain many of the utilities mentioned 
here or elsewhere but don't have a modem to down­
load the stuff from on-line services, there are 
Macintosh user groups. 

If you don't have a local user group, you can try the 
BMUG (Berl<eley Macintosh User Group) software library, 
one of the most complete in the country. It offers a cata­
log of programs and sells disks of programs. You might 
consider joining BMUG just to get its newsletter- a 
semiannual300-to-400-page extravaganza. 

BMUG can be reached at 1442A Walnut Street, #62, 
Berkeley, CA 94709-1496; 800-776-BMUG or 
(510) 549-2684. 

Another user group is the BCS-Mac (Boston Computer 
Society Macintosh) Group. BCS-.Mac also has a nice 
fat PD catalog and a great monthly magazine. It's 
located at 1972 Massachusetts Avenue, Cambridge, 
MA 02140; (617) 864-1700. 

Of course, you can call Apple at 800-538-9696 for 
the name of your local Mac user group. 

VIRTUAL MEMORY 
Use Virtual Memory With Syquest Drives 
System Ts virtual-memory feature lets you operate 
with more memory than you have in physical RAl\1 by 
using hard disk space to swap memory blocks. You 
can't assign removable drives as the home for your vir­
tual R~\1, however. Fortunately, a freeware utility, 
VMEject, corrects this for owners of SyQuest remov­
able-cartridge drivers. 

WINDOWS 
Control Your Windows 
With a dozen windows open on your desktop, getting to 
the one at the bottom means a lot of shuffling. Instant 
Menus (QuickTools, Advanced Software, 1092 E. Duane 
Ave, Suite 103, Sunnyvale, CA 94086; 
800-346-5392) has a Windows feature that lets you 
instantly bring any open window to the front. Kiwi 
Power Windows Kiwi Power Windows (Kiwi Software, 
Inc, 6546 Pardall Road, Santa Barbara, CA 93117; 
800-321-5494) advances that concept by bringing any 
open window in any application to the foreground. 

WORD PROCESSING 

WORKS 
Apple Pro DOS-To-Mac '&anslation 
Need to deal with an Apple ProDOS-to-Mac-OS trans­
lation? The most common of these translations is 
necessary when you're transferring an Apple Works file 
to Microsoft Works. The standard way to do this is to 
save the Apple Works file on a 3.5-inch ProD OS disk 
and then use AFE (Apple File Exchange) with 
Microsoft's Works-Works Translator. The problem is 
that most Apple II-family computers have only 5.25-
inch-disk drives, and for AFE to do the conversion the 
source file must be on a 3.5-inch Pro DOS disk. 

Here's a workaround that doesn't require finding an 
available ProDOS drive. If you can get the Apple Works ~ 
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file onto a Mac disk by electronic transfer, you can get 
the file onto a 3.5-inch Pro DOS disk. 

Launch AFE, put in a blank disk, and choose ProDOS 
Fonnatting from the File menu. After the disk has 
been formatted, use AFE to "default copy" the 
AppleWorks file from the Mac disk to the ProDOS disk. 
Then make sure that the AppleWorks to Microsoft 
Works translator is available and checked in the 
ProDOS to Mac menu, and convert the file. 

GENERAL 
Underlining Words With Descended 
Characters 
There's not a whole lot you can do about poor 
underlining of letters with descenders- for exam­
ple, when you underline a word such as change and 
the g gets sliced through. Words with such letters in 
the middle look better if you change the offending 
letter(s) to plain text and leave the rest of the let­
ters underlined. 

MACWRITE 
Opening Mac Write Flies Without The 
Application 
Many software developers continue to use Mac Write 
format as their standard for on-disk program docu­
mentation. This can be inconvenient if you don't have 
Mac Write. You have to open up Microsoft Word or some 
other word processor and import the file, even if all 
you want to do is take a peek at the documentation. 

You could change Word's Creator to MACA, using 
ResEdit. However, if you're not comfortable with 
ResEdit or if text files are what you're after, there's a 
nice shareware utility, Read MacWrite, that opens 
Mac Write files and scrolls through them on the 
screen while saving the contents as a plain text file. 

Now if you need to take a look at some documenta­
tion on the fly, you can just open the file with aDA 
such as miniWRITER (which is also shareware). 

You can pause the scrolling, but Read MacWrite lacks a 
text buffer and elevator boxes for scrolling back over 
what you've read. Once the text has scrolled by, it's gone 
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until you reopen the file and start at the beginning. 

Read Mac Write's quick production of text files from 
MacWrite-formatted documents would also come in 
handy if you had several MacWrite files that you need­
ed to get into plain-text format in a hurry. (Read 
MacWrite is available in the Download Library Forum 
onZmac.) 

Save As '!ext When You're Exporting Hies 
While there are a few word processors that can't rec­
ognize and open MacWrite files (most notably 
Microsoft Word), in general you'll find it easier to 
export data to other programs or via modems by 
saving it as a Thxt Only file. The Text format is easily 
transmissible over ASCII data lines, and works well 
when you're transferring data to other types of com­
puters. 

Lack Of Disk Space Can Cause Printing 
Problems 
You can run into trouble trying to print documents if 
there isn't enough space on the disk to save the docu­
ment to the buffer. If your disk is too full to print, 
either delete some files or else transfer the document 
to a less-overburdened disk. In a pinch, you can print 
a few pages at a time. 

Hidden Spaces Can Affect Printouts 
If your text doesn't print correctly after you've set up 
tabs for columns, check problem lines or columns 
carefully to see if any spaces were mistakenly entered 
there. As soon as these inadvertent spaces have been 
erased, your printouts should come out spaced the 
way you meant them to look. 

Identifying Hookup Problems 
If you're getting the message that your document can't be 
printed, try again, watching the dialog box while the 
Mac tries to print. If the Mac displays the message 
"Looking for the ImageWriter/LaserWriter" for longer 
than usual and then tells you it can't print your docu­
ment, check all the connections to be sure the printer is 
hooked up correctly. 

Creating Flash Cards 
Here is a simple way to use the Mac to make flash cards. 
All you need is a program that prints two columns on a 
page (or you can do it the hard way and use tabs). 'fl1ese 
instructions are for using Claris' Mac Write II, but sophis-



ticated word processors such as Word, WordPerl'ec~ or 
Nisus work just as well. 

1 Create a format with two columns. Make sure that if 
the page were folded down the middle, the columns 
would be situated on either side of the crease. 

2 Type in the words or phrases in your target lan­
guage-let's say Spanish- in the left-hand column. 

3. Do a column break. Directly across from each Spanish 
word or expression, type the equivalent in English. Make 
sure that the equivalents are directly opposite each other, 
on the same imaginary horizontal line. 

4. Increase the space between the selections, either by 
double-spacing (pressing Return twice) or by increasing 
the line spacing. This step isn't essential, but the results 
look bette[ 

5. Print out the list You' 11 have a column of foreign words 
and phrases on the left and their equivalents in English on 
the right. 

6. If your printer has a sheet feeder, tum the paper 
over and run it through the printer again, head first, 
printing the other side. If you have a continuous form 
printer, make sure the paper is rolled to exactly the 
same point before printing each side. 

7. Cut the paper vertically up the middle. This yields 
two strips, each with English expressions on one side 
and their equivalents in the other language on the 
opposite side. Put one strip away to use if you make 
mistakes in the next step or if you later lose some of 
the printed phrases and want to make a new set. 

8. Trim off all the excess white paper. 

9. Cut the printed words and phrases apart, and mix 
them up. 

10. Whenever you want to test yourself, revie\V, or 
learn new expressions, just pull a slip of paper out and 
look at one side. After you've tried the translation, 
tum the paper over to see if you were correct. 

Nifty Smart Quote Feature 
MacWrite II has a nifty smart-quote feature that 
automatically converts the typewriter-style single­
and double-quote marks (like this:"") to the more­
professional-looking curly quotes. 

What do you do if you customarily use special foreign 

quote marks (such as guillemets in French, Italian, 
and German)? You can change Mac Write II to be 
smart in any language by changing the SMQT 
resource with ResEdit. Open the resource and substi­
tute the guillemets (both single and double) for the 
curly quotes. The keystrokes for < < and > > are 
Option-backslash and Shift-Option-backslash, 
respectively. The keystrokes for< and> are Shift­
Option-3 and Shift-Option-4, respectively. Close 
ResEdit and save the changes you've made. Now the 
program will smartly insert the new types of quote 
marks as you type. 

The 'Irick 1b Editing Footnotes 
If you place footnotes at the end of a MacWrite II docu­
ment, you will discover that the footnote page cannot 
be fully edited. That means that you cannot easily add 
a title, such as "REFERENCES," to the top of a page. 
Claris' technical support says that the official solution 
is to save the document as a text file, reopen it, and 
edit the final footnote page as needed. 

A better solution is to create footnotes in the usual way 
-in this case, auto-numbered and placed on the last 
page. Before you print, change your footnote prefer­
ences to disable the Auto Numbering option. Now place 
the insertion bar somewhere before the first footnote 
marker and insert a dummy footnote. 

When you are prompted for the footnote marker, use 
a space, which will be invisible in the body of the 
text. For the actual footnote, type the desired title. It 
will be unnumbered on the footnote page and will 
appear before footnote 1. You can edit this title/foot­
note to change its size, style, and ruler configura­
tion so it matches other titles in the document. 

If you want to add other footnotes to the paper after 
you have created the title/footnote, do not enable auto­
numbering. Instead, when the prompt for the footnote 
appears, press Return, and the appropriately numbered 
footnote marker will appear -without disturbing the 
title/footnote. 

NISUS 3.05 
Nonbreaking Spaces 
Sometimes you don't want a sequence of characters 
that includes spaces to break between lines at the 
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spaces (for example, in a mathematical equation). 
You can avoid this in Nisus 3.05 by using an Option­
space (called a nonbreaking space in other pro­
grams). To create such a space, hold the Option key 
down while you press the space bar. 

If you want to globally change the spaces within a 
selection to Option-spaces, you can do so by creating 
the following one-line macro: 

1. Choose New from the Macro submenu, on the Tools 
menu. 

2 Type the words "Find/Replace·; followed by a space. 
Type a pair of straight (dumb) quotation marks with a 
space between them. Type a second pair of quotes, this 
time with an Option-space between them. Type a final 
set of quotes containing an "s" (this tells the macro to 
replace the spaces in the current selection only). 

Your macro should look like this: 

Find/Replace " " " " "s" 

3. Save the new macro, and assign a key to it. Select 
the text that you want to change, and invoke the 
macro with this key. 

Zooming The Unzoomable 
Sometimes you might position a window on the 
screen so that its zoom box in the right corner of the 
menu bar (for resizing) is off the screen. However, 
Nisus lets you use the zoom box- even if it's off­
screen- simply by double-clicking on the window's 
title bar. This is true for all of your windows, including 
the Macro, Glossary and Catalog windows. 

Making Smart Quotes Stupid 
If you use smart quotation marks a lot, you should 
probably set up your Editing Preferences with Smart 
Quotes checked. Then whenever you type an ordinary 
quote (double or single), the correct curly quote will 
be substituted automatically. 

Sometimes, however, you want to insert straight 
quotes (when using the symbols for feet or inches, for 
example). Rather than going to the Editing 
Preferences menu and changing the settings each 
time, all you have to do is hold the Command key 
down while you type the quotes. Holding down the 
Command-key modifier reverses the Smart Quotes 
setting for that entry. 

182 

Doing Windows 
Here's a tip that's very useful if you have several win­
dows open simultaneously. 

Press the Command key, and click on the title bar of 
any window (including the Catalog and Macro win­
dows). The Windows submenu (which you ordinarily 
access on the Tools menu) will pop up and show you 
which windows are open. You can then access any 
window by double-clicking on its name on the 
Windows submenu. 

TEACHTEXT 
Placing Graphics In 'Ieach'Iext Documents 
Using The ScrapBook 
Using the Paste command to paste pictures into 
Thach Text documents doesn't work. Thach Text's docu­
ment-creation facilities aren't the greatest, but graph­
ics can be included. Here's how: 

- Collect all the pictures you plan to include in your 
document and save them in the Scrapbook. 

-At every place in your TeachThxt document that you 
plan to have a graphic, hold down the Option key and 
press the space bar. You won't see anything on screen, 
but a place will be reserved for your graphic. 

-When you're finished with the document, open both 
the document and your Scrapbook file with ResEdit. 
Res Edit will ask if you wish to create a resource fork for 
the ThachThxt document -you do. 

-Copy the pictures from the PICT resource in the 
Scrapbook file and paste them into the TeachThxt 
resource fork. Then select each picture resource, type 
Command-I to open an Info window on it, and set the 
resource ID of the first picture to 1000, the second to 
1001 and so forth. 

When you next open your Thach Text document, a pic­
ture should appear in each place where you entered 
Option-space. ThachThxt will center each picture, but 
you'll probably need to add some blank lines to open 
up white space for the pictures to occupy. 

Placing Pictures In 'leach 'lext Documents 
To place pictures in Thach Thxt documents, type 
Option-space where you want the picture to appear. 



The pictures must be stored as resources of type PICT 
in the document, copied there by ResEdit. The first 
Option-space is drawn as picture 1000, the second as 
1001, etc. Leave enough blank lines after the Option­
space so the picture does not cover the following text. 
To make the document read-only, change the file type 
to "ttro." Thach Thxt will display additional lines of 
credits while holding down Command-option and 
selecting About Teach '!ext. 

Placing The 'Ieach'Iext Newspaper Icon On 
Files 
Ever wonder how some of those little ThactThxt 
ReadMe files appear on the desktop as newspaper 
icons? It's really simple. 

1. Launch ResEdit or a similar program that allows 
you to edit the type/creator information of a file. 

2 Choose Get File/Folder Info from the File menu 
(that's how it appears in ResEdit 2.1; your version may 
be different). 

3. Choose the ThactThxt document file you want repre­
sented by the newspaper icon. The file type of normal 
ThactThxt files is TEXT, and the creator string is ttxt. 
Change the type to ttro, save your changes, and quit. 

4. Close the folder that contains your file, and reopen 
it. There's the newspaper icon! 

TEXT FILES 
Mac, DOS And Unix 'lext Files 
Mac text files ("text with line breaks," or some such 
in most word processors) terminate each line with a 
carriage-return character, while DOS text files use a 
carriage return and a line feed. Unix, of course, is dif­
ferent: It uses just the line-feed character. Programs 
that let you search for and replace non-printing char­
acters can be used to convert text files from one of 
these formats to another. 1\vo such shareware pro­
grams are Add/Strip and McSink, both available on 
ZiffNet/Mac or from your local user group. 

WORD 
Setting Predetermined Spaces 
If you find yourself restricted to a word-processing 
program for DTP after experiencing the relative luxury 
of a dedicated DTP product, you'll quickly begin to 
miss the ability to set predetermined spaces. Word, for 
instance, has a nonbreaking space, but that's it. 

You can, however, create spaces by "whiting out" 
characters of the desired width -namely, an em dash, 
an en dash, or any number (in most fonts, all num­
bers are the same width to aid in alignment). Here's 
how to do this in Microsoft Word: 

Type a dash or a placeholding number, select it, and 
choose White from the Character dialog box. You can 
assign a key combination to White and Black through 
the Commands option on the Edit menu, or .you can 
use a macro program to create the entire space. This 
technique greatly speeds up typesetting chores in 
which lots of specified spaces are needed. 

Dashes in text should have a tiny bit of space on both 
sides. Normally typesetters use one or two units, with 
units being defined as 1/18 of an em. You can create 
your own thin space in any program that allows you 
to print in white by using any punctuation mark, such 
as a period or a comma, that is the same width as a 
thin space. Store the entire dash-with-spaces combi­
nation in a macro, and you'll be able to provide the 
perfect dash instantly. 

In Show Paragraph mode, Word does not display white 
text as invisible, although the text does print that way. 

Discovering New Keyboard Combinations 
Sometimes while using Word, I accidentally discover 
new key combinations without knowing exactly what 
function they serve. Here's a quick way to find out the 
action of any key sequence: 

1. Choose Commands from the Word Edit menu. 

2. Pick any command from the list on the left, and 
click on the Add button in the Keys section of the dia­
logbox. 

3. Word will ask you to type a key sequence for the 
command you've chosen. Type the key sequence 
that performed the unknown action, and you' II get ~ 
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another dialog box telling you what command this 
key sequence is now assigned to. No more mystery, 
·-but be sure to click on Cancel to prevent reassign­
ment of the key. 

Mail Merge With The 'lltble Feature 
One of the worst aspects of Microsoft Word's mail­
merge feature is all the stupid punctuation rules 
you have to follow. Trying to make sure you have 
quotes and commas in all the right places often 
isn't worth the effort, and it can make inputting 
addresses sheer hell. 

If you use Word's Table feature to create the data 
documents for the merge, however, you can put the 
entire address- including commas and Return­
into one cell. Not only do you avoid having to 
enclose fields containing punctuation with quota­
tion marks but you also don't need to use as many 
fields, because all address information (company 
name, street, city, state, and ZIP code) is contained 
in one cell under one field name. Unfortunately, 
you can't use the Table format if you want to sort 
your data by its parts, such as by ZIP code or city. 

Fast Save Uses Disk Space 
Microsoft Word has a Fast Save feature, which lets 
you save files relatively quickly in exchange for 
greater disk-space consumption. 

\Vhen the Fast Save option in the Save As dialog box 
is checked, Microsoft Word doesn't actually delete 
text or graphics that you remove from a document; it 
just skips over them when you're displaying, editing, 
or printing the document. So, files don't get smaller 
when you delete things from them, and there is more 
overhead when you add new information. When you 
choose Save As and un-check the Fast Save check 
box, Microsoft Word actually erases all the deleted 
information, so the file size should decrease. 

Spell-Checking Without Putting The Cursor 
At Document Top 
It's possible to run your spelling checker on a Word doc­
ument without having to move all the way back to the 
beginning. First, select the entire document by moving 
the cursor to the left margin, where it changes into an 
arrow, and then click the mouse while pressing the 
Command key. When you run your spelling checker, 
the entire document will be checked in a single pass, 
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without the annoying "Continue Check from begin­
ning" message. 

Re-Spacing Between Letters 
Word creates its own "normal" spacing between let­
ters, based on the type and size of the font you're 
using. The problem is, sometimes the spacing created 
isn't exactly what you want. 

You can fix spacing between letters by selecting the 
text you want to change, choosing Character on the 
Format menu, and then selecting Expanded when the 
list of options appears. The program will suggest an 
expansion amount in the By box. Override this sug­
gested spacing by typing in any value from .25 to 14 
points. As you experiment with different results, you'll 
find the re-spacing that works best for you. 

Hiding Oudine Headings 
People who compose a lot of outlines will be vexed to 
find that most headings must be left out of the fin­
ished product. You can delete the outline headings 
manually, but in a long document this can be 
extremely time-consuming and can hinder your 
efforts to revise the file later. 

A solution is to use Define Styles to create a style sheet 
on which all outline styles are based. Its style would be 
the same as Normal Thxt. Using Define Styles again, 
you can define each of the subsequent outline styles as 
being based on this "normal" style by entering that 
name in the "based on" box. Now, any changes you 
make to the definition of the base style will automati­
cally be made to all outline styles. 

When you've finished composing and want to hide the 
outline, choose Define Styles and add Hidden Thxt to 
the style definition. All outline heads will vanish, 
unless you select Show Hidden Thxt. When you print 
documents created with this method, be sure Print 
Hidden Thxt isn't selected in the Print Dialog Box. 

Using Define Styles To Create Outline Styles 
A problem with Word's outlining capabilities is that 
there is no Hide Outline Headings command. Often, 
one wants to compose in an outline, but most head­
ings must be left out of the finished product. You 
could delete the outline headings manually, but this 
can be very time consuming in a long document and 
can also hinder future document revision. 



The solution is to use Define Styles to create a style 
sheet on which all outline styles are based. You could 
call this "base style." Its style would be the same as 
Nonnal Text. Again, using Define Styles, each of the 
subsequent outline styles should be defined as being 
based on this Nonnal style by entering that name in 
the Based On Box. Now, any changes made to the defi­
nition of the base style will automatically be made to 
all outline styles. 

When you have finished composition and want to hide 
the outline, choose Define Styles and add Hidden Text 
to the style definition. Thxt to the style definition. All 
outline heads will vanish (unless you select Show 
Hidden Text). When you print, make sure Print 
Hidden Thxt is not checked in the Print Dialog Box. 

"Auto-Date" Headers And Footers 
Anywhere In A Document 
When you paste "auto-date" headers and footers any­
where you want in your document, it continues to 
change automatically whenever you start a new doc­
ument. This is especially useful if you work from 
templates. 

The "auto-date" can be distinguished from text by 
using the Show Paragraph command (press 
Command-Y), which displays a dotted outline around 
all "auto-dates." 

This also works for time and page numbering. As an 
extra shortcut, try pasting "auto-date" into your glos­
sary and then add it to a menu. 

Key Strokes For Line Fonnatting 
In Word, the Return key is used to end a paragraph, 
while Shift- Return is used to end a line without creat­
ing a new paragraph. Shift- Return works fine as long 
as it isn't used in a justified paragraph. In the latter 
case, the line created with Shift-Return is justified­
something most people will want to avoid. And you 
can avoid it by pressing Shift-Option-Return. 

This undocumented method of concluding a line is 
very useful for lines within a justified paragraph that, 
for example, are to contain only a mathematical 
equation located at a center tab. It's also the only way 
to create the appearance of multiple justified para­
graphs within a single box. Simply apply the boxed 
fonnat to the paragraph and conclude each pseudo 
paragraph within the box with a Shift- Option-Return. 

The concluding line of each "paragraph" will not be 
fully justified. 

Incidentally, the Shift-Option-Return symbol that 
appears when Show is active looks just like the Return 
symbol. 

Condensing The Space Between Italicized 
Characters 
Sometimes Word puts too much space between itali­
cized words (especially if each word is capitalized, as in 
subheads or titles). Simply condensing italicized type 
usually results in squished type. But if you tum on 
Show from the Edit menu, you can select the space 
markers between the words and condense only them by 
using the Condense feature found in the Character 
dialog box. You can condense by anything from 0 to 
1.75 points. After you've highlighted the first space 
mark and condensed it, go on to the next space mark, 
highlight it, and press Command-A ('/\gain") so you 
don't have to reenter the values in the dialog box. 

Dialog Box Command Keys 
Word allows users to substitute command key combi­
nations for mousing in all dialog boxes. Any dialog box 
can be canceled by using Command-period. 

In The Save As ... dialog box: 

Command-S saves the file; 
Command-C cancels; 

In the Open ... dialog box: 
Command-O opens the highlighted file; 
Command-C cancels. 

In the OK or Cancel dialog box: 
Command-O presses the OK button; 
Command-C cancels the box; 

Creating Double And 'lliple Unes In Word 
Set Below and Double borders on the Paragraph selec­
tion under the Format menu to create a double line 
underneath a paragraph. For a really interesting 
effect, go to the paragraph directly below the double­
underlined one and set the borders for Double and 
Above. The results will be three horizontal lines. 

Placing A Background Screen Behind A 
Paragraph 
There are times when you may want to accent Word 
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paragraphs with a background screen. The following 
PostScript command, placed before a paragraph, will 
do the job: 

para. 0 0 moveto 0 1000 rlineto 1000 0 rlineto 0 -1000 
rlineto closepath gsave .97 setgray fill grestore 

'lltis instruction must be in PostScript style, which is 
one of Word's automatic styles and can be applied by 
entering PostScript in the Define Styles dialog box. The 
value 1000 will handle any paragraph up to 13 inches 
square, but if you want a smaller area, which will also 
print faster, you can pick a more realistic value by mul­
tiplying the number of inches by 72 and using that 
result. You can adjust the intensity of the gray scale by 
changing the .97 next to setgray. The closer this value is 
to 1, the lighter the screen. Word considers the space 
above and below your paragraph to be part of it, so 
some white space may get filled unless you use the 
Paragraph command and set this space to zero. 

Shortcuts When You "Save As ••• " 
There are a number of keyboard shortcuts you can 
take if youtl rather work through the keyboard than 
the mouse: 

Command-S saves the file. 
Command-E ejects the disk. 
Command-C cancels the dialog box. 
In the Delete dialog box, the same commands work, 
except that Command-S activates the Delete command 

Copying Parts Of A Style Sheet 
It's possible to copy one or just a few styles from one 
Word document's style sheet to another, without bring­
ing in the entire style sheet. First, open the document 
that contains the style(s) you want to copy. Select a 
paragraph that's formatted in that style (to copy several 
different styles, copy a series of paragraphs). 

Now, open the document to which you're going to copy 
the styles, and paste the paragraphs into the style 
sheet. TI1e new styles are now a part of the old style 
sheet. So nO\V, you can delete the text you pasted in, 
and the styles will remain in the document. 

Spell-Checking Around ligatures 
If you use a lot of fi and flligatures in long documents, 
you'll save time running the spelling checker by replac­
ing the character pairs "fi" and "fl" with the ligatures 
AFTER the spell-checking is completed. 
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The spelling checker can't recognize ligatures as 
alphabetic characters, and you can't add words that 
contain them to your dictionary. So, if you put the lig­
atures in before running the spelling checker, the pro­
gram regards any remainder of a ligature word to be 
misspelled- unless the remainder happens to match 
a word in the Main dictionary. 

After the spelling checker has finished running, go to 
the start of the document (Command-Keypad 9), 
open the Change dialog box (Command-H), set the 
replacement parameters, select Match 
Upper/Lowercase, and click Change All. 

Avoiding Disk-Swapping Hassles 
A lot of people use several different document disks 
during a single work session. If you do, and you work 
on a floppy disk-based system, you can avoid a lot of 
disk-swapping by double-clicking on the Word applica­
tion, instead of a document, when you start working. 

Correcting Pagination Problems With Serial 
Printer Drivers 
When you use the serial printer driver with either a 12-
or IS-pitch printer, you must first set the line spacing 
for all paragraphs, or the pagination will be incorrect. 
When you create a new document, first go to the 
Paragraph dialog box under the Format menu and set 
the line spacing to 12 points instead of the default 
spacing, "auto." 

If you are having problems printing an existing docu­
ment, select the entire text and then go to the 
Paragraph dialog box and do the procedure described 
above. 

Twelve is the proper setting to emulate a single­
spaced typewriter which produces 6lines per inch. To 
emulate other spacing, set a value of 72 divided by the 
number of lines per inch. 

Speeding Up The Graphic Redrawing 
Routine 
Word can take what seems like forever to redraw a 
complex graphic, especially one that has had 
smoothing activated for its curves. You can avoid 
this by creating a special Graphics style for each 
graphic, and including Hidden as one of its charac­
teristics. Make sure that your Preferences setting has 
Show Hidden Text set to Off. Now, you'll be able to 
quickly scroll through and edit text in the docu-



ment, without having to wait forever for graphics to 
redraw. 

Just remember to redefine your Graphics style by 
cancelling the Hidden characteristic before you print 
or repaginate. 

Printing Long Documents With Page 
Numbers 
The Word manual describes a rather involved proce­
dure for people who need to print long documents 
(meaning documents composed of several Word files) 
that have page numbers. One particularly annoying 
hoop you have to jump through is having to repagi­
nate each part of your document, finding out what its 
last page number is, and then having to set up the 
next file so that it starts with the next page number. 

There is a work-around to this situation. Choose Page 
Setup for each file, and type the file name of the next 
file, as the manual says. Then, WITH THE EXCEP­
TION OF THE FIRST FILE of the set of files composing 
the document, blank out the Start Page Numbers At 
box. That is, leave a 1 in the Start Page Numbers At 
box for the first file, and erase the 1 in that box for all 
the other files. Now, reopen the first file of the docu­
ment and tell the Mac to print. 

The entire document will print out with the right 
pagination, without your having had to repaginate 
each file. 

This only works if you begin printing with the first file 
of the series. If you print a file that appears in the 
middle or end of the set of document files, you'll have 
to follow the instructions in the Word manual. 

Cleaning Up Returns In Print Merge 
Documents 
When creating a list of names or addresses, for 
example, for print-merging in Word, making sure 
you have appropriately "Commanded" and "Shift­
Returned" each and every set of data can be unnerv­
ing. (Remember a Return is only entered at the end 
of each record, while a Shift-Return may be used for 
arranging the data more logically.) To eliminate 
most of the problem, you can use the Document 
Renumber command to number each set of data 
which isolates the entries with just a Return instead 
of the desired Shift-Return. Where you find the erro­
neous Return, put the cursor in front of the entry 

and press the Delete key, then press Shift-Return. 
Using the Document Renumber command also lets 
you know just exactly how many names or addresses 
you have. 

Ftnding The Missing Comma In Data 
Record 
'l11e easiest way to find a missing comma in a data 
record, while doing a Print Merge, is to select the New 
Document button in the Print Merge windO\v. This 
creates a document on the screen. When you come 
across the "Missing Comma in Data Record" dialog box, 
quit the Merge and scroll the document to the last record. 
The next record in your data file is the one with the prob­
lem. Once you have a successful Merge to the screen doc- · 
ument, select Print and you are assured of printing the 
entire batch successfully. 

When You Get The "Missing Comma In Data 
Record" Error Message 
Word's Print Merge capability requires that you sepa­
rate field names with commas or tabs. Unfortunately, 
when you accidentally omit one, the program simply 
puts up an error message, without telling you where 
your comma might be missing. Instead of going 
through each and every record you're working with, 
you can use this shortcut: 

Count the number of commas in the header record, 
and then use the Change command to systematically 
isolate the record that's missing a comma. You do this 
by entering a comma into both the Find What box and 
the Change To box. Then select sections of records 
and start searching. 

Word count11 the number of changes that it makes, and 
puts that number into the lower left corner. If the 
number of changes is not evenly divisible by the num­
ber of commas in the header record, you know that the 
defective record is somewhere in the records you just 
selected. If the number is evenly divisible, you can 
move on and select another section. 

Continue this process until you narrow down the data 
records sufficiently to isolate the one or more records 
with missing commas. 

Accessing Help Fast 
You don't have to dig out your manual every time you 
need help, if you have Apple's Extended Keyboard. The 
key, labeled "Help," is right under the F13 key. When ~ 
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you press it, you'll see a question mark appear. This is 
your cursor. Move it to whatever you want explained, 
including menu choices, and then just click the 
mouse for the help you need. 

If you don't have the Extended Keyboard, press the 
Command key and and the ? key to get the question 
cursor 

Using The ASCII Code Search-And-Replace 
Capability 
Microsoft Word has an ASCII code search-and-replace 
capability that can come in handy when using Word 
to edit and refom1at text files created on an IBM PC or 
PC clone. To find a particular ASCII code within a 
Word document, type a caret (Shift-6) followed by the 
decimal value of the ASCI I code in the Find What dia­
log box. Here's how to use this feature to fix a typical 
PC text file imported into the Mac environment 
(always work on a backup copy of the file you wish to 
convert): 

1. Select Change from the Search Menu (Command-H). 

2. Replace the double carriage-Return/ line-feed 
( CRILF) pairs at the end of each PC text paragraph 
with a special Mac character as follows. Click the I­
beam to the left of the first character in the file. In the 
Find What box, type " 13" 10" 13" 10" 03 is the deci­
mal value of the ASCII carriage-return code; 10 is the 
decimal value of an ASCII line feed). 

3. In the Change To box, type Option-S for a bullet or 
another special Mac character not used in the file. 
Click Start Search or Change All to make the changes. 

4. NO\v, replace the CR/LF codes at the end of each line 
within paragraphs with a space: With your insertion 
point at the top of the document enter " 13" 10 in the 
Find What box; in the Change To box, type one space; 
and then click Start Search or Change All. 

5. Finally, go back and replace the special Mac charac­
ters (used to mark the end of PC text file paragraphs) 
with a Return. First click the I -beam at the top of the 
file. In the Find What box, type a bullet (or whatever 
special character you used). In the Change To box, 
type "p (a caret followed by a lowercase p represents a 
Word Return character). Click Start Search or Change 
All as before. 

You can also use this ASCII code search feature to fix 
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PC word-processing documents within Word. For 
example, some PC documents contain normal text 
with only occasional ASCII control codes (such as 
decimal value 12 for fom1 feeds or 9 for tabs). Use 
FEdit Plus or another Mac file editing utility program 
to examine the codes in the PC document, and then 
use this technique to search for and delete these codes 
within Word. For a complete list of the decimal values 
for all ASCII codes, see the Appendix in the Microsoft 
Word manual. 

By the way, the reverse of this process works as well. 
You can replace return characters in a Word text file 
with ASCII CR/LF codes. TI1is allows you to create 
readable text files for your PC friends and customers 
without leaving your Mac. 

Slow Save In Word 
Other applications, such as Correct Grammar and 
Page .Maker, seem to hate documents saved with 
Word's Fast Save feature. If you want to eliminate the 
Fast Save feature in Microsoft Word, add the Fast 
Save Enabled option to the File menu using Word's 
Commands feature and then un-check it. 

'Ib accomplish this, choose Commands from the Edit 
menu in 4.0 and the Tools menu from Word 5.0. 
Scroll until you see Fast Save Enabled, and place 
this item in the File menu. Then select the Fast Save 
Enabled item under the menu you placed it in so 
that it does not have a checkmark next to it. 

Fitting Long Entries In Mail-Merge Fields 
As you're creating the data file, you might well find 
that some of your entries are too long or that they just 
don't fit the pattern you've established in the header 
information. You can get around this problem by 
breaking the field entry into two or more lines with a 
soft Return (Shift-Return). 

If you enter a soft Return, the mail-merge will bring 
that onto the next line without disrupting the field 
order. Be sure to save the data file as a normal Word 
document- soft Returns are stripped out of ASCII 
documents. To see the difference in a Word data file, 
just be sure that Show Paragraphs is on. 

Spacing Paragraphs In Styles 
One useful aspect of Word's style-sheet feature is its 
ability to assign a space before and/or after a para­
graph to a style. A space before and after in a style def-



inition lets you maintain consistent spacing between 
elements such as body text and section titles through­
out a document. 

If you assign Space Before to a style, however, and a 
paragraph with that style begins at the top of a page, 
Word adds the extra space at the top of the page, leav­
ing a gap. As a result, the top margin for that page 
appears to be shifted down, making it inconsistent 
with the other pages. Unfortunately, the only way to 
avoid this unwanted result requires manual labor: 

I. Place the cursor in the paragraph with the unwant­
edspace. 

2. With the Paragraph command, change Space Before 
to Opoints. 

Word removes the extra space at the top of the page. 

Note: Because page breaks can change while you're 
editing a document, it's wise to wait to make this cor­
rection until you're ready to print a final draft. 

Adding Words 1b A Dictionary 
Here's a relatively easy way to add large groups of 
words to Word's dictionary. Create a file containing 
the words you want to enter. Then select Spelling 
from the Utilities menu in Full Menus. Select the dic­
tionary to which you want to add the words. When the 
first word is queried, create a macro (with your macro 
program of choice) that clicks on the + button and 
then on the Continue button. Assign a keystroke for 
the macro, and press it as necessary as you continue to 
check spelling in the document. 

You' 11 find that this also makes your regular spell 
checking go faster, because you don't need to reach for 
the mouse when you add words to the dictionary. 

Managing Data With The 'lllble Feature 
An easy and straightforward solution to manage data 
in Word is to keep data in Word's tables. 

From scratch, simply type your merge field names on 
a single line, separating them with tabs. Select the 
line by pointing in the left area of the window and 
clicking once. Now, from the Document menu, select 
Insert Table, and accept the defaults presented to you. 
Your data is now in an easy-to-manage grid, one that 
changes height as you enter data. 

1b enter data, click on the last cell in the row and 

press Return - a new row is started, and you can start 
entering your merge data. 

If you don't like the column widths, you can change 
them: Click on the Ruler icon in the ruler, and T mark­
ers appear; shift these markers around until the table 
suits you. You can also change the page setup to land­
scape instead of portrait, because only the characters in 
your table - not their format -will be merged. 

If you're merging from a database such as one pro­
duced in FileMaker, the process is even easier: Select 
the entire document you've exported from your 
database (Command-click in the selection bar or press 
Command-Option-M), and choose Insert Table from 
the Document menu. FileMaker can output data in the 
exact format Word needs to produce a merge docu­
ment, and the Table feature organizes the information 
so that you can see what you have without having to 
wade around in all those defaulted tabs. 

Tune-saving Indexing 
To use Word's indexing feature, you must mark each 
word that you want to index with i. in front of the word 
and ; after it. This is extremely time-consuming, 
especially if you want to index a word every time it 
appears in a document. Here's an easy way to add 
hidden.i. and; characters around all occurrences of a 
given word in an open document: 

1. Index the first instance of the word as you normally 
would. Choose Save As from the File menu. 

2. In the Save As dialog box, click on File Format and 
choose Interchange Format (RTF). Click on OK. 

3. Give the RTF document a name, and save it. You'll 
see a new version of the file with all kinds of strange 
control codes embedded in it. 

4. Find the first instance of the word that you indexed 
normally. it will be surrounded by codes that might 
look something like this: {\v {\xe\pard\plain\s240 
Indexwork}}. 

5. Select the word and all of this index code -which 
always starts with {\v and ends with}}- and copy 
the selection to the Clipboard. Next, place your inser­
tion point after this word and all the code that sur­
rounds it. 

6. Choose Change (Command-H) from the Utilities 
menu. Type the word you want to index into the Find ~ 
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What: box, and then paste the contents of the 
Clipboard into the Change To: box. 

7. Click on Start Search (choose No when Word asks 
you if you want to continue the search from the 
beginning of the document). This will add the correct 
index codes at the beginning and end of each occur­
rence of the word you want to index. Repeat this pro­
cess for all words you want to index. 

When you've finished, save and close the RTF docu­
ment. When you reopen the document, Word will ask, 
"Interpret RTF text?": click on Yes. The document will 
then appear in normal fonnat with all the relevant 
entries properly indexed. You can verify that all the 
words have been correctly labeled by choosing 
Preferences from the Edit menu and toggling the 
Show Hidden Text button on. You can then create an 
index for the document as normal, using the Index 
command, on the Utilities menu. 

The Word Screen Saver 
Ordinary screen savers may dim your screen or offer 
fireworks and clock displays, but in Word 4.0 and later, 
there's an animated display that is quite beautiful in 
color. Select Commands from the Edit menu and 
choose Screen Thst from the list of commands in the 
dialog box. Click on the Do button. If you click once 
while the images are dancing across the screen, a dia­
log box will let you customize the display or cancel it. 

Formatting Ftelds From A Database Using 
The Mail-Merge Function 
Most database programs can export to PageMaker (and 
other desktop publishing programs), but fonnatting 
text with anything but paragraph-based styles is diffi­
cult. (For example, you might want one field to come 
out in bold, one in italic, and one in a different font 
than the rest). The answer is to use Word's mail-merge 
function. Fonnat the main document as desired, using 
the field names from your database; for example, you 
could boldface the name field and italicize the phone 
field, as shown here: <<DATA Data document>> 
<<Name>> tab <<Address>> tab <<Phone no>> 

Export your database to a tab-delimited ASCII file, 
and set this exported file up in Word as a data docu­
ment. Then you can enter the field names in the data 
document. 

Make sure that no commas appear within the fields 
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(you can search for commas to be certain). 

Go to the main document, choose Print Merge from 
the File menu, produce a new document, and use the 
Change command to get rid of the page breaks 
between entries. You can now import the fonnatted 
Word document into PageMaker or any other page­
layout application. 

Creating An On-Line Hints Menu 
Word users have been inundated with documenta­
tion, help files, and third-party books discussing all 
the program's intricate features. Trying to keep track 
of all this information in its present state is mind­
boggling but worth the effort. 

To have this information literally at your fingertips, 
create a file named Hints in which you store a per­
sonalized set of commands, shortcuts, and tricks 
that you want to keep at your fingertips. Give this 
Hints file menu-bar status by adding it to the Work 
menu. Press Command-Option-+ (plus symbol). 
When the cursor turns into the plus symbol, click on 
your Hints document, either in the Open dialog box 
or in its title bar (if it is the active document). 

Word will create a Work menu on the right-hand side 
of your menu bar or add your Hints document to an 
existing Work menu. 

Launching Mac Write Documents With Word 
Whenever you double-click on a plain-text MacWrite 
document (such as the documentation files you 
download frequently from bulletin boards), it won't 
open unless you have Mac Write on your disk. As a lot 
more people use Word 4.0 than MacWrite, here's a way 
to make Word 4.0 automatically open those MacWrite 
documents in its own fonnat when you double-click 
on them. 

First, make a backup copy of Mac Write (if you have it 
installed) on a floppy and then delete it from your 
hard drive. 

Next, make a duplicate copy of Word 4.0 on the hard 
drive and rename it MacWord. 

By using ResEdit, you can change the Creator of 
MacWord from MSWD to MACA (higl1light MacWord 
and choose Get Info from the File menu). Make the 
changes in the Creator box. 

Now, when you double-click on a MacWrite document, 



MacWord will launch and the document will be con­
verted automatically. 

Quickly Adding Fonts To Word's Font Menu 
If you need to add font names to Word's Font menu 
pressing Command-Option-+ each time can get ' 
tedious in a hurry. Here's a fast, undocumented way to 
add all the currently installed fonts to your menu. 

Choose Commands from Word's Edit (Tools in Word 
5.0) menu, and choose List All Fonts from the list of 
commands. Then click on the Do button. 

The menu bar will flash as Word adds Suitcase fonts 
one at a time to the Font menu. 

Using Insert Graphic To Speed Printing 
Tune 
Inserting a graphic in a word-processing document 
can significantly increase printing time. Here's a trick 
for trimming your printing time on working drafts 
and proofs. 

Measure the illustration's height (many object-oriented 
draw programs have a Show Size option). Insert the 
graphic into a Word document. With the graphic select­
ed, choose Paragraph from the Format menu. Type a 
minus sign in the Line Spacing box and then enter the 
graphic's measurement. The minus sign adjusts the 
paragraph's height to match the size of the graphic. 

Select the graphic again, choose Character from the 
Format menu, and format the graphic as hidden text. 
When you print draft documents, be sure Print Hidden 
Thxt in the Print dialog box is not selected. The illus­
trations will be replaced by an appropriate amount of 
white space, and you'll know where your page breaks 
are. When you're ready for the final version, recheck 
Print Hidden Thxt, and the graphics will print properly. 

Printing Grey 'Iext 
Microsoft Word lets you assign one of eight basic col­
ors to text. Most users don't have access to color output 
devices, and if they do, they probably don't want to 
print those overripe colors anyway. 

But there's a clever application of this feature that 
almost everyone can use. If you color text and then 
print to a laser printer with Version 6.0 or later of the 
LaserWriter driver, the text is halftoned. The order of 
grey-scales, increasing in darkness, is Yellow, Cyan, 
Green, Magenta, Red, Blue. 

Customizing Word To Open The Ruler 
Automatically 
You can make your documents open with the ruler 
automatically displayed by using Commands from 
the Edit menu. Here is how to do it: 

1. Open any Word document. Make sure Full Menus is 
selected. 

2. Choose Commands from the Edit menu. 

3. Make sure the dialog box says "Configuration: Word 
Settings ( 4)" in the lower left comer. This tells you the 
name of the file you are customizing. 

4. Scroll down the command list until Open 
Documents With Ruler show up. (Shortcut: Press the 0 
key to jump to the beginning of the 0 listings.) Click 
on the command name to select it. 

5. Click on the Add button. 

6. Click on Cancel. 

The Open Documents With Ruler command will now 
be listed on the Format menu. It will not be checked 
though, so you will have to activate it. Highlight the' 
new menu command to select it. Every document you 
open from now on will automatically show the ruler. 

It's worth looking through the entire list of com­
mands in the Commands dialog box, since many use­
ful items are tucked away in there, and some of them 
are not documented in the Word manual. 

Accessing The Macron Character 
In most Adobe laser fonts, you can access a plain 
macron character by pressing Shift-Option-comma 
(although the macron may not show on-screen if you 
do not have the appropriate screen font). 

Microsoft Word's formula language allows you to over­
strike one character with another, placing a macron 
over long vowels. 

To put a macron over the desired vowel, type the 
Formula character, Command-Option-\ (it may not 
be visible if the paragraph markers are hidden). If you 
get a beep instead of the Formula character, select Full 
Menus from the Edit menu. 

Next , type an 0 for Overstrike, and then type ( and 
the character you want to have the macron. Finally 
type a comma, the macron and). 
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A Macro For 'lhutsposed Characters 
You can design a macro for Microsoft Word that trans­
poses two letters accidentally typed in the wrong 
order, a common typing error. There may be a draw­
back to this method if the macro uses the standard 
Cut and Paste commands, because it empties the 
Clipboard. Here's a macro that does the job without 
using the Clipboard. 

First, be sure that Num Lock (toggled by the Clear key) 
is off- the status box in the lower left comer of the 
active window should not read Num. Lock. Now begin 
recording your macro. (The macro assumes that 
you've placed the insertion point just after the second 
mistyped letter.) Press Shift-keypad-4, which high­
ligllts the second letter. Next, press Command­
Option-X (the status box will now read Move To), and 
then press the keypad 4 twice, which moves a flashing 
gray vertical line to the spot just before the first letter. 
Now press Return, and then move the insertion point 
back to its original spot by pressing the keypad 6 once. 
Stop recording and assign a keystroke. 

Globally Replacing Fonnats 
There are two indirect ways to globally find and 
replace fonts or formats in Word, for example, if you 
want to be able to change underlined text in a file to 
italicized text. 

The first is to convert the document into RTF (rich 
text fonnat). To do this, choose Save As from the File 
menu, click on the File Fonnat button, and choose 
Interchange fonnat (RTF). When you save the docu­
ment, it appears on screen complete with the fonnat­
ting code. Because the code for underlined text is \ul 
and the code for italici7.ed text is \i, you can globally 
change the fonnatting by using the Change command 
(Command-H). In the Find What box, type \ul; in the 
Change To box, type \i; and then close the document 
and save your changes. When you reopen the docu­
ment and Word asks if you want to interpret RTF text, 
click on OK. All underlined text is now italicized in 
the new (untitled) document. 

The other way to do this is to use the obscure Find 
Fonnat command, described in the Word manual. It 
let<; you search for underlined text, but you have to 
change it to italic manually. 

Here's how it works: To find each occurrence of under­
lined text, first select an underlined character. Invoke 
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Find Fonnats by pressing Command-Option-R, and 
the program finds and selects the next occurrence of 
underlined text. Change it to italic by choosing Italic 
from the Format menu (or type Command-Shift-1). 
1b find the next occurrence of underlined text, choose 
Find Again from the Utilities menu (or type 
Command-Option-A). 

This procedure isn't global; however, it does what you 
want fairly easily. If global-format changing is impor­
tant to you, you should know that other word proces­
sors do it faster and more easily. MacWrite II, for 
example, does it with a few simple selections in its 
Find/ Change dialog box, and Nisus and FuiiWrite 
Professional work similarly. 

Ask yourself how much pain Word's lack of a Change 
By Style feature causes you; if it's really affecting your 
quality of life, think about changing word-processing 
programs. 

Speeding 'lllble Scroll 
When you're working with a table-laden document in 
Word, it can take forever to scroll through the table 
sections. If you frequently use tables in your work, 
here's a trick that can eliminate scroll crawl: 

1. Select the entire table, and choose Copy as Picture 
from Commands in the Edit menu (and while you're 
at it, place this command on your Edit menu). Click 
on Do. 

2. With the table still selected, perfonn a Paste 
( Command-V). The text table will be replaced by a 
graphic version of the same table. Now that the table 
has been changed to a graphic, you can scroll it 
much faster. 

3. Go back to the Commands menu and choose Use 
Picture Placeholders (you can add this to the Edit 
menu as well). Click on Do. 

Caution: If you ever expect to revise the table, you 
should first save a copy of the text version in a sepa­
rate file. Once you have replaced a table with its 
graphic image, you can no longer edit it, with one 
exception: You can cut rows from the bottom up and 
columns from right to left if Show Paragraph 
( Command-Y) and Use Picture Placeholders are off. 
just grab one of the handles on the graphic and drag 
to crop it. 



Add The Pctst Save Enabled Command To 
The File Menu 
The Fast Save command increases the speed of the 
Save command, thereby making it less painful to save 
your files frequently. When you use the Fast Save 
Enabled command, Word saves files in a special file 
fonnat that's fine for saving work in progress. Fast 
Save isn't suitable for final versions, though. If files 
saved in this fonnat are damaged, it's much harder, if 
not impossible, to recover them. 

Placing Fast Save Enabled on the File menu makes it 
easy for you to select or deselect the command before 
you save. Word's default option is to add this com­
mand to the Edit menu, but it makes more sense to 
add it here. 

To add the Fast Save command, choose Commands 
under the Edit menu and look for the Fast Save 
Enabled option in the scrolling field on the left. 
Highlight it, and choose the File menu and click the 
Add button. (You may have to remove the command 
from another menu before adding it to the File menu.) 

Add The Make Backup Files Command To 
The File Menu 
Nonnally, each time you save your work, the new ver­
sion of your file overwrites the previous version. When 
you select the Make Backup Files command, however, 
Word makes a copy of the previous version of your file 
and names it Backup of Filename before executing the 
save. As a result, you always have the last two saved 
versions of your file on-disk. This means that you can 
go back to the previous version of your file, and you 
also have a backup in case something happens to the 
current version of your file. 

To add the Make Backup Files command, choose 
Commands under the Edit menu and look for the 
Make Backup Files option in the scrolling field on the 
left. Highlight it, and choose the File menu and click 
the Add button. 

Add The Load File Into Memory Command 
To A Menu 
This command, which is nonnally in the Preferences 
dialog box, causes Word to keep the current document 
in RAM rather than keep only the currently displayed 
portion of the file in RAM and read the rest from disk as 
you scroll the file. If you're going to be scrolling up and 

down within your file frequently or executing com­
mands that require Word to access the whole document 
(such as Spelling, Hyphenate, Repaginate Now, or 
Print), keeping the file in RAM can speed up Worrl's per­
fonnance. 

If you always work on files for long periods, you may 
be better off checking the Always Load File into 
Memory option in the Preferences dialog box rather 
than adding this command to your menu. However, if 
you sometimes open and close files without perfoml­
ing extensive editing, using this option as a command 
is more efficient. 

Add The Move To Commands To A Menu 
Word provides an exhaustive array of cursor-move­
ment commands that most users never discover. If 
you use the arrow keys to scroll across your files, 
learning to use these commands can give you a whole 
new perspective on word processing. 

Once you are familiar with the commands, learn the 
keyboard command equivalents for real efficiency. You 
can also use these commands to select text; just add the 
Shift key to any of the keyboard command equivalents, 
and text is selected as you move the cursor. 

To add any of the Move To ~ommands, choose 
Commands under the Tools (or Edit menu in Word 4) 
menu and look in the scrolling field on the left. 

Add The Select Whole Document Command 
To The Edit Menu 
People often want to select an entire Word document, 
but it's hard to remember the keyboarrl command 
equivalent (Command-Option-M) or inconvenient to 
use the mouse-click method (Command-click with 
the arrow tool at the far left edge of the window). With 
the Select Whole Document command in the Edit 
menu, selecting an entire document is no longer a 
brain-teaser. Interlace purists will also want to assign 
it the Option-A keyboard equivalent. 

Recovering Word 'Iemp Files 
Before you save a Word document, Word sets up a tem­
porary file and places it in the System Folder. If your 
system has crashed and you want to try recovering a 
Word Thmp file, you can try opening it by holding 
down the Shift key and choosing Open Any File from 
Word's File menu. That should enable you to open the 
Thmp file (try the one with the highest number). If 
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you want to, you can add the Open Any File command 
to your menu permanently by using Word's command 
option, which you'll find on the Edit menu. 

WORD 4.0 
Changing The Default Font 
There is an easy way to change the default font in Word. 
Choose Define Styles from the Fonnat menu, click on 
the Normal style, pull down the Hmt menu (or type 
Command-O), choose the font you want and click on 
the Set Default button. A dialog box will confirm that 
you want to record your choice to the default style sheet. 
Click on OK. That's it- your default font is changed. 

Indexing 'Iechnique Using The Clipboard 
Here's an easy technique that you can use for indexing 
all occurrences of a word. 

Start by manually indexing the first occurrence, using 
Insert Index Entry, on the Document menu. Then 
select the word (make sure you include the index 
characters that appear at the beginning and end of 
the word), and copy it to the Clipboard. In the Change 
dialog box (Command-H), type the word you want to 
index in the Find What Field and type Ac (caret and 
c) in the Change To field (A c represents the Clipboard 
contents). Replace all nonindexed occurrences of the 
word by clicking on either the Change or the Change 
All button. The pasted text retains all fonnatting. 

Using Word Fmder With System 7 
If you use System 7 and Microsoft Word 4.0 or a later 
version, you've probably already discovered that you 
can't use the Word Finder thesaurus DA that comes 
bundled with Word. Because of the way System 7 han­
dles DAs, Word Finder gets confused when it looks to 
see if Word is running. 

There is a workaround for this problem, however. 
(Note that this procedure should be perfonned only on 
a copy of the Word application- never experiment 
with the original program!) 

First, open the Font/DA Mover utility. (You need 
Version 4.1 if you're ~unning System 7. If you have 
only an earlier version, boot from a System 6 floppy 
disk and follow the rest of the directions.) 

Open the Word Finder DA suitcase file on the left side 
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of the Font/DA Mover dialog box. Hold down the 
Option key while clicking on the other Open button, 
and open Microsoft Word on the right side of the dia­
log box. Select Word Finderl and copy it into the Word 
application. Now quit Font/DA Mover. 

Nmv, whenever Word is the active application, the Word 
Finder DA will appear on the Apple menu and function 
properly. 

Inserting Graphics Into A Print-Merge 
Document 
You may be familiar with Word 4.0's Print Merge fea­
tures, which allow you to generate fonn letters by 
using data exported as text files from database pro­
grams. But you aren't limited to using text files for 
your data document; you can also use Word docu­
ments fonnatted as tables in which each row is a 
record and each column is a field. 

One advantage of this method is that it lets you 
include graphics in your data document. For exam­
ple, to include your scanned signature in documents 
to be sent by fax modem, put it into a table cell in 
your data document instead of pasting a copy into 
each file. Then set up the main document to be 
faxed as a print-merge document. Your signature 
will automatically be "scribbled" on each page. 

Use PostScript To Control Cell Border Width 
In 'lllbles 
Word 4.0 has a great table feature, but only limited 
border options for each cell. All it takes is a little 
PostScript programming, however, to make a cell bor­
der of any width. Place the cursor in the cell that you 
want the border around, and type the following two 
lines: 

.cell.. 75 setlinewidth 

wp$box stroke 

and press Retum. 

Then highlight only these lines (not the actual con­
tents of the cell to be printed), and fonnat with the 
PostScript style by pressing the Shift key and choosing 
All Styles from the Fonnat menu. Select PostScript in 
the scrolling list that appears, and click on Apply. 

The number .75 can be replaced with any number of 
your choice. Make sure you've deselected Print Hidden 
Thxt in the Print dialog box before you print. Note that 



Print Preview doesn't accurately reflect your actual 
hard-copy output. Also, this tip works only if you are 
printing to a PostScript printer. 

Combining Box And Check Mark Zapf 
Dingbats 
Here's how to put a Zapf Dingbat check mark into a 
box with a drop shadow: 

1. Press Command-Y to see the symbols for para­
graphs, spaces, and tabs. 

2. Press Command-Option-Backslash, and then 
type 0(0,4). 

3. Select the text (including the backslash), and 
choose Zapf Dingbats from the Font menu. Press 
Command-Y again to hide the paragraph and space 
symbols. You now see a box containing a check mark. 
You can experiment with the various boxes and check 
marks in Zapf Dingbats until you have a combination 
you like. 

Boxing In text 
Just about any currently available word processor 
offers a variety of ways to format words to make them 
stand out from the main body of the document. But 
what do you do when underlining or boldface or even 
something as exotic as a shadow doesn't fit the bill? 
Try a box! Here's how: 

1. Select and format the text to be boxed. (Note: After 
it's been boxed, the text itself can't be reformatted.) 

2. Use Command-Option-D to copy the selection to the 
Clipboard as a graphic. 

3. While the text is still highlighted, use Command-V 
to replace it with the graphic image of the copied 
selection. 

4. Click on the graphic to select it, and box it in by 
choosing the Outlinestyle from the Format menu 
(Command-Shift-D). You can also add shadow 
or boldface format to the outline style for extra 
emphasis. 

The secret here is that the style commands don't work 
just with text- which is what most people assume -
they also work with graphics. 

If the boxed text is on a line with other text, it will sit 
higher, because the bottom of the box sits even with 
the baseline of the text on that line. To correct this, 

select the graphic, choose the Character command 
from the ~onnat menu (Command-D), select sub­
script, and offset the text as needed (the larger the 
font size, the greater the offset required). 

Using Postscript Code to Shade A Cell 
You can use PostScript code to shade a cell in a Word 
4.0 table by typing: .cell .. 75 set gray wp$box fill and 
pressing Enter. Then select the text, and format it with 
the PostScript style by pressing the Shift key and 
selecting Define All Styles from the Format menu. You 
can replace the number .75 with whatever number 
you choose. Make sure that you have deselected Print 
Hidden Thxt in the Print dialog box. 

Viewing Landscape 'Ihbles 
Here's a tip for creating full-page landscape-oriented 
(horizontal, not vertical) tables in Microsoft Word 
when using a small-screen Mac. This tip avoids the 
constant (and painfully slow!) screen redrawing 
that occurs when the cursor moves past the edge of 
the currently visible portion of the table. 

1. Create your table. After you've created the column 
headings and table layout, use the Insert Row com­
mand to specify the number of rows. 

2. Resize the window you're working in so that it fills the 
entire screen horizontally but only half of the screen 
vertically. Place the window at the top of the screen. 

3. Now open a second window for the table; don't split 
the window you're working in -open a new one. 
Resize the new window so that it fits just underneath 
the original one. 

4. Use the horizontal scroll bar to shift the view in the 
new window so that you can see the right edge of the 
table. 

Now you can see your whole table - the top window 
shows the left edge of the table and several of the 
columns toward the middle; the bottom window shows 
the right edge of the table and some of the same mid­
dle columns. 

Enter the table information. When you've finished 
with the last fully visible column in the top window, 
use the mouse to move to the column following it in 
the bottom window. When you get to the right edge 
of the table, use the mouse to move back up to the 
next row in the top window. 
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This is a much quicker and more accurate method 
of creating a table - you never have to wait for the 
screen to redraw while you're typing, and you never 
lose your place because you can't see the row head­
ers at the left edge of the table. 

Sorting A Mail Merge 
Do you want to sort a mail merge data file by zip code 
when the first field is I.&INAME and ZIPCODE is some­
where in the middle of the record? You can try using 
Option-drag to select just the ZIPCODE column. You 
need to set your tabs so that all the zip codes are left­
aligned in a column. Hold down the Option key as you 
drag the mouse to highlight the desired column of text. 

Once you've selected a column of text, using the Sort 
command sorts the records based on the first word of 
each line in the selected column rather than on the 
first word of each paragraph in the data document. 
And remember not to select the field name at the top 
of the document. 

Using Outlining 1b Navigate 
Word 4.0's outline feature is frequently underused, 
probably because most people don't make outlines. 
But this feature can be helpful for more than out­
lining. 

Here is a way to jump quickly to a specified place in a 
long document: 

1. Select Outlining mode (Command-O) from the 
Document menu. 

2. Click on the line of paragraph you want to go to 
(collapsing or expanding as needed). In effect, you're 
creating a kind of bookmark by entering an insertion 
point. 

3. Choose Outlining again to go back to normal edit­
ing mode. Now your cursor is at the right spot, but it's 
probably off-screen. 

4. Press the right- or left-arrow key to scroll the document 
to the cursor's location. 

Using The NEC Daisywheel Printer 
If you use Word 4.0 and a NEC daisywheel printer, you may 
find that the 12th line of te:-.1 on a page often prints over 
the 11th line. This didn't occur with earlier versions. 

You can count down lllines and then insert a blank 
line to overcome the problem, but there is a better 
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solution. The NEC printer uses a pitch of 12, so if 
you choose the Paragraph command from the 
Format menu ( Command-M) and replace Auto in 
the Line Spacing box with-12, the overlapping stops. 

Creating 'lllbles With Varying Column 
Widths 
The Insert lable command in Word 4.0 only lets you 
create table with columns of equal width. Ordinarily, 
you have to struggle with the column markers across 
the ruler to vary the column widths, but there is a 
shortcut that makes it easy: 

1. Say you're creating a three-column table with one 
narrow column on the left for labels and two wide 
columns to the right for entries. As you create the 
table, enter 5 in the Number of Columns box. 

2. Select all the cells in the second and third columns 
by holding down the Option key while dragging the 
mouse over these columns. 

3. Choose Table from the Edit menu and select the 
option for merging the two columns. Repeat this pro­
cedure with columns 4 and 5. 

You now have a three-column table. To get a narrower 
first column and wider entry columns, just increase 
the number of columns in the table by a factor of 2 

A Patch For Fractional Font Widths On 
ImageWriters . 
If you do not own Adobe Type Manager, and you are 
using Microsoft Word, there is a patch -a set of 
modifications to Word - that allows for fractional 
font widths on ImageWriters. It's called 
WORD4MOD.SIT. (It should be available from the , 
usual shareware outlets such as user-group libraries, 
BBSs, and so on. On CompuServe it's called WORD­
MO. BIN in the Macintosh Productivity Forum's word­
processing library.) 

Installing the patch requires familiarity with ResEdit 
(available from the same outlets). Obligatory ResEdit 
waming: Never use ResEdit on an original or master 
of anything. Always work on a copy. And don't forget to 
lock your master disks. That way, if you happen to 
make a mistake and damage something, you can 
always make a fresh copy from the master disk. 

Kerning With The Displace Command 
Microsoft doesn't mention kerning anywhere in the 



Word manuals, but you can do rudimentary kerning 
with two characters: 

1. Choose Show from the Edit menu. 

2. Place the cursor between the two characters you 
want to kern. 

3. Press Option-Command-backslash and then type 
the letter D (the formula code for Displace). 

4. Press Option-Command-backslash again, and then 
type the letters BA (the formula code for Backward). 

5. Enter the number of points to kern (in whole 
points). 

6. Follow this with both open and close parentheses to 
end the formula. The code you see on-screen should 
look like this: \d\ba3 () (using 3 points as an example). 

7. Choose Show again or print your text, to see the dif­
ference in spacing. If you save this formula as a 
Glossary item, you'll have to enter it only once. 

Inserting The Date Into Documents 
Word lets you insert the date into documents through 
its Commands dialog box, but you're stuck with its 
date formats, which include the day of the week 
(except for the short format - for example, 3/31/89 ). 
If you want a date such as March 31, 1989, you'll have 
to suppress the weekday in the System file with 
ResEdit 1.2. (Try this on a copy of your System file 
before you change your working System file.) 

1. Open the System file and scroll down to itll. 

2. Open itll. Select itll US" ID=O and open it. 

3. Next, click on the Suppress Day box (see Figure 2). 

4. Close ResEdit and save the changes. Open a Word 
document. To get the date, make sure you're using Full 
Menus and select Glossary from the Edit menu. You'll 
see the following date entries: date - now - abbreviat­
ed, date - now -long, and date - now -short. 

Select either the long or the abbreviated format and 
click on Insert. The date will appear either as March 
31, 1989, or as Mar. 31, 1989, respectively. 

Inserting PostScript Code In A Word 
Document 
Placing bits of PostScript code (or even lengthy rou­
tines) into a Word document is simple. But Word 

requires that you first clearly define what part of the 
page will be affected by the PostScript code. Is it going 
to affect the entire page (for example, a box enclosing 
the page) or just a paragraph or inserted graphic? 

You define the boundaries by inserting a group com­
mand immediately before the page element it will 
affect. In Word 3.02, you could use three such com­
mands: .page., .para., or .pic. (referring to the entire 
page, the next paragraph, or the next graphic inser­
tion). Version 4.0 has added .cell. and .row. to facili­
tate PostScript manipulation of tabular material. 

1. Group Command'i- Group commands create a 
drawing rectangle that specifies the overall size of a 
PostScript graphic. The actual dimensions of the 
graphic never have to be entered, because the com­
mand gathers this information from Word itself. The 
drawing rectangle created by .page., for example, is 
determined by the page size you've specified with the 
Page Setup command. If your page is 5 x 7 inches, the 
drawing rectangle mirrors those measurements exact­
ly. Most other group commands, such as .para. and 
.pic. let you focus on increasingly smaller or more pre­
cise areas of the page - a paragraph, or a graphic 
frame within a paragraph. 

Mter the group command is entered, you can enter 
PostScript code you've written or copied from another 
source. Here's a simple example that places a 5 x 7 -
inch box on a page. At the top of the page, type the 
following: 

.page. 

newpath 

.25 setlinewidth 

126 144 moveto 

360 0 rlineto 

0 504 rlineto 

-360 0 rlineto 

closepath 

stroke 

Anyone with PostScript savvy will notice some pecu­
liarities here. The primary one is that the PostScript 
inclusion hasn't been bracketed by a save /restore or 
gsave/grestore pair, which prevents certain PostScript ~ 
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operators (rotate, for example) from changing the 
graphics environment of the entire page. Why this 
apparent breach of PostScript etiquette? Because the 
group commands automatically bracket each group­
ing of PostScript code with a save/restore couplet. 

You might also notice that the origin point (0 0) in 
Word's version of the PostScript coordinate system cor­
responds exactly to that found in PostScript itself. 
This means that the origin point (0 0) is found at the 
lower left corner of the current drawing rectangle, 
whether it is a page, paragraph, or graphic frame. 

2 Creating Global Commands-When PostScript 
requires specific measures or positions that can't be 
referred to through the built-in variables, the dimen­
sions are expressed in points. If you feel more comfort­
able working in inches, simply place the following code 
after a group command such as .para. or .page. (and, 
of course, format it in Word's PostScript Style): 

/inch (72 mul) def 

Then you can use code such as I inch 1 inch moveto 
instead of 72 72 move to. The routine you've inserted 
automatically multiplies the inch units by 72, convert­
ing them into PostScript's point system. 

Ordinarily, such a routine applies only to the drawing 
rectangle indicated by the group command. So if you 
had a .page. and several.para. PostScript groups on 
the same page, you would have to insert /inch 172 
mull def in each group. When Word scans the page for 
PostScript, it does each group in turn and discards the 
variables or routines of that group as soon as it has 
been processed. Even routines or variables placed 
after the .page. command can't be used by other 
groups on the same page. 

3. Executing The Postscript Code-If you print the 
document now, you won't magically have a PostScript­
generated box on the page. The code prints as ordi­
nary text. To have it executed, you must do several 
things. 

First, select the PostScript code (including any group 
command). Then hold down the Shift key and pull 
down the Format menu. You'll see that Styles has 
been replaced by the All Styles command. All Styles 
has several predefined styles, including one called 
PostScript. Select it and click on OK. The PostScript 
code has now been changed into a form that will be 
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interpreted rather than printed. To see the code after 
this point, make sure that Show Hidden Thxt is select­
ed in the Preferences dialog box (Edit menu). You 
can't see the results of your tinkering by using the 
Print Preview command; you must print the docu­
ment on a LaserWriter. 

When you print, make sure that Print Hidden Thxt isn't 
selected in the Print dialog box and check the Chooser to 
make certain that Background Printing is turned off, If 
Background Printing is left on, the PostScript effects will 
be shifted down and to the right from where you want 
them on the first page of the document. Subsequent 
pages will print correctly. 

4. Modifying Word's PostScript Code Style-The on­
screen appearance of Word's native PostScript style 
leaves something to be desired. 

Fortunately, you can easily modify most of the 
attributes. While holding down the Shift key, select 
Define All Styles from the Format menu. Select 
PostScript. The description box defines the style as 
"Normal + Font: 10 point, Bold Hidden." The main 
culprit here is Bold, which makes the type hard to 
read. So just pull down the Format menu while the 
dialog box is showing and turn off Bold. You can safe­
ly change anything in the Postscript style other than 
the Hidden attribute. 

Zapf Dingbat Check Mark With Drop 
Shadow 
Here's how to put a Zapf Dingbat check mark into a 
box with a drop shadow: 

1. Press Command-Y to see the symbols for paragraphs, 
spaces, and tabs. 

2. Press Command-Option-Backslash, and then type 
O(o~). 

3. Select the text (including the backslash), and 
choose Zapf Dingbats from the Font menu. Press 
Command-Y again to hide the paragraph and space 
symbols. You now see a box containing a check mark. 
You can experiment with the various boxes and check 
marks in Zapf Dingbats until you have a combination 
you like. 

Exporting 'Ihbles 
Microsoft Word is a great tool for making tables to 
export into page-layout and drawing programs. 1b 



capture the table's border and cell relationships, you 
must use Word's Copy as Picture command 
(Command-Option-D), but this command doesn't 
work properly when you want to include text that is 
not part of the table with the table (as a title or cap­
tion, for instance). Here's a work-around: 

First, move the table away from the header or caption 
to another part of the document. Select the table, 
choose Copy as Picture, and paste the picture where 
the table was before you moved it. Select the picture 
you just pasted, along with the accompanying title or 
caption, and choose Copy as Picture again. The whole 
thing can now be pasted into the DTP or drawing pro­
gram, and you still have a copy that's suitable for edit­
ing in your Word document. 

At first glance, it may seem easier just to make the 
caption or header part of the table by putting the text 
into a table cell, but because this involves deleting 
columns, repositioning cell boundaries, removing cell 
border, and applying styles, it's generally quicker and 
easier to use the two-step Copy as Picture solution. 

Underlining Equations 
Underlining equations with subscripts or superscripts 
can be hard in Word 4.0. The underline style 
(Command-Shift-U) places separate underlines under 
the subscripted or superscripted numbers. Here's how 
to get a solid underline under equations, whether the 
format is displaced or in-line: 

1. Choose the Show Paragraph command from the Edit 
menu (or type Command-Y). 

2. Press Command-Option-/. This is the preparatory 
command for doing mathematical typesetting. 

3. Enter the letter-typesetting code- in this case, X 
(for the Box command). 

4. Press Command-Option-/ again, followed by BO for 
the bottom border of the box. 

5. Type in the arguments, and enclose them in parenthe­
ses. Apply superscript and subscript fom1atting where 
necessary. 

6. To view the fommla, select Hide Paragraphs. Word's 
typesetting code draws a solid line under the equation 
and won't interfere with the rest of the paragraph's for­
matting. 

WORD 5.0 
Producing White Type On A Black 
Background 
With Word S.O's Border Shading feature, you can easily 
produce white type on a black background. It looks 
great for headings in text or tables. Here's how to do it: 

Hrst select the text (a thick, sans serif font works best). In 
tl1e Character dialog box (Command-D), choose bold for 
the style and white as tl1e text color Click on OK. 

With the text still selected, choose Border from the 
Format menu. Select 100 percent from the Shading 
option (to create a solid black background), and click 
on OK. If you don't want the black background to 
stretch across the page, adjust the right margin on 
the ruler. 

To apply inverted headings quickly, save this format as 
a style. If you plan to reuse the same heading text, 
save it in the Glossary or the Scrapbook. 

You can vary this basic procedure to produce attractive 
headings or chapter titles by changing the text's align­
ment, by using a text color other than white, or by 
using a border shade other than 100-percent black. 

Word Finally Calls Fonts By Name 
With Version 5.0, Word finally calls fonts by name. 

You may have encountered a font substitution prob­
lem at some point. This usually occurs when the ID 
numbers of fonts in your system don't match those in 
another system. This is a problem only if your appli­
cation tracks fonts internally by ID number; in such a 
case, ID number 1578 may be Palatino on your Mac 
and Brush Script on another Mac. Current versions of 
most applications- PageMaker, QuarkXPress, and 
FreeHand, for example-identify fonts by name, 
which eliminates the problem. 

If you use older versions of Word or other programs, 
you may run into problems. One workaround for Word 
is to save files in its Interchange Fonnat (RTF), which 
does store font information by name. 

Copying And Pasting Headers And Footers 
To copy headers and footers into a new document, 
simply select and copy (Command-C) the old docu- ~ 
ment's last paragraph return (turn on paragraph 
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display by pressing Command-} if necessary) and 
paste (Command-V) the paragraph return into the 
new document. It doesn't matter how many pages 
long the old document is. When you display the 
headers and footers in the new document, you'll 
find that the old header or footer text has also been 
copied and pasted. The footers and headers remain 
in the new document even if you delete the pasted 
paragraph return. 

WORDPERFECT 
Working Around The Default Application 
Folder 
WbrdPetfect's file selector usually defaults to the 
WOrdPerfect tOlde~ which is a nuisance if you group doc­
uments into fOlders other than the application fOlder. It's 
also annoying that Page Setup selections can't be saved 
as a part of a style even though they can be saved in a 
document file. 

The solution to these problems is simple under 
System 7: first, start WordPerfect, and then select your 
default style and make whatever changes you want in 
the Page Setup dialog box. When you've saved the 
document as you normally would, save it as a 
WordPerfect stationery pad, and put it into the same 
folder that contains your WordPerfect documents. You 
can also create an alias of the document and place it 
in the folder from which you usually launch 
WordPerfect. It's a good idea to paste the WordPerfect 
application icon on to the stationery document so 
other users will know to double-click on it. 

From now on, whenever you want to use WordPerfect, 
double-click on the stationery pad's alias. Not only 
will you open to an empty document that is set up 
exactly the way you want but your file selector will 
also default to the WordPerfect document folder 
instead of to the application folder. 

Graphic Rulers 
WordPerfect's drawing environment doesn't provide a 
ruler, but there are a couple of easy workarounds. You 
can use a screen-capture utility such as Capture to 
graph the ruler in the main document window and 
paste it into the drawing window. Save the ruler in the 
Scrapbook for future use. The other option is to leave 
an untitled document open with the ruler displayed. 
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Open a second document and then open the drawing 
window. Move the document window down until the 
ruler in the first untitled document becomes visible. 

Quick Kerns 
Kerning is an option of the Layout menu's Line com­
mand. It brings up a dialog box in which you can 
enter kerning values, but a quick kerning method is to 
use the F 1 and F2 keys. 

Place the insertion point between the two letters you 
want to kern. Press Shift-Fl to move letters together 1 
pointorShift-F2 to move them apart 1 point. You'll 
see the change in your document immediately. 

WRITE NOW 
Setting Up Infonnal Style Sheets 
You can set up informal style sheets, using the dummy 
formats that you frequently use, in a document tem­
plate that is kept open whenever you're working in 
WriteNO\v. 

When you need a style, just switch windows, click on 
the paragraph containing the format you need, and 
copy the ruler (Command-1}. Then switch back to 
the document window and paste the ruler in 
(Command-2). Although this method only copies 
ruler settings (not font or style changes, for instance), 
it can still be a real time-saver. It also helps ensure 
that your documents all have a uniform style. 

Later, if you want to change a particular format, you 
can use WriteNow's identical ruler feature. just select 
the text from the first occurrence of the format to the 
end of the document and then hold down the Shift key 
while making the change in its ruler. 

Mac User Hints & Tips is a collection of Mac User's tips, 
tricks, and undocumented features. Edited and com­
piled by Erica Kerwien. Special thanks to Ric Ford's 
keen eyes. Questions regarding this stack can be for­
warded to Erica Kerwien on CompuServe at 72511,241, 
and on AppleLink at EKerwien. Ziff-Davis Publishing 
Company. 
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